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WARNINGWARNING

For continued protection against fire hazard, replace fuses with those 
of the same type and rating.

AVERTISSEMENT

Remplacez les fusibles par ceux de même type et puissance pour 
éviter les risques d’incendie.

WARNINGWARNING

Before handling any chemicals, refer to the Material Safety Data Sheet 
provided by the manufacturer, and observe all relevant precautions.

AVERTISSEMENT

Avant de manipuler des produits chimiques, veuillez consulter la fiche 
de sécurité du matériel fournie par le fabricant, et observer les 
mesures de précaution qui s’imposent.

WARNINGWARNING

Always wear eye protection when working with solvents or any 
pressurized liquids.

AVERTISSEMENT

Porter toujours des protections pour les yeux lorsque vous manipulez 
des solvants ou tout autre liquide sous pression.



WARNINGWARNING

PEEK tubing is a polymeric material. Use caution when working with 
any polymer tubing under pressure.

1. Always wear eye protection when in close proximity to pressurized
polymer tubing.
2. Extinguish all nearby flames if using flammable solvents.
3. Do not use PEEK tubing that has been severely stressed or
kinked.
4. Do not use PEEK tubing with tetrahydrofuran or concentrated nitric
and sulfuric acids.
5. Methylene chloride and dimethyl sulfoxide cause PEEK tubing to
swell and greatly reduce the rupture pressure of the tubing.
6. With high solvent flow rates (40 ml/min), a static charge may build
up on the surface of the tubing. Electrical sparks may result.

AVERTISSEMENT

Le tubage PEEK est un matériau polymère. Prenez des précautions 
lorsque vous travaillez avec un tubage polymère sous pression.

1.Porter toujours des protections pour les yeux lorsque vous vous 
trouvez à proximité d’un tubage polymère sous pression.
2.Éteindre toutes les flammes avoisinantes si vous utilisez des 
solvants inflammables.
3.Nes pas utiliser un tubage PEEK qui a déjà été sérieusement 
travaillé ou plié.
4.Nes pas utiliser un tubage PEEK avec du tétrahydrofurane ou des 
acides nitriques et sulfuriques concentrés.
5.Le chlorure de méthylène et le sulfoxyde de diméthyle entraînent un 
gonflement du tubage PEEK et réduisent fortement la résistance à la 
rupture du tubage.
6.Avec des débits d’écoulement de solvants élevés (>á 40 ml/min), 
une charge statique puet se développer sur la surface du tubage. Des 
étincelles électriques peuvent en résulter.



WARNINGWARNING

Use this product only as specified in this document. Using this system 
in a manner not specified may result in injury or damage to the system.

AVERTISSEMENT

Veuillez suivre avec attention les indications figurant dans ce 
document lorsque vous utilisez ce produit. Un usage différent le 
système causer un accident ou endommager le système.



CAUTION

Failure to leave the pH and conductivity monitors in a 1 M salt solution 
and to run the SYSCLEAN method after daily use may result in system 
downtime. See Section 2.6, Starting Up and Shutting Down, for the 
recommended procedure.

CAUTION

Do not use methylene chloride, tetrahydrofuran, dimethyl sulfoxide, or 
concentrated nitric or sulfuric acids. These materials are not 
compatible with the PEEK components in the BioCAD 700E 
Workstation.

CAUTION

Certain organic solvents, such as acetonitrile and isopropanol used 
over long time periods or in high concentrations, can weaken PEEK 
tubing on the BioCAD 700E Workstation. Change the PEEK tubing on 
the workstation periodically if you use organic solvents frequently or in 
high concentrations. For more information, contact Applied Biosystems 
Technical Support.

CAUTION

If you are using organic solvents, bypass the pH and conductivity 
monitors to prevent damage. You can bypass the pH and conductivity 
monitors by clicking the Bypass option button in the pH/Cond section 
of the Control Panel or in the General Settings of a method.



US Safety and EMC (Electromagnetic Compatibility) Standards

Safety

This instrument has been tested to and complies with standard ANSI/UL 3101-1, “Electrical 

Equipment for Laboratory Use; Part 1: General Requirements”, 1st Edition. It is an ETL Testing 

Laboratories listed product.

EMC

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) this device must accept 

any interference received, including interference that may cause undesired operation.

Warning: Changes or modifications to this unit not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

Note: Shielded cables must be used with this unit to ensure compliance with the Class A FCC 
limits.



Canadian Safety and EMC (Electromagnetic Compatibility) Standards

Safety

This instrument has been tested to and complies with standard CSA 1010, “Safety Requirements 

for Electrical Equipment for Measurement, Control, and Laboratory Use; Part 1: General 

Requirements”. It is an ETL Testing Laboratories listed product.

Sécurité

Cet instrument a été vérifié avec la norme CSA 1010, «Spécifications de sécurité du matériel 

électrique utilisé pour les mesures, les contrôles et dans les laboratoires ; Partie 1 : Spécifications 

générales», et il est conforme à cette norme. C’est un produit homologué par les ETL Testing 

Laboratories.

EMC

This Class A digital apparatus meets all requirements of the Canadian 

Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le 

materiel brouilleur du Canada.

European Safety and EMC (Electromagnetic Compatibility) Standards

Declaration of Conformity

Application of Council Directive(s): 73/23/EEC “Low Voltage”

89/336/EEC “Electromagnetic Compatibility”

Standard(s) to which conformity is 

declared:

EN61010-1:1993, “Safety Requirements for Electrical Equipment for 

Measurement, Control and Laboratory Use”

EN55011:1991, Group 1, Class B “Radiated Emissions”

EN50082-1:1991 “Generic Immunity”

Manufacturer’s Name: Applied Biosystems

Manufacturer’s Address: 500 Old Connecticut Path

Framingham, Massachusetts 01701 USA

Type of Equipment: Laboratory Instrumentation

Model Name: BioCAD 700E Workstation

Model Number: 5-1004-75

Serial Number: 1068 and later

Year of Manufacture: 1997 and later
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How to Use This Guide

Purpose Applied  Biosystems’ BioCAD® 700E Workstation User Guide 

details the procedures for installing, running, maintaining, and 

troubleshooting the BioCAD® 700E Workstation.

Audience This guide is intended for novice and experienced BioCAD 

700E Workstation users who are developing and executing 

analytical and preparative separation protocols of 

biomolecules based on POROS® Perfusion Chromatography® 

media and conventional chromatography media. 

Structure Applied  Biosystems’ BioCAD 700E Workstation User Guide is 

divided into ten chapters. Each chapter page is marked with a 

tab and a header to help you locate information within the 

chapter.

The table below describes the material covered in each 

chapter.

Chapter 1, 
Introducing the 

BioCAD 700E 

Workstation

Describes the system hardware and 

software. Includes a quick introduction 

to Microsoft ® Windows®.

Chapter 2, 

Installing the 

BioCAD 700E 

Workstation

Provides procedures for installing the 

system, connecting components (such 

as tubing and external devices), 

installing the software, starting up, and 

shutting down. 

Chapter 3,

Preparing the 

Workstation and 

External 

Devices

Describes how to prepare the 

hardware components of the system 

for operation, including columns, 

plumbing, buffers/solvents, samples, 

and external devices. Explains how to 

prime and flush the system.
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Chapter 4, 

Configuring and 

Preparing the 

BioCAD 

Software

Describes how to configure and 

prepare the BioCAD software for 

operation. Includes instructions for 

configuring and preparing the pump, 

buffers/solvents, samples, columns, 

detectors, autosampler, and fraction 

collector.

Chapter 5,

Controlling the 

Workstation 

from the Control 

Panel

Describes how to control the system 

manually from the Control Panel and 

Sample Table.

Chapter 6, 
Creating and 

Running 

Methods 

Describes how to use the Method 

Editor to create and run methods.

Chapter 7, 
Creating and 

Running 

Templates and 

Multi-Methods

Describes how to use templates and 

multi-methods to systematically run 

and develop methods.

Chapter 8,

Viewing Results

and Checking 

Status

Describes how to use the Method 

Queue, Status Window, Strip Chart 

Recorder, Timer, and Event Log to 

view the results and status of an 

injection.

Chapter 9,
Maintenance

Describes maintenance procedures. 

Includes a checklist of preventative 

maintenance tasks and schedule.

Chapter 10,

Troubleshooting

and Error 

Codes

Includes troubleshooting information 

and error codes.
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Appendix A,
Specifications

Includes system specifications.

Appendix B,
Spare Parts

Provides a list of spare parts.

Appendix C,
Warranty/

Service 

Information

Includes warranty information.

Appendix D,

BioCAD Sample 

Methods

Describes the sample methods 

supplied with the system.

Appendix E,

External 

Instrument 

Connections

Lists the pin assignments for the 

connectors on the left panel of the 

workstation.

Appendix F,

Autosampler 

Injection Types

Describes the processes that occur 

when making each type of 

autosampler injection.

Appendix G,

Maintenance 

Log

Contains log sheets that you can use 

to keep track of scheduled 

maintenance.

Appendix H,

Autoloader 

Flow Path

Includes diagrams of the autoloader 

flow path during various operations.
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Conventions This guide uses the following conventions to make the text 

easier to understand.

General
conventions

The following general conventions are used:

• Bold text indicates user action:

“Type 0 and press Enter for the remaining 

fields.” 

• Italic text denotes new or important words, and is also 

used for emphasis:

“Prior to operation, always check for eluent 

miscibility.”

Notes, Hints,
Cautions, and

Warnings

Notes, Hints, Cautions, and Warnings are used as follows:

• A note calls out important information to the user:

NOTE: Record your result before proceeding with the 
next step.

• A hint provides helpful suggestions not essential to the 

use of the product:

Hint: Use Heat/Mix segments after Dilute segments 
to produce a uniform mixture.

• A caution calls out information to avoid damage to the 

system or equipment:

CAUTION
Do not touch the flow cell window. This may damage 
the flow cell. 

• A warning calls out information essential to the safety of 

the user:

WARNING
Always observe safe laboratory practices when 
operating your system.
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Remarques,

recommandations
et avertissements

Une remarque fournit une information importante à l’opérateur 

er se présente ainsi:

REMARQUE: Si on vous demande d’insérer la disquette de 
démarrage dans le lecteur, insérez-la puis appuyez sur 
n’importe quelle touche.

Une recommandation fournit une information destinée à éviter 

des détériorations du système et de la synthèse ou la perte de 

données:

RECOMMANDATION
La lampe peut être endommagée. N’y touchez pas.

Un avertissement fournit une information indispensable à la 

sécurité de l’operateur et se présente ainsi:

AVERTISSEMENT
Conformez-vous toujours aux règlements du laboratoire 
quand vous utilisez votre système.

Symbols used
on the system

The following symbol appears next to the values of the fuses 

required by the system.

Le symbole ci-contre figure à côté de la valeur des fusibles 

nécessaires avec ce système.
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Related

documentation
These additional documents are shipped with your system:

• Applied  Biosystems’ BioCAD 700E Workstation 
Getting Started Guide—Use this guide to learn the 

basics of operating your BioCAD 700E Workstation. It 

provides step-by-step information for running your first 

experiment.

• Applied  Biosystems’ Data Analysis Getting Started 
Guide and User’s Guide—Use these guides to learn 

to how to use the Data Analysis software provided with 

your BioCAD 700E Workstation.

• Applied  Biosystems’ UV/Vis-201/205 Absorbance 
Detectors Operating Manual—Use this manual if you 

are setting up an external or auxiliary UV/Vis detector. If 

you are using the internal UV/Vis detector in the 

BioCAD 700E Workstation, you do not need this 

manual.

• Applied  Biosystems’ 304/305 Fluorescence 
Detectors Operating Manual —If your system 

includes a fluorescence detector, use this manual to 

obtain detailed operating instructions, advanced 

programming information, and maintenance 

information. The BioCAD 700E Workstation User Guide 

includes information for connecting and configuring a 

fluorescence detector as an external or auxiliary 

detector.

• Applied  Biosystems’ SCOUT ® Column Selector 
User’s Guide—If your system includes a SCOUT 

Column Selector, use this guide to obtain procedures 

for installing, running, maintaining, and 

troubleshooting the SCOUT Column Selector.

• Printer documentation (depends on the printer you 

purchase)—Use this documentation to set up and 

service your printer.
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• Microsoft ® Windows® User Guide and related 

documents—Use this guide to learn detailed 

information about the Microsoft Windows user interface. 

The BioCAD 700E Workstation User Guide includes a 

quick introduction to Windows.

• Microsoft ® Excel  User’s Guide and related 

documents—If your workstation includes the Microsoft 

Office option, use these documents to learn how to use 

the Microsoft Excel software after you export data from 

the BioCAD software. 

• SpectraSYSTEM ® Autosamplers Reference 
Manual—If your system includes an optional 

autosampler, use this manual to obtain detailed 

operating instructions, advanced programming 

information, and maintenance information for the 

autosampler. The BioCAD 700E Workstation User 
Guide contains basic programming information.

• Advantec ® Super Fraction Collector SF-2120-
Operation Instruction Manual or Gilson ® FC 205 
Fraction Collector User Guide —If your system 

includes an optional fraction collector, use this manual 

to obtain detailed operating instructions, advanced 

programming information, and maintenance information 

for the fraction collector. The BioCAD 700E Workstation 
User Guide contains basic programming information.

Send us your
comments

We welcome your comments and suggestions for improving 

our manuals. You can send us your comments in two ways: 

Use the Technical Publications Customer Survey at:

www.appliedbiosystems.com/perseptive/techsup/survey2.htm

Send e-mail to: 

TechPubs@appliedbiosystems.com 
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®

 700E
Workstation

This chapter includes the following sections:
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1.2  Systematic Method Development with

Perfusion Chromatography .....................  1-4

1.3  Parts of the System.................................  1-8
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1.5  BioCAD Software File Structure ............  1-30

1.6  A Quick Introduction to Microsoft 

Windows ...............................................  1-36
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1 1.1  System Features

Overview Applied Biosystems’ BioCAD® 700E Workstation for Perfusion 

Chromatography® is a computer-aided chromatography 

workstation that integrates all aspects of biomolecule 

purification with Perfusion Chromatography technology.

The BioCAD 700E Workstation is designed for:

• Chromatographic method execution—Routine 

execution of chromatographic methods for the 

purification and analysis of biomolecules.

• Systematic method development—The goal of 

method development is to optimize conditions for your 

application. Systematic method development makes it 

easy to identify variables that affect your application, 

systematically change the variables, observe the 

effects, and use the information to optimize 

chromatographic conditions.
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Features The BioCAD 700E Workstation provides the following 

features:

• Simplicity—Microsoft® Windows®-based software that 

is intuitive and easy to use. You can efficiently develop 

and execute separations for analytical and preparative 

applications.

• Full Process Capability—Full capability from sample 

injection through fraction collection, including 

automated column washing and regeneration.

• Speed—Chromatographic separations in as little as 

one to three minutes, when using POROS® media and 

columns.

• Versatility—Multiple column configurations and 

injection mode options.

• Gradient Capability—Six-buffer/solvent capability, 

with simultaneous blending between any four 

buffers/solvents.

• Detection—Monitoring of pH, conductivity, 

dual-wavelength UV/Vis absorbance, fluorescence 

(optional), and system pressure.

• Templates—Predefined templates for systematic 

method development of key variables such as pH, 

gradient slope, and sample load.

• Data Analysis—Data analysis of single data files or 

groups of data files.

• SCOUT® Column Selector—Automated multi-column 

switching device that allows flow to be diverted to any 

one of six attached columns (optional).
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1 1.2  Systematic Method
Development with

 Perfusion Chromatography

Overview You can manipulate many variables in the separation of 

biological molecules. Ideally, you identify the variables most 

likely to affect your separation and systematically optimize the 

variables.

The development of each new method proceeds differently, 

but follows a typical method development cycle (Figure 1-1). 

Often, the cycle does not proceed linearly. Instead, results 

from each step can require that you reoptimize a variable from 

a previous step.

Figure 1-1  Method Development Cycle
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Conventional

chromatography
With conventional liquid chromatography columns and media, 

run times range from 30 minutes to several hours. To develop 

a method in a timely manner, you must often make guesses 

and change more than one variable at a time.

Perfusion
Chromatography

and BioCAD

With POROS Perfusion Chromatography media and columns 

and the BioCAD 700E Workstation, separations can often be 

completed in less than five minutes. Short run times, the 

unique templating and multi-method features, and the 

automated analysis features of the BioCAD software allow you 

to systematically investigate and optimize each variable, one 

at a time.

Variables
affecting a
separation

Table 1-1, “Variables Affecting Separations,” on page 1-6 lists 

variables that affect separations and the BioCAD 700E 

template you can use to optimize the variable. The table also 

rates the effect (Strong, Moderate, Weak) each variable has 

on four different modes of chromatography.

NOTE: Variables listed as Strong have a major effect on a 
separation and should be examined. Moderate variables 
can have a significant effect. Weak variables can often be 
ignored.
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Table 1-1   Variables Affecting Separations 

Variable
BioCAD 700E

Template

Mode

Ion 
Exchange

Hydrophobic 
Interaction

Reversed-
Phase

Affinity

Surface 

chemistry

Column 

Switching Strong Strong Moderate Weak

pH pH Map Strong Moderate Moderate Moderate

Eluting agent Combinatorial Moderate Moderate Weak Strong

Buffers/ 

additives Combinatorial Moderate Weak Strong Weak

Elution steps

Step 

Optimization Strong Strong Moderate Moderate

Gradient 

profile

Linear 

Gradient Strong Strong Strong Weak

Column 

length

Column 

Switching Weak Weak Moderate Weak

Flow rate1

1. Weak variable for Perfusion Chromatography media only. Flow rate can have a strong effect on 

conventional chromatography media.

Flow Rate Weak Weak Weak Weak

Sample load

Loading 

Study Strong Strong Strong Weak

Cleanup/ 

regeneration2

2. Importance varies highly with sample.

Auto Cycling Moderate Moderate Moderate Moderate
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Example of
systematic

method
development

The following example is a typical procedure that you might 

use for systematic method development of an ion exchange 

method:

1. Identify the key variables that affect the separation: pH, 

solvent blending, and sample load.

2. Create the method. 

3. Run a pH Map template to determine the optimum pH for 

the separation.

4. Using the method that generated the data file with 

optimized pH, run a Linear Gradient template to determine 

the optimum gradient for the separation.

5. Using the method that generated the data file with 

optimized gradient, run a Loading Study template to 

determine the optimum sample load for the separation.

You now have a method that is optimized for pH, 

gradient, and sample load.
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1 1.3  Parts of the System

Overview The BioCAD 700E Workstation is shown in Figure 1-2. 

Opening front
doors

The BioCAD 700E Workstation has two front doors that open 

from the center. To open the front doors, run your hand along 

the bottom of the door (not the bottom of the workstation) until 

you locate the notch. Pull out on the notch.

Parts of the
system

The BioCAD 700E Workstation includes:

• Front panel indicators and controls

• Buffer/solvent and pump system

• Sample loader

• Columns and plumbing

• Detector and monitors

• Fraction collection

• Computer components

Figure 1-2  BioCAD 700E Workstation
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1.3.1  Front Panel Indicators and Controls

The front panel is located at the top-right side of the 

workstation (Figure 1-3).

Figure 1-3  Front Panel Indicators and Controls

Indicators The front panel includes LED (light emitting diode) indicators: 

• Power On/Off—Indicates status of system power

• Fraction—Indicates valve position of the built-in 

fraction/waste valve

• Pump On/Off—Indicates status of pump

• Event Mark—Indicates status of Event Mark control

• Lamp On/Off—Indicates status of UV/Vis detector 

lamp

Controls The front panel includes push-button controls:

• Fraction—Selects fraction/waste valve position 

(fraction or waste)

• Pump On/Off—Turns pump on and off

• Event Mark—Marks the electronic strip chart recorder 

manually with an MRK notation

• Lamp On/Off—Turns UV/Vis detector lamp on and off
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1.3.2  Buffer/Solvent and Pump System

The buffer/solvent and pump system is located behind the 

door at the bottom-right side of the workstation (Figure 1-4). 

It includes:

• Tubing

• Proportioning valve

• Pump

• Pump seal wash system

• Prime/purge valve

• Filter/Mixer

• Sparge panel (located on the right side panel)

NOTE: Do not add inline or endline solvent filters before the 
pumps. Filters before the pumps can cause pump cavitation 
(vacuum formation).

Figure 1-4  BioCAD 700E Buffer/Solvent and Pump System
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Tubing The lines that extend out of the right side of the workstation 

include:

• Six buffer/solvent lines, labeled A through F

• Two urethane pump seal wash lines

• One autoloader waste line

Proportioning
valve

The proportioning valve is located behind the door at the 

bottom of the BioCAD 700E Workstation (see Figure 1-4). It 

can simultaneously blend up to four solvents.

Pump The pump is located behind the door at the bottom of the 

workstation (see Figure 1-4). It includes:

• Primary pump—Located on the right, this larger pump 

receives the blend from the six buffer/solvent lines and 

delivers to the Accumulator pump.

• Accumulator pump—Located on the left, this smaller 

pump delivers the blend to the system.

The pump heads protrude through the plastic panel to allow 

easy removal for service. 

Pump seal wash
system

The pump seal wash system consists of the pump seal wash 

lines and pump seal wash solution. The pump seal wash 

system minimizes pump seal deterioration by flushing the 

back side of the seals continuously for maximum cleaning. 

This method is superior to gravity flow seal-flushing systems 

or scheduled manual cleaning. Each time the piston cycles, 

wash solution is drawn over the back side of the piston, 

keeping the piston clean and prolonging the lifetime of the 

pump seals. 

Prime/purge valve The prime/purge valve is located to the right of the pump 

heads (see Figure 1-4). You can control this valve to remove 

air from the buffer/solvent flow path.

Filter/mixer The mixer is located to the right of the prime/purge valve (see 

Figure 1-4). It contains a frit that filters mobile phase as it 

leaves the pump to remove particulate matter that may occur 

as pump seals wear.

Sparge panel The sparge panel is located on the right side panel of the 

workstation (Figure 2-3).

There are six sparge valves, labeled A through F. Six sparge 

lines connect from the sparge valves to the buffer/solvents. 

Each sparge valve has an individual gas flow control knob.
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1.3.3  Sample Loader

Parts of the
sample loader

The sample loader is located at the top of the workstation 

(Figure 1-5). The sample loader includes:

• Injection valve (6 ports, high-pressure) 

• Sample loop (100 µl, 2 ml, and 5ml, included)

• Needle port adaptor

• Syringe pump (500 µl and 5 ml syringes included)

• Autoloader (4 port low-pressure sample selection valve)

• Sample lines (4)

Figure 1-5  BioCAD 700E Sample Loader
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Table 1-2   BioCAD 700E Workstation Injection Modes

For information on making injections, see Section 5.3, Making 

Injections From the Control Panel, or Section 6.3, Creating 

Typical Methods.

Injection 
Mode

Description When to Use
Volume 
Range

Autoloader Automatically injects from one 

of four sample vessels.

For routine injections. 

To switch between 

various samples.

25 ml 

maximum

Direct 

Autoloader

Bypasses the sample lines and 

automatically injects directly 

from one sample vial mounted 

on the column clamp adjacent 

to the valve. 

To minimize sample 

loss by reducing 

prime volume.

25 ml 

maximum

Manual Bypasses the autoloader and 

allows you to inject directly into 

the injection valve and sample 

loop using a syringe and 

needle port adapter.

To further minimize 

sample loss by 

eliminating prime 

volume.

Limited by 

syringe 

size

Pump Bypasses the injection valve 

and injects large volume 

samples through the pump 

using the buffer/solvent lines.

To inject large volume 

samples.

Greater 

than 5 ml

Direct Wire 

Autosampler

Injects from an optional, 

external autosampler. You 

control the autosampler 

functions from the autosampler 

controls.

To make multiple 

injections of single or 

multiple samples for 

analytical 

applications.

Limited by 

vial size

Integrated 

Autosampler

Injects from an optional, 

external autosampler 

(AS 3500). You control the 

autosampler functions from the 

BioCAD software.

To make multiple 

injections of single or 

multiple samples for 

analytical 

applications.

Limited by 

vial size
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1.3.4  Columns and Plumbing

Columns and
plumbing

Columns and plumbing are located on the front-center panel 

of the workstation (Figure 1-6).

Figure 1-6  BioCAD 700E Columns and Plumbing
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Column plumbing

configurations
Five column plumbing configurations are available on the 

BioCAD 700E Workstation:

• Single column

• Tandem column

• Three column

• Direct control

• Low dispersion

Plumbing configurations are illustrated in Section 3.1.3, 

Plumbing Tubing and Columns.

Single column Single-column configuration allows you to:

• Operate Column 1 alone

• Bypass Column 1 directly to the detectors

• Backflush Column 1 for washing, regeneration, or 

reversed elution

Tandem column Tandem-column configuration allows you to:

• Operate Column 1 alone

• Operate Column 2 alone

• Operate Column 1 and Column 2 in series

• Bypass both columns directly to the detectors

Three column Three-column configuration allows you to operate any one of 

the three columns individually. You cannot operate more than 

one column at a time. You cannot bypass all of the columns. 

One column is inline at all times.

Direct control Direct control configuration allows you to customize plumbing 

in configurations other than those directly supported by the 

software. You plumb columns and column switching valves 

any way you desire. You control flow direction by specifying 

column switching valve positions (clockwise or 

counterclockwise).

Low dispersion Low-dispersion configuration is a single-column configuration. 

It shortens the flow path and minimizes delay volume by 

bypassing the two column switching valves. However, only 

forward flow is available, and the column is inline at all times.

SCOUT The optional SCOUT® Column Selector is an automated 

multi-column switching device that allows the flow to be 

diverted to up to six columns. For more information, see the 

SCOUT ® Column Selector User’s Guide.
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1.3.5  Detectors and Monitors

Detectors and monitors are located on the left side of the 

workstation, behind the front door (Figure 1-7). The BioCAD 

700E Workstation includes three detectors and monitors:

• pH monitor

• Conductivity monitor

• UV/Vis absorbance detector

You can connect two optional detectors:

• External detector (not shown)

• Auxiliary detector (not shown)

Figure 1-7  BioCAD 700E Detectors and Monitors
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pH and

conductivity
monitors

The BioCAD 700E Workstation includes pH and conductivity 

monitors to monitor the buffer/solvent composition.

A 6-port selection valve allows you to bypass the pH and 

conductivity monitors. When you take the pH and conductivity 

monitors out of line, the output from the UV/Vis absorbance 

detector flows directly to the fraction collection valve.

NOTE: Detector bypass affects only pH and conductivity 
monitors. You cannot bypass the UV/Vis detector.

UV/Vis detectors The BioCAD 700E Workstation has two UV/Vis detector 

options:

• Internal dual-wavelength—A Model 205 detector is 

installed in the workstation. This detector can function 

in single- or dual-wavelength mode. It includes 

deuterium and tungsten lamps.

A motorized grating allows data sampling at two 

wavelengths. However, only one lamp can be used for 

dual wavelength operation. The lamp used depends on 

the wavelength setting. The wavelength range depends 

on whether you select single- or dual-wavelength mode 

when you control detectors. See Section 5.2.6, 

Controlling Detectors.

• External dual-wavelength—An external Model 201, 

204, or 205 detector is connected to and controlled 

from the BioCAD 700E Workstation. Dual-wavelength 

mode is always available, because the internal detector 

is used for one wavelength and the external detector is 

used for the second wavelength. See “External 

detectors” on page 1-18 for more information.

Single Wavelength Range 
190 nm to 800 nm

Dual wavelength Range 
190 nm to 700 nm

Deuterium lamp (UV)—

190 to 365 nm

Deuterium lamp (UV)—

190 to 450 nm

Tungsten lamp (Vis)—

366 to 800 nm

Tungsten lamp (Vis)—

366 to 700 nm
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1 NOTE: The maximum number of UV/Vis wavelengths you 
can monitor is two. When you connect an external detector, 
only dual-wavelength mode is available, because the internal 
detector is used for one wavelength and the external detector 
is used for the second wavelength. The internal UV/Vis 
detector is limited to single-wavelength monitoring when 
you install an external UV/Vis detector.

External
detectors

You can optionally connect an external UV/Vis or external 

fluorescence detector to the BioCAD 700E Workstation. 

Use UV/Vis or fluorescence detectors provided by Applied 

Biosystems only (see below). The BioCAD software has 

complete control over the external detector functions. You 

program the external detector using the BioCAD software.

See Section 2.4.1, Connecting an External Detector (UV/Vis 

or Fluorescence), for installation instructions.

UV/Vis You can optionally install one of the following as an external 

UV/Vis detector:

• Model 201 UV/Vis Detector (single-wavelength)

• Model 204 UV/Vis Detector (single-wavelength)

• Model 205 UV/Vis Detector (dual-wavelength)

See “UV/Vis detectors” on page 1-17 for more information on 

external UV/Vis detectors. 

Fluorescence You can optionally install a Model 304/305 Fluorescence 

Detector as an external detector. 

Auxiliary
detectors

You can optionally connect an auxiliary detector to the 

BioCAD 700E Workstation and collect the analog signal. 

Auxiliary detectors can be UV/Vis, fluorescence, refractive 

index, electrochemical, or any detector with an analog output. 

The BioCAD software has no control over the auxiliary 

detector functions. You program the auxiliary detector using 

the detector controls.

See Section 2.4.2, Connecting an Auxiliary Detector, for 

installation instructions.
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1
1.3.6  Fraction Collection

The fraction/waste valve (Figure 1-8) is located on the top-left 

side of the workstation, behind the front door.

Figure 1-8  BioCAD 700E Fraction/Waste Valve

The 3-port fraction/waste valve allows you to divert the flow to 

waste or to collect fractions. By controlling the fraction/waste 

valve from the Control Panel or in a method, you have direct 

control over the fractions you collect. 

Optional fraction
collector

You can also install an optional fraction collector and control it 

from the Control Panel or in a method. For more information, 

see the following sections:

• Section 2.4.3, Connecting the Fraction Collector

• Section 3.5, Preparing the Fraction Collector

• Section 4.6, Configuring and Preparing the BioCAD 

Software for a Fraction Collector

• Section 5.4.1, Controlling the Fraction Collector

• Section 6.2.6, Adding Events

PB100064

To fraction

To waste

From
bypass

valve
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1
1.3.7  Computer Components

Hardware The BioCAD 700E Workstation includes the following 

minimum computer hardware components:

• Internal Pentium® 133 MHz computer with a 

3.2 gigabyte hard disk drive and 64 MB RAM (Random 

Access Memory)

• Internal 3.5-inch HD (high density) 1.44 MB floppy disk 

drive

• 14-inch color monitor (optional 17-inch or 21-inch 

monitors available)

• Windows 95 104-key Keyboard

• Microsoft-compatible mouse (PS/2 or bus mouse)

• Network card

• SCSI (Small Computer System Interface) card

• Printer (optional)

Software The BioCAD 700E Workstation includes the following 

software:

• Microsoft Windows 95 Version OSR 2.5 (minimum)

• BioCAD Software

• Microsoft Office 97 (optional)

• Supervisor™ Software (optional)

NOTE: Hardware and software components may change 
without notice. Contact Technical Support for more 
information.
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11.4  BioCAD Software Overview

BioCAD software consists of the following:

• System Control

• Configuration dialog box

• Method Editor

• Data Analysis Software

Figure 1-9   Overview of BioCAD Software
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1
Supervisor ™

software option
The Supervisor software option is a stand-alone version of the 

BioCAD software, designed to run on a computer without a 

BioCAD 700E Workstation. The Supervisor software option 

contains all software modules listed above except the Control 

Panel. It allows you to create and edit methods and 

configurations, and analyze data.

Displaying
software version

To display the version number of BioCAD software loaded on 

your workstation, select About BioCAD from the Window 

menu.

1.4.1  System Control

The System Control module allows you to:

• Manually control the workstation

• Observe run status

• Observe data collection

The System Control module includes:

• Control Panel window

• Status window

• Timer window

• Strip Chart Recorder window

The Control Panel, Status, and Strip Chart Recorder windows 

are displayed when you start the BioCAD software.
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1
Control Panel The Control Panel window (Figure 1-10) allows you to 

manually control the workstation. You can control all parts of 

the system, including the flow rate, gradients, injections, 

detectors, and fraction collection, without creating a method. 

Figure 1-10  BioCAD 700E Control Panel

NOTE: Control Panel actions override a currently running 
method and are recorded in the method file.

The Control Panel is described in Chapter 5, Controlling the 

Workstation From the Control Panel.
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1
Status The Status window (Figure 1-11) displays data about the 

workstation status, including pump flow rate, system pressure, 

monitor and detector signals (pH, conductivity, absorbance, 

temperature), fraction collection valve position, and 

information about the method that is running.

Figure 1-11  Status Window

The Status window is described in Section 8.2, Using the 

Status Window.

Timer The Timer window (Figure 1-12) is a utility which allows you to 

record elapsed volume as well as time. Use it as you would 

use a stop watch.

Figure 1-12  Timer Window

The Timer is described in Section 8.4, Using the Timer.
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1
Strip Chart

Recorder
The Strip Chart Recorder window (Figure 1-13) is an 

electronic recorder that displays and temporarily stores data 

as it is acquired during a method run. You determine the 

amount of data displayed and stored by the Strip Chart 

Recorder. 

Figure 1-13  Strip Chart Recorder Window

Strip Chart Recorder data:

• Is collected in the Strip Chart Recorder whenever the 

pump is running, independent of the running of 

methods

• Is independent of data stored in data files

• Can include information from different runs

• Can be recalled and saved as data files for analysis and 

reporting

The Strip Chart Recorder is described in Section 8.3, Using 

the Strip Chart Recorder.
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1
1.4.2  Configuration

You access the Configuration dialog box (Figure 1-14) by 

selecting Edit Config from the Config menu in the Control 

Panel.

You can create different configurations for different 

applications. Each configuration includes information 

identifying system pressure, samples, buffers/solvents, 

plumbing, columns, injection mode, detection, fraction 

collection, and data collection.

Figure 1-14  Configuration Dialog Box

The Configuration dialog box is described in Section 4.2, 

Creating a New Configuration.
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1
1.4.3  Method Editor

The Method Editor window (Figure 1-15) allows you to 

construct and edit methods (instructions) that the BioCAD 

700E Workstation uses to perform a separation and generate 

a data file (chromatogram). 

Figure 1-15  Method Editor Window

The Method Editor is described in Chapter 6, Creating and 

Running Methods.
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1
Blocks,

segments,
and events

The Method Editor window uses an intuitive approach to 

building and editing methods. You build a chromatographic run 

using:

• Blocks—Six types of operations that you compile to 

create a method

• Segments—Actions you can add to a block

• Events—Additional customized actions you can add to 

a segment

For more information on blocks, segments, and events, see 

Chapter 6, Creating and Running Methods.

Templates The Template feature in the Method Editor allows you to set up 

experimental sequences in which one or more variables 

changes with each method run.

For more information on templates, see Section 7.1, Creating 

and Running Templates.

Multi-methods The Multi-method feature in the Method Editor allows you to:

• Set up experimental sequences in which one or more 

variables change

• Create your own experimental sequences for which 

templates do not exist

• Link methods together

For more information on Multi-methods, see Section 7.2, 

Creating and Running Multi-Methods.
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1
1.4.4  Data Analysis Software

The Data Analysis Software is described in detail in the Data 
Analysis User’s Guide.

The Data Analysis window allows you to:

• View chromatograms

• Background analyze single data files or groups of data 

files

• Export data files or chromatograms

• Print reports and chromatograms

• Analyze data files interactively

• Adjust analysis parameters

• Adjust report format parameters
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1 1.5  BioCAD Software File Structure

This section describes:

• File types

• File contents

• Directories

1.5.1  File Types

The file types that you can create using the BioCAD software 

include:

File Type File Extension

Data .BIO or.B##, where ## are sequential 

numbers incremented for each data file

Method .MET

.G##, when you create methods using 

a multi-method

Configuration .CFG

Group .GRO

Multi-method .GMM

Strip chart recorder .DRC

Event log .EVL
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1
1.5.2  File Contents

Figure 1-16 illustrates the file contents for each file type. 

Figure 1-16  BioCAD File Contents for Each File Type
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1 NOTE: If you save data files (.BIO or .B##) from the Strip 
Chart Recorder, the chromatographic method and 
configuration information are not automatically saved and 
the data cannot be exported to Microsoft Excel.

The following table describes the file contents for each file 

type:

File Content Description

System 

Configuration

Instrument setup information

Chromatographic

Method

Information that controls method run 

and data collection

Chromatographic

Data

Chromatogram

Group Directory List of data files in a group file

Method Directory List of method files in a multi-method

Event Log List of all events and errors that occur

Analysis Section Processing (peak detection, 

integration, report/replot printing), 

and calibration parameters

Report Format 

Section

Parameters included in a printed 

report

Results Section Analyzed data
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1
1.5.3  Directories

Default
directories

The BioCAD software is set up to store files in default 

directories (Figure 1-17). The default directories are:

• Biocad

• Data

• GettingStarted

• Group

• Methods

• Setup

• Temp

• Penexe (not shown)

Figure 1-17  BioCAD Default Directories

You can save your files in the default directories, or create new 

subdirectories to save your files. To store a file in a directory 

other its corresponding default directory, select Save As 

instead of Save.

NOTE: It is strongly recommended that you create different 
subdirectories for different users and different projects. This 
practice helps you easily locate files of interest. See 
“Creating subdirectories for data files” on page 1-35.

CAUTION
The PENEXE directory contains the Data Analysis software 
files. Do not delete this directory.
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1
The following table lists the file types stored in each BioCAD 

default directory:

Default 
Directory

File Type

biocad Configuration (.CFG)—SYSCONF.CFG

Event log (.EVL)

Calibration (.CAL):

• pH.CAL

• COND.CAL

• BLND.CAL

Dictionary (.DCT library files): 

• SOLVENT.DCT

• SAMPLE.DCT

• SYRINGE.DCT

• COLUMN.DCT

NOTE: Do not delete any .DCT files or the 
BLND.CAL file.

Other files stored in this directory are internal 

files used by the BioCAD software.

data Data files (.BIO and .B##)

group Group files (.GRO)

methods Method files (.MET)

Multi-method files (.GMM)

Method files created in a multi-method (.G##)

setup Setup files used to update hardware setup

temp Strip chart recorder (.DRC and DATAREC.C##)

NOTE: Other files stored in this directory are 
internal files used by the BioCAD software.
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1
Creating

subdirectories for
data files

To easily store and find data files related to specific users and 

projects, you can create subdirectories in the 

C:\BIOCAD\DATA directory (Figure 1-18). 

.

Figure 1-18  Creating Subdirectories for Data Files

You can create new subdirectories:

• When you use the Method Editor. See Section 6.2.10, 

Specifying Data Storage Options, for more information 

on creating subdirectories.

• From Windows Explorer. Refer to the Microsoft 
Windows User’s Guide for more information on creating 

subdirectories.

Subdirectories
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1 1.6  A Quick Introduction
to Microsoft Windows

This section introduces you to Microsoft® Windows® features 

that you need to know to use the BioCAD software. Refer to 

the Microsoft Windows User’s Guide for more information.

This section describes:

• Using the desktop and windows

• Using the mouse and menus

• Using the Open File dialog box

1.6.1  Using the Desktop and Windows

Overview All work you perform using Windows software occurs in the 

desktop. The desktop is the screen space that Windows 

occupies (Figure 1-19).

Figure 1-19  Desktop and Windows 
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1
Starting BioCAD When you start up the BioCAD software, a window is 

displayed. A window is an area on the desktop on which a 

software application (for example, the BioCAD software) runs.

You can open more than one window at a time on the desktop.

Hint: When you have more than one window open, it is 
sometimes hard to find a particular window. To display a list 
of all open windows, press Control+Escape to display the 
Windows Task List. Double-click the window you want to 
view.

Parts of a window A sample window is shown in Figure 1-20.

Figure 1-20  Parts of a Window
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1
Parts of a window Parts of a window that you need to know about include:

• Control Menu Box—Allows you to close a window. 

Double-click on the Control Menu box to close a 

window.

• Title Bar—Displays the name of the window. In some 

BioCAD windows, the title bar also displays 

instructions.

If more than one window is open, only one window is 

the active window. The active window is the window 

affected when you type or click. The title bar of the 

active window is a different color than the non-active 

windows (see Figure 1-19).

To move a window, click-drag the title bar.

• Close Button—Closes the active window. You will be 

prompted to save any changes made before closing the 

file.

• Minimize Button—Allows you to shrink a window. Click 

on the Minimize button to shrink a window to a button 

on the taskbar.

• Maximize Button—Allows you to enlarge a window. 

Click on the Maximize button to enlarge a window to full 

screen size.

• Scroll Bar—Allows you to view different parts of a 

window. Click the arrows at the ends of the scroll bar to 

move different parts of the window into view.

• Window Borders and Corners—Allow you to resize a 

window. Move the cursor over window edges until the 

cursor changes to a two-headed arrow. Click-drag the 

border or corner to resize the window. 

Click-dragging a window border resizes the width or 

length of the window. Click-dragging a window corner 
resizes the window proportionately. 

• Menu Bar—Lists available menus. Each menu contains 

a list of commands.
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1
Parts of a

dialog box
A dialog box is displayed when you select a menu command 

followed by an ellipses (...) (Figure 1-21). See Section 1.6.2, 

Using the Mouse and Menus. A dialog box requests additional 

information.

Figure 1-21  Dialog Box

Parts of a dialog box that you need to know about include:

• Command buttons—Click a command button to 

activate a command. For example, click OK. Command 

buttons that contain an ellipses (...) display a second 

dialog box.

• Option buttons—Click to enable or disable an option. 

Option buttons are mutually exclusive. You can select 

only one option at a time. The selected option contains 

a black dot.

• Check boxes—Click to enable or disable an option. 

You can select more than one check box at a time. A 

selected check box contains an "X".

• Text box—Type text in the box.

• Drop-down list box—Click the down arrow on the 

right to display a list of selections. To select an item, 

click on the item.

• Combination box—Functions as both a text box and 

a drop-down list box. You can type text or select an 

item.
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button
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1
1.6.2  Using the Mouse and Menus

Using the mouse There are several actions you perform using the mouse:

NOTE: All mouse actions listed below require that you click 
the left mouse button. For information on using the 
keyboard instead of the mouse, refer to the Microsoft 
Windows User’s Guide.

• Click—Position the mouse pointer on the item you want 

to click and press the left mouse button one time to 

select an item. 

For example, click the OK button or click the Events 

box.

• Double-click—Position the mouse pointer on the item 

you want to double-click and press the left mouse 

button two times to activate an item.

For example, double-click the Control menu box to 

close a window, or double-click an icon to maximize 

it.

• Click-drag—Position the mouse pointer on the item 

you want to drag. Press and hold the left mouse button 

while dragging the mouse. 

For example, click-drag a window title bar to move 

the window or click-drag a window border or corner to 

resize the window. 
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Using menus Most menus on the menu bar have a list of associated 

commands. To display menu commands, click the menu. To 

select a command, click the command.

Note the following when using menus:

Menu 
Convention

Meaning

Command is 

dimmed or 

missing

Command not active at this time. Either 

you have not selected the information 

needed to activate this command, or this 

command does not apply to the window at 

this time.

For example, the Edit Multi-method 

command is dimmed until you open a 

multi-method.

Ellipsis (...) 

follows 

command

A dialog box is displayed when you select 

the command. You must enter additional 

information in the dialog box before the 

command is activated.

For example, selecting Edit Config… from 

the Edit menu displays the Configuration 

dialog box.

Check mark 

next to 

command

Command is enabled. 

For example, selecting the Block View 

command from the Display menu in the 

Method Editor enables or disables this 

view. When checked, the Method Editor 

displays methods in block view. When not 

checked, the Method Editor displays 

methods in sequence view.

Triangle 

follows 

command

When you select this command, a cascade 

menu listing additional commands is 

displayed.

For example, selecting the CV Units 

command from the Display menu in the 

Method Editor displays a list of columns.
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1.6.3  Using the Open File Dialog Box

Overview You use the Open File dialog box (Figure 1-22) to open a file, 

such as a configuration (.CFG), method (.MET), or data (.BIO) 

file.

Understanding how the Open File dialog box works will help 

you easily find directories and files. You access the Open File 

dialog box by selecting Open Configuration from the 

Control Panel File menu or Open from the Method Editor File 

menu.

Figure 1-22  Open File Dialog Box
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1
Parts of the Open

File dialog box
The Open File dialog box includes:

• File Name—Allows you to type or select a file name. 

When opening a file, you can select from the list of file 

names instead of typing a file name. If the desired file 

names are not displayed, you probably are not 

viewing the correct directory or are not displaying the 

correct file type.

• List Files of Type—Allows you to display different file 

types (designated by extensions). To display all file 

types, select All Files [*.*].

• Directories—Allows you to display files from different 

directories and subdirectories. A directory is an area on 

a disk drive in which you store files. The active directory 

is the directory with the open file folder next to it. The 

File Name list box displays all files stored in the active 

directory. 

• Drives—Allows you to display directories and files from 

different drives. Typically, your hard drive is C:, your 

floppy drive is A:, and network drives are designated 

with other letters.

File naming
conventions

Maximum file name length is 8 characters (not including the 

extension). File names must start with a letter or number.

Do not include spaces or the following special characters in 

file names:

• Period (.)

• Quotation mark (")

• Slash (/)

• Backslash (\)

• Brackets ([])

• Colon (:)

• Semicolon (;)

• Vertical bar (|)

• Equal sign (=)

• Comma (,)

It is not necessary to type the extension. The BioCAD software 

automatically appends the correct extension for you.
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1
Selecting a

directory
You select a directory or subdirectory to display all files 

contained in that directory.

To select a directory, click the directory folder in the Directories 

list box (Figure 1-23). The directory file folder opens. The 

subdirectories that the directory contains are displayed below 

it in the Directories list box. The files that the directory contains 

are displayed in the File Name list box.

Figure 1-23  Selecting a Directory

Selecting a
subdirectory

To select a subdirectory contained within the active directory, 

click the subdirectory folder below the open folder 

(Figure 1-24).

Figure 1-24  Selecting a Subdirectory
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1
Selecting an

equal or higher
level directory

To select a directory at the same or higher level than the active 

directory, close the active directory (Figure 1-25).

For example, if you are in the C:\BIOCAD\DATA directory, but 

want to view method files (C:\BIOCAD\METHODS directory), 

double-click the biocad folder to close the data directory. All 

folders in the biocad directory are listed. Double-click the 

methods folder. You must also select Method Files (*.MET) 
from the List Files of Type drop-down list box.

Figure 1-25  Selecting an Equal or Higher Level Directory
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2.1  Initial Installation

Your BioCAD 700E Workstation is initially installed by a Applied 

Biosystems technical representative. All internal plumbing and 

electronic connections have been made. Do not run the 

workstation before it is properly installed.

Use the information in this chapter if you:

• Move the BioCAD 700E Workstation

• Install optional external components

CAUTION

If the workstation will be exposed to freezing temperatures or 
left unused for an extended period of time, remove the pH 
probe to prevent damage. Store the probe in the storage 
solution (saturated KCl) and protective container provided 
with the probe. For information on removing the probe, see 
Section 9.5, pH and Conductivity Monitor Maintenance.
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2.2  Site Requirements

This section describes:

• General requirements

• Changing the voltage setting

• Cold room operation

2.2.1  General Requirements

Required space The BioCAD 700E Workstation requires a space measuring:

• 36 inches (91 cm) deep

• 72 inches (183 cm) wide, which includes 18 inches 

(46 cm) on either side of the BioCAD 700E Workstation 

for computer monitor, keyboard, and buffers

• 36 inches (91 cm) high

Additional space If your system includes an autosampler, fraction collector, 

external or auxiliary detector, or optional large monitor, allow 

additional space:

• Autosampler—18 inches (46 cm) above.

• Fraction Collector—18 inches (46 cm) to the left.

• External or Auxiliary Detector—18 inches (46 cm) 

above. If you are also installing an autosampler, place the 

detector to the left of the workstation.

• Large Monitor—10 additional inches (25 cm) to the left.

Weight The BioCAD 700E Workstation weighs approximately 

275 pounds (125 kg).
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Gas supplies The BioCAD 700E Workstation requires:

• Helium source for sparge panel, with regulated maximum 

pressure of 5 psi (0.3 bar)

• Compressed dry air or nitrogen source for valve 

operation, regulated between 80 and 100 psi 

(5.4 to 6.8 bar)

Power and
voltage

requirements

The BioCAD 700E Workstation requires a grounded outlet for its 

three-pronged plug. Check that the BioCAD 700E Workstation 

is configured for the voltage of your power source (Figure 2-1). 

The voltage setting is displayed on the rear panel near the 

power plug. For instructions on changing the voltage setting, 

see Section 2.2.2, Changing the Voltage Setting.

Figure 2-1  Checking Voltage

The power and voltage requirements are:

PB100013

Voltage
displayed

Electrical Ratings

Volts/Amps Fuse

100V~6A T6A 250V

120V~5A T5A 250V

220V~3A T3A 250V

240V~2.5A T2.5A 250V

50/60 Hz AC
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2.2.2  Changing the Voltage Setting

To change the voltage setting on the BioCAD 700E Workstation:

1. Power down the workstation.

2. Remove the power cord from the workstation.

3. Pry out the voltage selector cover using a small flat-blade 

screwdriver (Figure 2-2).

Figure 2-2  Removing the Voltage Selector Cover and Removing the Fuse Block

4. Rotate the voltage selection wheel until the proper voltage 

is displayed.

5. Pull out on the white tab to remove the fuse block

(Figure 2-2).

PB100030 PB100031
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6. Remove the fuse and replace with a fuse of the proper 

rating.

7. Insert the fuse block into the receptacle. 

8. Replace the voltage selector cover.

9. Plug in and power up the workstation.

2.2.3  Cold Room Operation

You can install and operate the BioCAD 700E Workstation in a 

cold room (39° F/4° C). 

CAUTION

Any instrument that you operate in the cold runs the risk of 
damage due to corrosion or electrical shorts caused by 
condensation.

Take the following precautions when installing and operating the 

workstation in a cold room:

1. As soon as the instrument is placed in the cold room, 

connect the power cord and power up the workstation.

2. Leave workstation powered up at all times while the 

workstation is in the cold room. When not in use, turn off the 

UV/Vis detector lamp.

3. When you remove the workstation from the cold room, 

connect the power cord and power up the workstation as 

soon as possible. Leave the system power on until the 

workstation reaches room temperature.

Voltage Fuse Rating

100V~6A T6A 250V

120V~5A T5A 250 V

220V~3A T3A 250V

240V~2.5A T2.5A 250V
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2.3  Connecting Tubing

This section describes connecting:

• Compressed gas supply line

• Helium supply line

• Buffer/solvent and sparge lines

• Pump seal wash lines

• Waste lines

2.3.1  Connecting the
Compressed Gas Supply Line

The BioCAD 700E Workstation requires compressed dry gas 

(air or nitrogen) to operate the valves.

To connect the compressed gas supply line:

1. Using Teflon® tubing (1/16-inch ID, 1/8-inch OD), connect 

the gas source to the fitting labeled Air on the right side of 

the workstation, near the top rear corner. 

2. Regulate the gas between 80 and 100 psi.
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2.3.2  Connecting the Helium Supply Line

The BioCAD 700E Workstation requires helium to sparge the 

buffers/solvents.

To connect the helium supply line:

1. Using Teflon tubing (1/16-inch ID, 1/8-inch OD), connect 

the helium source to the fitting labeled Helium on the right 

side of the system. The fitting is also labeled with the 

appropriate pressure, 5 psi max (Figure 2-3).

2. Regulate the helium source to 5 psi.

Figure 2-3  Sparge Panel Connections

CAUTION

Do not close the helium tank without turning off the helium 
switch. Helium diffuses out of the line, forming a vacuum, 
which pulls liquid into the sparging system.
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2.3.3  Connecting the
Buffer/Solvent and Sparge Lines

Connect the buffer/solvent bottles to the buffer/solvent pump 

system and the sparge panel (see Figure 2-3).

To connect the buffer/solvent and sparge lines:

• Prepare the lines and bottle caps

• Connect the sparge element

• Prepare the buffer/solvent reservoirs

• Wet the sparge element 

CAUTION

Do not use methylene chloride, tetrahydrofuran, dimethyl 
sulfoxide, or concentrated nitric or sulfuric acids. These 
materials are not compatible with the PEEK components in 
the BioCAD 700E Workstation.

CAUTION

Certain organic solvents, such as acetonitrile and 
isopropanol, used over long time periods or in high 
concentrations can weaken PEEK tubing on the BioCAD 
700E Workstation. Change the PEEK tubing on the 
workstation periodically if you use organic solvents frequently 
or in high concentrations. For more information, contact 
Applied Biosystems Technical Support.

Sparge kit The BioCAD 700E Workstation is provided with a sparge kit, 

which contains the following:

• Teflon tubing (0.085-inch ID, 1/8-inch OD, 4 feet long)

• Bottle caps (45 mm screw thread, for 1 liter bottles)

• Bottle cap inserts

• Vent plugs

• Sparge elements

• Urethane tubing (1/4-inch OD, 2 inches long)

Unused lines Place unused buffer/solvent lines in filtered deionized water. Do 

not leave these lines dry.



Chapter  2    Installing the BioCAD 700E Workstation

2-10 Applied Biosystems

2

Preparing lines
and bottle caps

To prepare the lines and bottle caps:

1. Slide one of the buffer/solvent lines (labeled A through F) 

through a bottle cap, with the top of the cap toward the 

system.

2. Slide a sparge line through the bottle cap. If the sparge line 

is connected to a sparge valve, make sure it is the sparge 

line that corresponds to the buffer/solvent line above 

(A through F).

3. Hold a bottle cap insert as shown in Figure 2-4.

Figure 2-4  Buffer/Solvent Connections

4. Push approximately 8 inches of the sparge line through the 

1/8-inch port in the bottle cap insert. 

5. Push approximately 8 inches of the buffer/solvent line 

through the 3/16-inch port in the bottle cap insert.

6. Insert a vent plug in the largest port in the bottle cap insert.
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Connecting the
sparge element

To connect the sparge element to the lines:

1. Insert the reservoir-end of the sparge line snugly into the 

port next to the gas diffuser on the sparge element (see 

Figure 2-4).

2. Insert the reservoir-end of the buffer/solvent line through 

the open port on the sparge element. The tubing should 

extend just beyond the opening on the underside of the 

sparge element. Do not push the tubing beyond the bottom 

plane of the sparge element.

NOTE: Do not insert the buffer/solvent line into the port 
next to the gas diffuser on the sparge element. This may 
restrict flow and cause pump cavitation.

3. Submerge the sparge element and connected lines in the 

appropriate buffer/solvent or filtered deionized water.

4. Screw the bottle cap onto the bottle.

Preparing the
buffer/solvent

reservoirs

To prepare the buffer/solvent reservoirs:

1. Place buffer/solvent reservoirs to the right of the 

workstation. Place reservoirs at the same level as or 

slightly higher than the workstation. Place all reservoirs at 

the same approximate height. 

CAUTION
Do not place the buffer/solvent reservoirs below the level 
of the workstation. Doing so could cause loss of system 
prime, pump cavitation, and faulty flow rate readings. 

2. On the right side of the workstation, set the Helium On/Off 

switch to the On position (see Figure 2-3).

3. Open the sparge valves for the reservoirs in use by turning 

the gas flow control knobs on the right side of the 

workstation (see Figure 2-3). Open the valves until you see 

a steady stream of bubbles in the reservoir.

CAUTION
Do not close the helium tank without turning off the 
helium switch. Helium diffuses out of the line, forming a 
vacuum, which pulls liquid into the sparging system.
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2.3.4  Connecting the Pump Seal Wash Lines

Insert the two pump seal wash lines (see Figure 1-4 on 

page 1-10) in a wetting agent for the pump seal wash solution. 

A 30 percent isopropanol/water mixture is recommended.

Place the reservoir containing the pump seal wash solution at 

the same level as or slightly higher than the workstation.

Filter the wash solution through a 0.22 or 0.45 micron filter 

before using. Change the wash solution weekly or more often if 

you run the system very frequently. Prime the pump seal wash 

lines if they become drained. See Section 3.4.1, Priming the 

Pump Seal Wash Lines.

2.3.5  Connecting the Waste Lines

Insert the following lines in waste containers before operating 

the BioCAD 700E Workstation:

• Autoloader waste line—1/16-inch OD Teflon tubing on 

the right side of the workstation (see Figure 1-4 on 

page 1-10).

• Fraction/waste valve line—1/8-inch or 1/16-inch OD 

Teflon tubing attached to the waste (bottom) port of the 

fraction/waste valve at the top-left of the workstation 

(see Figure 1-8 on page 1-19).

NOTE: You can also connect the fraction/waste valve 
line to an optional fraction collector. For more 
information, see Section 2.4.3, Connecting the Fraction 

Collector.
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2.4  Connecting External Devices

This section describes connecting:

• External detector (UV/Vis or fluorescence) 

• Auxiliary detector

• Fraction collector

• Autosampler (integrated and direct wire)

• SCOUT Column Selector

• Strip chart recorder or integrator

• Keyboard, monitor, and mouse

• Printer

• Network

• Peripheral devices (SCSI)

Side panel
connections

The left side panel of the BioCAD 700E Workstation contains 

the connectors to which you connect external devices 

(Figure 2-5).

NOTE: The arrangement of boards in your computer may not 
match Figure 2-5. To locate COM2, look for the 25-pin 
connector. To locate LPT1, look for the 25-socket connector.

Figure 2-5  Connections for External Devices
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2.4.1  Connecting an External Detector
(UV/Vis or Fluorescence)

CAUTION

If you install a second detector in the system, it must have a 
semi-prep flow cell installed. If the second detector has an 
analytical flow cell, high system pressure can damage the 
flow cell in the first detector.

Overview If you have one of the following external detectors provided by 

Applied Biosystems, you can control it from the BioCAD 700E 

Workstation:

• Model 201 UV/Vis Detector (single-wavelength)

• Model 204 UV/Vis Detector (single-wavelength)

• Model 205 UV/Vis Detector (dual-wavelength)

• Model 304/305 Fluorescence Detector

To use the external detector, you must:

• Connect the external detector

• Update the hardware setup

• Enable UV/Vis Channel #2 in configuration

Connecting an
external detector

NOTE: The BioCAD 700E Workstation has two COM ports. 
You can connect only two of the following external devices to 
these COM ports: external detector, integrated autosampler, 
or SCOUT Column Selector.

To connect an external detector:

1. Power down the BioCAD 700E Workstation.

2. Place the external detector on top of the workstation.

If your system includes an autosampler, place the external 

detector to the left of the workstation.

3. Connect the detector cable to COM1 or COM2 on the left 

side of the workstation (see Figure 2-5). 
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Two cables are provided with the external detector kit. 

Use the cable that is compatible with the COM port. 

COM1 is the 9-pin connector, and COM2 is the 25-pin 

connector.

NOTE: When you update the hardware setup, select the 
same COM port you connected to above. See 
Section 2.5.2, Updating BioCAD Hardware Setup Options.

4. Plumb the external detector inline after the internal UV/Vis 

detector and before the detector bypass valve 

(see Figure 1-7 on page 1-16):

• Connect the outlet line (top) from the internal 

UV/Vis flow cell to the inlet (bottom) of the 

external detector flow cell. Do not overtighten.

• Connect the outlet line (top) from the external 

detector flow cell to the green connector (port 5) 

on the Detector Bypass valve.

CAUTION
Plumb the UV flow cell so that fluid flows into the cell at 
the bottom and out of the cell at the top. If plumbing 
connections are reversed, air bubbles can be trapped in 
the flow cell and cause excessively noisy baselines.

Updating
hardware setup

After connecting the external detector, update the hardware 

setup to recognize the external detector. When you update the 

hardware setup, select the COM port you connected to above. 

For directions, see Section 2.5.2, Updating BioCAD Hardware 

Setup Options.

Enabling UV/Vis
channel #2

Before using the external detector, enable the UV/VIS #2 

channel in the Data Recorder Configuration. For directions, see 

Section 4.2.5, Configuring Detectors.

NOTE: When you connect an external detector (UV/Vis or 
fluorescence), the signal is displayed in the UV/VIS #2 
channel in the Strip Chart Recorder and in data files.
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2.4.2  Connecting an Auxiliary Detector

CAUTION

If you install a second detector in the system, it must have a 
semi-prep flow cell installed. If the second detector has an 
analytical flow cell, high system pressure can damage the 
flow cell in the first detector.

Overview You can connect an auxiliary detector (UV/Vis, fluorescence, 

refractive index, electrochemical, or any detector with an analog 

output) to the BioCAD 700E Workstation to collect another 

channel of data. 

You cannot control an auxiliary detector from the BioCAD 700E 

Workstation.

Connecting an
auxiliary
detector

To connect an auxiliary detector:

1. Place the auxiliary detector on top of the workstation. If 

your system includes an autosampler, place the auxiliary 

detector to the left of the workstation.

NOTE: When connecting a device to the Auxiliary 
connector, use a shielded cable with a ferrite bead to 
maintain CE compliance. Recommended source and part 
number for the ferrite bead is: 
Fair-Rite Products Corporation, No. 2643164151.

2. Connect a cable between the 1 V output signal on the 

auxiliary detector and the Auxiliary connector on the 

workstation (see Figure 2-5 on page 2-13). Connect to the 

following pins on the Auxiliary connector on the left side of 

the workstation:

• Pin 1 Analog Input (+)  0–1 Volt Full Scale

• Pin 2 Analog Input (-)  0–1 Volt Full Scale
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3. Plumb the auxiliary detector inline after the internal UV/Vis 

detector and before the detector bypass valve 

(see Figure 1-7 on page 1-16):

• Connect the outlet line (top) from the internal 

UV/Vis flow cell to the inlet (bottom) of the 

auxiliary detector flow cell. Do not overtighten.

• Connect the outlet line (top) from the auxiliary 

detector flow cell to the green connector (port 5) 

on the Detector Bypass valve.

CAUTION
Plumb the UV flow cell so that fluid flows into the cell at 
the bottom and out of the cell at the top. If plumbing 
connections are reversed, air bubbles can be trapped in 
the flow cell and cause excessively noisy baselines.

Enabling
auxiliary
channel

Before using the auxiliary detector, enable the Auxiliary channel 

in the Data Recorder Configuration. For directions, see 

Section 4.2.5, Configuring Detectors.

Programming
event outputs

You may need to program event outputs from the workstation to 

the auxiliary device. For directions, see the reference manual 

for the device and Section 5.2.10, Programming Event Outputs.
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2.4.3  Connecting the Fraction Collector

Connecting
fraction

collector

To connect the fraction collector provided by Applied 

Biosystems to the BioCAD 700E Workstation:

1. Place the fraction collector to the left of the workstation. 

2. Connect the thick cable supplied with the fraction collector:

• Attach the orange connector to the fraction 

collector. 

• Attach the green connector to the left side of the 

workstation, to the connector labeled Fraction 

Collector (see Figure 2-5 on page 2-13).

3. Connect the thin valve control cable supplied with the 

fraction collector:

• Attach one end to the white connector 

protruding from the thick cable connected to the 

fraction collector

• Attach the other end to the fraction collector 

diverter valve

4. Plumb from the waste port (bottom port) of the BioCAD 

700E fraction/waste valve (see Figure 1-8 on page 1-19) to 

the IN connector on the fraction collector diverter valve. Use 

the tubing provided with the fraction collector.

5. Plumb from the NO (normally open) line on the fraction 

collector to a waste container. Use the tubing provided with 

the fraction collector.

Configuring
fraction

collector

Before using the fraction collector, configure the fraction 

collector in the Configuration dialog box. For directions, see 

Section 4.6, Configuring and Preparing the BioCAD Software 

for a Fraction Collector.
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Other fraction
collectors

You can connect fraction collectors other than those supplied by 

Applied Biosystems to the BioCAD 700E Workstation in two 

ways:

• Connect to the BioCAD Fraction Collector outputs

• Connect to the BioCAD Auxiliary outputs

NOTE: You can connect the fraction collector diverter valve 
to the BioCAD 700E Workstation. For assistance, contact 
Applied Biosystems Technical Support.

Connecting to
Fraction Collector

outputs

You can connect any fraction collector to the Fraction Collector 

outputs on the workstation. You can control the diverter valve on 

the fraction collector from the BioCAD software if you make the 

connections described in the following table. Connect only to 

the pins that transmit the signals you need. 

Fraction Collector 

Connection

BioCAD 700E 

Connection
Type of Signal

Start/Run Fraction Collector pin 4 External Start 

Out

Stop Fraction Collector pin 5 External End Out

Advance (if desired) Fraction Collector pin 6 External Count 

(Advance) Out

Ground Fraction Collector pin 3 Ground

Tube change Fraction Collector pin 7 Mark

Valve - Fraction Collector pin 9 Valve switch

Valve + (12 V valve) Fraction Collector pin 10 Valve power

Valve + (24 V valve) Auxiliary pin 10* +24 Vdc

*NOTE: When connecting a device to the Auxiliary connector, use a shielded cable 
with a ferrite bead to maintain CE compliance. Recommended source and part 
number for the ferrite bead is: Fair-Rite Products Corporation, No. 2643164151.
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NOTE: After connecting a fraction collector to the Fraction 
Collector outputs, configure the fraction collector in the 
Configuration dialog box. See Section 4.6, Configuring and 

Preparing the BioCAD Software for a Fraction Collector. Set up 
the fraction collector to accept inputs from the BioCAD 700E 
Workstation. See the fraction collector manual.

Connecting to
Auxiliary outputs

You can connect any fraction collector to the BioCAD Auxiliary 

outputs. However, you cannot control the fraction collector from 

the BioCAD software. You must program all information on the 

fraction collector. 

NOTE: When you connect a fraction collector to Auxiliary 
outputs as described above, do not configure the fraction 
collector in the Configuration dialog box.

Fraction Collector 

Connection

BioCAD 700E 

Connection
Type of Signal

Start/Run Auxiliary pin 10* Aux Out 1

Stop Auxiliary pin 11 Aux Out 2

Advance (if desired) Auxiliary pin 6 Spare out LC

Ground Auxiliary pin 6 Ground

Detector + Chart Recorder Red Chart Rec +

Detector -/ground Chart Recorder 

Black

Chart Rec -

Tube change Fraction Collector 

pin 7

Mark

*NOTE: When connecting a device to the Auxiliary connector, use a 
shielded cable with a ferrite bead to maintain CE compliance. 
Recommended source and part number for the ferrite bead is: Fair-Rite 
Products Corporation, No. 2643164151.
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2.4.4  Connecting the Autosampler

There are two ways to connect the autosampler:

• Integrated—The BioCAD software has complete control 

over autosampler functions. You program sample 

information using the BioCAD software. You must use an 

AS 3500 autosampler provided by Applied Biosystems.

• Direct Wire—The BioCAD software triggers the 

autosampler to make injections. You program sample 

information using the autosampler controls. You can use 

any autosampler.

Connecting
integrated

autosampler

NOTE: The BioCAD 700E Workstation has two COM ports. 
You can connect only two of the following external devices 
that connect to COM ports: external detector, integrated 
autosampler, or SCOUT Column Selector.

To connect the AS 3500 autosampler provided by Applied 

Biosystems as an integrated autosampler:

1. Power down the BioCAD 700E Workstation.

2. Place autosampler on top of or beside the workstation.

3. Connect the ribbon-style cable supplied with the 

autosampler:

• Connect the 8-pin telephone-style connector to 

the connector labeled COMM on the autosampler.

• Connect the 9- or 25-pin D-connector to COM1 or 

COM2 on the left side of the workstation 

(Figure 2-5 on page 2-13).

NOTE: When you update the hardware setup, specify an 
integrated autosampler and select the same COM port 
you connected to above. See Section 2.5.2, Updating 

BioCAD Hardware Setup Options.

4. Power up the autosampler.
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Connecting
direct wire

autosampler

To connect the AS 3500 autosampler provided by Applied 

Biosystems as a direct wire autosampler:

1. Place the autosampler on top of or beside the workstation.

2. Connect the thin gray cable supplied with the autosampler:

• Connect the 12-pin black connector to the 

autosampler.

• Connect the green connector to the left side of 

the workstation, to the connector labeled 

Autosampler (see Figure 2-5 on page 2-13).

NOTE: When you update hardware setup, specify a 
direct wire autosampler. See Section 2.5.2, Updating 

BioCAD Hardware Setup Options.

3. Do not power up a direct wire autosampler until you 

configure the BioCAD software. For more information, see 

Section 4.8, Configuring and Preparing the BioCAD 

Software for a Direct Wire Autosampler.

Other
autosamplers

You can connect autosamplers other than those available from 

Applied Biosystems to the workstation, but only as a direct wire 

autosampler. Connect the autosampler to the pins in the 

Autosampler connector (see Figure 2-5 on page 2-13) on the 

left side of the workstation. Connect only to the pins that 

transmit the signals you need. Pin assignments are listed below:

BioCAD 700E Connection Type of Signal

Autosampler pin 1 Logic Input Ground

Autosampler pin 2 Input Injection Trigger—TTL

Autosampler pin 3 Input Stop—TTL

Autosampler pin 4 Busy Output—TTL

Autosampler pin 5 Start Output—TTL

Autosampler pin 6 Stop Output—TTL

Autosampler pin 7 Logic Output Ground
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2.4.5  Connecting a SCOUT Column Selector

If your system includes a SCOUT Column Selector, refer to the 

SCOUT ® Column Selector User’s Guide, Chapter 2, Installing 

the SCOUT Column Selector.

NOTE: The BioCAD 700E Workstation has two COM ports. 
You can connect only two of the following external devices 
that connect to COM ports: external detector, integrated 
autosampler, or SCOUT Column Selector.

2.4.6  Connecting a
Strip Chart Recorder or Integrator 

To connect a strip chart recorder or integrator to the BioCAD 

700E Workstation, connect the cables to the Chart Recorder or 

Integrator connectors on the left side panel of the workstation 

(see Figure 2-5 on page 2-13). Connect the red cable to the red 

connector and the black cable to the black connector.

Signals for these devices are:

Device Signal

Strip chart recorder 0–10 mV

Integrator 0–1 V
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2.4.7  Connecting the
Keyboard, Monitor, and Mouse

Connect the keyboard, monitor, and mouse to the following 

connectors on the left side panel of the BioCAD 700E 

Workstation:

NOTE: The arrangement of boards in your computer may not 
exactly match Figure 2-6. To identify the correct connectors, 
look for the connectors described in the above table.

Figure 2-6  Connecting Keyboard, Monitor, and Mouse

Component Connector

Keyboard Small round connector next to monitor connector

Monitor 15-pin high-density connector (3 rows of pins), 

between keyboard and COM1

Mouse Small round connector
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2.4.8  Connecting a Printer

Supported
printers

You can connect one printer to the BioCAD 700E Workstation. 

Printers must be supported by Microsoft Windows 95.

Connecting Connect the printer to LPT1 connector (25-socket) on the left 

side panel of the workstation (see Figure 2-5 on page 2-13).

Installing Install the printer by clicking the Start button, pointing to 

Settings, and clicking Printers. Refer to the Microsoft Windows 
User’s Guide for more information. If there is no print driver 

listed for the printer you are installing, contact Applied 

Biosystems Technical Support for a recommendation.

2.4.9  Connecting to a Network

Connecting to
local area

network

Your BioCAD 700E Workstation is provided with a pre-installed, 

pre-configured Ethernet network card (see Figure 2-5 on 

page 2-13). You can connect the workstation to a local area 

network (LAN) using one of the following cables:

• 10BASE-T

• 10BASE2

• 10BASE5

Your network manager is responsible for connecting your 

workstation to the network, installing the appropriate client 

software, and maintaining your network. For more information, 

see the Microsoft Windows User’s Guide and the 

documentation provided for the network card. 

CAUTION

Do not change the configuration settings for the network 
card. Doing so will disrupt the operation of your workstation 
and can invalidate your warranty.

Diagnostic software for the network card is installed on your 

workstation. If you need assistance, contact Applied Biosystems 

Technical Support.



Chapter  2    Installing the BioCAD 700E Workstation

2-26 Applied Biosystems

2

2.4.10  Connecting Peripheral Devices

Your BioCAD 700E Workstation is provided with a pre-installed, 

pre-configured SCSI (Small Computer System Interface) card 

(see Figure 2-5 on page 2-13). The SCSI card allows you to 

connect peripheral devices such as:

• CD ROM drive

• Hard drive

• Iomega® Zip™ drive

To connect a peripheral device to the SCSI card, connect the 

device to the SCSI connector shown in Figure 2-5 on page 2-13. 

For more information, see the documentation provided with the 

SCSI card.

CAUTION

Do not change the configuration settings for the SCSI card. 
Doing so will disrupt the operation of your workstation and 
can invalidate your warranty.

Diagnostic software for the SCSI card is installed on your 

workstation. If you need assistance, contact Applied Biosystems 

Technical Support.
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2.5  Installing the BioCAD Software

This section describes:

• Installing the software

• Updating the hardware setup options

• Installing the hardware key

• Starting the software

• Exiting the software

2.5.1  Installing the Software

When to install The BioCAD 700E Workstation is provided with the software 

pre-installed. If you need to re-install the software or install a 

new version of software, follow the procedures in this section.

Installation
requirements

The instrument version of BioCAD software requires:

• A BioCAD 700E Workstation

• 100 MB of free disk space

• CD ROM drive

• Microsoft Windows 95 Version OSR 2.5 or later (provided 

with the system)

The Supervisor option (stand-alone version) of BioCAD 

software requires:

• Pentium 100 MHz or greater computer

• VGA (600 x 800) or greater resolution display

• Mouse or trackball

• 32 MB of RAM required (64 MB suggested)

• 100 MB of free disk space

• Hardware key 

• 1 parallel port (for the hardware key)

• CD ROM drive access

• Microsoft Windows 95 (minimum)

Before installing Before installing the BioCAD software, make sure all display, 

network, and printer driver software is installed on your 

computer.
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Install procedure The following procedure assumes you have an external CD 

ROM drive attached to your workstation. For more information 

on connecting an external CD ROM drive, see Section 2.4.10, 

Connecting Peripheral Devices.

To install the BioCAD software, you must install the Data 

Analysis software first, then the instrument software:

Installing Data
Analysis software

1. Insert the BioCAD CD in the CD drive attached to the 

BioCAD 700E Workstation.

2. From the Windows desktop, click Start, then click Run.

3. In the Run dialog box, click Browse and navigate to find 

D:\TURBOCHROM\DISK1\SETUP.EXE. Click Open. Click 

OK. 

4. Click Next to bypass the Welcome dialog box.

5. In the Choose Destination Directory dialog box, click Next 
to accept the default directory.

Temporary setup files are copied to your hard drive.

6. Click Next to bypass the Welcome dialog box.

7. In the Choose Destination Location dialog box, click Next to 

accept the default directory of C:\PENEXE.

8. If the Installation Options dialog box appears, select 

Complete Installation and click Next.

9. In the Setup Options dialog box, select only the Help Files 
check box and click Next.

10. In the Setup Options dialog box, select 60 Hz and click 

Next.

11. In the Installation Options Summary dialog box, click 

Next to copy the Data Analysis software files.

12. In the Restart Computer dialog box, select Yes and click 

Finish.

Your computer restarts automatically.

Installing
instrument

software

1. From the Windows desktop, click Start, then click Run.

2. In the Run dialog box, click Browse and navigate to find 

D:\PERSEPTIVE\DISK1\SETUP.EXE. Click Open. Click 

OK. 
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3. Click Next to bypass the Welcome dialog box.

4. In the Select Instrument dialog box, select BioCAD 700E 
and click Next.

5. In the Setup Type dialog box, select one of the following:

• Instrument Full Installation—Prompts you to 

enter hardware setup options

• Instrument Upgrade Installation—Retains the 

existing hardware setup options

• Stand Alone—For Supervisor (stand alone) 

software

Click Next. 

6. In the Select Components dialog box, select BioCAD 

Program Files and BioCAD Example Files and click Next.

7. In the Select Program Folder dialog box, select PerSeptive 

and click Next.

8. If you selected Full Installation in step 5, continue to step 9. 

If you selected Upgrade Installation or Stand Alone in 

step 5, skip to step 11.

9. In the Enter Information dialog box, type the serial number 
(located on the right side panel of your workstation).

10. Enter hardware setup options. For more information, 

see Section 2.5.2, Updating BioCAD Hardware Setup 

Options.

11. In the Start Copying Files dialog box, click Next to copy 

the instrument software files.

12. When the Setup Complete dialog box appears, click 

Finish.

The BioCAD icon appears on the Windows desktop.

NOTE: If you delete the BIOCAD software or need to 
replace your hard drive, contact Applied Biosystems 
Technical Support for assistance in re-installing the 
software.
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Other
installation

options

If you do not have an external CD ROM drive connected to your 

workstation, you can do one of the following:

• Install the BIOCAD software over a local area network 

from a computer with a CD ROM drive

• Use a computer with a CD ROM drive to create floppy 

disks of the BIOCAD software

• Obtain the BIOCAD software on floppy disks from 

Applied Biosystems

For more information, contact Applied Biosystems Technical 

Support.
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2.5.2  Updating BioCAD
Hardware Setup Options

When to update You must update the BioCAD Hardware Setup options if:

• You change the hardware connected to your workstation

• No previous software version was installed on your hard 

drive (for example, if the software was deleted or the 

hard drive was replaced)

Update
procedure

To update the BioCAD Hardware Setup options:

1. Click Start, point to Programs, point to PerSeptive, and 

then click BioCAD Setup. 

The Welcome dialog box is displayed.

2. Click Next.

NOTE: The BioCAD 700E Workstation has two COM 
ports. You can connect only two of the following external 
devices that connect to COM ports: external detector, 
SCOUT Column Selector, or integrated autosampler.

External detector 3. Select an external detector option:

• None

• UV 205—Dual-Wavelength 

• UV 201—Single-Wavelength 

• UV 204—Single-Wavelength 

• FL 304/305—Fluorescence Detector

Click Next.

4. If you selected a detector in step 3, select the COM port to 

which the external detector is connected: COM1 or COM2 

(see Figure 2-5 on page 2-13). Click Next.
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Autosampler 5. Select an autosampler option:

• None

• Direct Wire Autosampler

• AS3500 (basic version)

• AS3500 + Cooling option

• AS3500 + Prep option

• AS3500 + Prep and Cooling options

• AFC 2000

NOTE: To determine if your AS 3500 autosampler 
supports the Cooling option, look for a wick below the 
left-hand tray.
To determine if your AS 3500 autosampler supports the 
Preparation option, look for two syringes behind the tray 
area or look for a heat/mix chamber to the left of the tray 
area.

6. Click Next.

7. If you selected an autosampler in step 5, select the COM 

port to which the autosampler is connected: COM1 or 

COM2 (see Figure 2-5 on page 2-13). Click Next.

SCOUT 8. If you have a SCOUT Column Selector installed, select Yes. 

If you do not have a SCOUT Column Selector installed, 

select No. Click Next.

9. If you selected Yes in step 8, select the COM port to which 

the SCOUT Column Selector is connected: COM1 or COM2 

(see Figure 2-5 on page 2-13). Click Next.

10. Click Next to bypass the Setup Summary dialog box. 

Click Finish to exit the BioCAD Hardware Setup 

program.

NOTE: If you configure an AS 3500 autosampler, you 
must also set the autosampler options using the front 
panel of the autosampler. Refer to “Setting autosampler 

options” on page 3-45.
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2.5.3  Installing the Hardware Key

To run the Supervisor option (stand-alone software version), you 

must install a hardware key before you can start the software.

Connect the hardware key to the LPT1 connector (25 socket) on 

your stand-alone computer. The computer side of the key is 

labeled. Make sure the key is firmly attached to the connector. 

Screw in place.

If you have a printer connected to LPT1, connect the hardware 

key to the connector, then connect the printer cable to the 

hardware key.
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2.5.4  Starting the Software

Starting the
software

To start the BioCAD software:

1. Power up the workstation and computer.

The Windows desktop screen is displayed.

2. Double-click the BioCAD icon .

The Control Panel (Figure 2-7) is displayed.

Figure 2-7   BioCAD Control Panel

NOTE: The BioCAD software automatically checks to make 
sure at least 20 percent of your disk is free. If the space is 
inadequate, a warning appears. You can exit the BioCAD 
software and delete files from the disk to make more room.
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Supervisor option When you start the Supervisor option (stand-alone software), 

the Supervisor option main screen is displayed (Figure 2-8). 

The Supervisor option includes the Method Editor, but not the 

Control Panel.

Figure 2-8  Supervisor Option Main Screen

CAUTION

You can use the Supervisor option to open data files acquired 
on a workstation with software earlier than version 3.0. 
However, when you analyze these data files in version 3.0 
software, the files are updated using version 3.0 Data 
Analysis and cannot be opened again in the previous version 
of software. The data files inherit the default analysis (.MTH) 
and report format (.RPT) parameters of the version 3.0 
software. You can adjust these parameters to make them 
consistent with the original .ANP file used in the earlier 
software version.
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Hint: You may want to backup data files that you acquired 
using an earlier software version. You can use the backup 
data files with the earlier software version.

CAUTION

If you use the Supervisor option to write methods, you can 
run the methods on workstations with version 3.0 software or 
later. You cannot run these methods on workstations with 
earlier software versions.

2.5.5  Exiting the Software

CAUTION

If you are running the BioCAD 700E Workstation and you exit 
the BioCAD software, you can no longer control the 
workstation. Do not exit the BioCAD software while the 
workstation is running.

To exit the BioCAD software:

1. Select Exit BioCAD from the File menu in the Control 

Panel.

The BioCAD software closes.

2. To exit Microsoft Windows, click Start, then click Shut 
Down.
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2.6  Starting Up and Shutting Down

This section describes:

• Starting up

• Shutting down

• Long term shutdown

Starting up Power up the BioCAD 700E Workstation and external 

components in the following order:

1. Turn on the compressed dry gas source (air or nitrogen) 

and regulate to 80 to 100 psi.

2. Turn on the helium source and regulate to 5 psi.

3. Power up the following external components before 

powering up the workstation:

• Auxiliary detector

• External detector

• Fraction collector

• Integrated autosampler

• Monitor and printer

• SCOUT Column Selector

4. Power up the workstation by turning on the power switch, 

located on the right side of the workstation, near the top of 

the panel.

5. When Windows Desktop is displayed, double-click the 

BioCAD icon (see Figure 2-7) to start the BioCAD 

software.

When the Control Panel or the Supervisor Option window 

is displayed, the workstation is ready to configure.

NOTE: If nothing appears on the monitor screen, check 
that the monitor is powered on, that the cable is 
connected between the monitor and the workstation, and 
adjust the contrast of the monitor display.

6. After configuring the workstation for a direct wire 

autosampler, power up the direct wire autosampler.
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Shutting down To power down the BioCAD 700E Workstation:

CAUTION

Failure to leave the pH and conductivity monitors in a 1 M salt 
solution and to run the SYSCLEAN method after daily use 
may result in system downtime.

1. Click the Bypass option button in the Column section of 

the Control Panel to take the column out of line.

NOTE: If you configure Low Dispersion, Three Columns, 
or Direct Control column plumbing configurations, the 
column cannot be bypassed. Physically remove the 
column and replace with a union before priming.

2. Purge the system with a 1 M salt solution with the pH and 

conductivity monitors inline. For more information, see 

Section 5.2.4, Purging the System.

3. Run the SYSCLEAN method supplied with the system:

NOTE: As an alternative to running the SYSCLEAN 
method, you can purge the system with water from the 
Control Panel. Take the pH monitor offline by clicking the 
Bypass option button in the pH/Cond section of the 
Control Panel. Then purge the system with filtered 
deionized water. For more information, see Section 5.2.4, 

Purging the System.

• Place all buffer/solvent lines and sample lines in 

filtered deionized water.

• Select Open from the File menu in the Method 

Editor to display the Open File dialog box.
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• Select SYSCLEAN.MET from the 

C:\BIOCAD\METHODS directory and click OK.

You may see some configuration mismatch 

errors, which are usually due to differences in 

buffer/solvent and column configuration. Click 

Update Method with System Configuration to 

accept changes.

• Select Run Method from the File menu. This 

method takes the column, pH monitor, and 

conductivity monitor out of line.

4. Close the BioCAD software by selecting Exit BioCAD from 

the Control Panel File menu.

The BioCAD software closes.

5. To exit Microsoft Windows, click Start, then click Shut 
Down.

6. Power down the components of the workstation in any 

order. 

7. Close the sparge valves by turning the gas flow control 

knobs on the right side of the workstation.

8. Set the Helium On/Off switch to the Off position.

9. Power down the BioCAD 700E Workstation.

10. Turn off the gas and helium sources.
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Long term
shutdown

If you are shutting down the BioCAD 700E Workstation for more 

than one week:

1. Click the Bypass option button in the Column section of 

the Control Panel, to take the column out of line.

NOTE: If you configure Low Dispersion, Three Columns, 
or Direct Control column plumbing configurations, the 
column cannot be bypassed. Physically remove the 
column and replace with a union before priming.

2. Purge the system with a 1 M salt solution with the pH and 

conductivity monitors inline. For more information, see 

Section 5.2.4, Purging the System.

3. Run the SYSCLEAN method as described on page 2-38.

NOTE: As an alternative to running the SYSCLEAN 
method, you can purge the system with water from the 
Control Panel. Take the pH monitor offline by clicking the 
Bypass option button in the pH/Cond section of the 
Control Panel. Then purge the system with filtered 
deionized water. For more information, see Section 5.2.4, 

Purging the System.

4. Purge the system with a solution of water and 

isopropanol (80:20). For more information, see Section 

5.2.4, Purging the System.

5. Remove the pH probe and store as described in 

Section 9.5, pH and Conductivity Monitor Maintenance.

6. Close the BioCAD software by selecting Exit BioCAD from 

the File menu in the Control Panel.

7. Close Microsoft Windows by clicking Start, then clicking 

Shut Down.

8. Power down the components of the workstation in any 

order. 

9. Set the Helium On/Off switch to the Off position.
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10. Power down the BioCAD 700E Workstation.

11. Turn off the gas and helium sources.

CAUTION
Do not close the helium tank without turning off the 
helium switch. Helium diffuses out of the line, forming a 
vacuum, which pulls liquid into the sparging system.

NOTE: If you shutdown the system for an extended time 
period, you may want to remove the pH probe. Store the 
probe in the storage solution (saturated KCl) and 
protective container provided with the probe.
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3.1  Plumbing the Workstation

This section describes:

• Selecting tubing diameter and length

• Connecting fittings to tubing

• Plumbing tubing and columns

• Changing the syringe and sample loop

NOTE: For information on plumbing a fraction collector, see 
Section 2.4.3, Connecting the Fraction Collector. 
For information on plumbing an autosampler, see Section 3.6, 

Preparing an Autosampler.

3.1.1  Selecting Tubing Diameter and Length

Tubing diameter Appropriate tubing diameter for plumbing the injection valve and 

column switching valves is determined by flow rate. See 

Table 3-1 to determine the appropriate tubing diameter for each 

flow rate range.

Small . Smaller diameter tubing adds less additional delay volume in 

the system and results in higher efficiency. 

For maximum separation efficiency, use the smaller tubing.

Large Larger diameter tubing allows operation at higher flow rates with 

minimal pressure increase.

If you will be running at significantly different flow rates, use the 

larger tubing for maximum versatility.

NOTE: 10 the appropriate size tubing for your flow rate. 
If you use smaller tubing and run at higher flow rates, the 
pump shuts down when the pressure maximum you set in the 
Configuration dialog box is reached.
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Flow rate and
tubing size

Use Table 3-1 to determine the appropriate tubing diameter for 

your application flow rate.

Table 3-1   Flow Rate and Tubing Size

NOTE: When using the blue 0.010-inch ID tubing, it is 
recommended that you run at flow rates under 20 ml/min. 
However, you can take the column out of line and increase 
the flow rate to quickly purge the system when changing to a 
new buffer/solvent blend.

NOTE: To minimize the back pressure of the system when 
running low-pressure columns, use the variable length flow 
cell (part number P5-1085-53-0000).

Tubing length To determine the lengths of tubing you need for plumbing the 

injection valve and column switching valves for each column 

plumbing configuration, refer to Figure 3-6 through Figure 3-10.

Flow Rates Tubing 

ID

Tubing 

Color

Tubing Volume

µl/ft µl/cm

0 to 20 ml/min 0.010" Blue 15 0.51

0 to 60 ml/min 0.020" Orange 62 2.03

0 to 100 ml/min 0.030" Green 139 4.56

0 to 100 ml/min, 

low pressure columns

0.030" Green 139 4.56

0 to 100 ml/min,

glass columns

0.030" Green 139 4.56

NOTE: All tubing has a 1/16-inch OD.
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Cutting tubing If you cannot find an appropriate length of tubing for the 

connection that you are making, you can cut your own. 

Use the tubing cutter and coils of PEEK tubing provided in the 

startup kit. When cutting tubing:

• Make sure you cut PEEK tubing ends squarely

• Minimize the length of tubing you use

3.1.2  Connecting Fittings to Tubing

The BioCAD 700E Workstation uses four types of fittings:

• Rheodyne RheFlex® fittings (Figure 3-2)

• Compression ring fittings (Figure 3-3)

• Wing nut fittings (Figure 3-4)

• Low-pressure plastic fittings (Figure 3-5)

Figure 3-1 shows the location of the four fitting types.

Figure 3-1  BioCAD 700E Workstation Fitting Diagram
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CAUTION

Plumb the UV/Vis flow cell so that fluid flows into the cell at 
the bottom and out of the cell at the top. If plumbing 
connections are reversed, air bubbles can be trapped in the 
flow cell and cause excessively noisy baselines.

NOTE: Fittings on the buffer/solvent proportioning valve are 
plastic barbed slip-on fittings, not low-pressure plastic 
screw-on fittings.

Rheodyne
RheFlex fittings

Use Rheodyne RheFlex fittings to connect tubing to:

• 6-port injection valve

• 6-port column switching valves

To connect Rheodyne RheFlex fittings to tubing:

1. Slip a compression fitting over the end of the tubing.

2. Slip a split ferrule over the end of the tubing, with the 

tapered end of the ferrule pointing away from the 

compression fitting. The split end of the ferrule should point 

toward the compression fitting. Make sure at least 1/16-inch 

of tubing extends beyond the ferrule (Figure 3-2).

Figure 3-2  Connecting Rheodyne RheFlex Fittings

to Tubing

3. Bottom the tubing in a port. Finger-tighten the compression 

fitting.

PB100018

Ferrule

Compression

fitting
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Compression
ring and wing

nut fittings

Use compression ring fittings or wing nut fittings to connect 

tubing to:

• Columns

• Prime/purge valve

• Filter/Mixer

• Union to the UV/Vis detector flow cell

NOTE: To connect PEEK columns, do not use standard 
stainless steel fittings that require tightening with a wrench. 
Overtightening can strip the threads of the column.

To connect compression ring fittings to tubing:

1. Slip a stainless steel compression fitting over the end of 

the tubing.

2. Slip a stainless steel ring over the end of the tubing with the 

flat end of the ring toward the fitting.

3. Slip a PEEK ferrule over the end of the tubing with the 

narrow end of the ferrule toward the ring. Make sure at least 

1/16-inch of tubing extends beyond the ferrule (Figure 3-3).

Figure 3-3  Connecting Compression Ring Fittings to 

Tubing

4. Bottom the tubing in a port. Finger-tighten the compression 

fitting. Tighten 1/4 turn with needle-nose pliers.

PB100654

Compression fitting
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To connect wing nut fittings to tubing:

1. Slip a wing nut fitting over the end of the tubing.

2. Slip a ferrule over the end of the tubing, with the tapered 

end of the ferrule pointing away from the compression 

fitting. Make sure at least 1/16-inch of tubing extends 

beyond the ferrule (Figure 3-4).

Figure 3-4  Connecting Wing Nut Fittings to Tubing

3. Bottom the tubing in a port. Finger-tighten the compression 

fitting.

Low-pressure
plastic fittings

Use 1/4-28-inch low-pressure plastic fittings to connect 

low-pressure tubing to:

• Autoloader sample selection valve 

• Detector bypass valve

• Fraction/Waste valve

• pH and conductivity monitors 

To connect plastic fittings to tubing:

1. Slip the plastic compression fitting over the end of the 

tubing.

2. Slip a plastic ferrule over the end of the tubing with the 

tapered end toward the compression fitting. Use a yellow 

ferrule with 1/8-inch tubing. Use a blue ferrule with 

1/16-inch tubing. Make sure tubing is flush with the ferrule 

(Figure 3-5).

PB100765
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Figure 3-5  Connecting Low-Pressure Plastic Fittings to 

Tubing

3. Bottom the tubing in a port. Finger-tighten the compression 

fitting.

PB100020

Ferrule
Compression

fitting
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3.1.3  Plumbing Tubing and Columns 

Plumbing
configurations

The BioCAD 700E Workstation supports four standard plumbing 

configurations and one customized configuration:

• Single Column

• Tandem Columns

• Three Columns

• Low Dispersion

• Direct Control

Configurations and tubing lengths for each configuration are 

shown in Figure 3-6 through Figure 3-10.

Hint: You can display plumbing configurations on the 
workstation monitor by selecting Show Column Plumbing or 
Show System Plumbing from the Config menu in the 
Control Panel. The system plumbing diagram shows the 
Single Column plumbing configuration.

Plumbing tubing
and columns

Connect tubing and columns to a BioCAD 700E Workstation 

following one of the plumbing configurations shown in 

Figure 3-6 through Figure 3-10. 

See “Column plumbing configurations” on page 1-15 for more 

information on each plumbing configuration.

NOTE: After connecting the columns and tubing to the 
workstation, you must edit the system configuration to match 
the physical plumbing. See Section 4.2.4, Configuring 

Columns and Plumbing.
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Figure 3-7  BioCAD 700E Tandem Column Configuration
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Figure 3-9  BioCAD 700E Low Dispersion Configuration
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Figure 3-10  BioCAD 700E Direct Control Configuration
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3.1.4  Changing the
Syringe and Sample Loop

You may need to change the syringe and sample loop to 

accommodate your injection volume when making autoloader or 

manual injections.

NOTE: Pump injections and autosampler injections do not 
use the syringe and sample loop on the BioCAD 700E.

Selecting
syringe and

sample loop size

Injection volume determines the syringe and sample loop size. 

To achieve maximum injection volume accuracy and precision, 

follow these guidelines when specifying injection volumes and 

selecting sample loop sizes:

• For injection volumes less than 50 percent of the sample 

loop volume, enter the injection volume in the Control 

Panel or method.

• For injection volumes equal to the sample loop volume, 

enter a volume of three times the sample loop volume in 

the Control Panel or method. For example, you can 

accurately inject a 100 µl sample using the 100 µl sample 

loop if you use an injection volume of 300 µl.

• Do not inject volumes between 50 percent and 

100 percent of the sample loop volume.

NOTE: The actual volume injected onto the column never 
exceeds the sample loop size.

Changing
syringe

Change the syringe to accommodate different injection 

volumes. Syringes provided with the BioCAD 700E Workstation 

include:

• 500 µl—Injection volume range 0.001 to 0.5ml

• 5 ml—Injection volume range 0.01 to 5 ml

To change the syringe, you must:

• Remove the existing syringe

• Attach a new syringe 
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Removing To remove the syringe:

1. Select Change Syringe from the Sample menu on the 

Control Panel.

The syringe plunger retracts and the Set Syringe Size 

dialog box is displayed (Figure 3-11).

Figure 3-11  Set Syringe Size Dialog Box

CAUTION
Do not remove the syringe before retracting the plunger. 
The syringe will break.

2. Unscrew and remove the knurled knob at the base of the 

plunger. 

3. Unscrew the body of the syringe (turn to the left) and 

remove.
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Attaching To attach a new syringe:

1. Place the hole in the base of the plunger over the pin on 

the syringe piston.

Figure 3-12  Replacing the Syringe

2. Pull up on the syringe body until it reaches the fitting.

3. While pushing up gently, turn the syringe body to the right 

and screw into place.

4. Replace the knurled knob in the plunger base.

5. Select the size of the syringe you installed from the 

drop-down list box in the Set Syringe Size dialog box. 

Click OK. 

The syringe plunger returns to the home position.

NOTE: The home position varies with different syringe 
sizes. The syringe size you select updates the syringe 
size in the Configuration dialog box.

POWER FRACTION

LAMP

PUMP EVENT MARK

PerSeptive Biosystems, Inc.

PB100022

Place hole
over pin, 
then pull up
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Changing
sample loop

Change the sample loop to accommodate different injection 

volumes. Sample loops provided with the BioCAD 700E 

Workstation include:

• 100 µl

• 2 ml

• 5 ml

To change the sample loop:

1. Unscrew the installed loop from positions 2 and 5 on the 

sample injection valve. 

2. Replace with the appropriate sample loop.

Figure 3-13  Installing a Sample Loop

3. Select Change Loop Size from the Sample menu on the 

Control Panel.

The Set Sample Loop Size dialog box is displayed.

4. Type the size of the loop you installed and click OK.

NOTE: The sample loop size you type updates the 
sample loop size in the Configuration dialog box.

PB100046

Connect loop to
positions 2 and 5
on injection valve
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3.2  Preparing Buffers,
Solvents, and Solutions

This section describes preparing:

• Buffers/solvents

• pH blend mode buffers

• Pump seal wash solution

NOTE: For information on preparing autosampler solvents, 
see Section 3.6, Preparing an Autosampler.

Incompatible
solvents

CAUTION

Do not use methylene chloride, tetrahydrofuran, dimethyl 
sulfoxide, or concentrated nitric or sulfuric acids. These 
materials are not compatible with the PEEK components in 
the BioCAD 700E Workstation.

CAUTION

Certain organic solvents, such as acetonitrile and 
isopropanol, used over long time periods or in high 
concentrations can weaken PEEK tubing on the BioCAD 
700E Workstation. Change the PEEK tubing on the 
workstation periodically if you use organic solvents frequently 
or in high concentrations. For more information, contact 
Technical Support.

Organic solvents CAUTION

If you use organic solvents, bypass the pH and conductivity 
monitors to prevent damage. You can bypass the pH and 
conductivity monitors by clicking the Bypass option button in 
the pH/Cond section of the Control Panel or in the General 
Settings of a method.
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3.2.1  Preparing Buffers/Solvents

You can use up to six buffers/solvents on the BioCAD 700E 

Workstation. You can blend up to four buffers/solvents.

CAUTION

If you use salt solutions, be aware that lower grade salts can 
have high acid contamination, which can decrease the pH of 
the buffer/solvent.

Filtering Filter all buffers/solvents through a 0.22 or 0.45 micron filter 

before using them in the workstation. 

You do not need to filter HPLC-grade liquid solvents, but you 

should sparge them.

Location Place buffer/solvent reservoirs to the right of the workstation. 

Place reservoirs at the same level as or slightly higher than the 

workstation. Place all reservoirs at the same approximate 

height. 

CAUTION

Do not place the buffer/solvent reservoirs below the level of 
the workstation. Doing so could cause loss of system prime, 
pump cavitation, and faulty flow rate readings. 

Unused lines Place unused buffer/solvent lines in filtered deionized water. Do 

not leave these lines dry.

Sparging Sparge all buffers/solvents used on the BioCAD 700E 

Workstation. Sparging prevents outgassing and helps ensure 

pump flow rate precision and gradient accuracy.
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Sparging the
buffer/solvent

Make sure the buffer/solvent bottles are connected according to 

Section 2.3.3, Connecting the Buffer/Solvent and Sparge Lines. 

Adjust the following controls on the right side panel of the 

system: 

1. Set the Helium On/Off switch to the On position.

2. Open the sparge valves for the reservoirs in use by turning 

the gas flow control knobs on the right side panel 

(see Figure 2-3 on page 2-8). Open the valves until you see 

a steady stream of bubbles.

3. Allow 15 minutes for the helium sparging to equilibrate.

CAUTION

Do not close the helium tank without turning off the helium 
switch. Helium diffuses out of the line, causing a vacuum to 
form, pulling liquid into the sparge system.

Before changing
buffer/solvent

Before changing to a new buffer/solvent, make sure the sparge 

line is clear. If there is any liquid in the sparge line:

1. With the sparge element in the original buffer/solvent, 

blow helium through the sparge line by opening the gas 

flow control knob for a few seconds.

2. Remove the sparge element and connected lines from the 

original buffer/solvent and submerge them in the new 

buffer/solvent. 

NOTE: This step prevents contamination of the new 
buffer/solvent.
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3.2.2  Preparing pH Blend Mode Buffers

pH blend mode The BioCAD 700E Workstation allows you to run in three blend 

modes: Percentage, Eluent, and pH. To run in pH blend mode, 

you need to prepare four buffers/solvents:

• Two pH blend buffers (anion or cation)

• A salt solution

• Water

NOTE: Configure the two pH buffers as type Buffer, the salt 
solution as type Eluent, and the water as type H2O. For more 
information, see Section 4.2.2, Configuring Buffers/Solvents, 
and Section 4.5.1, Customizing the Buffer/Solvent Library.

The three types of pH blend mode buffers you can prepare are:

• pH Blend Buffers—Special anion or cation pH buffers 

for which the workstation is already calibrated. These 

buffers exist in the Buffer/Solvent Library. Recipes for 

these buffers appear on page 3-21. When you blend in 

pH mode, you specify a pH value in the Control Panel, 

method segment, or pH Map template. The BioCAD 

software then calculates the percent of each buffer 

needed to achieve the desired pH.

• Custom pH Blend Buffers (Calibrated)—Any pair of 

buffers can be used for pH blending. You calibrate 

custom buffers using the Calibrate pH Mode Buffers 

feature. (For more information, see Section 5.2.9, 

Calibrating Custom pH Blend Buffers.) You will need to 

add these buffers to the Buffer/Solvent Library. When you 

blend in pH mode, you specify a pH value in the Control 

Panel, method segment, or pH Map template. The 

BioCAD software then calculates the percent of each 

buffer needed to achieve the desired pH.

• Custom pH Blend Buffers (Uncalibrated)—Any pair 

of buffers can be used for pH blending. You will need to 

add these buffers to the Buffer/Solvent Library. When you 

blend in pH mode, you specify a percentage value in the 

Control Panel, method segment, or pH Map template. 
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pH blend buffers The Buffer/Solvent Library in the BioCAD software contains the 

following pH blend mode buffers:

• Anion Buffer - pH 6.0 + 100.0 mM Tris/bis-Tris propane

• Anion Buffer - pH 9.0 + 100.0 mM Tris/bis-Tris propane

• Cation Buffer - pH 4.5 + 100.0 mM MES/HEPES/Acetate

• Cation Buffer - pH 7.5 + 100.0 mM MES/HEPES/Acetate

• H20

• NaCl + 3000.0 mM NaCl

Recipes for special anion and cation buffers appear below. 

Buffer strength of the buffers should be two to five times more 

concentrated than the buffer strength of the blend needed for 

the separation. For example, 100 mM pH buffers are 

appropriate for pH separations that require a 20 to 50 mM blend 

concentration.

Anion buffers Use anion buffers with anion exchange columns. Anion buffers 

cover the pH range of 6 to 9. Anion buffers for pH Map 

templates are composed of:

• 50 mM Tris

• 50 mM bis-Tris propane

Make two bottles of buffer with a total buffer concentration of 

100 mM. Adjust one buffer to pH 6.0 (with HCl) and the other to 

pH 9.0 (with NaOH).

Cation buffers Use cation buffers with cation exchange columns. Cation 

buffers cover the pH range 4.5 to 7.5. Cation buffers for pH Map 

templates are composed of:

• 33.3 mM HEPES—(N-[2-Hydroxyethyl]piperazine-N'-

[2-ethanesulfonic acid])

• 33.3 mM MES—(2-[N-Morpholino]ethane-sulfonic acid)

• 33.3 mM sodium acetate

Make two bottles of buffer each with a total buffer concentration 

of 100 mM. Adjust one buffer to pH 4.5 (with HCl) and the other 

to pH 7.5 (with NaOH).

NaCl and water Prepare 3 M NaCl using HPLC-grade water.
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3.2.3  Preparing Pump Seal Wash Solution

Choose a wetting agent for the pump seal wash solution. A 

30 percent isopropanol/water solution is recommended.

Filtering Filter the wash solution through a 0.22 or 0.45 micron filter 

before using. 

Location Place the reservoir containing the pump seal wash solution at 

the same level as or slightly higher than the workstation.

Replacement Change the wash solution weekly or more often if you run the 

system very frequently.

NOTE: For information on connecting the pump seal wash 
lines, see Section 2.3.4, Connecting the Pump Seal Wash 

Lines.
For information on priming the pump seal wash lines, see 
Section 3.4.1, Priming the Pump Seal Wash Lines.
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3.3  Preparing Samples

This section describes how to prepare samples for:

• Autoloader injections (small vessels)

• Autoloader injections (large vessels)

• Direct autoloader injections

• Manual injections

• Pump injections

For information on preparing samples for autosampler 

injections, see Section 3.6, Preparing an Autosampler.

NOTE: To determine which injection mode to use, see 
“Selecting an injection mode” on page 1-12.

3.3.1  Preparing Samples for 
Autoloader Injections (Small Vessels)

To prepare samples for autoloader injections using small 

vessels that fit in the sample compartment:

1. Filter samples through a 0.22 or 0.45 micron filter before 

injection. 

2. Transfer samples to small sample vessels.

3. Place up to four small sample vessels in the sample 

compartment at the top of the BioCAD 700E Workstation 

(see Figure 3-14).

4. Insert the four sample lines in the appropriate vessels.

5. Prime or flush the sample lines as described in Section 

3.4.3, Priming and Flushing the Autoloader Sample Lines.
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Figure 3-14  Preparing Samples for Autoloader Injection

3.3.2  Preparing Samples for 
Autoloader Injections (Large Vessels)

To prepare samples for autoloader injections using large 

vessels that do not fit in the sample compartment:

1. Filter samples through a 0.22 or 0.45 micron filter before 

injection. 

2. Transfer samples to large sample vessels.

3. Place up to four large sample vessels on top of the BioCAD 

700E Workstation.

4. Replumb the sample lines with green 0.030-inch ID tubing 

and insert the tubing into the sample vessels.

5. Prime or flush the sample lines as described in Section 

3.4.3, Priming and Flushing the Autoloader Sample Lines.

NOTE: Change the prime and flush volumes in the 
Configuration dialog box to account for the extra volume 
added by the sample lines you replumbed. Green 0.030-inch 
ID tubing volume is 4.56 µl/cm.

PB100519
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3.3.3  Preparing Samples for 
Direct Autoloader Injections

To prepare samples for direct autoloader injections:

1. Filter samples through a 0.22 or 0.45 micron filter before 

injection. 

2. Transfer the sample to a sample vial.

3. Place the sample vial in the top right column clamp on the 

workstation, next to the injection valve (Figure 3-15).

Figure 3-15  Preparing Sample for 
Direct Autoloader Injection

4. Disconnect the autoloader line from port 6 on the injection 

valve (top valve). 

5. Connect a short length of orange 0.020-inch ID tubing from 

the sample vial to port 6 on the injection valve.

6. Prime or flush the sample lines as described in Section 

3.4.3, Priming and Flushing the Autoloader Sample Lines.

NOTE: Reduce the prime and flush volumes in the 
Configuration dialog box to account for the shorter length 
of sample tubing used for the direct autoloader injection. 
Orange 0.020-inch ID tubing volume is 2.03 µl/cm.

PB100023
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3.3.4  Preparing Samples
for Manual Injections

To prepare samples for manual injections:

1. Filter samples through a 0.22 or 0.45 micron filter before 

injection. 

2. Disconnect the autoloader line from port 6 on the injection 

valve (top valve). 

3. Screw the needle port adaptor (from the startup kit) loosely 

into port 6 of the injection valve (Figure 3-16).

Figure 3-16  Inserting Needle Port Adaptor

4. Place a waste vial in the top right column clamp on the 

workstation, next to the injection valve.

5. Disconnect the line from port 1 on the injection valve (top 

valve). 

6. Connect a waste line from port 1 on the injection valve to 

the waste vial.

PB100062
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3.3.5  Preparing Samples for Pump Injections

To prepare samples for pump injections:

1. Filter the sample through a 0.22 or 0.45 micron filter 

before injection. 

2. Transfer the sample to large sample container.

3. Place the sample container to the right of the workstation, 

keeping it at the same level as the workstation.

4. Insert one of the six buffer/solvent lines into the sample 

container. 

Hint: You may want to replace the buffer/solvent tubing 
with smaller diameter silicon tubing for easier handling 
and to minimize waste. You may need to decrease flow 
rate when using smaller diameter silicon tubing.

5. Prime the sample lines as described in Section 3.4.4, 

Priming Buffer/Solvent Sample Lines for a Pump Injection.
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3.4  Priming and Flushing the System

This section describes priming and flushing:

• Pump seal wash lines

• Buffer/solvent lines

• Autoloader sample lines

• Buffer/solvent sample lines for a pump injection

NOTE: For information on priming the autosampler, see 
Section 3.6, Preparing an Autosampler.

3.4.1  Priming the Pump Seal Wash Lines

When to prime Prime the pump seal wash lines whenever the lines become 

drained or if you take the pump heads apart.

Priming To prime the pump seal wash lines:

1. Locate the two pump seal wash lines as they emerge 

from the pump heads in the lower right panel of the 

workstation. Pump seal wash lines are urethane tubing, 

and are not bundled together with the buffer/solvent lines 

(Figure 3-17).

2. Identify the inlet line (longer of two lines and connects to the 

bottom of the pump heads) and outlet line (shorter of the 

two lines and connects to the top of the pump heads).
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3. Place the inlet line in the pump seal wash solution.

NOTE: A 30 percent isopropanol/water solution is 
recommended for the pump seal wash solution.

4. Connect a syringe to the outlet line. 

5. Prime the lines by pulling pump seal wash solution into the 

syringe until the inlet and outlet lines are filled with fluid.

6. Remove the syringe from the outlet line and place the outlet 

line in the pump seal wash solution reservoir.

PB100029
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3.4.2  Priming the Buffer/Solvent Lines

This section describes:

• When to prime

• Priming using the Purge command

• Priming from the Control Panel

When to prime Prime any of the six buffer/solvent lines after changing 

buffers/solvents or if there are air bubbles in the lines. Priming 

fills the line with buffer/solvent and removes air bubbles.

Hint: If you are changing solvents, tap the old solvent out of 
the end of the line. This forms a bubble to prevent intermixing 
and helps ensure complete changeover.

Priming using
Purge command

To prime the buffer/solvent lines using the Purge command:

1. Connect the 60 ml syringe (provided in the startup kit) to 

the Luer-Lok® fitting at the end of the vent tube 

connected to the prime/purge valve (Figure 3-18). Open 

the valve one-half to one full turn to the left 

(counterclockwise).

Figure 3-18  Syringe Attached to Luer-Lok Fitting on 

Prime/Purge Valve

Prime/purge
valve

Vent tube
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2. Select Purge System from the Control Panel Blend menu.

NOTE: The Purge System command is not displayed if 
you configure Low Dispersion, Three Columns, or Direct 
Control column plumbing configurations. In these 
configurations, the column cannot be bypassed. See 
“Priming from Control Panel” on page 3-33, to prime with 
these column plumbing configurations.

The Purge Segment Setup dialog box is displayed 

(Figure 3-19).

Figure 3-19  Purge Segment Setup Dialog Box

3. Select a buffer/solvent channel (A through F) to prime 

and set it for 100%.

NOTE: If no buffers/solvents are displayed, configure 
buffers/solvents. For more information, see Section 4.2.2, 

Configuring Buffers/Solvents.

4. Type a flow rate of at least 20 ml/min.

5. Type a volume in ml sufficient to clear all air from the 

buffer/solvent line.
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6. Select the Flow Direction at End of Purge. The selections 

depend on the current plumbing configuration.

7. Click OK to start the purge segment.

8. Prime the line by pulling 20 ml of buffer/solvent into the 

syringe you attached to the prime/purge valve. 

9. Close the prime/purge valve by turning it clockwise and 

remove the syringe from the vent tube. 

10. Stop the pump by clicking the Stop button on the Control 

Panel or by pressing the Pump button on the front panel 

of the workstation.

11. Repeat this procedure for all buffer/solvent channels. 

Prime each buffer/solvent line with the appropriate 

buffer/solvent. Prime unused lines with deionized water.
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Priming from
Control Panel

You can also prime buffer/solvent lines from the Control Panel:

1. Connect the 60 ml syringe (provided in the startup kit) to 

the Luer-Lok® fitting at the end of the vent tube 

connected to the prime/purge valve. See Figure 3-18 on 

page 3-30. Open the valve one-half to one full turn to the 

left (counterclockwise).

2. In the Blend section of the Control Panel, select a 

buffer/solvent channel, set it to 100%, and click Set.

NOTE: If no buffers/solvents are displayed, configure 
buffers/solvents. For more information, see Section 4.2.2, 

Configuring Buffers/Solvents.

3. Select a flow rate of at least 20 ml/min in the Pump section 

of the Control Panel.

4. Click the Bypass option button in the Column section of the 

Control Panel to place the column out of line.

NOTE: If you configure Low Dispersion, Three Columns, 
or Direct Control column plumbing configurations, the 
column cannot be bypassed. Physically remove the 
column and replace with a union before priming.

5. Click the Start button to start the pump.

6. Prime the line by pulling 20 ml of buffer/solvent into the 

syringe you attached to the prime/purge valve. 

7. Close the prime/purge valve by turning it clockwise and 

remove the syringe from the vent tube. 

8. Click the Stop button to stop the pump.

9. Repeat step 2 through step 8 for all buffer/solvent channels. 

Prime each buffer/solvent line with the appropriate 

buffer/solvent. Prime unused lines with deionized water.
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3.4.3  Priming and Flushing the
Autoloader Sample Lines

When to prime If you make an autoloader injection on the BioCAD 700E 

Workstation, prime the sample lines before injecting from a 

sample vessel for the first time. Priming fills the entire selected 

sample line, up to the injection valve (Figure 3-20).

When to flush If you make an autoloader injection or direct autoloader injection 

on the BioCAD 700E Workstation, flush the sample lines to 

remove previously injected sample from the line before 

switching between the four sample channels. Flushing clears 

the sample line from the sample selection valve to the injection 

valve (Figure 3-20). 

Figure 3-20   Priming and Flushing the Autoloader 

Sample Lines

Flow path
diagrams

Appendix H, Autoloader Flow Path, includes additional 

diagrams that illustrate the flow path of the autoloader during 

different operations.
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Priming To prime the autoloader sample lines:

1. Prepare the samples as described in Section 3.3, 

Preparing Samples.

Hint: If you are changing samples, tap old sample out of 
the end of the line. This forms a bubble to prevent 
intermixing and helps ensure complete changeover.

2. Configure a prime volume as described in Section 4.2.3, 

Configuring the Autoloader.

NOTE: The default prime volume is 350 µl. 
If you have limited sample volume or are making a direct 
autoloader injection, decrease the prime volume 
accordingly by editing the system configuration. 
If you replumb the sample lines leading to the selection 
valve, increase the prime volume accordingly by editing 
the system configuration.
For more information, see Section 4.2.3, Configuring the 

Autoloader.

3. Select a sample line (Direct, 1, 2, 3, or 4) to prime from 

the Sample Loader drop-down list box in the Sample 

section of the Control Panel.

NOTE: If no sample names are displayed, configure 
sample names. For more information, see Section 4.2.3, 

Configuring the Autoloader.

4. Select Prime from the Control Panel Sample menu. The 

Prime selection on the Sample menu shows the selected 

channel, indicating that this channel is being primed.

The selected sample line is primed with the prime volume 

you set in the Configuration dialog box.

5. Repeat step 3 and step 4 for all sample lines in use.
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Flushing To flush the autoloader sample lines:

1. Prepare the samples as described in Section 3.3, 

Preparing Samples.

Hint: If you are changing samples, tap old sample out of 
the end of the line. This forms a bubble to prevent 
intermixing and helps ensure complete changeover.

2. Configure a flush volume as described in Section 4.2.3, 

Configuring the Autoloader.

NOTE: The default flush volume is 100 µl. If sample 
carryover is a concern, increase the flush volume by 
editing the system configuration. For more information, 
see Section 4.2.3, Configuring the Autoloader.

3. If you are making an autoloader injection, prime the sample 

line (1, 2, 3, or 4). For more information, see “Priming” on 

page 3-35.

4. Select a sample line (1, 2, 3, 4, or Direct) to flush from the 

Sample Loader drop-down list box in the Sample section of 

the Control Panel.

5. Select Flush from the Control Panel Sample menu. The 

Flush selection on the Sample menu shows the selected 

channel, indicating that this channel is being flushed.

The selected sample line is flushed with the flush volume 

you set in the Configuration dialog box.

6. Repeat step 3 and step 4 for all sample lines in use.
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3.4.4  Priming Buffer/Solvent Sample
Lines for a Pump Injection

If you use the pump to inject a sample through one of the 

buffer/solvent lines, use the following procedure to prime and fill 

the buffer/solvent line with the sample and to remove air 

bubbles:

1. Prepare the samples as described in Section 3.3, 

Preparing Samples.

2. Connect the 60 ml syringe (provided in the startup kit) to the 

Luer-Lok® fitting at the end of the vent tube connected to the 

prime/purge valve. See Figure 3-18 on page 3-30. Open the 

valve one-half to one full turn to the left (counterclockwise).

3. Click the Bypass option button in the Column section of the 

Control Panel to take the column out of line.

NOTE: If you configure Low Dispersion, Three Columns, 
or Direct Control column plumbing configurations, the 
column cannot be bypassed. Physically remove the 
column and replace with a union before priming.

4. In the Blend section of the Control Panel, select the 

buffer/solvent channel containing the sample, set it to 

100%, and click Set.

5. In the Pump section of the Control Panel, type a flow rate 

of at least 20 ml/min and click Start to start the pump.
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6. Prime the line by pulling 20 ml of sample into the syringe 

attached to the prime/purge valve. Close the prime/purge 

valve by turning it clockwise and remove the syringe from 

the vent tube.

Hint: To conserve sample, introduce a bubble in the 
sample line before placing the line in the sample. Prime 
the line only until the bubble passes the proportioning 
valve. 

NOTE: After priming the buffer/solvent line with sample, 
purge the system with equilibration buffer to remove 
sample that may have passed the proportioning valve. 
For information, see Section 5.2.4, Purging the System.
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3.5  Preparing the Fraction Collector

Features The fraction collector provided (Advantec or Gilson) by Applied 

Biosystems includes the following features:

• Collects fractions based on time or volume.

• Performs peak cutting based on threshold and slope 

values. 

• Performs both of the above simultaneously.

• Includes fraction collector event marks in BioCAD data 

files. 

BioCAD software corrects for all system delay volumes and 

properly synchronizes all fraction collector event marks with the 

detector signal. If you change the length of tubing between the 

fraction/waste valve on the workstation and the fraction 

collector, you must set delay volume settings in the 

Configuration dialog box. For more information, see “Setting 

delay volumes” on page 4-13.

To prepare the fraction collector (Advantec or Gilson) provided 

by Applied Biosystems, you must:

• Install the fraction collector racks

• Set fraction collector mode (Gilson only)

• Prepare the fraction collector software (Advantec only)

3.5.1  Installing Fraction Collector Racks

The fraction collector is supplied with a test tube rack. Optional 

racks include:

• Eppendorf® rack

• Preparative funnel rack (for use with large bottles) 

(Advantec only)

All racks have tabs that line up with the base of the fraction 

collector. Make sure to push the rack all the way back against 

the base. Make sure all test tubes are centered in the slots and 

pointing straight up.
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3.5.2  Setting Fraction Collector Mode

If you have a Gilson fraction collector, set the fraction collector 

to Manual mode and enter a delay time of 0. For more 

information, see the Gilson Fraction Collector User’s Guide.

3.5.3  Preparing Fraction Collector Software

Overview If you have an Advantec fraction collector, prepare the fraction 

collector software by programming operating parameters on the 

front panel of the fraction collector. You can program the fraction 

collector in two modes:

• Simple Mode—Use the standard 120-tube configuration.

• Bottle Mode—Use a customized configuration. You 

must teach the fraction collector this customized 

configuration.

NOTE: After you prepare the fraction collector software, you 
must configure and prepare the BioCAD software for a 
fraction collector. See Section 4.6, Configuring and Preparing 

the BioCAD Software for a Fraction Collector.

Before you
begin

To program the fraction collector front panel, you must do one of 

the following:

• Deselect the Fraction Collector in the Configuration 

dialog box

• Disconnect the fraction collector cable from the 

workstation

• Exit the BioCAD software before programming

NOTE: If you select the Fraction Collector in the 
Configuration dialog box, the front panel of the fraction 
collector does not respond.
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Programming
Simple mode

To program the fraction collector in Simple mode:

1. On the fraction collector, press C/N (Change and 

Confirm).

The mode flashes.

NOTE: If mode does not flash, deselect Fraction 
Collector in the Configuration dialog box.

2. Enter 1 to select Simple mode.

3. Enter 0000 for the Wait Time. Press ENT/Y.

4. Enter 3 to select Signal for the collection mode.

5. Enter 0001 count per tube for the Signals per Fraction. 

Press ENT/Y.

6. Enter 120 for the Fractionating Number. Press ENT/Y.

The fraction collector beeps.

Programming
Bottle mode

To program the fraction collector in Bottle mode:

1. On the fraction collector, press C/N (Change and 

Confirm).

2. The mode flashes. 

NOTE: If mode does not flash, deselect Fraction 
Collector in the Configuration dialog box.

3. Enter 5 to select BSimple (Bottle) mode. 

4. You can store up to 3 bottle arrangements in the fraction 

collector software. Enter 1 to select the first arrangement.

5. Enter 0000 for the Wait Time. Press ENT/Y.

6. Enter 3 to select Signal for the collection mode.

7. Enter 0001 count per tube for the Signals per Fraction. 

Press ENT/Y.
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8. Enter the number of bottles you are using for the 

Fractionating Number. Press ENT/Y. 

The fraction collector beeps.

After you program the fraction collector in Bottle mode, 

you must teach the fraction collector bottle positions. See 

“Teaching bottle positions” below.

Teaching bottle
positions

If you program the fraction collector in Bottle mode, you must 

teach the fraction collector bottle positions:

1. On the fraction collector, press C/N (Change and 

Confirm).

The mode flashes.

2. Place the bottles in desired positions below the fraction 

collector arm. If you are using a rack, push the rack into the 

corner formed by the base of the fraction collector. This will 

help you easily reposition the rack in the correct place.

3. Enter 0 to select FC (Fraction Collector mode).

4. Enter 2 to select Bottle Arrange.

5. Enter the number (1, 2, or 3) of the bottle arrangement you 

selected above in step 4 of “Programming Bottle mode” on 

page 3-41.

6. Enter 0 to set the bottle arrangement.

7. The first bottle you set position for is Bottle 0 (this 

corresponds to Bottle 1 in the BioCAD software). Press the 

arrow keys (keys 2, 4, 6, and 8) to position the fraction 

collector diverter valve over the first bottle. Press 5 and an 

arrow key to move the diverter valve quickly. Press ENT/Y 

to store the position.

8. Repeat for all bottles. Make sure to press ENT/Y after the 

last bottle.

9. Press END.

The fraction collector beeps and automatically runs a test 

of bottle positions.
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3.6  Preparing an Autosampler

Overview The way you prepare an autosampler depends on how you 

connect the autosampler to the BioCAD 700E Workstation:

• Integrated Connection—The BioCAD software has 

complete control over autosampler functions. You 

program sample information using the BioCAD software. 

You must use an AS 3500 autosampler provided by 

Applied Biosystems.

• Direct Wire Connection—The BioCAD software 

triggers the autosampler to make injections. You program 

sample information using the autosampler controls. You 

can use any autosampler.

NOTE: For more information on connecting an autosampler, 
see Section 2.4.4, Connecting the Autosampler.

Preparing To prepare an AS 3500 autosampler provided by Applied 

Biosystems, you must:

• Prepare the autosampler software

• Plumb the autosampler injector valve

• Attach compressed gas supply (optional)

• Prepare autosampler solvents

• Prime the autosampler

• Prepare sample vials

• Load vials in autosampler trays

• Program the autosampler method and sample set 

(direct wire only)

NOTE: After you prepare the autosampler, you must 
configure and prepare the BioCAD software for an 
autosampler. For more information, see Section 4.7, 

Configuring and Preparing the BioCAD Software for an 

Integrated Autosampler, or Section 4.8, Configuring and 

Preparing the BioCAD Software for a Direct Wire Autosampler.
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3.6.1  Preparing the Autosampler Software

To prepare the autosampler software:

• Check the software version (integrated only)

• Set the autosampler to SpectraNet or Stand Alone mode

• Set the autosampler options

Checking
software version

To run as an integrated autosampler, your autosampler must be 

installed with software version 3.36 or later. To check the current 

version of software installed on your autosampler:

1. When the status on the autosampler front panel is Idle, 

press the Menu key.

2. Select Tests.

3. Select Software Version.

The current version of software is displayed.

NOTE: If your autosampler does not have software version 
3.36 or later, contact Technical Support to have your 
autosampler upgraded for use as an integrated autosampler.

Setting
SpectraNet or

Stand Alone
mode

To run as an integrated autosampler, set the autosampler to 

SpectraNet mode. To run as a direct wire autosampler, set the 

autosampler to Stand Alone mode.

To set the autosampler mode:

1. When the status on the autosampler front panel is Idle, 

press the Menu key.

2. Select Options.

3. Select Configurations.

4. Use the down arrow key to select Mode.

5. Use the + or - key to select SpectraNet or Stand Alone.

6. Press Enter to accept the mode.
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Setting
autosampler

options

Set the autosampler options (Prep Installed or TrayTemp 

Installed) using the front panel on the autosampler.

If you connect your autosampler as an integrated autosampler, 

set the options (Prep Installed or TrayTemp Installed) that 

correspond to the options (Prep option or Cooling option) you 

select in hardware setup. See Section 2.5.2, Updating BioCAD 

Hardware Setup Options.

To set the autosampler options:

1. When the status on the autosampler front panel is Idle, 

press the Menu key.

2. Select Options.

3. Select Configurations.

4. Use the down arrow key to select Prep Installed.

5. Select Yes if your autosampler supports the sample 

preparation option.

6. Use the down arrow key to select TrayTemp Installed.

7. Select Yes if your autosampler supports the sample cooling 

option.

8. Press Enter to accept the options.

NOTE: To determine if your autosampler supports the sample 
preparation option, look for two syringes behind the tray area 
or look for a heat/mix chamber to the left of the tray area.
To determine if your autosampler supports the sample 
cooling option, look for a wick below the left-hand tray.
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3.6.2  Plumbing Autosampler Injector Valve

Injection types Plumb the autosampler injector valve for one of the following 

injection types:

• Pull Loop

• PushLoop®

• Full Loop

For a description of the three injection types, see “Injection type” 

on page 4-38.

If you use an integrated autosampler, select the same injection 

type when you configure the autosampler. For more information, 

see “Configuring” on page 4-37.

Plumbing Figure 3-21 illustrates the plumbing from the BioCAD 700E 

Workstation to the autosampler injector valve. Figure 3-22 

illustrates how to plumb the autosampler injector valve for the 

three injection types. Table 3-2 describes how to plumb the 

autosampler injector valve for the three injection types. 

Figure 3-21  Plumbing from the BioCAD 700E 
Workstation to the Autosampler Injector Valve
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Table 3-2   Plumbing the Autosampler Injector Valve 

Injection 
Type

Plumbing

PushLoop • Plumb from the pump to port 6

• Plumb from port 5 to port 2 on Column Switching Valve 1 on the 

BioCAD 700E Workstation

Pull Loop 

OR 

Full Loop

• Plumb from the pump to port 5

• Plumb from port 6 to port 2 on Column Switching Valve 1 on the 

BioCAD 700E Workstation

NOTE: This plumbing ensures that sample enters and exits the sample 
loop from the same end, thereby preventing sample dispersion in the 
loop.
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3.6.3  Attaching the Compressed Gas Supply

If your autosampler supports the sample preparation option and 

you want to use the mixing feature, connect a compressed, dry 

gas (air or nitrogen) supply to the back of the autosampler to 

mix sample vials. For information on pressure settings, see the 

Autosampler Reference Manual.

3.6.4  Preparing Autosampler Solvents

Flush solvent Select a flush solvent appropriate for use with your autosampler 

solvents and your samples. One to five percent isopropanol is 

appropriate for most applications. 

If you use an integrated autosampler, select the same flush 

solvent when you configure the Sample Loader section of the 

Configuration dialog box on page 4-37.

Insert the autosampler flush solvent line into the flush solvent 

reservoir. The autosampler flush solvent line, which exits from 

the back of the autosampler, is not labeled. 

Autosampler
solvents

If your autosampler supports sample preparation, you can use 

up to four solvents with your autosampler.

If you use an integrated autosampler, select the same 

autosampler solvents in the Sample Preparation Configuration 

dialog box on page 4-42.

NOTE: The autosampler solvent lines, connected to the 
autosampler solvent selection valve on the back of the 
autosampler, are labeled S1 through S4 and correspond to 
lines AS1 through AS4 in the BioCAD software. 

Filtering Filter all autosampler solvents through a 0.22 or 0.45 micron 

filter before use.
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3.6.5  Priming the Autosampler

After installing the flush and autosampler solvents, prime the 

autosampler to fill the lines and remove air bubbles. 

Priming
direct wire

If you use a direct wire autosampler, see the Autosampler 
Reference Manual for information on priming.

Priming
integrated

If you use an integrated autosampler, you prime the 

autosampler from the BioCAD software.

To prime an integrated autosampler:

1. Select Sample Table from the Window menu in the 

Control Panel.

The Sample Table is displayed.

2. Select Prime Autosampler from the Sample menu in the 

Sample Table.

If your autosampler does not support the sample 

preparation option, the autosampler solvent line is 

primed with prime volume set in the AS 3500 

Autosampler dialog box. For more information, see 

Section 4.7, Configuring and Preparing the BioCAD 

Software for an Integrated Autosampler.

If your autosampler supports the sample preparation 

option, the Prime Autosampler dialog box is displayed

(Figure 3-23).

Figure 3-23  Prime Autosampler Dialog Box
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3. Select the autosampler lines to prime. Selecting All 

Channels selects all lines. 

4. Make sure the lines you selected are fully submerged in the 

autosampler solvents you connected to the autosampler. 

For more information, see Section 3.6.4, Preparing 

Autosampler Solvents.

5. Click OK.

The workstation primes the selected autosampler lines. 

It primes each line with the prime volume set in the 

AS 3500 Autosampler dialog box. For more information, 

see Section 4.7, Configuring and Preparing the BioCAD 

Software for an Integrated Autosampler. It primes for 

approximately 5 minutes per channel, for up to 

25 minutes.
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3.6.6  Preparing Sample Vials

Use vials, septa, and screw-on caps ordered from Applied 

Biosystems to ensure smooth autosampler operation.

Septa For septa, use either:

• An 8 mm diameter, 1.0 to 1.5 mm thick, rubber or silicon 

septum with a 0.1 mm thick Teflon® liner on the bottom 

side

• A single 0.25 mm thick Teflon liner by itself

Standard and
micro vials

Vials available from Applied Biosystems include:

Fill vials with the appropriate volumes. Do not fill vials with less 

than the vial dead volume (volume below which no injection can 

be made).

NOTE: If your autosampler supports the sample preparation 
option, do not use plastic vials if using the heat chamber. 
Plastic vials do not conduct heat well.

Vial Volume Range
 Dead

Volume

Standard—1.8 ml glass 200 µl to 1.8 ml 200 µl

Micro—250 µl conical plastic 20 µl to 250 µl 20 µl
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Vial inserts for
Unspecified

vial shape

You can purchase 100 µl inserts with self-centering bottom 

springs from other vendors for use with the 1.8 ml glass vials 

that are available from Applied Biosystems. Examples include 

Alltech #98031 (glass) and Alltech #98069 (propylene).

When to use
vial inserts

Use the vial inserts whenever you use the Unspecified vial 

shape in the BioCAD software. The vial inserts and Unspecified 

vial shape are useful if the following are true of your application:

• Small sample volume

• Maximum sample recovery is important

• Minimal sample loss is important

• Quantitative injection volume is not required

For more information on the Unspecified vial shape, see 

“Understanding Unspecified vial shape” on page 4-41.

How do vial
inserts work?

The autosampler is designed so that the sample needle is at a 

fixed height. This design creates a clearance between the 

needle tip and the vial bottom. The clearance protects the 

needle from damage, but also creates a dead volume of liquid 

that cannot be sampled. 

The vial insert with a self-centering bottom spring raises the vial 

bottom so that this dead volume is eliminated without damaging 

the needle. It allows you to inject nearly the complete contents 

of the vial.

How to use
vial inserts

To use vial inserts, place the insert in a 1.8 ml glass vial and fill it 

with sample using an appropriate size pipet tip.

After you prepare your sample, make sure you do the following 

when configuring the integrated autosampler:

• Select Pull loop as the injection type. For more 

information, see “Injection type” on page 4-38.

• Select Unspecified as the vial shape when you enter the 

sample in the Sample Table. For more information, see 

Section 4.7.3, Entering Vials in Sample Table.
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Filtering Filter samples through a 0.22 or 0.45 micron filter before filling.

Sample heating
and cooling

If you use an integrated autosampler that supports sample 

heating and cooling, you can control sample heating and 

cooling from two places:

• Configuration dialog box (see “Configuring sample prep” 

on page 4-42)

• Sample Table window (see “Controlling sample heating 

and cooling” on page 5-50)

3.6.7  Loading Vials in Autosampler Trays

Tray design The AS 3500 autosampler provided by Applied Biosystems has 

three interchangeable trays. Trays A, B, and C are arranged in 

the autosampler from left to right. 

Each tray holds 35 vials, arranged in seven rows of five. 

The first vial position is A1. The last vial position is C35. Position 

labels are to the left of each position (Figure 3-24).

NOTE: AS 3500 autosamplers that do not support the cooling 
option have trays that hold 40 vials (eight rows of five). If 
using an integrated autosampler, do not use vial positions 
A36–A40, B36–B40, or C36–C40.

Figure 3-24  AS 3500 Autosampler Tray
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Vial location If you use an AS 3500 autosampler provided by Applied 

Biosystems as a direct wire autosampler, place vials in the vial 

positions you program in your sample set. For more information, 

see Section 3.6.8, Programming the AS 3500 Autosampler 

Method and Sample Set. Place the vials consecutively, following 

the numbering of the vial positions.

NOTE: In direct wire mode, the AS 3500 autosampler 
sampling needle can start at any vial position, but cannot skip 
positions. It moves forward following the numbering of the 
vial positions. It does not move in a serpentine pattern.

If you use an integrated autosampler, location of vials is not 

important, but you must enter vials in the Sample Table that 

correspond to the vials you physically load in the autosampler 

trays. When injecting, the software ignores vial position and 

finds the first vial with the specified sample name.

Including
empty vials

If you use a direct wire autosampler that supports sample 

preparation, include an appropriate number of empty vials in the 

autosampler trays. See the Autosampler Reference Manual for 

more information.

If you use an integrated autosampler that supports sample 

preparation, you can add Prep blocks to a method. If you add 

Prep blocks to a method for sample preparation (diluting or 

combining), include an appropriate number of empty vials in the 

autosampler trays to accommodate Derived vials that the Prep 

block creates. For more information, see “Creating Prep Blocks” 

on page 6-53.

NOTE: Include the same shape of empty vials (Standard or 
Micro) for the final vial and all intermediate vials that a Prep 
block creates. That is, if a Prep block creates a final vial that 
is a Micro vial, you must include empty Micro vials for the 
intermediate vials that the Prep block creates.

Location of empty vials is not important, but you must enter 

Empty vial types in the Sample Table that correspond to the 

empty vials you physically load in the autosampler trays. When 

an empty vial is needed, the autosampler finds the first available 

empty vial.
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Installing
sample trays

To install an autosampler tray:

1. Hold the tray handle, tilting the back end down.

2. Insert the runners on the tray into the slots in the 

appropriate position at the rear of the tub (Figure 3-25).

Figure 3-25  Installing Autosampler Trays

 (Side View of Autosampler Tray Area)

3. Lower the front of the tray into place and press down firmly 

to seat the tray. When properly seated, the upper front edge 

of the tray fits under the lip of the tub.

Hint: Pull the handle back toward you until the tray snaps 
into place. Move each tray from side-to-side to make 
sure it is seated properly.

4. Repeat for remaining trays. It is not necessary to install all 

trays before running the autosampler.

PB100168
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3.6.8  Programming the AS 3500
Autosampler Method and Sample Set

If you use a direct wire autosampler, you control it from the 

autosampler controls. The BioCAD software does not use the 

information you program on the autosampler front panel.

This section describes programming the AS 3500 autosampler 

provided by Applied Biosystems. If you are using another 

autosampler, see the Autosampler Reference Manual for 

programming information.

NOTE: If you are using an integrated autosampler, skip this 
section. You control an integrated autosampler from the 
BioCAD software, not from the autosampler front panel.

This section explains:

• Programming hints

• Programming the autosampler method

• Loading the autosampler method

• Programming the autosampler sample set

NOTE: This is a brief introduction to programming the 
AS 3500 autosampler. For detailed operating information, 
refer to the Autosampler Reference Manual.

Programming
hints

When you program the front panel of the AS 3500 autosampler, 

note the following:

• To select a menu item, move the cursor with the arrow 
keys, then press Enter.

• To enter numeric or alphabetic values, use the plus (+) 
and minus (-) keys to scroll through numbers. Use the 

arrow keys to move the cursor to each digit or position.

• To display preset values (for example, On or Off), use the

+ and - keys.

• To accept an entry and move to the next field, press 

Enter.
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Programming
the method

If you use a direct wire autosampler, program an autosampler 

method to control sample injections, preparation, and cooling.

NOTE: The following procedure describes information you 
need to program the autosampler for use with the BioCAD 
700E Workstation only.

To program the autosampler method:

1. When the status on the autosampler front panel is Idle, 

press the Menu key.

2. Select Files.

3. Select Edit. 

You can store up to four files (methods) in the 

autosampler software.

4. Use the + or - key to select the File # to edit.

5. Enter a file name a letter at a time. Use the + and - keys to 

display a letter. Press the right arrow key to move to the 

next position. Press Enter when you have entered the 

complete name.

6. Select Injection, Injection Volume, and Number of 
Injections per sample.

7. Enter 0 for Cycle Time.

8. If your autosampler supports the sample cooling option, 

turn on the autosampler tray heater/cooler. Select a 

temperature.

NOTE: To determine if your autosampler supports the 
sample cooling option, look for a wick below the left-hand 
tray.

9. When Calibration is displayed, enter information for 

standard injections. For information on programming 

calibration information, refer to the Autosampler Reference 
Manual.

10. Press Enter to bypass all Timed Event parameters.

11. Press Enter to bypass Equilibration and Gradient Delay.
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12. If appropriate for your samples, change the Sample 
Viscosity setting.

NOTE: If Sample Viscosity is set to Viscous, the 
autosampler can take more than three minutes to inject. 
Set Autosampler Timeout in Configuration accordingly.

13. Leave the Flush Volume set at the default 400 µl.

14. Select Injection Type: Pull Loop, PushLoop®, or Full 

Loop. Press Enter. For more information on injection 

type, see Appendix F, Autosampler Injection Types, or the 

Autosampler Reference Manual.

15. Press Enter to bypass Injection Range and Needle 

Height. Press Enter to display the menu.

Loading the
method

Load the autosampler file (method) you just created by selecting 

Load, and selecting the file.

Programming
the sample set

You can program up to 100 sample sets:

1. When the status on the autosampler front panel is Idle, 

press the Sample key. This key is blank and labeled 

below the key on the front panel.

2. Select the file (method) you created above.

3. Press Enter to accept the Injection Volume, Number of 

Injections, and Cycle Time you entered in the file.

4. Select the first sample vial number. The autosampler rack 

is numbered A01 through A35, B01 through B35, and C01 

through C35. Numbers are on the side of the rack.

5. Enter the number of samples.

6. Add the sample set to the sample queue.

7. Press Run on the front panel of the autosampler.

NOTE: When you use a direct wire autosampler, the 
sampling needle can start at any vial position, but then 
moves forward following the numbering of the vial positions, 
without skipping any positions. It does not move in a 
serpentine pattern.
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4.1  Configuration Overview

What is a
configuration?

A configuration is a software file that specifies the physical 

setup of the BioCAD 700E Workstation, including:

• Buffers/solvents

• Samples

• Sample loop size

• Syringe size

• Injection mode

• Columns

• Plumbing

• Optional external devices

• Data collection

• System pressure

NOTE: A configuration does not alter the physical setup of 
the BioCAD 700E Workstation. You must create the 
configuration file to match the physical setup.

You control the configuration by changing settings in the 

Configuration dialog box (Figure 4-1).

Figure 4-1  Configuration Dialog Box
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You can create configurations, save configurations, and load 

configurations at a later time. 

System versus
method

configuration

It is important that you understand the difference between the 

system configuration and the method configuration.

• System configuration is the configuration information 

currently set in the Configuration dialog box. The system 

configuration is always used when you run the BioCAD 

700E Workstation. You can think of the system 

configuration as the active configuration.

NOTE: The system configuration is stored in the 
SYSCONF.CFG file. Editing the Configuration dialog 
box overwrites this file.

• Method configuration is the configuration information 

stored with a method file (.MET). It represents the 

configuration information set in the Configuration dialog 

box when the method was run or saved. The method 

configuration may or may not be the same as the current 

system configuration. You can think of the method 

configuration as the inactive configuration. 

NOTE: The system configuration (not the method 
configuration) is used when you run a method. To update the 
system configuration to a specific method configuration, you 
must load the configuration from the method. For more 
information, see Section 4.4, Loading an Existing 

Configuration.

CAUTION

Changing the settings in the Configuration dialog box during 
a method run will abort the run.
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4.2  Creating a New Configuration

Displaying
Configuration

dialog box

You use the Configuration dialog box to create a configuration 

and configure the various components of the workstation. To 

display the Configuration dialog box (Figure 4-2), select Edit 
Config from the Config menu in the Control Panel.

Figure 4-2  Configuration Dialog Box

The following sections describe configuring:

• Pump

• Buffers/solvents

• Autoloader

• Columns and plumbing

• Detectors and Strip Chart Recorder

NOTE: For information on configuring a fraction collector, see 
Section 4.6, Configuring and Preparing the BioCAD Software for 
a Fraction Collector. 

For information on configuring an autosampler, see Section 
4.7, Configuring and Preparing the BioCAD Software for an 
Integrated Autosampler, or Section 4.8, Configuring and 
Preparing the BioCAD Software for a Direct Wire Autosampler.
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4.2.1  Configuring the Pump

To configure the pump:

1. Display the Configuration dialog box by selecting Edit 
Config from the Config menu in the Control Panel.

2. In the Solvent Pump section of the Configuration dialog 

box, type high and low pressure limits in the

High Pressure and Low Pressure text boxes.

Hint: Set the high pressure limit to the pressure limit of 
the column with the lowest pressure limit.

3. Click the down arrow to the right of the text box to select 

one of the following pressure units: 

• psi (pounds per square inch)

• bar

• MPa (megapascal)

1 bar = approximately 15 psi = 0.1 MPa

The pressure maximum is 3,000 psi (204 bar, 20.4 MPa). The 

pressure maximum does not vary with flow rate.

The pump stops if the system pressure exceeds the high 

pressure limit or falls below the low pressure limit.
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4.2.2  Configuring Buffers/Solvents

You can configure up to six buffers/solvents in the 

Configuration dialog box. After you configure them, you can 

select up to four of the six buffers/solvents for blending from the 

Control Panel or when creating a method.

To configure buffers/solvents:

1. Display the Configuration dialog box by selecting Edit 
Config from the Config menu in the Control Panel.

2. Double-click a buffer/solvent channel (A through F) in 

the Solvent Pump section of the Configuration dialog box 

(Figure 4-3).

Figure 4-3  Buffer/Solvent Channels

The Buffer/Solvent Library is displayed.

3. Select a buffer/solvent, then click OK.

The buffer/solvent is added to the Configuration dialog 

box.

4. To clear a buffer/solvent channel, double-click the channel 
(A through F) to display the Buffer/Solvent Library, then 

click the Clear button.

5. Repeat step 2 and step 3 for all buffer/solvent channels.

For information on adding items to the Buffer/Solvent 

Library, refer to Section 4.5.1, Customizing the 

Buffer/Solvent Library.

Double-click a
buffer/solvent
channel
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4.2.3  Configuring the Autoloader

When to
configure the

Autoloader

Configure the Autoloader before making the following types of 

injections:

• Autoloader injection

• Direct autoloader injection

Do not configure the Autoloader when making the following 

types of injections:

• Manual injection

• Pump injection

• Autosampler injection

Configuring To configure the autoloader:

1. Display the Configuration dialog box by selecting Edit 
Config from the Config menu in the Control Panel.

2. In the Sample section of the Configuration dialog box 

(Figure 4-4), click the Configuration button under 

Autoloader. 

Figure 4-4  Autoloader Configuration

The Autoloader dialog box is displayed (Figure 4-5).

Click
here
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Figure 4-5  Autoloader Dialog Box

Syringe 3. Select the syringe size (0.1, 0.5, 1.0, 2.5, 5, 10, or 25 ml) 

from the Syringe Size drop-down list box.

The BioCAD 700E Workstation is provided with 500 µl 

and 5 ml syringes.

Sample loop 4. Type the sample loop size in microliters.

The BioCAD 700E Workstation is provided with provided 

with 100 µl, 2 ml, and 5 ml sample loops.

NOTE: You can create your own sample loop by coiling 
an appropriate length of tubing.

Install the appropriate syringe and sample loop on the 

workstation. For instructions on selecting and installing 

the syringe and sample loop, see Section 3.1.4, Changing 

the Syringe and Sample Loop.

NOTE: You can also change the syringe size or sample 
loop size without accessing the Configuration dialog box. 
Select Change Syringe or Change Loop Size from the 
Sample menu on the Control Panel.
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Sample names 5. Select up to four sample names from the Sample Library.

Sample names are not required, but provide information 

in your reports.

• Double-click a sample channel (1 through 4) to 

display the Sample Library.

• Select a sample, then click OK to add the 

sample name to the Configuration dialog box.

• To clear a sample channel, double-click the 

channel (1 through 4) to display the Sample 

Library, then click the Clear button.

• Repeat the above procedure for each sample 

you want to configure.

For information on adding names to the Sample Library, 

refer to Section 4.5.2, Customizing the Sample Library.

Prime and flush
volumes

6. Type Prime and Flush volumes as needed (Figure 4-6). 

Default volumes are acceptable for most applications.
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Figure 4-6   Priming and Flushing the Autoloader Sample Lines

Parameter
Default 

Volume
Description

Prime 

volume

350 µl Volume required to fill the entire sample line from the 

sample vessel to the injection valve.

NOTE: Modify the prime volume if you replumb the sample 
lines leading to the selection valve. For more information, 
see Section 3.3.2, Preparing Samples for Autoloader 

Injections (Large Vessels).

Flush 

volume

100 µl Volume required to flush the sample line between sample 

selection valve and the injection valve. Flushing removes 

the previously injected sample from the sample line before 

loading from a different sample channel. 

NOTE: Use a larger flush volume if sample carryover is a 
concern.
Use a smaller flush volume if sample volume is limited.
Use a smaller flush volume if making a direct autoloader 
injection. For more information, see Section 3.3.3, Preparing 

Samples for Direct Autoloader Injections.

Syringe
Pump

Sample 
Loop

Injection 
Valve

Sample

PB100070

Sample 
Valve

Prime Flush

Injection 
Valve

Syringe
Pump

Sample

Sample 
Valve
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4.2.4  Configuring Columns and Plumbing

To configure columns and plumbing, you must:

• Configure the column plumbing option

• Set the delay volumes

Configuring
the column

plumbing option

Configure a column plumbing option that matches the physical 

plumbing configuration. For more information, see 

Section 3.1.3, Plumbing Tubing and Columns.

NOTE: After you configure the column plumbing option, you 
can control the flow path from the Control Panel or when 
creating a method. See Section 5.2.5, Controlling Columns, or 
“Plumbing Events” on page 6-36.

To configure the column plumbing option:

1. Display the Configuration dialog box by selecting Edit 
Config from the Config menu in the Control Panel.

Figure 4-7  Column Plumbing Configuration

2. Select a column plumbing option from the Column 

Option drop-down list box (Figure 4-7). Choices are:

• Low Dispersion

• Single Column

• Tandem Columns

• Three Columns

• Direct Control

For more information on each column plumbing option, 

see “Column plumbing configurations” on page 1-15.
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3. Select up to three columns from the Column Library. If no 

column is configured, the column is designated with 

question marks and zeroes.

• Double-click a column line to display the 

Column Library.

• Select a column, then click OK to add the 

column to the Configuration dialog box.

• To clear a column, double-click the column 

entry, then click the Clear button.

• Repeat the above procedure to configure each 

column.

For information on adding columns to the Column 

Library, refer to Section 4.5.3, Customizing the Column 

Library.

4. Type the tubing inner diameter (in inches) in the Tubing 

ID text box. Use the following table to select the minimum 

diameter tubing for your flow rate.

NOTE: It is important to enter correct tubing ID because 
delay volumes are calculated based on tubing ID.

Flow Rates Tubing Volume

ID Color µl/ft µl/cm

0 to 20 ml/min 0.010" Blue 15 0.51

20 to 60 ml/min, or for 

optimal system pressure

0.020" Orange 62 2.03

0 to 60 ml/min, low 

pressure columns

0.030" Green 139 4.56

NOTE: All tubing has a 1/16-inch OD.
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5. Select the type of flow cell (Analytical, Semi-prep, or 

Other) installed in the UV/Vis detector from the Flow Cell 

drop-down list box.

Path length, volume, and maximum flow rates for these 

flow cells are:

• Analytical—6 mm path length, 9 µl volume 

(45 ml/min maximum flow rate)

• Semi-prep—3 mm path length, 4.5 µl volume 

(100 ml/min maximum flow rate)

CAUTION

If you have an analytical flow cell installed in the UV/Vis 
detector, do not exceed a 45 ml/min flow rate.

Setting delay
volumes

Delay volumes are used to:

• Perform calculations of column efficiency parameters 

when exporting data 

• Set a delay before collecting fractions to synchronize 

collected fractions with the UV/Vis detector signals

When to set Set delay volumes if you:

• Change the length of tubing between the pump filter and 

the injection valve.

• Change the length of any tubing plumbed to the injection 

valve or column switching valves. See Section 3.1.1, 

Selecting Tubing Diameter and Length, for recommended 

tubing lengths.

• Change the length of tubing between the fraction/waste 

valve on the workstation and the fraction collector 

supplied with the BioCAD 700E Workstation. This tubing 

is supplied with the fraction collector.

NOTE: Do not modify delay volumes if you use 
different diameter tubing. Delay volumes are 
automatically updated for tubing diameter changes, 
based on the value you type in the Tubing ID text box.
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Setting To set the delay volumes:

1. Click the Delay Volumes button in the Plumbing section 

of the Configuration dialog box.

The Estimate Delay Volumes dialog box is displayed 

(Figure 4-8).

.

Figure 4-8  Estimate Delay Volumes Dialog Box

2. Change the following delay volumes as needed:

• Gradient Valve to Sample Injector—Tubing 

between proportioning valve and injection valve. 

• Sample Injector to UV Detector—Tubing 

plumbed to injection valve or column switching 

valves.

• Fraction Valve to Fraction Collector—Tubing 

connected between the fraction/waste valve on 

the workstation and a fraction collector. You can 

calculate this volume based on tubing 

dimensions or determine it experimentally by 

creating and timing an air bubble in the tubing. 

For more information, contact  Biosystems 

Technical Support.

NOTE: All other delay volumes in this dialog box are 
optimized for the standard tubing provided on the 
workstation. Do not change these delay volumes.

3. Click OK.

Do not
change
any of

values
these
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4.2.5  Configuring Detectors

To configure detectors, you must:

• Select wavelength mode

• Configure data channels for UV/Vis, fluorescence, pH, 

conductivity, pressure, and auxiliary detector

• Configure the auxiliary detector

Selecting
wavelength

mode

The wavelength mode you select for UV/Vis detection depends 

on the detectors you enable in hardware setup. For more 

information, see Section 2.5.2, Updating BioCAD Hardware 

Setup Options.

The following table summarizes the wavelength modes 

available based on the detectors you enable in hardware setup.

If your internal UV/Vis detector is Model 205, and you do not 

enable an external UV/Vis detector, you must select 

single- or dual-wavelength mode:

• To select single-wavelength mode, select UV/VIS Single 
Wavelength from the Detector menu in the Control 

Panel.

• To select dual-wavelength mode, select UV/VIS Dual 
Wavelength from the Detector menu in the Control 

Panel. 

If you enable … Then …

Internal UV/Vis Detector 

(Model 201)

UV/Vis single-wavelength mode 

only is available

Internal UV/Vis Detector 

(Model 205)

UV/Vis single- or dual-wavelength 

mode is available

External UV/Vis Detector 

(Model 201, 204, or 205)

UV/Vis dual-wavelength mode is 

only available

External Fluorescence 

Detector (Model 304/305)

UV/Vis single-wavelength mode 

only is available
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Configuring
data channels

To configure data channels:

1. Click the Setup button in the Recorder section of the 

Configuration dialog box.

The Data Recorder Configuration dialog box is displayed 

(Figure 4-9).

Figure 4-9  Data Recorder Configuration Dialog Box

CAUTION

Changing the settings in the Data Recorder Configuration 
dialog box deletes the contents of the Strip Chart 
Recorder.

Buffer duration 2. Type the Buffer Duration (acquisition time) for the 

electronic Strip Chart Recorder. 

The default is one hour. The maximum is 24 hours. 

The number you type depends on the data rates 

selected, the amount of memory, and the amount of disk 

space on your computer. 

Set the buffer duration to accommodate your longest run, 

but note that when you make changes to the Strip Chart 

Recorder (by zooming or changing options), it takes 

longer to update when you have a long buffer duration 

set.
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Data is collected in the electronic Strip Chart Recorder 

whenever the pump is running, independent from data 

that is stored as part of running a method. 

CAUTION

When the buffer duration expires, the oldest data is lost 
as new data is added.

Enabling
channels

3. Enable the data channels for the detector signals you want 

to collect in data files. Choices are:

NOTE: If you do not enable a data channel, the 
corresponding signal or trace is not stored in data files.

Channel Displays Signal/Trace From …

Int UV/VIS #1 Internal UV/Vis detector first wavelength

Int UV/VIS #2 Internal UV/Vis detector second wavelength

NOTE: This channel is available only if you do not enable 
an external detector in hardware setup.

Ext UV/VIS External UV/Vis detector 

NOTE: This channel is available only if you enable an 
external UV/Vis detector in hardware setup.

Ext Fluor External fluorescence detector

NOTE: This channel is available only if you enable an 
external fluorescence detector in hardware setup.

pH pH monitor

Conductivity Conductivity monitor

Pressure System pressure trace

Auxiliary Auxiliary detector
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Setting data rates 4. Set the data rate for acquisition of each channel in points 

per second. Data rate ranges are:

Guidelines for
data rates

Use the following guidelines to determine appropriate 

data rates:

• Default settings are recommended for most 

applications.

• Use a data rate of 1 or 2 points per second for 

very long runs or runs with conventional 

(non-perfusion) columns. Adjust the rate for 

UV/Vis Channel #1 and UV/Vis Channel #2 if 

you are operating in dual-wavelength mode.

• Lower data rates allow longer buffer duration. 

• Higher data rates can create large files that take 

longer to display and analyze.

• Set data rates for the UV/Vis and auxiliary 

channels high enough to collect at least 10 data 

points per peak.

Configuring the
auxiliary
detector

To configure an auxiliary detector:

1. Enable the auxiliary channel and set the data rate as 

described in “Configuring data channels” on page 4-16.

2. Select Auxiliary Detector Setup from the Detector menu. 

Channel
Data Rate Ranges

(points per second)

UV/Vis #1 and UV/Vis #2 (Model 201 UV/Vis, 
Model 205 UV/Vis, and Model 304/305 Fluorescence)

0.1–20.0 

UV/Vis #2 (Model 204 UV/Vis only) 0.1–10.0

pH, Conductivity, and Pressure 0.1–1.0 

Auxiliary 0.1–10.0

NOTE: Default data rates are displayed in Figure 4-9.
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The Auxiliary Setup dialog box is displayed (Figure 4-10).

Figure 4-10  Auxiliary Setup Dialog Box

3. Select conversion units from the drop-down list box to 

convert to from volts. Enter a maximum value for the units 

you selected.

NOTE: Refer to the reference manual for your auxiliary 
detector for the conversion units and maximum value.

This information is not stored in the configuration, but it is 

saved in the Control Panel. Change the value only if you 

change the voltage-to-units conversion on the auxiliary 

detector.

4. If necessary, modify the list of available units for calibration 

using Add Unit, Del Unit, or Edit Unit, then give a 

conversion factor for volts to the desired units (Figure 4-11).

Figure 4-11  Edit Unit Dialog Box

NOTE: Refer to the reference manual for your auxiliary 
detector for the conversion factor.

The auxiliary detector channel on the Strip Chart 

Recorder and other data displays will be available in the 

added units as well as V (volts).
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4.3  Saving and 
Printing Configurations

Saving
configuration

information

There are two ways to save configuration information:

• Manually—You can manually save configuration 

information as a configuration file (.CFG). For more 

information, see “Manually saving”  below.

• Automatically—When you run a method, the system 

configuration is automatically saved in method files 

(.MET) and data files (.B*). When you save a method 

after creating it, the system configuration can be saved 

as the method configuration in the method file (.MET). 

The configuration information is for documentation 

purposes and can be included in reports. This does not 

create a .CFG file. For more information, see 

“Automatically saving” on page 4-21.

Manually saving To manually save a configuration for future use: 

1. After you enter all configuration information in the 

Configuration dialog box, click OK.

2. Select Save Configuration from the File menu in the 

Control Panel. 

The Save File dialog box is displayed.

3. Type a file name for the configuration file in the File Name 

text box.

4. Specify a directory in the Directories list box.

5. Click OK.

The configuration is save as a configuration file (.CFG).

NOTE: If you do not manually save the configuration, you can 
recall it at a later time by loading a method or data file that 
used the configuration. For more information, see “Loading 

from a method (.MET) or data (.B*) file” on page 4-23.
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Automatically
saving

When you create or edit a method, and then save the method, 

the current configuration settings are saved with the method file. 

You can control whether the system configuration is saved as 

the method configuration in the method file (.MET).

If you want the method configuration to be the same as the 

system configuration, do one of the following:

• Do not alter the settings in the Configuration dialog box 

after creating the method.

• Alter the settings in the Configuration dialog box by 

accessing it from the Control Panel after creating the 

method. Select Update Configuration from the Method 

Editor Options menu.

If you want the method configuration to be different from the 

system configuration, do one of the following:

• Alter the settings in the Configuration dialog box by 

accessing it through the Method Editor Options menu. 

This action changes the method configuration, but does 

not change the system configuration.

• If you alter the settings in the Configuration dialog box by 

accessing it through the Control Panel after creating the 

method, do not select Update Configuration from the 

Method Editor Options menu. This action changes the 

system configuration, but does not change the method 

configuration.

Printing To print the current system configuration, select Print 
Configuration from the File menu in the Control Panel.

Print setup Menus that contain a Print command also contain a Print Setup 

command.

Print Setup allows you to select a printer, as well as other printer 

options. Print Setup is a standard feature with all Microsoft 

Windows applications. For more information on Print Setup and 

connecting printers to your computer, refer to the Microsoft 
Windows User’s Guide.
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4.4  Loading an
Existing Configuration

There are two ways to load an existing configuration as the 

system configuration:

• Load from a configuration file (.CFG)

• Load from a method (.MET) or data (.B*) file

Loading from
a configuration

file (.CFG)

To load an existing configuration you saved previously as a 

configuration file:

1. Select Open Configuration from the File menu in the 

Control Panel.

The Open File dialog box is displayed. A list of existing 

configuration files (.CFG) is also displayed.

2. Select a configuration file (.CFG), then click OK. 

The new configuration settings are loaded in the 

Configuration dialog box. This is now the system 

configuration.

3. Check the physical setup of the BioCAD 700E Workstation 

and make sure it matches the system configuration. 

Change the physical setup if necessary. For more 

information, see Chapter 3, Preparing the Workstation and 

External Devices.



Loading an Existing Configuration

BioCAD® 700E Workstation User Guide 4-23

4

Loading from a
method (.MET)

or data (.B*) file

You can also load a configuration from a method or data file:

1. Select Open Configuration from the Control Panel File 

menu. 

The Open File dialog box is displayed (Figure 4-12). 

Figure 4-12  Open File Dialog Box

2. Select Method Files (*.MET) or Data Files (*.B*) from the 

List Files of Type drop-down list box.

No files are listed because the methods or data 

directories are not open.

3. Double-click the methods folder or data folder.

 All method (.MET) files or data (.B*) files are listed.

4. Select a method file or data file. Click OK.

The configuration settings associated with the method 

file or data file are loaded in the Configuration dialog box. 

This is now the system configuration.

5. Check the physical setup of the workstation and make sure 

it matches the system configuration. Change the 

configuration if necessary. For more information, see 

Chapter 3, Preparing the Workstation and External Devices.

Double-click

folder

data or

Click arrow,

Method Files (*.MET)

methods

or Data Files (*.B*)

then select
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4.5  Customizing
Configuration Libraries

The BioCAD software lets you customize the following 

configuration libraries:

• Buffer/Solvent Library

• Sample Library

• Column Library

Each configuration library allows you to create, edit, and save 

information about buffer/solvents, samples, or columns that you 

expect to use frequently. You can quickly and easily retrieve 

information for a specific buffer/solvent, sample, or column 

when you create future configurations.
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4.5.1  Customizing the Buffer/Solvent Library

To customize the Buffer/Solvent Library:

1. Select Edit Config from the Config menu in the Control 

Panel to display the Configuration dialog box.

2. Double-click any of the buffer/solvent channels
(A through F) in the Solvent Pump section (Figure 4-13).

Figure 4-13  Buffer/Solvent Channels

The Buffer/Solvent Library dialog box is displayed

(Figure 4-14).

Figure 4-14  Buffer/Solvent Library 

Double-click a
buffer/solvent
channel
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Creating or
editing

3. To create a buffer/solvent channel, click the New button. To 

edit a buffer/solvent channel, select the channel and click 

the Edit button. 

The Specify Channel dialog box is displayed 

(Figure 4-15).

Figure 4-15  Specify Channel Dialog Box

NOTE: If you are editing a buffer that has been 
calibrated, the bottom of the Specify Channel dialog box 
displays a Calibrated With text box that lists the solution 
used to calibrate the buffer.
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4. Enter or modify the following information:

Parameter Description

Name Describes the buffer/solvent for 

documentation purposes.

Short Name Eight characters displayed on the Control 

Panel next to the channel letter.

Component 

Name

Identifies the component in the buffer or 

eluent. The component name is:

• Used in pH and Eluent blend mode

• Not required in Percent blend mode

Concentration Concentration of the component in the 

buffer or eluent. The concentration is:

• Used in pH and Eluent blend mode

• Not required in Percent blend mode

NOTE: When you program in pH or Eluent 
blend mode, the software uses the 
component concentration in the eluent or 
buffer to calculate the percent of eluent or 
buffer in the final blend.

Continued



Chapter  4    Configuring and Preparing the BioCAD Software

4-28 Applied Biosystems

4
Deleting 5. To delete an entry from the Buffer/Solvent Library, select a 

buffer/solvent, then click Delete.

NOTE: Before clicking Delete, make sure you select the 
correct item. After you click Delete, you cannot retrieve 
the item.

Type Choices are:

• None (default)—Used in Percent mode 

or as the base buffer/solvent in Eluent 

mode.

• Buffer—Used for pH mode. Enter the 

buffer concentration. 

• Eluent—Column eluent for Eluent and 

pH modes. 

• H2O—Water used in the pH mode to 

adjust buffer and eluent strength.

• Sample—Select when you are making 

pump injections to load large-volume 

samples through the pump. Enter 

concentration for export to Group 

Analysis software.

Hint: If you are programming in Eluent 
blend mode, specify a buffer/solvent, such 
as 3 M NaCl, as Eluent.

If you are programming in pH blend mode, 
specify pH buffers as Buffer, water as H2O, 
and a salt solution as Eluent. 

For information on the pH Map template, 
see Section 7.1.1, pH Map Template.

Parameter Description
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4.5.2  Customizing the Sample Library

To customize the Sample Library:

1. Select Edit Config from the Config menu in the Control 

Panel to display the Configuration dialog box.

2. In the Sample section of the Configuration dialog box, click 

the Configuration button under Autoloader. 

The Autoloader dialog box is displayed (Figure 4-16).

3. Double-click any of the sample channels in the Autoloader 

dialog box.

 

Figure 4-16  Sample Channels

The Sample Library dialog box is displayed (Figure 4-17).

NOTE: If you configure an integrated autosampler, you 
can also display the Sample Library dialog box from the 
Sample Table. See Section 4.7, Configuring and Preparing 

the BioCAD Software for an Integrated Autosampler.

Double-click
any sample
channel
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Figure 4-17  Sample Library 

Creating or
editing

4. To create a new sample, click the New button. To edit a 

sample, select the sample and click the Edit button.

 The Sample Editor dialog box is displayed (Figure 4-18).

Figure 4-18  Sample Editor Dialog Box

NOTE: Samples with the same Short Name, but different 
attributes are treated as different samples. In most 
locations in the software, all attributes are listed for a 
sample. However, Short Name only is displayed in error 
codes, Inject segments, and in the Control Panel.
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5. Enter or modify the following information:

6. When all components are added, click OK.

Deleting 7. To delete an entry from the Sample Library, select a 

sample, then click Delete.

NOTE: Before clicking Delete, make sure you select the 
correct item. After you click Delete, you cannot retrieve 
the item.

Parameter Description

Component Enter all component names in the sample. You must 

enter at least one component name.

To add additional components, click the Add button and 

enter information on the line provided. To delete a 

component, select the component and click Delete. 

Component Names are used for documentation 

purposes only.

Concentration

and Units

Enter concentrations and units for all components. The 

first component defaults to 100% v/v.

Concentration is used for documentation purposes only.

Short Name Enter up to eleven characters. The Short Name is 

displayed in error codes, in Inject segments in a method, 

and on the Control Panel next to the sample number.

NOTE: Use unique Short Names for different samples. 
Samples that have the same Short Name but different 
attributes are treated as different samples.

Diluent Enter the diluent that a sample contains. This diluent is 

for documentation purposes only. 

Viscosity Not functional at this time.
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4.5.3  Customizing the Column Library

To customize the Column Library:

1. Select Edit Config from the Config menu in the Control 

Panel to display the Configuration dialog box.

2. Double-click any of the column options in the Plumbing 

section of the Configuration dialog box.

 

Figure 4-19  Column Options

The Column Library dialog box is displayed (Figure 4-20).

Figure 4-20  Column Library 

Double-click
any column
channel
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Creating or
editing

3. To create a new column entry, click the New button. To edit 

a column entry, select the column and click the Edit button.

The Column Editor dialog box is displayed (Figure 4-21).

Figure 4-21  Column Editor Dialog Box

4. Enter or modify the following information:

NOTE: If you enter a valid part number for your POROS 
column, the software automatically fills in all fields except 
Serial Number, Lot, Date Made, and Made By.
If you do not enter column dimensions, you cannot use 
CV (column volumes) or cm/hr (linear velocity) when 
programming volumes or flow rates.

Parameter Description

Length Column length in mm, from column label.

Diameter Inside diameter of column in mm, from column 

label.

Volume Column volume. Software calculates value 

based on column length and diameter.

Continued
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Deleting 5. To delete an entry from the Column Library, select a 

column, then click Delete.

NOTE: Before clicking Delete, make sure you selected 
the correct item. After you click Delete, you cannot 
retrieve the item.

% Void 

Volume

(Total Particle Volume ÷ Column Volume) x 100

NOTE: % Void Volume is dependent on the 
packing characteristics of your media.

Void 

Volume

Column void volume. Software calculates 

estimated value based on column length, 

diameter, and % void volume.

Pressure 

Limit

Column pressure limit. If system exceeds 

column pressure limit while the column in 

inline, the pump shuts down.

Serial 

Number

From column label.

Part 

Number

Valid part number, from column label.

Particle Column chemistry and particle size, from 

column label.

Lot From column label.

Date Made From column label.

Made By From column label.

Parameter Description
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4.6  Configuring and Preparing
the BioCAD Software 
for a Fraction Collector

Before you begin Before you configure and prepare the BioCAD software for a 

fraction collector, do the following:

• Connect the fraction collector to the BioCAD 700E 

Workstation as described in Section 2.4.3, Connecting 

the Fraction Collector.

• Program operating parameters on the front panel of the 

fraction collector as described in Section 3.5.3, Preparing 

Fraction Collector Software. 

Configuring the
fraction collector

To configure and prepare the BioCAD software for a fraction 

collector:

1. Select Edit Config from the Config menu in the Control 

Panel to display the Configuration dialog box.

2. Select Advantec/Gilson Fraction Collector from the 

Collector list box (see Figure 4-2 on page 4-4).

3. Type the number of tubes in the fraction collector tube 

rack.

4. Type the tube volume (ml/tube).

5. If you replumb the tubing from the fraction waste valve to 

the fraction collector, set the delay volume for the new 

tubing length. See “Setting delay volumes” on page 4-13.

NOTE: After you configure the fraction collector, you can 
control it from the Control Panel or in a method. For more 
information, see Section 5.4.1, Controlling the Fraction 

Collector, or “Fraction Collector Events” on page 6-41.
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4.7  Configuring and Preparing
the BioCAD Software for
an Integrated Autosampler

To configure and prepare the BioCAD software for an integrated 

autosampler, you must:

• Configure an integrated autosampler

• Customize the Sample Library

• Enter vials in the Sample Table

4.7.1  Configuring Integrated Autosampler

Overview There are two ways you can configure an autosampler:

• Integrated—The BioCAD software has complete control 

over autosampler functions. You program sample 

information using the BioCAD software. You must use an 

AS 3500 autosampler provided by  Biosystems.

• Direct Wire—The BioCAD software triggers the 

autosampler to make injections. You program sample 

information using the autosampler controls. You can use 

any autosampler.

Before you begin Before you configure an integrated autosampler:

• Power up the autosampler.

• Start the BioCAD software. See Section 2.6, Starting Up 

and Shutting Down, for more information.

• Make sure your BioCAD software is version 2.05 or later 

by selecting About BioCAD from any Window menu. 

• Make sure your autosampler software is version 3.36 or 

later. See “Checking software version” on page 3-44.
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Configuring To configure an integrated autosampler:

1. Make sure your autosampler has an integrated 

connection to the workstation and is powered up. See 

“Connecting integrated autosampler” on page 2-21.

2. Select Edit Config from the Config menu to display the 

Configuration dialog box.

3. In the Autosampler section of the Configuration dialog box, 

click the Configuration button under Integrated AS3500.

Figure 4-22  Integrated Autosampler Configuration

NOTE: If Integrated AS 3500 is not displayed in the 
Autosampler section, specify AS 3500 as autosampler in 
the hardware setup. See Section 2.5.2, Updating BioCAD 

Hardware Setup Options.

The AS 3500 dialog box is displayed (Figure 4-23).

Figure 4-23  AS 3500 Autosampler Dialog Box

Click
here



Chapter  4    Configuring and Preparing the BioCAD Software

4-38 Applied Biosystems

4

Injection type 4. Select the injection type from the Injection drop-down list 

box. Choices are:

For a description of how different injection types are 

made, see Appendix F, Autosampler Injection Types.

Injection 
Type

When to Use
Injection Volume 

Range
 Volume Drawn

Pull Loop 
(small)
(default 
setting)

To conserve sample. 
Only desired sample 
amount is pulled into 
sample loop.

0.1 µl to 200 µl Injection volume + 1.1 µl

Pull Loop* 
(large)

To make large 
injections.

200 µl to 1.5 ml Injection volume + 45 µl

PushLoop • To make low-
volume injections

• To make 
variable-volume 
injections with 
high precision 

0.1 µl to 200 µl Injection volume + 14 µl

Full Loop • To make routine 
injections of the 
same volume

• To make 
fixed-volume 
injections with 
high precision 

Volume of 
sample loop, up 
to a maximum 
of 1.2 ml

• (1.33 x loop vol) + 70 µl

(for injections ≤ 100 µl)

• (2 x loop vol) + 45 µl

(for injections > 100 µl)

*You can make Pull Loop (large) injections only if your autosampler supports the sample preparation option.
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Default
vial shape

5. Select a vial shape from the Default Vial Shape 

drop-down list box.

NOTE: This selection sets the default vial shape for other 
parts of the software. You can change the vial shape in 
other parts of the software, if desired.

Default 

Vial Shape

Dead 

Volume

Maximum 

Capacity

*Available 

Sample 

Volume

When to Use

Std 1800 µl 200 µl 1800 µl Up to 

1600 µl

When using the 1.8 ml glass vial.

Std 2000 µl 200 µl 2000 µl Up to 

1800 µl

When using the 1.8 ml glass vial.

NOTE: This vial shape allows you to 
override the maximum capacity 
suggested by the vendor, thereby 
increasing the available sample 
volume*.

Micro 20 µl 250 µl Up to 

230 µl

When using the 250 µl conical 

plastic vial.

Unspecified None 2000 µl Contents 

of vial

When handling small volume 

samples and using the 1.8 ml glass 

vial with a vial insert.

For applications where sample 

recovery is more important than 

injection volume accuracy. 

NOTE: For more information, see 
“Vial inserts for Unspecified vial 

shape” on page 3-52, and 
“Understanding Unspecified vial 

shape” on page 4-41.

*NOTE: Available sample volume equals the volume of liquid in the vial minus the 
dead volume for the vial. 

NOTE: The needle height is the same for all of the above vial shapes.
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Flush reagent 6. Select a reagent to use for the autosampler Flush 
Solvent:

• Double-click on the Flush Solvent field. The 

Buffer/Solvent Library is displayed.

• Select a reagent and click OK.

NOTE: Select a flush solvent that is appropriate for use 
with your autosampler solvents and your samples. One to 
five percent isopropanol is appropriate for most 
applications.

Flush volume 7. Type the Flush volume. The default and recommended 

volume is 430 µl.

The Flush volume is used to flush the needle and the line 

between the needle and injection valve on an integrated 

autosampler. The Flush volume is used when you:

• Flush an integrated autosampler from the 

Sample Table. For more information, see 

Section 5.4.2, Controlling an Integrated 

Autosampler.

• Flush an integrated autosampler during an 

Autosampler Inject segment in a method. For 

more information, see “Autosampler Inject 

Segments” on page 6-30.

Prime volume 8. Type the Prime volume. 

Prime volume is used when you prime the autosampler 

solvent and flush lines. See Section 3.6.5, Priming the 

Autosampler.

NOTE: Type a prime volume of at least 7,500 µl to 
ensure complete priming of autosampler lines.

Loop size 9. Type the Loop size.

You must physically install the correct sample loop on the 

autosampler. See the Autosampler Reference Manual.
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Understanding
Unspecified

vial shape

The Unspecified vial shape is a feature of the BioCAD software 

that allows for maximum flexibility when working with small 

volume samples. It has no dead volume limitation and a 

maximum volume of 2.0 ml in the software.

It allows you to inject nearly the complete contents of the vial if 

you use a micro vial insert inside a 1.8 ml glass vial. The micro 

vial insert eliminates the dead volume. For more information on 

micro vial inserts, see “Vial inserts for Unspecified vial shape” 

on page 3-52.

When to use
Unspecified

vial shape

Use Unspecified vial shape if the following are true of your 

application:

• Small sample volume

• Maximum sample recovery is important

• Minimal sample loss is important

• Quantitative injection volume is not required

How to use
Unspecified

vial shape

To use the Unspecified vial shape:

• Prepare your sample in a micro vial insert inside of a 

1.8 ml glass vial. For more information, see “Vial inserts 

for Unspecified vial shape” on page 3-52.

• Select Pull loop as the injection type when you configure 

the integrated autosampler. For more information, see 

“Injection type” on page 4-38.

• Select Unspecified as the vial shape when you enter the 

sample in the Sample Table. For more information, see 

Section 4.7.3, Entering Vials in Sample Table.

CAUTION

Always use micro vial inserts when using the Unspecified vial 
shape. Other vials do not eliminate dead volume and will 
cause you to aspirate air if you sample below the dead 
volume for that vial type.
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Configuring
sample prep

The integrated autosampler that you use with your BioCAD 

Workstation may support sample heating and cooling or sample 

preparation. If so, you need to configure sample preparation:

1. Click the Sample Preparation button in the AS 3500 

Autosampler dialog box (see Figure 4-23).

NOTE: If the Sample Preparation button is not displayed, 
select autosampler 310 or 311 in hardware setup. See 
Section 2.5.2, Updating BioCAD Hardware Setup Options.

The Sample Preparation Configuration dialog box is 

displayed (Figure 4-24).

Figure 4-24  Sample Preparation Configuration

Sample
 heating

(heat chamber)

2. If desired, turn on the autosampler heat chamber by clicking 

the On button and typing a setpoint temperature. Valid 

range is from ambient temperature to 100°C (212°F) in 1°C 

increments. 

The autosampler heat chamber is set to this temperature.

NOTE: You can set the temperature as low as 0°C, but 
the actual setpoint does not go below ambient 
temperature.

NOTE: To heat a sample vial, you add a Heat/Mix 
segment to a method, which places the sample vial in the 
heat chamber. See “Heat/Mix Segments” on page 6-64. 
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Sample cooling
(tray area)

3. If desired, turn on the autosampler cooler by clicking the On 

button and typing a setpoint temperature. Valid range is 

from 0 to 60°C (32 to 140°F) in 1°C increments.

The autosampler tray area is set to this temperature.

NOTE: Allow 30 minutes for heating and cooling devices 
to reach temperature. 

NOTE: You can also control autosampler sample heating 
and cooling from the Sample Table. See Section 5.4.2, 

Controlling an Integrated Autosampler. The settings you 
make last are active.

Autosampler
solvents

4. To configure autosampler solvents, double-click an 

autosampler solvent line, AS1 through AS4. Lines AS1 

through AS4 correspond to the physical lines S1 through S4 

on the autosampler. Autosampler solvents you configure 

are available for use in Dilute and Combine segments in a 

method. For more information, see “Dilute Segments” on 

page 6-57, and “Combine Segments” on page 6-61.

The Buffer/Solvent Library is displayed.

5. Select a buffer/solvent, then click OK.

For information on adding to the Buffer/Solvent Library, 

refer to Section 4.5.1, Customizing the Buffer/Solvent 

Library.

6. Repeat step 4 and step 5 for each autosampler solvent line.

To clear an autosampler solvent channel, double-click it 

to display the Buffer/Solvent Library, then click the Clear 
button.

7. Click OK.



Chapter  4    Configuring and Preparing the BioCAD Software

4-44 Applied Biosystems

4

4.7.2  Customizing the Sample Library

If you configure an integrated autosampler, the Sample Library 

is available. The Sample Library allows you to create, edit, and 

save samples for use with an integrated autosampler.

To customize the Sample Library:

1. Select Sample Table from the Window menu in the 

Control Panel. 

The Sample Table window is displayed (Figure 4-25).

Figure 4-25  Sample Table Window

NOTE: If Sample Table is not displayed in the Window menu, 
select an AS 3500 autosampler in hardware setup. See 
Section 2.5.2, Updating BioCAD Hardware Setup Options.
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2. Double-click any vacant vial position in the grid. 

The Vial Editor dialog box is displayed (Figure 4-26).

Figure 4-26  Vial Editor Dialog Box

3. Click the Sample option button.

The Sample Library dialog box is displayed (Figure 4-27).

Figure 4-27  Sample Library Dialog Box

4. Create, edit, or delete samples as described in “Creating or 

editing” on page 4-30, and “Deleting” on page 4-31.

Sample
option
button
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4.7.3  Entering Vials in Sample Table

Overview If you use an integrated autosampler, enter vials in the Sample 

Table to correspond to the vials you physically loaded in the 

autosampler trays. When you enter sample vials in the Sample 

Table window, the vials are automatically added to the current 

system configuration.

When you run a method, the BioCAD software compares the 

sample names and volumes requested by the method to the 

sample names and volumes entered in the Sample Table. If all 

requested sample names and volumes are not listed in the 

Sample Table, a “Method’s configuration does not match ...” 

error is displayed.

NOTE: You cannot alter the Sample Table when a method is 
running. However, you can make an injection from the 
Sample Table when a method is running.

This section describes:

• Entering single vials or batches of vials

• Autonaming batch-entered vials

• Adding base name and suffix to Sample Library

• Clearing vials

• Saving Sample Table settings in a configuration
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Entering
single vials or

batches of vials

To enter single vials or batches of vials in the Sample Table:

1. Physically load sample vials in the autosampler trays.

See Section 3.6.7, Loading Vials in Autosampler Trays.

2. Select Sample Table from the Window menu in the Control 

Panel. 

The Sample Table window is displayed (Figure 4-28).

Figure 4-28  Sample Table Window

3. To enter a single vial, double-click a vial position in the 

Sample Table. To enter a batch of vials, click-drag over the 

vial positions and click Add Vials.

The Vial Editor dialog box is displayed (Figure 4-29).

Figure 4-29  Vial Editor Dialog Box

Sample
text box
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4. Select the vial type:

If you select Empty, “Empty” is displayed in the Sample 

text box, and the vial is entered.

If you select Sample, Standard, Control, or Reagent, the 

Sample Library is displayed. Select a sample name or 

add a new sample name and click OK. The Vial Editor 

dialog box is displayed, with the name you selected from 

the Sample Library displayed in the Sample text box.

Vial Type Description

Sample, Standard, 

Control, or 

Reagent

Vial is listed anywhere you select a Sample vial in a 

method, for example, in a Dilute, Combine, Heat/Mix, 

or Inject Segment Setup dialog box.

Empty* Vial will be used as the destination vial in a method 

Prep block segment, such as Dilute or Combine.

Derived* Derived vial types are display-only and reflect the 

state of an entered vial (Sample, Standard, Control, 

Reagent, or Empty). Derived vial types are the result 

of some action by the autosampler. For example, an 

Empty vial changes to a Derived vial after reagents 

and samples are added to the vial during the 

execution of a Prep block segment, such as Dilute or 

Combine.

Derived vial types are listed anywhere you select a 

Derived vial in a method, for example, in a Dilute, 

Combine, Heat/Mix, or Inject Segment Setup dialog 

box.

Waste* Waste vial types are display-only and reflect the state 

of an entered vial. For example, intermediate vials 

created by a Prep block are changed to Waste vials 

at the end of the Prep block.

*Empty, Derived, and Waste vial types are available only if your autosampler supports the sample 

preparation option.
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If the vial has already been entered as Sample, 

Standard, Control, or Reagent, double-click the Sample 

text box to display the Sample Library. Select a sample 
name or add a new sample name and click OK. The Vial 

Editor dialog box is displayed again, with the name 

selected from the Sample Library displayed in the 

Sample text box.

For information on adding names to the Sample Library, 

see Section 4.7.2, Customizing the Sample Library.

5. Select a vial shape (Std 1800 µl, Std 2000 µl, Micro, or 

Unspecified) from the Vial Shape drop-down list box.

For information on vial shapes, see “Default vial shape” on 

page 4-39.

6. Type a volume for Sample, Standard, Control, or Reagent 

vial types. Allowable fill volumes for each vial shape are:

• Std 1800 µl—200 µl to 1.8 ml

• Std 2000 µl—200 µl to 2.0 ml

• Micro—20–250 µl 

• Unspecified—0–2.0 ml

NOTE: Always type an accurate volume to avoid injecting 
from a vial with insufficient volume.

NOTE: As injections are made, the software recalculates 
the volume remaining in the vial. It accounts for volume 
used for injections and waste associated with making 
injections.

7. Click OK.
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8. Repeat step 3 through step 7 for all vials you want to enter 

in the Sample Table.

The Sample Table window is displayed again, with all 

selected vial positions labeled with the designated vial 

type: Sample (S), Standard (St), Control (C), Reagent 

(R), or Empty (E). You can click any vial position, and the 

sample name selected from the Sample Library and the 

vial volume are displayed at the bottom of the window.

Hint: Because you cannot alter the Sample Table during a 
method run, you may want to enter “dummy” vials in the 
Sample Table to account for any vials you may need to add to 
the autosampler tray during a method run.
Type an appropriate volume and name (such as “unknown#”) 
for the “dummy” vials. Be aware that you cannot update the 
sample name of the “dummy” vials in the final data files. This 
technique is not advisable for quality assurance procedures.

Autonaming
batch-entered

vials

You can use the Autoname feature when you batch-enter 

sample vials to specify a base name for the vials. The BioCAD 

software adds a suffix (-1, -2, -3, and so on) to the base name. 

You can also add the base name and suffix to the Sample 

Library.

To autoname batch-entered sample vials:

1. Physically load sample vials in the autosampler trays.

See Section 3.6.7, Loading Vials in Autosampler Trays.

2. Select Sample Table from the Window menu in the Control 

Panel. 

The Sample Table window is displayed (see Figure 4-28 

on page 4-47).

3. Select the sample vials to enter by click-dragging over the 

vial positions.

The maximum number of sample vials you can add is 

105 (total number of vials in autosampler trays A, B, 

and C). Selected vials are highlighted.

4. Click the Add Vials button.

The Vial Editor dialog box is displayed (Figure 4-30).
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Figure 4-30  Vial Editor with Autoname Check Box

5. Click the Autoname check box. 

The Sample text box changes to Base Name text box 

(Figure 4-31).

Figure 4-31  Vial Editor with Base Name Text Box

6. Type a base name (up to approximately 16 characters) for 

the vials.

7. Select the vial type, vial shape, and volume. See step 4 

on page 4-48 to determine vial type. Click OK.

The Sample Table window is displayed again, with all 

selected vial positions labeled with the designated vial 

type: Sample (S), Standard (St), Control (C), 

Reagent (R), or Empty (E). You can click any vial position 

to display the base name, suffix, and vial volume. The 

sample name for each vial is the base name plus the 

suffix.
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Adding
 base name and
suffix to Sample

Library

When you batch-enter vials using Autoname, you can also add 

the base name and suffix (sample name) to the Sample Library:

1. In the Sample Table window, double-click a vial position 

that was added using the Autoname feature.

The Vial Editor dialog box is displayed.

2. Double-click the base name and suffix in the Sample text 

box.

The Sample Library is displayed, with the base name and 

suffix added to the library list, with the following 

information:

• Short Name—Base name and suffix (for example, 

SAMPLE-1)

• Sample Viscosity—Normal

• Component Name—Base name and suffix (for example, 

SAMPLE-1)

• Concentration/Units—100%

To change this information, see Section 4.7.2, 

Customizing the Sample Library.

Clearing vials To clear sample vials from the Sample Table window:

1. Select the vial positions to clear. Click-drag to select 

multiple vials.

2. Click the Remove Vials button.

Vials are cleared from the Sample Table window and 

from the current system configuration. Sample name 

information is not deleted from the Sample Library.

Saving
Sample Table

settings in a
configuration

You can save the settings in the Sample Table to a configuration 

file that you can call up and use at a later time.

Select Save Configuration As from the File menu in the 

Control Panel. Type a file name for the configuration file. The 

Sample Table settings are saved to the configuration.

If you want to use this configuration and Sample Table settings 

again, you can load the configuration by selecting Open 
Configuration from the File menu in the Control Panel.
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4.8  Configuring and Preparing
 the BioCAD Software for

a Direct Wire Autosampler

Overview There are two ways you can configure an autosampler:

• Integrated—The BioCAD software has complete control 

over autosampler functions. You program sample 

information using the BioCAD software. You must use an 

AS 3500 autosampler provided by Applied Biosystems.

• Direct Wire—The BioCAD software triggers the 

autosampler to make injections. You program sample 

information using the autosampler controls. You can use 

any autosampler.

Before
you begin

Before you configure a direct wire autosampler:

• Program an autosampler method using the controls of 

the direct wire autosampler. For more information, see 

Section 3.6, Preparing an Autosampler, or the 

Autosampler Reference Manual.

• Power down the direct wire autosampler.

• Start the BioCAD software. For more information, see 

Section 2.6, Starting Up and Shutting Down.

After
configuring

After you configure a direct wire autosampler, you can power 

it up and control it from the autosampler controls. For more 

information, see the Autosampler Reference Manual. 

From the Control Panel, you can trigger the direct wire 

autosampler to make an injection. For more information, see 

Section 5.4.3, Controlling a Direct Wire Autosampler.

You can create a BioCAD method to trigger the autosampler 

method. For more information, see Section 6.3.7, Making 

Direct Wire Autosampler Injections in a Method.
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Configuring To configure and prepare the BioCAD software for a direct wire 

autosampler, you must:

• Set contact closure information

• Set timeout period

• Set starting vial and injections per vial

To configure a direct wire autosampler:

1. Make sure your autosampler has a direct wire connection 

to the workstation and is powered down. See “Connecting 

direct wire autosampler” on page 2-22.

2. Select Edit Config from the Config menu to display the 

Configuration dialog box.

3. In the Autosampler section of the Configuration dialog box, 

click the Configuration button under Direct Wire 
Autosampler.

Figure 4-32  Direct Wire Autosampler Configuration

NOTE: If Direct Wire Autosampler is not displayed in the 
Autosampler section, specify a direct wire autosampler in 
the hardware setup. See Section 2.5.2, Updating BioCAD 

Hardware Setup Options.

Click
here
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The Direct Wire Autosampler dialog box is displayed 

(Figure 4-33).

Figure 4-33  Direct Wire Autosampler Dialog Box

Contact closure 4. If you are using the autosampler provided by  Biosystems, 

use the default contact closure information already selected 

in the Connections section.

If you are using another autosampler, specify contact 

closure information to allow the BioCAD software to 

control the autosampler. Refer to your autosampler 

manual for information.

Timeout period 5. Type the Timeout period.

The timeout period is the length of time the BioCAD 

software waits for an injection before stopping pump flow 

and generating an error message. Default is 

180 seconds.

NOTE: Set the Timeout long enough to allow the 
autosampler to make an injection. When using a slow 
sample speed, injecting a viscous sample, or performing 
sample preparation, the autosampler may require more 
than 180 seconds for an injection.

6. Click OK to save the configuration and return to the Control 

Panel.
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Starting vial and
injections per vial

7. Select Set Vial from the Control Panel Sample menu.

The Set Vial Number dialog box is displayed 

(Figure 4-34).

Figure 4-34  Set Vial Number Dialog Box

8. Type the starting vial number and the number of 
injections to make from each vial. Click OK.

In the AS 3500 autosampler provided by Applied 

Biosystems, vials are labeled A1 through A35, 

B1 through B35, and C1 through C35. In the BioCAD 

software, vials are designated 1 through 105. To specify 

any of the B or C positions in the BioCAD software, 

determine the actual vial number.

NOTE: The starting vial number and injections per vial 
information does not control a direct wire autosampler. 
You must control a direct wire autosampler from the 
autosampler controls.
The starting vial number and injections per vial 
information is for documentation purposes only and is 
stored in the data file. If you do not enter this information, 
no starting vial number or injection number is reported.

Rack Rack Vial #
Vial # in 

BioCAD Software

Rack A A1–A35 1–35

Rack B B1–B35 36–70

Rack C C1–C35 71–105
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5.1  Overview

Use the Control Panel and Sample Table to manually control the 

BioCAD 700E Workstation. Any actions you perform from the 

Control Panel or Sample Table override a running method.

NOTE: All operations described in this chapter can also be 
performed using a method.

Displaying
Control Panel

The Control Panel (Figure 5-1) is displayed when you start the 

BioCAD software. If you are using the BioCAD software, but the 

Control Panel is not displayed, do one of the following:

• Select Control Panel from the Window menu in the 

BioCAD software.

• Double-click the Control icon at the bottom of the 

screen, if you have minimized the Control Panel.

Figure 5-1  Control Panel
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Displaying
Sample Table

If you configure an integrated autosampler, the Sample Table 

(Figure 5-2) is available. Display the Sample Table by selecting 

Sample Table from the Window menu. 

NOTE: If Sample Table is not displayed in the Window menu, 
select an AS 3500 autosampler in hardware setup. See 
Section 2.5.2, Updating BioCAD Hardware Setup Options.

Figure 5-2  Sample Table

Adding events
to a running

method

When you perform an operation from the Control Panel or 

Sample Table, such as turning off the pump, an event is added 

to the method that is stored with the data file (.BIO or .B##). 

These added events are flagged with an asterisk (*) and a 

plus sign (+) and appear only in methods contained in data files. 

No event is added to the method file (.MET).

If you retrieve the method from the data file (.BIO or .B##) and 

run the method, events that control hardware are executed. 

Events that do not control hardware, such as Event Mark, or 

events that are specific for the original data, such as Collect 

Fraction to Tube 1, are ignored. 



Chapter  5    Controlling the Workstation From the Control Panel

5-4 Applied Biosystems

5

5.2  Controlling Workstation
Components and Systems

You can manually control all workstation components and 

systems from the Control Panel. This section describes:

• Changing the syringe and sample loop

• Purging the system

• Controlling buffers/solvents and blending

• Controlling the pump and flow rate

• Controlling columns

• Controlling detectors

• Controlling the fraction/waste valve

• Running a gradient

• Calibrating custom pH blend buffers

• Programming event outputs

• Stopping and resuming a method

5.2.1  Changing the Syringe and Sample Loop

Overview You can change the syringe size and sample loop size from the 

Control Panel. The changes you make update the syringe and 

sample loop sizes in the Configuration dialog box.

Selecting
syringe and

sample loop size

Injection volume determines the syringe and sample loop size. 

To achieve maximum injection volume accuracy and precision, 

follow these guidelines when specifying injection volumes and 

selecting sample loop sizes:

• For injection volumes less than 50 percent of the sample 

loop volume, enter the injection volume in the Control 

Panel or method.

• For injection volumes equal to the sample loop volume, 

enter a volume of three times the sample loop volume in 

the Control Panel or method. For example, you can 

accurately inject a 100 µl sample using the 100 µl sample 

loop if you use an injection volume of 300 µl.

• Do not inject volumes between 50 percent and 

100 percent of the sample loop volume.
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Changing
syringe

Change the syringe to accommodate different injection 

volumes. 

Syringes provided with the BioCAD 700E Workstation include:

• 500 µl—Injection volume range 0.001 to 0.5 ml

• 5 ml—Injection volume range 0.01 to 5 ml

To change the syringe, you must:

• Remove the existing syringe

• Attach a new syringe 

Removing To remove the syringe:

1. Select Change Syringe from the Sample menu in the 

Control Panel.

NOTE: If Change Syringe is not displayed in the Sample 
menu, configure an autoloader. See Section 4.2.3, 

Configuring the Autoloader.

The syringe plunger retracts and the Set Syringe Size 

dialog box is displayed (Figure 5-3).

Figure 5-3  Set Syringe Size Dialog Box

CAUTION

Do not remove the syringe before retracting the plunger. 
The syringe will break.

2. Unscrew and remove the knurled knob at the base of the 

plunger. 

3. Unscrew the body of the syringe (turn to the left) and 

remove.
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Attaching To attach a new syringe:

1. Place the hole in the base of the plunger over the pin on 

the syringe piston.

Figure 5-4  Replacing the Syringe

2. Pull up on the syringe body until it reaches the fitting.

3. While pushing up gently, turn the syringe body to the right 

and screw into place.

4. Replace the knurled knob in the plunger base.

5. Select the size of the syringe you installed from the 

drop-down list box in the Set Syringe Size dialog box.

Click OK. 

The syringe plunger returns to the home position.

NOTE: The home position varies with different syringe 
sizes. The syringe size you select updates the syringe 
size in the Configuration dialog box.

POWER FRACTION

LAMP

PUMP EVENT MARK

PerSeptive Biosystems, Inc.

PB100022

Place hole
over pin, 
then pull up
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Changing
sample loop

Change the sample loop to accommodate different injection 

volumes.

Sample loops provided with the BioCAD 700E Workstation 

include:

• 100 µl

• 2 ml

• 5 ml

To change the sample loop:

1. Unscrew the installed loop from positions 2 and 5 on the 

sample injection valve. 

2. Replace with the appropriate sample loop.

Figure 5-5  Installing a Sample Loop

3. Select Change Loop Size from the Sample menu on the 

Control Panel.

NOTE: If Change Loop Size is not displayed in the 
Sample menu, configure an autoloader. See 
Section 4.2.3, Configuring the Autoloader.

The Set Sample Loop Size dialog box is displayed.

4. Type the size of the loop you installed and click OK.

NOTE: The sample loop size you type updates the 
sample loop size in the Configuration dialog box.

PB100046

Connect loop to
positions 2 and 5
on injection valve
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5.2.2  Controlling 
Buffers/Solvents and Blending

In the Control Panel, you can select and blend up to four of the 

six buffers/solvents configured.

Selecting
buffers/solvents

To select different buffers for blending:

1. Click the down arrow to the right of a buffer/solvent 

channel in the Blend section of the Control Panel 

(Figure 5-6).

Figure 5-6  Blend Section of Control Panel

A list of available buffers/solvents is displayed.

2. Double-click a buffer/solvent to select it for the channel. 

If the desired buffer/solvent is not available, change the 

buffer/solvent configuration. For more information, see 

Section 4.2.2, Configuring Buffers/Solvents.

Click here to
display available
buffers/solvents
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Blending To control blending of buffers/solvents:

1. Select a blend mode (Percentage, Eluent, or pH) from 

the Blend menu.

The Blend section of the Control Panel changes 

accordingly (Figure 5-7, Figure 5-8, and Figure 5-9).

Blend Mode Description

Percentage Conventional % (v/v) technique used on most 

HPLC instruments. Allows you to select a 

percentage of solvent and blend up to four of 

the six configured solvents.

Eluent Allows you to specify an eluent concentration, 

and select a buffer and an eluent to accomplish 

the blend.

NOTE: Eluent mode is available only if you 
configure a buffer/solvent as type Eluent. 
For more information, see Section 4.2.2, 

Configuring Buffers/Solvents, and Section 4.5.1, 

Customizing the Buffer/Solvent Library.

pH Uses two concentrated buffers at different pH 

values, water, and a concentrated eluent such 

as salt. This mode is required for running a pH 

Map template.

NOTE: pH mode is available only if you 
configure two pH buffers as type Buffer, a salt 
solution as type Eluent, and water as type H20. 
For more information, see Section 4.2.2, 

Configuring Buffers/Solvents, and Section 4.5.1, 

Customizing the Buffer/Solvent Library.

NOTE: When using either the pH or Eluent blend modes, you 
can switch back to the Percentage blend mode to view the actual 
calculated blend.
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2. Type values for the blends and click Set to activate the 

blending.

Percentage mode If you select Percentage mode, select the 

buffers/solvents to blend and type a percentage for 

each.

Figure 5-7  Percentage Blend Mode

NOTE: After you type a percentage for the first solvent, 
the percentages for additional solvents set automatically 
to equal a total of 100%. You can change the percentage 
of any solvent by entering a value.

For example, if you enter 20% for solvent A, when you 
click on solvent B, it sets to 80%. If you click on solvent C 
and enter a percentage, solvent B is again adjusted to 
make the total 100%.

Eluent mode If you select Eluent mode, enter or select the following:

• Base buffer/solvent (for diluting)

• Eluent concentration (mM) 

• Eluent 

Figure 5-8  Eluent Blend Mode
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pH mode If you select pH mode, enter or select the following:

• Blend concentration (mM) 

• Blend pH or %

• Two pH buffers

• Eluent concentration (mM) 

• Eluent

Figure 5-9  pH Blend Modes

Valid eluent concentration range is determined by:

• Requested concentration for the blend entered in the 

Control Panel

• Initial concentration of the buffers entered in the 

Buffer/Solvent Library

• Initial concentration of the eluent entered in the 

Buffer/Solvent Library

For example, assume the initial concentration of each buffer is 

200 mM. If you set the blend concentration to 100 mM of buffer, 

the system uses 50 percent of the buffer to achieve this 

concentration (100 mM/200 mM = 50 percent).

Assume the initial concentration of the eluent is 3,000 mM.

If 50 percent of the final solution is made up of buffer, the 

remaining 50 percent is made up of eluent and water. The valid 

range for the eluent in this example is 0 to 1,500 mM 

(50 percent of 3,000 mM = 1,500 mM). 

Using pH blend buffers
or calibrated custom buffers

Using uncalibrated
 custom buffers



Chapter  5    Controlling the Workstation From the Control Panel

5-12 Applied Biosystems

5

When using the following buffers, type a pH value:

• pH blend buffers (described in Section 3.2.2, Preparing 

pH Blend Mode Buffers)

• Calibrated custom pH blend buffers (described in 

Section 3.2.2, Preparing pH Blend Mode Buffers, and 

Section 5.2.9, Calibrating Custom pH Blend Buffers)

The BioCAD software automatically calculates the percent of 

each buffer needed to achieve the desired pH and eluent 

concentrations. 

When using uncalibrated custom pH blend buffers, type a 

percent value that regulates the percentages of the two 

buffers. For more information, see “Understanding percent 

value in pH blending”  below.

Understanding
percent value

in pH blending

The percent (%) value you type in the Blend section of the 

Control Panel corresponds to the pH of the two buffers used.

For example, you use two buffers of pH 6 and pH 8. To set the 

pH blend map for pH 7, type 50% (50% of pH 6 and pH 8 is 

approximately pH 7). The titration curve of the buffers affects 

the actual pH achieved.

Below is another example using buffers from pH 4 to pH 5:

pH 6 pH 8
pH 7 pH 7.5

50% 75%0% 100%

Buffers Type % … To achieve pH …

pH 4 and pH 5 10% 4.1

20% 4.2

30% 4.3
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5.2.3  Controlling the Pump and Flow Rate

To enter a flow rate and start and stop the pump:

1. Type a flow rate in the text box in the Pump section of 

the Control Panel (Figure 5-10). The flow rate range is 

0.2 to 100.0 ml/min.

NOTE: If you have an analytical flow cell installed in the 
UV/Vis detector, do not exceed a 45 ml/min flow rate.

Figure 5-10  Pump Section of Control Panel

2. Select flow rate units (ml/min, CV/min, or cm/hr) from the 

drop-down list box. For more information, see “Flow rate 

units” on page 5-14.

NOTE: CV/min and cm/hr are available only if you enter 
column dimensions in the Configuration dialog box.

3. Click Start to start the pump. 

The pump begins flowing, and the flow rate is displayed 

in the Status window.

4. To change the flow rate, type a new flow rate value, then 

click on any other area of the Control Panel to initiate the 

change.

5. Click Stop to stop the pump.
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Flow rate units You can specify flow rates in:

• ml/min—Conventional flow rate units.

• cm/hr—A unit of linear velocity, equal to the volumetric 

flow in ml/hr divided by the cross-sectional area of the 

column in cm2.

Linear velocity is useful when considering scale-up. 

If column length is held constant, then pressure drop, run 

time, and column performance are usually constant with 

linear velocity, and independent of column diameter. 

Cm/hr is available only when you enter column 

dimensions in the Configuration dialog box and a column 

is inline.

• CV/min (column volumes)—Equal to the volumetric flow 

in ml/min divided by the total column bed volume in ml. 

CV/min is useful for gauging the rate of turnover in the 

column. CV/min is available only when you enter column 

dimensions in the Configuration dialog box and a column 

is inline. 

NOTE: If you use a multi-column plumbing 
configuration, CV (column volume) calculations include 
the combined volumes of all inline columns, including 
columns installed on the SCOUT device.
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5.2.4  Purging the System 

When to purge Purge the system before making an injection to flush and 

equilibrate the system with your initial buffer/solvent blend. 

The Purge feature:

• Takes the columns out of line

• Changes the buffer/solvent blend to the set blend

• Increases the flow rate to the set rate

• Runs for a set volume duration

• Resets to the original flow rate 

• Resets the columns to the specified position

Purging using
Purge command

To purge the system:

1. Select Purge System from the Blend menu in the 

Control Panel.

NOTE: The Purge System command is not available if 
you configure Low Dispersion, Three Columns, or Direct 
Control column plumbing configurations. In these 
configurations, the column cannot be bypassed. See 
“Purging from Control Panel” on page 5-17, to purge with 
these column plumbing configurations.

The Purge Segment Setup dialog box is displayed 

(Figure 5-11). 

Figure 5-11  Purge Segment Setup Dialog Box
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2. Select a buffer/solvent blend for purging the system. 

To change the blend mode (Percent, Eluent, or pH) click 

Setup.

For more information on entering blends in different 

modes, see Section 5.2.2, Controlling Buffers/Solvents and 

Blending.

3. Type a flow rate for purging. The default is 30 ml/min.

CAUTION

If you are using an analytical flow cell and 0.010-inch ID 
blue tubing, reduce the purge flow rate to 20 ml/min to 
avoid exceeding the system pressure limit.

4. Type a purge volume sufficient to purge the system. The 

default is 10 ml. 

5. Select the Flow Direction at End of Purge. The selections 

depend on the current plumbing configuration.

NOTE: If you do not set flow direction, the column is not 
placed back inline after the Purge segment.

6. Click OK to begin the system purge.

Hint: To include the sample loop in the purge, click the 
Inject option button in the Sample section of the Control 
Panel. To bypass the sample loop during the purge, click 
the Load option button in the Sample section of the 
Control Panel. 

The columns are taken out of line, and the selected 

buffer/solvent blend is pumped through the system at the 

specified flow rate for the specified volume. 

At the end of the purge cycle, the flow rate is restored to 

the original rate and the columns are switched to the 

specified position.
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Purging from
Control Panel

You can also purge the system directly from the Control Panel:

1. Select a buffer/solvent blend for purging the system in 

the Blend section of the Control Panel.

2. Select a flow rate for purging in the Pump section of the 

Control Panel.

3. Click the Bypass option button in the Column section of the 

Control Panel to take the column out of line.

NOTE: If you configure Low Dispersion, Three Columns, 
or Direct Control column plumbing configurations, the 
column cannot be bypassed. Physically remove the 
column and replace with a union before purging.

4. Click the Start button to start the pump. Allow the pump to 

run for a time sufficient to purge the system.

5. Click the Stop button to stop the pump.
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5.2.5  Controlling Columns

Flow path
options

You can control the flow path by using the option buttons in the 

Column section of the Control Panel. The option buttons 

available in the Column section depend on the column option 

you select in the Configuration dialog box. To change the 

column plumbing configuration, see Section 4.2.4, Configuring 

Columns and Plumbing.

The options for each column plumbing configuration are:

Column Plumbing 

Configuration

Flow Path Options

Single Column

Tandem Columns

Three Columns

Direct Control

Low Dispersion None
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Single column Single-column configuration allows you to:

• Operate Column 1 alone

• Bypass Column 1 directly to the detectors

• Backflush Column 1 for washing, regeneration, or 

reversed elution

Tandem column Tandem-column configuration allows you to:

• Operate Column 1 alone

• Operate Column 2 alone

• Operate Column 1 and Column 2 in series

• Bypass both columns directly to the detectors

Three column Three-column configuration allows you to operate any one of 

the three columns individually. You cannot operate more than 

one column at a time. You cannot bypass all of the columns. 

One column is inline at all times.

Direct control Direct control configuration allows you to customize plumbing in 

configurations other than those directly supported by the 

software. You plumb columns and column switching valves any 

way you desire. You must specify flow rate in ml/min.

You control flow direction by specifying column switching valve 

positions (clockwise or counterclockwise) in the Valves section 

of the Control Panel:

• V1 CW—Column Switching Valve 1 clockwise 

• V1 CCW—Column Switching Valve 1 counterclockwise 

• V2 CW— Column Switching Valve 2 clockwise 

• V2 CCW—Column Switching Valve 2 counterclockwise 

For a diagram of the ports connected for each valve position 

(clockwise or counterclockwise), see Figure 3-10 on page 3-12.

Low dispersion Low-dispersion configuration is a single-column configuration. It 

shortens the flow path and minimizes delay volume by 

bypassing the two column switching valves. However, only 

forward flow is available, and the column is inline at all times.

Displaying
plumbing
diagrams

To display plumbing diagrams to assist you when you change 

column plumbing, select Show Column Plumbing or Show 
System Plumbing from the Edit menu, or refer to Figure 3-6 

through Figure 3-10 on page 3-10 through page 3-12.
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5.2.6  Controlling Detectors

You can use the Control Panel to:

• Enable and select UV/Vis detector mode and wavelengths

• Enable and select fluorescence detector wavelengths

• Zero the detector signal

• Add a chart mark to the Strip Chart Recorder

• Bypass the pH and Conductivity monitors

NOTE: You can use both the internal UV/Vis detector and an 
external fluorescence detector. However, you enable and 
select the wavelengths for each detector separately. For 
more information, see the following sections.

UV/Vis
wavelengths

To enable and select the UV/Vis detector wavelength:

1. Select UV/VIS Single Wavelength or UV/VIS Dual 
Wavelength from the Detector menu in the Control 

Panel.

NOTE: If you enable an external fluorescence detector in 
hardware setup, only single wavelength mode is 
available for the UV/Vis detector. If you enable an 
external UV/Vis detector in hardware setup, only dual 
wavelength mode is available for the UV/Vis detector.

2. If you enable single wavelength, type a wavelength in the 

top text box in the Detector section of the Control Panel 

(Figure 5-12).

Valid range is 190 to 800 nm. Operating wavelengths for 

the lamps are:

• Deuterium (UV)—190 to 365 nm

• Tungsten (Vis)—366 to 800 nm

3. Click elsewhere on the Control Panel to enable the 

wavelength setting.
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Figure 5-12  Detector Section of Control Panel

4. If you enable dual-wavelength, type wavelengths in both 

text boxes in the Detector section of the Control Panel 

(Figure 5-12).

If you are using the internal detector in dual wavelength 

mode, valid ranges are 190 to 450 nm OR 366 to 700 nm, 

because the detector cannot switch between the two 

lamps. Operating wavelengths for each lamp are:

• Deuterium (UV)—190 to 450 nm

• Tungsten (Vis)—366 to 700 nm

If you are using an external detector for dual wavelength 

mode, you can type any wavelength combination.

5. Click elsewhere on the Control Panel to enable the 

wavelength settings.

NOTE: When you run a method with dual wavelength 
enabled, the setting changes to single wavelength at the end 
of a method to reduce wear of the detector grating.

UV/Vis
Single-wavelength

UV/Vis
Dual-wavelength Fluorescence
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Fluorescence
wavelengths

To enable and select the fluorescence detector wavelengths:

1. Select Fluorescence Control from the Detector menu 

in the Control Panel.

NOTE: The Fluorescence Control command is available 
only if you enable an external fluorescence detector in 
hardware setup. For more information, see Section 2.5.2, 

Updating BioCAD Hardware Setup Options.

2. Type Excitation and Emission wavelengths in the 

Detector section of the Control Panel (see Figure 5-12). 

Valid entries ranges are (even values only):

• Excitation—200 to 650 nm

• Emission—200 to 800 nm

3. Click elsewhere on the Control Panel to enable the 

wavelength settings.

NOTE: To enhance sensitivity when using emission 
wavelengths above 650 nm, install a PMT that is 
sensitive to longer wavelengths. For more information, 
see the Applied Biosystems Model 304/305 
Fluorescence Detectors Operating Manual.

Zeroing detector Click the Zero button in the Detector section of the Control 

Panel to zero the detector signal (see Figure 5-12).

Adding
 chart mark

Click the Chart Mark button in the Detector section of the 

Control Panel to add a mark to the Strip Chart Recorder

(see Figure 5-12). This action also adds a Chart Mark event to a 

running method.

Bypassing
monitors

Click the Bypass option button in the Detector section of the 

Control Panel to take the pH and conductivity monitors out of 

line. Click the Inline option button to place the pH and 

conductivity monitors inline (see Figure 5-12).

NOTE: You can bypass only the pH and conductivity 
monitors. UV/Vis detectors are always inline.
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5.2.7  Controlling the Fraction/Waste Valve

Collecting single
fractions

You can control the fraction/waste valve on the BioCAD 700E 

Workstation to collect single fractions without using a fraction 

collector. For information on using a fraction collector to collect 

fractions, see Section 5.4.1, Controlling the Fraction Collector.

To collect single fractions:

1. Place the fraction (top) line in a container to collect 

fractions. 

2. Place the waste (bottom) line in a waste container. 

Figure 5-13  Fraction/Waste Valve

3. Divert flow to the fraction container or the waste container 

by clicking the valve option buttons in the Control Panel 

(Figure 5-14).

Figure 5-14  Valve Section of Control Panel

• Fraction—Diverts flow out the top port of the valve

• Waste—Divert flow out the bottom port of the valve

PB100064
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5.2.8  Running a Gradient

After you inject a sample from the Control Panel, you can run a 

gradient from the Control Panel to elute the sample.

To run a gradient manually from the Control Panel:

1. Select the Blend menu, then select the blend mode 

(Percentage, Eluent, or pH) for the gradient.

For more information on blend modes, see Section 5.2.2, 

Controlling Buffers/Solvents and Blending.

2. Type the initial conditions for the gradient in the Blend 

section of the Control Panel. 

Select the buffers/solvents to use in the gradient. If the 

buffer/solvent you want is not shown, click the arrow to 

the right of one of the channels. A list of available 

channels appears. Select the channel you want by 

clicking it. Click Set.

Hint: If you double-click a channel in the drop-down list 
box, 100% is entered automatically in the % text box. 

3. Type a flow rate in the Pump section of the Control Panel 

and click the Start button to start the pump.

4. When the column is equilibrated, select Run Gradient from 

the Blend menu. 

The Gradient Edit dialog box appears (Figure 5-15). The 

initial conditions you entered on the Control Panel are 

listed.
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Figure 5-15  Gradient Edit Dialog Box

5. Type the end conditions for the gradient.

6. Type the duration for the gradient and specify minutes, 

ml, or CV (column volumes for current column). 

NOTE: If CV units are not displayed in the drop-down list 
box, place the column inline by clicking the appropriate 
option button in the Column section of the Control Panel.

7. Click OK to begin the gradient. 
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5.2.9  Calibrating Custom pH Blend Buffers

Overview If you run in pH blend mode using your own custom pH blend 

buffers (instead of the pH blend buffers), you can calibrate your 

custom pH blend buffers.

For more information on custom and pH blend buffers, see 

Section 3.2.2, Preparing pH Blend Mode Buffers.

pH calibration
curve

When you calibrate custom pH blend buffers, the software 

generates a pH calibration curve. The pH calibration curve 

allows you to specify a pH value in the Control Panel, method 

segments, or the pH Map template. The software then 

calculates the percent of each buffer needed to achieve the 

desired pH.

NOTE: If you do not calibrate custom buffers, you can still run 
in pH blend mode. However, you must specify a percent 
value (instead of a pH value) in the Control Panel, method 
segment, or the pH Map template.

The pH calibration curve is permanently associated with the 

buffers you calibrate and is used any time you use the buffer 

pair. If you recalibrate the buffer pair, a new calibration curve is 

associated with the buffers.

CAUTION

If you recalibrate a buffer pair, the new calibration curve 
overwrites the original calibration curve. You cannot have 
more than one calibration curve for a buffer pair.



Controlling Workstation Components and Systems

BioCAD® 700E Workstation User Guide 5-27

5

Before
calibrating

Before you calibrate custom pH blend buffers:

1. Prepare and connect the pair of pH buffers to the 

workstation.

See Section 3.2.1, Preparing Buffers/Solvents.

2. Prime the buffer/solvent lines.

See Section 3.4.2, Priming the Buffer/Solvent Lines.

3. Configure the buffers as type Buffer in the Configuration 

dialog box. 

See Section 4.2.2, Configuring Buffers/Solvents, and 

Section 4.5.1, Customizing the Buffer/Solvent Library.

4. Configure and plumb columns. If you use Single or Tandem 

Column plumbing configuration, take the column out of line 

by clicking the Bypass option button in the Column section 

of the Control Panel. If you use Low Dispersion, Three 

Column, or Direct Control configuration, install a union in 

place of the column.

See Section 4.2.4, Configuring Columns and Plumbing.

5. Calibrate the pH probe. 

See Section 9.5.2, Calibrating the pH Probe.
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Calibrating To calibrate pair of custom pH blend buffers:

1. Select Calibrate pH Mode Buffers from the Blend menu 

in the Control Panel.

The Calibrate pH Mode Buffers dialog box is displayed 

(Figure 5-16).

Figure 5-16  Calibrate pH Mode Buffers

2. Select a First and Second Buffer by clicking on the lists 

of configured buffers. Selected buffers are highlighted.

3. Select the Number of Data Points for the calibration 

curve. The recommended number is 11.

4. Type a flow rate that is comparable to the rate you will use 

when running in pH blend mode. The default flow rate is the 

optimum flow rate calculated by the software, based on the 

column configuration.

5. Note the Buffer Volume Needed and Estimated Total 
Time displayed for each buffer. Make sure you have 

enough buffer before starting the calibration.

6. Click Run to start the calibration.
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During the
calibration

A calibration method runs. The method contains a Step 

segment for each data point you specified in the Calibrate pH 

Mode Buffer dialog box (see Figure 5-16). The buffer blend 

changes with each Step segment, starting with 100 percent of 

the first buffer, and ending with 100 percent of the second 

buffer. 

Each Step segment:

• Samples the buffer blend 

• Measures the pH

• Records the pH

Calibration
complete

When the calibration is complete, the software creates a file 

called PHCALIB.B##, and stores the file in the 

C:\BIOCAD\DATA directory.

NOTE: ThePHCALIB.B## file contains the data and method 
associated with the calibration. It does not contain the 
calibration curve. Calibration curve information is stored 
internally with the calibrated buffers. You can delete the 
PHCALIB.B## file without losing the calibration curve.

When the calibration is complete, the pH Buffer Calibration 

Curve dialog box is displayed (Figure 5-17).

Figure 5-17  pH Buffer Calibration Curve
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The pH Buffer Calibration Curve dialog box displays:

• The curve for the calibration (quadratic fit), with the x-axis 

scaled in percent of the higher pH buffer

• The final pH for each calibrated buffer

Calibration
acceptable

If the calibration curve is acceptable, click Accept to store the 

calibration with the buffers in the Buffer/Solvent Library for 

future use. Calibrated buffers are labeled with the solution used 

for calibration in the Specify Channel dialog box in the 

Buffer/Solvent Library. For more information, see Section 4.5.1, 

Customizing the Buffer/Solvent Library.

Calibration not
acceptable

If the calibration curve is not acceptable, click Cancel. To 

determine the problem with the calibration, you can:

• Examine the data file created by the calibration (the latest 

PHCALIB.B## file) in Data Analysis

• Examine the method

• Recalibrate the pH probe

When you have corrected the problem, calibrate the buffers 

again.

Running a pH
Map template

For information on running a pH Map template using calibrated 

custom pH blend buffers, see Section 7.1.1, pH Map Template.
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5.2.10  Programming Event Outputs

If you connect an auxiliary device to the BioCAD 700E, you may 

need to program event outputs from the workstation to provide 

the necessary power control for the device.

To program event outputs:

1. Select Auxiliary Output from the Control Panel Detector 

menu. 

The Auxiliary Out Event dialog box is displayed 

(Figure 5-18).

Figure 5-18  Auxiliary Out Event Dialog Box

2. Set the appropriate pulse levels and pulse durations. 

See the reference manual for the auxiliary device for its 

specific power control requirements.

You can use:

• Aux Out 1 and Aux Out 2 signals (TTL logic) to 

trigger another device

• Spare Out LC (low current 0.25 Amp) signal to 

power a 12 V device 

• Spare Out HC (high current 1 Amp) signal to 

power a 24 V device
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3. Make the following connections to the Auxiliary connector 

on the left side panel of the workstation. Connect only to the 

pins that transmit the signals you need.

NOTE: When connecting a device to the Auxiliary 
connector, use a shielded cable with a ferrite bead to 
maintain CE compliance. Recommended source and part 
number for the ferrite bead is: 
Fair-Rite Products Corporation, No. 2643164151.

4. Click OK to send the signal.

Auxiliary 

Pin
Assignment Signal

10 Output #1–TTL Aux Out 1

11 Output #2–TTL Aux Out 2

12 Logic output ground TTL Ground

5 Output valve power #2

(+ 12 V, 0.25 Amp)

Spare Out LC 

(12 V)

6 Output valve switch #2 LC Return

3 Output valve power #1

(+ 24 V, 1.0 Amp)

Spare Out HC 

(24 V)

4 Output valve switch #1 HC Return

NOTE: Always use pins 3 and 4 together to supply 
power and ground for a 24 V device. Always use pins 
5 and 6 together to supply power and ground for a 12 V 
device.
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5.2.11  Stopping and Resuming a Method

There are three ways to stop a method from the Control Panel:

• Hold

• Stop pump

• Abort

To stop a
method …

Description
To resume the 

method …

Click the Hold 

button in the 

Method section of 

the Control Panel

Suspends the method and freezes the 

workstation in its present state, with the 

pump running.

If a gradient is running, conditions do not 

change. You can perform manual actions 

from the Control Panel, such as 

replenishing buffers and priming lines.

Click the Resume 

button in the 

Method section of 

the Control Panel.

Stop the pump by 

clicking the Stop 

button in the 

Pump section of 

the Control Panel 

or by pressing the 

Pump button on 

the front panel of 

the workstation

Suspends the method and freezes the 

workstation in its present state, with the 

pump off.

Start the pump to 

resume the 

method. Click the 

Start button in the 

Pump section of 

the Control Panel 

or press the Pump 

button on the front 

panel of the 

workstation.

Click the Abort 

button in the 

Method section of 

the Control Panel 

or click the Abort 

button in the 

Method Queue

Clears the method and shuts down the 

pump. All methods are cleared from the 

Method Queue.

Data files contain data acquired up to the 

time you click Abort.

NOTE: To delete unwanted data files after 
clicking Abort, use Windows Explorer. For 
more information, refer to the Microsoft 
Windows User’s Guide.

You cannot 

resume a method 

after aborting it. 

You must run the 

method again.
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5.3  Making Injections 
From the Control Panel

You can make injections from the Control Panel without creating 

a method. This section describes how to make the following 

types of injections from the Control Panel:

• Autoloader injections

• Direct autoloader injections

• Manual injections

• Pump injections

For information on making the following types of injections from 

the Control Panel, see the appropriate section:

• Integrated Autosampler Injections—Section 5.4.2, 

Controlling an Integrated Autosampler

• Direct Wire Autosampler Injections—Section 5.4.3, 

Controlling a Direct Wire Autosampler

NOTE: To determine which injection mode to use, see 
“Selecting an injection mode” on page 1-12.

Injection volume
considerations

Injection volume determines the syringe and sample loop size. 

To achieve maximum injection volume accuracy and precision, 

follow these guidelines when specifying injection volumes and 

selecting sample loop sizes:

• For injection volumes less than 50 percent of the sample 

loop volume, enter the injection volume in the Control 

Panel or method.

• For injection volumes equal to the sample loop volume, 

enter a volume of three times the sample loop volume in 

the Control Panel or method. For example, you can 

accurately inject a 100 µl sample using the 100 µl sample 

loop if you use an injection volume of 300 µl.

• Do not inject volumes between 50 percent and 

100 percent of the sample loop volume.
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NOTE: The actual volume injected onto the column never 
exceeds the sample loop size.

Before
you begin

Before you make an injection from the Control Panel:

1. Prepare the sample as described in Section 3.3, 

Preparing Samples. 

2. Prime or flush the sample lines as described in 

Section 3.4.3, Priming and Flushing the Autoloader Sample 

Lines, or Section 3.4.4, Priming Buffer/Solvent Sample 

Lines for a Pump Injection.

3. Configure the workstation as described in Chapter 4, 

Configuring and Preparing the BioCAD Software.

4. Purge the system as described in Section 5.2.4, Purging 

the System.

5. Set the buffer/solvent blends for equilibrating as described 

in Section 5.2.2, Controlling Buffers/Solvents and Blending.

6. Set the appropriate flow rate and start the pump as 

described in Section 5.2.3, Controlling the Pump and Flow 

Rate. 

7. Click the Inject button in the Sample section of the Control 

Panel to place the Injection valve in the Inject position and 

fill the sample loop with buffer.

8. Place the column inline to equilibrate as described in 

Section 5.2.5, Controlling Columns.

9. Set the wavelength and zero the detector as described in 

Section 5.2.6, Controlling Detectors.

10. Allow the pressure to stabilize by checking the pressure 

display in the Status window.

Hint: When you make injections from the Control Panel, 
press the Chart Mark button at the time of injection to mark 
the Strip Chart Recorder with an event mark.
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5.3.1  Making Autoloader Injections

Flow path
diagrams

Appendix H, Autoloader Flow Path, includes diagrams that 

illustrate the flow path of the autoloader during different 

operations.

Making
injections

To make an autoloader injection from the Control Panel:

1. Complete the tasks listed in “Before you begin” on 

page 5-35.

2. Select a sample channel to inject from by clicking the 

down arrow to the right of the list box at the bottom of the 

Sample section (Figure 5-19).

If you entered sample names when you configured the 

Autoloader, the sample names appear next to the 

number of the sample channel.

Figure 5-19  Sample Section of Control Panel

3. Type an injection volume in the text box next to the Load 

Loop button.

For accurate injection volume delivery, follow the 

guidelines in “Injection volume considerations” on 

page 5-34.

4. Click the Load Loop button. 

The workstation automatically places the injection valve 

in the load position and loads the loop with sample from 

the selected channel.

Click here to 
select a
sample channel
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NOTE: Clicking the Load option button instead of the 
Load Loop command button places the sample loop in 
the load position, but does not load the loop.

5. After the syringe withdraws sample and returns to the home 

position, click the Inject option button.

The injection valve switches to the inject position and 

injects the sample onto the column.

Hint: After the injection is complete and before running a 
gradient, click the Load option button to place the 
injection valve in the load position. This step reduces 
delay time and volume when you run a gradient.

6. Run a gradient or change the buffer/solvent blend to elute 

the sample. For more information, see Section 5.2.8, 

Running a Gradient.

7. When the run is complete, stop the pump by clicking the 

Stop button in the pump section of the Control Panel.

8. Save the data from the run by selecting Save Data As from 

the File menu in the Strip Chart Recorder window. Type a 

file name and select a directory in the Save File dialog 

box. Click OK.

The data is saved to a data file. Method information is not 

saved in the data file.
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5.3.2  Making Direct Autoloader Injections

Flow path
diagrams

Appendix H, Autoloader Flow Path, includes additional 

diagrams that illustrate the flow path of the autoloader during 

different operations.

Making
injections

To make a direct autoloader injection from the Control Panel:

1. Complete the tasks listed in “Before you begin” on 

page 5-35.

2. Select Direct from the drop-down list box at the bottom of 

the Sample section (Figure 5-20). 

Figure 5-20  Sample Section of Control Panel

The Enter Sample Information dialog box is displayed 

(Figure 5-21).

Figure 5-21  Enter Sample Information Dialog Box

3. Double-click on Direct to display the Sample Library. 

Select or add a sample. For information on adding sample 

names to the Sample Library, see Section 4.5.2, 

Customizing the Sample Library.

4. Click OK to close both dialog boxes.

Click here to 
select Direct

Double-click
here to display
Sample Library
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5. Type an injection volume in the text box next to the Load 

Loop button.

For accurate injection volume delivery, follow the 

guidelines in “Injection volume considerations” on 

page 5-34.

6. Click the Load Loop button.

The workstation automatically places the injection valve 

in the load position and loads the loop with sample from 

the Direct mode channel.

NOTE: Clicking the Load option button instead of the 
Load Loop command button places the sample loop in 
the load position, but does not load the loop.

7. After the syringe withdraws sample and returns to the home 

position, click the Inject option button.

The injection valve switches to the inject position and 

injects the sample onto the column.

Hint: After the injection is complete and before running a 
gradient, click the Load option button to place the 
injection valve in the load position. This step reduces 
delay time and volume when you run a gradient.

8. Run a gradient or change the buffer/solvent blend to elute 

the sample. For more information, see Section 5.2.8, 

Running a Gradient.

9. When the run is complete, stop the pump by clicking the 

Stop button in the pump section of the Control Panel.

10. Save the data from the run by selecting Save Data As 

from the File menu in the Strip Chart Recorder window. 

Type a file name and select a directory in the Save File 

dialog box. Click OK.

The data is saved to a data file. Method information is not 

saved in the data file.
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5.3.3  Making Manual Injections

To make a manual injection from the Control Panel:

1. Complete the tasks listed in “Before you begin” on 

page 5-35.

NOTE: When making a manual injection, the Sample 
Loader configuration does not matter and there are no 
sample lines to prime.

2. Click the Load option button in the Sample section of the 

Control Panel. 

The workstation places the injection valve in the load 

position.

3. Insert the needle port adaptor in port 6 of the injection 

valve.

4. Load a syringe with your sample.

For accurate injection volume delivery, follow the 

guidelines in “Injection volume considerations” on 

page 5-34.

5. Insert the syringe in the needle port adaptor and inject the 

sample (Figure 5-22).
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Figure 5-22  Making a Manual Injection

6. Click the Inject option button.

The injection valve switches to the inject position and 

injects the sample onto the column.

Hint: After the injection is complete and before running a 
gradient, click the Load option button to place the 
injection valve in the load position. This step reduces 
delay time and volume when you run a gradient.

7. Run a gradient or change the buffer/solvent blend to elute 

the sample. For more information, see Section 5.2.8, 

Running a Gradient.

8. When the run is complete, stop the pump by clicking the 

Stop button in the Pump section of the Control Panel.

9. Save the data from the run by selecting Save Data As from 

the File menu in the Strip Chart Recorder window. Type a 

file name and select a directory in the Save File dialog 

box. Click OK.

The data is saved to a data file. Method information is not 

saved in the data file.
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5.3.4  Making Pump Injections

To make a pump injection from the Control Panel:

1. Complete the tasks listed in “Before you begin” on 

page 5-35.

NOTE: When making a pump injection, the Sample 
Loader configuration does not matter. 

NOTE: When making a pump injection, create a 
buffer/solvent channel of type Sample. For more 
information, see Section 4.5.1, Customizing the 

Buffer/Solvent Library.

2. Click the Stop button in the Pump section of the Control 

Panel to stop the pump.

3. Type a flow rate in the Pump section of the Control 

Panel.

4. Select the buffer/solvent channel that you are using for 

your sample in the Blend section of the Control Panel. Set 

to 100%. Click the Set button.

5. Click the Start button to start pumping your sample.

6. Allow the pump to run for a time sufficient to introduce the 

desired volume of sample onto the column.

7. Run a gradient or change the buffer/solvent blend to elute 

the sample. For more information, see Section 5.2.8, 

Running a Gradient.

8. When the run is complete, stop the pump by clicking the 

Stop button in the pump section of the Control Panel.

9. Save the data from the run by selecting Save Data As from 

the File menu in the Strip Chart Recorder window.

The data is saved to a data file. Method information is not 

saved in the data file.
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5.4  Controlling External Devices

This section describes how to control the following external 

devices from the Control Panel:

• Fraction collector

• Integrated autosampler

• Direct wire autosampler

5.4.1  Controlling the Fraction Collector

Controlling a
fraction

collector

If you configure a fraction collector, you can control it from the 

Collector section of the Control Panel:

1. Select Fraction Collector Setup from the Config menu 

in the Control Panel.

NOTE: If Fraction Collector Setup is not displayed, 
configure a fraction collector. For more information, see 
Section 4.6, Configuring and Preparing the BioCAD 

Software for a Fraction Collector.

The Fraction Collector Setup dialog box is displayed

(Figure 5-23). The tube size you selected in the 

Configuration dialog box is also displayed.

Figure 5-23  Fraction Collector Setup Dialog Box
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2. Select and type fraction collector setup parameters in the 

dialog box. For more information, see “Setting fraction 

collection parameters” on page 6-47. Click OK to accept 

the settings and return to the Control Panel.

3. If you change the length of the tubing between the BioCAD 

700E Workstation and the fraction collector, change the 

delay volume by clicking the Delay Volumes button in the 

Configuration dialog box. Type the correct delay volume in 

the Fraction Valve to Fraction Collector text box. For more 

information, see “Setting delay volumes” on page 4-13.

NOTE: The fraction collector response is not immediate. 
The delay volume set in the configuration must elapse 
before the commands you select execute.

4. Click one of the following option buttons to divert the flow:

• Fraction—Diverts flow to fraction collection tubes

• Waste—Diverts flow to waste

Figure 5-24  Collector Section of Control Panel
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5. Click the following buttons to control fraction collection:

• Start/Stop—Starts fraction collection according to 

the parameters you set in step 2. Stops fraction 

collection and diverts flow to waste if the fraction 

collector is collecting fractions.

• Advance—Advances the diverter valve to the next 

tube in the rack sequence and collects flow. Use 

this button to control fraction collection if you do not 

set parameters in step 2.

• Reset—Moves the fraction collector diverter valve 

to the home position (tube 1) in the rack and diverts 

flow to waste. Use when pooling fractions from 

multiple runs.
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5.4.2  Controlling an Integrated Autosampler

If you configure an integrated autosampler, you can control the 

autosampler from the Sample Table. You can also change the 

sample loop size and control heating and cooling from the 

Sample Table.

Before
you begin

Before you make an integrated autosampler injection from the 

Control Panel:

1. Connect an integrated autosampler as described in 

Section 2.4.4, Connecting the Autosampler.

2. Prepare the integrated autosampler and samples as 

described in Section 3.6, Preparing an Autosampler.

3. Configure and Prepare the BioCAD software for an 

integrated autosampler as described in Section 4.7, 

Configuring and Preparing the BioCAD Software for an 

Integrated Autosampler.

4. Purge the system as described in Section 5.2.4, Purging 

the System.

5. Set the buffer/solvent blends for equilibrating as described 

in Section 5.2.2, Controlling Buffers/Solvents and Blending.

6. Set the appropriate flow rate and start the pump as 

described in Section 5.2.3, Controlling the Pump and Flow 

Rate.

7. Place the column inline to equilibrate as described in 

Section 5.2.5, Controlling Columns.

8. Set the wavelength and zero the detector as described in 

Section 5.2.6, Controlling Detectors.

9. Allow the pressure to stabilize by checking the pressure 

display in the Status window.
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Making an
injection

To make an injection from the Sample Table:

1. Complete the tasks listed in “Before you begin” on 

page 5-46.

2. Select Sample Table from the Window menu in the Control 

Panel. 

The Sample Table window is displayed (Figure 5-25).

Figure 5-25  Sample Table Window

NOTE: If Sample Table is not displayed in the Window 
menu, select an AS 3500 autosampler in hardware setup. 
See Section 2.5.2, Updating BioCAD Hardware Setup 

Options.

3. Select a sample vial from the Sample Table by clicking it.

4. Type the volume to inject in the Volume text box.

5. If desired, flush the autosampler needle:

• Click the Flush button to display the Set Flush 

Amount dialog box.

• Change the flush volume, if desired (the default 

volume is the volume you set in Configuration).

• Click OK to flush the autosampler needle with 

the flush solvent set in Configuration.



Chapter  5    Controlling the Workstation From the Control Panel

5-48 Applied Biosystems

5

6. Click the Load Loop button.

The autosampler injector valve switches to the load 

position, and the autosampler picks up the selected vial, 

withdraws the specified volume, and loads the sample in 

the autosampler loop.

7. Click the Inject option button.

The autosampler injector valve switches to the inject 

position and injects the sample onto the column.

NOTE: The autosampler injects from the vial you select 
in the Sample Table. If the sample volume in the vial is 
insufficient to make the injection, a warning is displayed. 
Click OK to reduce the injection volume or select a 
different vial. Click Cancel to cancel the injection.

8. Run a gradient or change the buffer/solvent blend to elute 

the sample. For more information, see Section 5.2.8, 

Running a Gradient.

9. When the run is complete, stop the pump by clicking the 

Stop button in the pump section of the Control Panel.

10. Save the data from the run by selecting Save Data As 

from the File menu in the Strip Chart Recorder window. 

Type a file name and select a directory in the Save File 

dialog box. Click OK.

The data is saved to a data file. Method information is not 

saved in the data file.



Controlling External Devices

BioCAD® 700E Workstation User Guide 5-49

5

Changing
sample loop size

You can change sample loop size from the Sample Table 

without changing Configuration:

1. Select Change Loop Size from the Sample menu in the 

Sample Table.

The Set Sample Loop Size dialog box is displayed 

(Figure 5-26).

Figure 5-26  Set Sample Loop Size Dialog Box

2. Type a new sample loop size and click OK.

3. Change the sample loop installed on the autosampler. For 

more information, see the Autosampler Reference Manual.
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5

Controlling
sample heating

and cooling

The integrated autosampler that you use with the BioCAD 700E 

Workstation may support the sample preparation (heat 

chamber) and sample cooling (tray area) options. If so, you can 

control sample heating and cooling from the Sample Table 

without changing Configuration.

1. To turn on the integrated autosampler heat chamber, 

select Sample Heater from the Sample menu in the 

Sample Table window. Click the On button and type a 

setpoint temperature. Valid range is from ambient 

temperature to 100°C (212°F) in 1°C increments. 

The autosampler heat chamber is set to this temperature.

NOTE: You can set the temperature as low as 0°C, but 
the actual setpoint does not go below ambient 
temperature.

NOTE: To heat a sample vial, you place the sample vial 
in the heat chamber by adding a Heat/Mix segment to a 
method. See “Heat/Mix Segments” on page 6-64.

2. To turn on the autosampler cooler, select Sample Cooler 
from the Sample menu in the Sample Table window. Click 

the On button and type a setpoint temperature. Cooling 

range is from 0 to 60°C (32 to 140°F) in 1°C increments.

The autosampler tray area is set to this temperature.

Heater and cooler temperatures are displayed in the 

Sample Table window.

NOTE: Allow 30 minutes for the heat chamber or tray area to 
reach temperature.

NOTE: If your autosampler supports sample preparation, you 
can also control autosampler heating (heat chamber) and 
cooling (tray area) from the Configuration dialog box. See 
“Configuring sample prep” on page 4-42. The settings you make 
last are active.
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5

5.4.3  Controlling a Direct Wire Autosampler

Before
you begin

Before you make a direct wire autosampler injection:

1. Connect a direct wire autosampler as described in 

Section 2.4.4, Connecting the Autosampler.

2. Prepare the direct wire autosampler, including the samples 

and autosampler method, as described in Section 3.6, 

Preparing an Autosampler.

3.Configure and prepare the BioCAD software for a direct wire 

autosampler as described in Section 4.8, Configuring and 

Preparing the BioCAD Software for a Direct Wire 

Autosampler.

4. Purge the system as described in Section 5.2.4, Purging 

the System.

5. Set the buffer/solvent blends for equilibrating as described 

in Section 5.2.2, Controlling Buffers/Solvents and Blending.

6. Set the appropriate flow rate and start the pump as 

described in Section 5.2.3, Controlling the Pump and Flow 

Rate.

7. Place the column inline to equilibrate as described in 

Section 5.2.5, Controlling Columns.

8. Set the wavelength and zero the detector as described in 

Section 5.2.6, Controlling Detectors.

9. Allow the pressure to stabilize by checking the pressure 

display in the Status window.



Chapter  5    Controlling the Workstation From the Control Panel

5-52 Applied Biosystems

5

Making an
injection

Use the autosampler controls to program an autosampler 

method with an injection sequence. For more information on 

programming the AS 3500 autosampler, see Section 3.6.8, 

Programming the AS 3500 Autosampler Method and Sample 

Set, or the Autosampler Reference Manual.

To make the first injection, click the Inject option button in the 

Sample section of the Control Panel. The workstation signals 

the autosampler with a contact closure. The autosampler makes 

the injection and signals the workstation with a contact closure.

After the injection is complete, run a gradient or change the 

buffer/solvent blend to elute the sample. For more information, 

see Section 5.2.8, Running a Gradient.
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6 6.1  Using the Method Editor 

This section describes:

• Method structure

• Method views

• Method units

Overview Use the Method Editor to create, edit, and run separation 

methods. The Method Editor is designed to make method 

programming easy to learn and implement. 

To display the Method Editor window (Figure 6-1), select 

Method Editor from the Window menu in any window.

Figure 6-1  Method Editor
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6
6.1.1  Method Structure

The BioCAD method structure makes method programming 

easy and intuitive.

Blocks,
segments,

and events

A BioCAD method is made up of blocks, segments, and events.

• Blocks—Basic chromatographic steps, for example, 

Equilibrate or Elute

• Segments—Flow operations within a block, for example, 

Inject or Purge

• Events—Individual operations within a segment, for 

example, Set Flow Rate

Block

Segment

Event

Method
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6
6.1.1.1  Blocks 

Blocks are the building blocks you use to create a method. 

Blocks are basic chromatographic steps.

Blocks fall into two categories:

• Separation—Perform basic chromatographic steps. 

Equil, Load, Wash, Elute, and Clean are separation 

blocks.

• Preparative—Prepare sample using the autosampler 

(available only if your autosampler supports the sample 

preparation option).

You can include six types (one preparative, five separation) of 

blocks in a method. You can use one type of block more than 

once in a method. You do not need to use all six types of blocks 

in a method.

You typically add blocks to a method in the following order:

• Equil—Equilibrates the column and system for a 

separation

• Prep—Prepares samples (available only if you configure 

an integrated autosampler that supports sample prep)

• Load—Loads the sample onto the column

• Wash—Washes non-retained or weakly-retained 

contaminants off the column

• Elute—Removes retained molecules from the column as 

purified components

• Clean—Regenerates the column and system so that 

another separation can be performed
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6
6.1.1.2  Segments 

Segments are flow operations within a block. 

Separation block
segments

You can include five types of segments in separation blocks 

(Equil, Load, Wash, Elute, Clean):

• Step—Specifies a constant buffer/solvent blend to pass 

over the column for a specified duration or until 

thresholds are reached, for example, to wash or 

equilibrate the column

• Gradient—Defines a buffer/solvent blend that changes 

over time or volume, for example, a linear elution 

gradient

• Inject—Injects a sample onto the column using the 

autoloader injection valve and sample loop

• Autosampler Inject—Injects a sample onto the column 

using an optional integrated autosampler

• Purge—Flushes the system with a buffer/solvent blend 

while the column is bypassed

Prep block
segments

You can include three types of segments in Prep blocks:

• Dilute—Adds a diluent and sample in a specified ratio to 

an empty vial when using an integrated autosampler

• Combine—Add multiple samples and reagents to an 

empty vial when using an integrated autosampler

• Heat/Mix—Heats or mixes a sample vial when using an 

integrated autosampler
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6
Types of

segments in
blocks

A block can contain only segments that are appropriate for that 

block. For example, a Load block cannot contain a Gradient 

segment. The segments you can use with each block are:

Block Allowable Segments

Prep Dilute, Combine, Heat/Mix

Equilibrate Step, Gradient, Purge

Load Step, Inject, Autosampler Inject, Purge

Wash Step, Gradient, Purge

Elute Step, Gradient, Purge

Clean Step, Gradient, Inject, Autosampler Inject, Purge
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6
6.1.1.3  Events 

Events are individual operations within a segment, such as:

• Set Flow Rate = 5.00 ml/min

• Turn Pump On

You can add events to separation segments (Step, Gradient, 

Inject, Autosampler Inject, and Purge). You cannot add events 

to preparative segments (Dilute, Combine, and Heat/Mix).

There are four types of events in a method:

• Automatic Events—Predefined events that are part of a 

segment. They are automatically added to a method 

when you add a segment to a method.

• Added Events—Miscellaneous events you can add to a 

method segment individually, to meet your application 

needs. Added events are flagged with an asterisk (*).

• Control Panel Added Events—Events added to a 

method as a result of an action you make from the 

Control Panel, such as stopping the pump. These added 

events are flagged with an asterisk (*) and a plus sign (+) 

and appear only in methods contained in data files.

If you use Save As to save the method contained in the 

data file to a method file, these added events remain in 

the method, marked with *, but the + is removed. 

• Documentation Added Events—Events added to a 

method during the method run. These events document 

the result of other actions and are not executable. 

Examples include Method Canceled, Peak End, and 

Threshold Expired. These added events are flagged with 

an asterisk (*) and a minus sign (-) and appear only in 

methods contained in data files.

If you use Save As to save the method contained in the 

data file to a method file, these added events remain in 

the method, marked with * and -. When you run a 

method, events flagged with - are not executed.



Chapter  6    Creating and Running Methods

6-8 Applied Biosystems

6
6.1.2  Method Views

Scrolling If a method occupies more than one screen, use the scroll bars 

on the right side of the window to view the entire method.

Views The Method Editor lets you look at the method in two views. To 

change views, select Block View or Sequence View from the 

Display menu:

Block view Block view (Figure 6-2) is a summary view that includes:

• Each block, listed numerically (01, 02,...) 

• Each segment, listed alphabetically (A, B,...)

• Type of each segment (S, G, I, AI, or P)

• Duration of each segment in minutes, ml, and CV

• Total duration of the method in minutes, ml, and CV

Figure 6-2  Block View of a Method

NOTE: If you use a multi-column plumbing configuration, 
CV (column volume) readings include the combined volumes 
of all inline columns.
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6
Sequence view Sequence view (Figure 6-3) is a detailed view that includes:

• Block name and number

• Segments within each block

• Automatic events within each segment 

• Added events, flagged with an asterisk (*)

• Control Panel added events, flagged with a plus sign (+). 

These added events appear only in methods contained in 

data files.

• Duration of each block, segment, and event in minutes, 

ml, or CV

• Total duration of the method in minutes, ml, or CV

Figure 6-3  Sequence View of a Method

NOTE: If you use a multi-column plumbing configuration, 
CV (column volume) readings include the combined volumes 
of all inline columns.
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6
6.1.3  Method Units

Displaying units In Block view, the method displays segments in minutes, ml, 

and CV.

In Sequence view, you can display method duration in one of 

three different units by selecting one of the following from the 

Display menu:

• Time Units—Displays each event in minutes

• Volume Units—Displays each event in ml

• CV Units—Displays each event in column volumes

NOTE: If CV Units is dimmed, enter column dimensions in 
the Configuration dialog box. For more information, see 
Section 4.2.4, Configuring Columns and Plumbing.

Programming
units

When you create a method, you program segments and events 

in minutes, ml, or CV (column volumes). Use the following 

guidelines to select a unit:

• CV units are useful because column equilibration and 

gradient slope are primarily a function of the total number 

of column volumes of eluent passed through the column. 

• CV units make the method scalable because the BioCAD 

software automatically adjusts for changes in column 

sizes. 

• CV and ml units make the method effectively 

independent of flow rate. 

You can program a method in CV units only if you enter column 

dimensions in the Configuration dialog box. See Section 4.2.4, 

Configuring Columns and Plumbing.

If you use a multi-column plumbing configuration, 

CV (column volume) calculations include the combined volumes 

of all inline columns.

CV calculations are performed only for those segments for 

which a column is inline. If the column is bypassed, the CV 

duration is listed as zero. If the flow rate is set to zero in the 

General Settings, the volume-based segment duration is also 

listed as zero.
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66.2  Creating a New Method

Overview A summary of the basic steps for creating a new method appear 

below. For additional information on these steps, see the 

appropriate sections.

To create a new method:

1. Display the Method Editor. See Section 6.2.1, Displaying 

the Method Editor.

2. Create, edit, or load a configuration for your method. See 

Section 6.2.2, Selecting a Configuration.

3. Specify General Settings. See Section 6.2.3, Specifying 

General Settings.

4. Create the blocks. See Section 6.2.4, Creating Separation 

Blocks.

5. Create segments for each block. See Section 6.2.5, 

Creating Separation Block Segments.

6. Add additional events to the segments, if necessary. See 

Section 6.2.6, Adding Events.

7. Display the Blend Graph to verify that blend and gradient 

information is set properly. See Section 6.2.7, Using the 

Blend Graph.

8. Specify data storage options for the data files the method 

will create. See Section 6.2.10, Specifying Data Storage 

Options.

9. Specify print settings. See Section 6.2.11, Specifying Print 

Settings.

10. Specify analysis and printing after run. See 

Section 6.2.12, Specifying Analysis and Printing After Run.

11. Name and save the method. See Section 6.2.13, Saving 

Methods.

NOTE: For an example of how to create a simple method, 
see Section 6.3, Creating Typical Methods.



Chapter  6    Creating and Running Methods

6-12 Applied Biosystems

6
6.2.1  Displaying the Method Editor

Display the Method Editor by selecting the Window menu from 

any window, then selecting Method Editor. The Method Editor 

window is displayed (Figure 6-4).

Figure 6-4  Method Editor Window (New Method) 
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6
6.2.2  Selecting a Configuration

When you create a new method, the current system 

configuration is used as the method configuration.

NOTE: For definitions of method and system configurations, 
see “System versus method configuration” on page 4-3.

To create a specific method configuration, you can:

• Edit the system configuration before creating your 

method.

• Load a specific configuration as the system configuration 

before creating your method. For more information, see 

Section 4.4, Loading an Existing Configuration.

• Change the method configuration after creating your 

method. For more information, see “Changing the 

method configuration” on page 6-14.
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6
Changing the

method
configuration

After you start creating a method, there are two ways to change 

the method configuration:

If you plan to run your method immediately, check that the 

physical configuration of the BioCAD 700E Workstation, 

matches the system configuration. The system configuration is 

used when you run a method.

To change the method 

configuration …
Description

Select Edit 

Configuration from the 

Method Editor Options 

menu to display the 

Configuration dialog box. 

This changes the method configuration. It 

does not change the system configuration. 

The method configuration is not used 

when you run the method unless you load 

the method configuration as the system 

configuration before running. See 

Section 4.4, Loading an Existing 

Configuration.

Hint: Use Edit Config when you create a 
method to run at a later time, using a 
configuration different from the current 
system configuration.

Make changes to the 

system configuration by 

selecting Edit Config from 

the Edit menu in the 

Control Panel. Select 

Update Configuration 

from the Method Editor 

Options menu.

This loads the current system 

configuration as the method configuration.

NOTE: If you change the system 
configuration from the Control Panel 
Config menu, it does not affect the 
method configuration until you select 
Update Config from the Method Editor 
Options menu.

Hint: Use Update Config when you 
create a method to run using the current 
system configuration.
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6
6.2.3  Specifying General Settings

The General Settings section of a method allows you to set 

basic settings for your system including:

• Flow rate

• UV/Vis wavelengths

• Fluorescence wavelengths

• Initial column state

• Initial detector state

General settings do not usually change during a method, so 

you set them once at the beginning of the method.

NOTE: You can change General Settings later in a method by 
adding events.

To specify the General Settings for your method:

1. At the top of the Method Editor window, below the Block 

and Segment buttons, double-click the General Settings 

line. 

The General Settings dialog box is displayed 

(Figure 6-5).

Figure 6-5  General Settings Dialog Box
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2. Type or select the following parameters:

Parameter Description

Flow rate Valid range is 0.20 to 100.00 ml/min. Available units include 

ml/min, cm/hr, and CV/min. For more information, see “Flow rate 

units” on page 5-14.

NOTE: If you have an analytical flow cell installed in the 
UV/Vis detector, do not exceed a flow rate of 45 ml/min.

UV/Vis 

wavelengths

Valid ranges are:

• Single wavelength—190 to 800 nm.

• Dual-wavelength—190 to 450 nm OR 366 to 700 nm, 

because the detector cannot switch between the deuterium 

and tungsten lamps.

Lamps used in these ranges are:

Deuterium (UV)—190 to 450 nm

Tungsten (Vis)—366 to 700 nm

NOTE: If you enable an external fluorescence detector in 
hardware setup, dual wavelength mode is not available for the 
UV/Vis detector. If you enable an external UV/Vis detector in 
hardware setup, only dual wavelength mode is available for the 
UV/Vis detector.

NOTE: When you run a method with dual wavelength enabled, the 
setting changes to single wavelength at the end of a method to 
reduce wear of the detector grating.

Fluorescence 

wavelengths

Valid ranges are (even values only):

• Excitation—200 to 650 nm

• Emission—200 to 800 nm

Initial 

Column State

Initial setting for the flow direction. Choices available depend on 

column configuration.
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CAUTION
If you use organic solvents, select Bypass before 
running yoiur samples to take the pH and conductivity 
monitors out of line.

3. Click OK to return to the Method Editor.

Initial Detector 

State

Initial state for the pH and conductivity monitors:

• Bypass

• Inline 

NOTE: UV/Vis detectors are always inline. Detector bypass affects 
only the pH and conductivity detectors.

Parameter Description
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6
6.2.4  Creating Separation Blocks

Overview At the top of the Method Editor window, click a block button to 

add the appropriate separation block:

• EQ—Equil

• L—Load

• W—Wash

• EL—Elute

• C—Clean/Regenerate

NOTE: If block buttons are dimmed, select the General 
Settings line or the separator line below an existing block.

Figure 6-6  Selected Blocks 

Each block is sequentially numbered. The column headings 

(Type, min, ml, CV) above the General Settings line designate 

the type and duration of the segments within each block.

Duration of each block is initially zero because no segments are 

selected. Do not add a block without adding a segment to it. 
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6
6.2.5  Creating Separation Block Segments

Overview Segment buttons, at the top of the Method Editor window, are 

dimmed until you select a block. Click a block line in the method, 

and the appropriate segment buttons are activated. 

Click a segment button to add the appropriate segment to the 

block:

• S—Step

• G—Gradient

• I—Inject

• AI—Autosampler Inject

• P—Purge

NOTE: Segment buttons are dimmed until you select a block. 
By default, the line below the block is selected, instead of the 
block. Display the method in Sequence view to get a more 
detailed look at the method.

You set the duration of a segment in minutes, ml, or CV. 

You can set different segments within a method to have different 

duration units.
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6.2.5.1  Step Segments

You can add a Step segment to all separation block types 

(EQ, L, W, EL, C). A Step segment sets the buffer/solvent blend 

to a particular blend and holds it for a set duration (ml, min or 

CV) or until thresholds you set are reached. 

Add a Step segment to a Load block to make:

• Pump injections

• Direct wire autosampler injections

NOTE: If a method does not include an Inject segment, data 
collection begins at the beginning of a run. To trigger data 
collection later in a run without an Inject segment, add a Data 
Collection Start event.

To add a Step segment:

1. Select a separation block in the method by clicking it.

2. Click the Segment S button to display the Step Segment 

Setup dialog box (Figure 6-7).

Figure 6-7  Step Segment Setup Dialog Box 

(Percentage Blend Mode)
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The default blend settings are the blend settings 

specified in a previous segment.

3. Select a buffer/solvent blend for the Step segment. 

To change the blend mode (Percent, Eluent, or pH), click 

Setup.

For more information on entering blends in different 

modes see Section 5.2.2, Controlling Buffers/Solvents and 

Blending.

4. Type the duration of the segment in minutes, ml, or CV.

NOTE: Using CV (Column Volume) units makes the 
method scalable. That is, it operates the same way with 
different column sizes. Using ml or CV units makes the 
segment operate the same way independent of flow rate.

CV units are available only if you enter column 
dimensions in the Configuration dialog box.

5. Type a Segment Name to identify the function of the Step 

segment. The default name is Step Segment. The segment 

name appears in the Status window when a segment is 

running. 

6. Set thresholds and type a delay duration as needed. See 

below for information on thresholds and delay durations.

7. Click OK to add the Step segment to the block.

8. When you have added all segments to the method, save 

the method by selecting Save from the File menu.
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Setting

thresholds and
delay durations

You can use thresholds to end a segment before the specified 

duration. For example, you can use thresholds to:

• End an equilibration block when the conductivity or 

UV/Vis signal returns to baseline

• Collect a single peak with the fraction/waste valve

As a method runs, a segment continues for the specified 

duration, unless thresholds are reached. 

NOTE: All threshold conditions must be met before the 
segment stops.

For each detector signal, you can set a threshold maximum or 

minimum. To set a maximum threshold, click the > option button 

and type a value. To set a minimum threshold, click the < option 
button and type a value.

When using delay duration and thresholds, note the following:

• Always enter a delay duration when using thresholds. If 

you do not, the detector signal at the start of the segment 

may be outside the threshold criteria, and the segment 

will not run.

• When setting a threshold, make sure the detector signal 

exceeds the threshold value after the set delay. If, for 

example, you set the UV/Vis threshold to < 0.01 to mark 

the end of a peak and the peak has not started to elute 

after the set delay duration, the segment will not run 

because the threshold value is reached.

CAUTION

Do not add events to a Step segment with threshold settings. 
The added events cause the segment to ignore the threshold 
settings and continue to run.
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6
6.2.5.2  Gradient Segments

You can add a Gradient segment to all block types except a 

Prep or Load block. A Gradient segment sets the buffer/solvent 

blend to a starting blend and continuously changes the blend in 

a linear fashion to a final blend over a set duration. 

You can create more complex gradients by combining 

appropriate Step and Gradient segments.

To add a gradient segment:

1. Select a Wash, Equil, Elute, or Clean block by clicking it.

2. Click the Segment G button to display the Gradient 

Segment Setup dialog box (Figure 6-8).

Figure 6-8  Gradient Segment Setup Dialog Box

(Percentage Blend Mode)

The default blend settings are the blend settings 

specified in a previous segment.
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3. Select starting and ending buffer/solvent blends for the 

Gradient segment. To change the blend mode (Percent, 

Eluent, or pH) click Setup.

For more information on entering blends in different 

modes, see Section 5.2.2, Controlling Buffers/Solvents and 

Blending.

4. Type the duration of the segment in min, ml, or CV.

NOTE: Using CV (Column Volume) units makes the 
method scalable. That is, it operates the same way with 
different column sizes. Using ml or CV units makes the 
segment operate the same way independent of flow rate.

CV units are available only if you enter column 
dimensions in the Configuration dialog box.

5. Type a Segment Name to identify the function of the 

gradient segment. The default name is Gradient Segment. 

The segment name appears on the Status window when a 

segment is running.

6. Click OK to add the Gradient segment to the block.

7. When you have added all segments to the method, save 

the method by selecting Save from the File menu.
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6
6.2.5.3  Purge Segments

You can add a Purge segment to all separation block types 

(EQ, L, W, EL, C). A Purge segment quickly flushes the system 

with a new buffer/solvent blend at a high flow rate while the 

column is out of line. 

A Purge segment:

• Takes the columns out of line

• Changes the buffer/solvent blend to the set blend

• Increases the flow rate to the set rate

• Runs for a set volume duration

• Resets to the General Settings flow rate 

• Switches the columns to the specified position

Add a Purge segment to an Equil block to equilibrate the system 

with your initial buffer/solvent blend.

To add a Purge segment:

1. Select a block by clicking it.

2. Click the Segment P button to display the Purge Segment 

Setup dialog box (Figure 6-9).

Figure 6-9  Purge Segment Setup 

(Eluent Blend Mode)
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3. Select a buffer/solvent blend for purging the system. 

To change the blend mode (Percent, Eluent, or pH) click 

Setup.

For more information on entering blends in different 

modes, see Section 5.2.2, Controlling Buffers/Solvents and 

Blending.

4. Type a Segment Name to identify the function of the Purge 

segment. The default name is Purge Segment. The 

segment name appears in the Status window when a 

segment is running. 

5. Type a flow rate for purging. The default is 30 ml/min.

CAUTION
If you are using an analytical flow cell and 0.010-inch ID 
blue tubing, you may need to reduce the purge flow rate 
to avoid exceeding the system high-pressure limit.

6. Type a purge volume sufficient to purge the system. The 

default is 10 ml.

7. Select the Flow Direction at the end of the Purge. The 

selections depend on the current plumbing configuration.

NOTE: If you do not set flow direction, the column is not 
placed back inline after the Purge segment.

8. Click OK to add the Purge segment to the block.

9. When you have added all segments to the method, save 

the method by selecting Save from the File menu.
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6.2.5.4  Inject Segments

You can add an Inject segment to Load or Clean blocks.

Add an Inject segment to a Clean block to expose the column to 

strong cleaning agents, such as base or acid, without using a 

buffer/solvent channel.

Add an Inject segment to a Load block to make:

• Autoloader injections

• Direct autoloader injections

• Manual injections

NOTE: To make pump injections or direct wire autosampler 
injections, add a Step segment. To make integrated 
autosampler injections, add an Autosampler Inject segment.

Hint: To Inject different samples, or to make injections larger 
than the maximum for the injection mode you configured, you 
can add multiple Inject segments to a method.

To add an Inject segment:

1. Select a Load or Clean block by clicking it.

2. Click the Segment I button to display the Inject Segment 

Setup dialog box (Figure 6-10).
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Figure 6-10  Inject Segment Setup Dialog Box

3. Specify the injection mode by clicking an option button:

• Autoloader Channel 1 through 4—Injects 

through the autoloader, from one of four vials, 

placed on top of the workstation

• Direct Autoload—Injects through the 

autoloader, from a vial to the right of the 

injection valve, bypassing the sample selection 

valve

• Manual Load—You inject directly into the 

injection valve using a syringe

NOTE: When you run a method containing a Manual 
Load injection, the method pauses at the point of 
injection and prompts you to make the injection. After you 
make the injection, click OK or press the Event Mark 
button on the front panel, and the method resumes.
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4. If you specify Direct Autoload or Manual Load, specify a 

sample name by double-clicking the Sample text box, then 

selecting a name from the Sample Library. For information 

on adding names to the Sample Library, see Section 4.5.2, 

Customizing the Sample Library.

5. Type the injection amount in ml or µl. Valid range depends 

on the syringe size and sample loop size.

6. Type a Segment Name to identify the segment. The default 

name is Inject Segment. The segment name appears in the 

Status window when a segment is running.

7. Enable or disable Flush Loader.

Flush Loader flushes the sample line, between the 

sample selection valve and the injection valve. The flush 

occurs before the injection each time the method runs. 

The default flush volume is 100 µl. You can change the 

flush volume in the Configuration dialog box.

Hint: If you run a method multiple times to make 
autoloader injections from different samples, enable 
Flush Loader to prevent sample carryover. 

Hint: If you run a method multiple times without switching 
between samples, enabling Flush Loader consumes 
sample unnecessarily. 
If you do not switch between samples, disable Flush 
Loader and flush the loader from the Control Panel 
Sample menu before starting the first run.

8. Click OK to add the Inject segment to the block.

9. When you have added all segments to the method, save 

the method by selecting Save from the File menu.
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6.2.5.5  Autosampler Inject Segments

You can add an Autosampler Inject segment to a Load block.

Add an Autosampler Inject segment to a Load block to make an 

integrated autosampler injection.

NOTE: To make pump injections or direct wire autosampler 
injections, add a Step segment. To make autoloader, direct 
autoloader, or manual injections, add an Inject segment.

To add an Autosampler Inject segment:

1. Select a Load block by clicking it.

2. Click the Segment AI button to display the Autosampler 

Inject Segment dialog box (Figure 6-11).

NOTE: If the Segment AI button is dimmed, enter sample 
vials in the Sample Table. See Section 4.7.3, Entering 

Vials in Sample Table.

Figure 6-11  Autosampler Inject Segment Dialog Box 

(Integrated Autosampler)
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3. Select the type of samples to display in the Sample list box:

• Sample/Standards—Displays a list of all 

sample vials entered in the Sample Table as 

Sample, Standard, Control, or Reagent. See 

Section 4.7.3, Entering Vials in Sample Table.

• Derived—Displays a list of all Derived vials 

created by preceding Prep blocks in this 

method. This option is available only if your 

autosampler supports the sample preparation 

option.

4. Select a sample from the Sample list box.

The maximum injection volume and available sample 

volume for the sample vial are displayed in the dialog 

box.

5. Type the injection volume in ml or µl.

Valid range for autosampler injections depends on the 

type of injection you specify in the Configuration dialog 

box (Pull Loop, PushLoop, or Full Loop), the size of the 

installed sample loop, and the available volume in the 

sample vials.

NOTE: To calculate the available volume, the software 
looks at all sample vials with the selected name, finds the 
vial with the largest volume, and subtracts the dead 
volume for that vial shape.

NOTE: If your autosampler supports sample preparation, 
you can make injections larger than 200 µl. The 
autosampler uses the Prep syringe (2,500 µl) instead of 
the Sample syringe (250 µl). Both syringes are located at 
the rear of the autosampler.
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6. Type a Segment Name to identify the function of the 

Autosampler Inject segment. The default name is AS Inject 

Segment. The segment name appears in the Status window 

when a segment is running.

7. To flush the autosampler with flush solvent after each 

injection, click the Flush Loader check box. 

Flush Loader flushes between the needle tip and the 

autosampler injection syringe. Flushing is recommended 

to minimize carryover. The default flush volume is 430 µl. 

You can change the flush volume in the Configuration 

dialog box.

8. Click the Mix Sample check box to mix for 2 seconds 

before injecting. This option is available only if your 

autosampler supports the sample preparation option.

CAUTION
Mixing samples may denature proteins.

9. Click OK to add the Autosampler Inject segment to the 

block.

Hint: Autosampler injections can take several minutes to 
complete. Include a Zero Detector event at the start of 
the Inject segment.

Insufficient
injection volume

When you run a method containing an Autosampler Inject 

segment, the autosampler injects from the sample vial you 

select in the Sample list box. If the sample volume in the vial is 

insufficient to make the injection, a warning is displayed before 

the method runs. The system:

• Finds the vial with the same sample name and smallest 

adequate volume (if any) and asks if you want to inject 

from this vial. Click OK to inject from this vial, or click 

Cancel to cancel the method.

• If there is no vial with sufficient volume, the software asks 

if you want to reduce the injection volume. Click OK to 

reduce the injection volume, or click Cancel to cancel the 

method.
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6.2.6  Adding Events

Automatic
events versus
Added events

There are four types of events in a method:

• Automatic Events—Predefined events that are part of a 

segment. They are automatically added to a method 

when you add a segment to a method.

• Added Events—Miscellaneous events you can add to a 

method segment individually, to meet your application 

needs. Added events are flagged with an asterisk (*).

• Control Panel Added Events—Events added to a 

method as a result of an action you make from the 

Control Panel, such as stopping the pump. These added 

events are flagged with an asterisk (*) and a plus sign (+) 

and appear only in methods contained in data files.

• Documentation Added Events—Events added to a 

method during the method run. These events document 

the result of other actions and are not executable. 

Examples include Method Cancelled, Peak End, and 

Threshold Expired. These added events are flagged with 

an asterisk (*) and a minus sign (-) and appear only in 

methods contained in data files.

Adding events You can add events to all separation segment types (S, G, I, AI, 

and P). You cannot add events to preparation segment types (D, 

C, and H/M). You can add as many events as you like. 

NOTE: In the Method Editor, events are displayed in 
Sequence view only. To change to Sequence view, select 
Sequence View from the Display menu. 

To add an event to a segment:

1. Select a separation segment in the Method Editor 

window. You can click on any portion of the segment. The 

position at which the new event is inserted is determined 

by the time or volume you enter for the event.
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2. Click the Add Event button at the top of the Method Editor 

window.

A list of events is displayed. Scroll through the list to find 

the event to add. Events are described in the “Method 

events” on page 6-35.

3. Select the event to add.

4. Click Add.

A dialog box appears prompting you to type a time 

(minutes) or volume (ml or CV) for the selected event to 

occur within the segment. 

5. Type a time, volume, or CV value, then click OK to insert 

the event.

NOTE: The unit (minutes, ml, or CV) that you specify for 
an event is the same unit that you specified for the 
segment. For example, if you set the segment in ml, you 
set the added event in ml.

Hint: You can add events to the end of a segment to 
perform functions such as stopping the pump. If you 
change the duration units (minutes, ml, or CV) of a 
segment, the event is automatically set to occur at the 
end of the segment. You do not need to change the event 
time to the end of the segment.

6. When you have added all events to the method, save the 

method by selecting Save from the File menu.

Deleting events To delete an event that you added, select the event, then select 

Cut Event from the Edit menu.

NOTE: When you perform an operation from the Control 
Panel, such as stopping the pump, an event is added to the 
method in a data file. This event is flagged with an asterisk (*) 
and a plus sign (+), and you cannot delete it using Cut Event.

To delete this type of event, first save the file as a method file 
(.MET) by selecting Save As from the File menu.
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Method events The following tables describe events that you can add to a 

method. 

NOTE: The events displayed are determined by the method 
configuration (not the system configuration). For more 
information, see Chapter 4, Configuring and Preparing the 

BioCAD Software.

Pump Events

Event Description

Pump Off Turns off pump.

NOTE: If you add a Pump Off event to a 
segment specified in CV or ml, the 
event is automatically added to the end 
of the segment.

NOTE: The pump automatically turns 
off at the end of a method or 
multi-method.

Pump On Turns on pump.

Set Flow Rate Starts a new flow rate and uses this flow 

rate until next flow rate event is 

encountered. This added flow rate 

event is not changed when using the 

flow rate template.

Valid ranges are 0.20 to 60.00 ml/min 

NOTE: If you add a Set Flow Rate=0.00 
event to a segment specified in CV or 
ml, the event is automatically added to 
the end of the segment.
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6 NOTE: Plumbing events displayed are determined by the 
column plumbing option in the method configuration.

Plumbing Events

Event Description

Set Column 

Offline 

Bypasses columns and directs flow from 

injection valve directly to detectors. 

Available only with Single and Tandem 

column plumbing configurations.

NOTE: If you add a Set Column Offline 
event to a segment specified in CV or 
ml, the event is automatically added to 
the end of the segment.

Set Column 1 

Inline

Places column 1 inline in Single, 

Tandem, and Three column plumbing 

configurations.

Set Column 2 

Inline 

Places column 2 inline in Tandem and 

Three column plumbing configurations.

Set Column 3 

Inline 

Places column 3 inline in Three column 

plumbing configuration.

Set Column 1 

Reversed

Reverses flow through the column. 

Available only in Single column 

plumbing configuration.

Set Column 1 

and 2 Inline 

Directs flow through column 1 and 

column 2 prior to the detection module. 

Available only in Tandem column 

plumbing configuration.
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6pH/Conductivity Detector Events

Event Description

Set Detectors 

Inline

Places pH and conductivity monitors in the 

flow path.

Set Detectors 

Offline 

Removes pH and conductivity monitors 

from the flow path.
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Event Description

Set UV Detector 

Wavelength 

Sets a new wavelength for the internal 

UV/Vis detector and automatically zeroes 

the detector. 

Valid ranges are:

Single wavelength—190 to 800 nm.

Dual-wavelength—190 to 450 nm OR 366 

to 700 nm, because the detector cannot 

switch between the deuterium and tungsten 

lamps.

NOTE: Wavelength change is not 
instantaneous, especially when switching 
wavelengths between the UV and visible 
regions (365 nm). In these cases, one lamp 
turns off while the other turns on. The 
deuterium lamp (UV) takes several minutes 
to turn on. During the warm-up period, no 
meaningful data is collected.

NOTE: If you enable an external 
fluorescence detector in hardware setup, 
dual wavelength mode is not available for 
the UV/Vis detector. If you enable an 
external UV/Vis detector in hardware setup, 
only dual wavelength mode is available for 
the UV/Vis detector.

NOTE: When you run a method with dual 
wavelength enabled, the setting changes to 
single wavelength at the end of a method to 
prevent wear of the detector grating.

Continued
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Turn UV 

Detector Lamp 

On 

Turns on:

• Deuterium lamp (UV) for wavelengths 

up to 365 nm 

• Tungsten lamp (Vis) for wavelengths 

above 365 nm

Turn UV 

Detector Lamp 

Off 

Turns off the internal and external 

UV/Vis detector lamp.

Hint: Include this event in the last run of 
the day.

Zero UV 

Detector 

Zeroes the absorbance detector output.

UV Detector 

Event Mark 

Marks the UV/Vis data channel in the Strip 

Chart Recorder and data files with an event 

mark (red MRK).

UV/Vis Detector Events (Continued)

Event Description
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6 Fluorescence Detector Events

Event Description

Turn Fluorescence 

Detector Lamp On 

Turns on the lamp in the fluorescence 

detector.

Turn Fluorescence 

Detector Lamp Off 

Turns off the lamp in the 

fluorescence detector lamp.

Hint: Include this event in the last run of 
the day.

Set Fluorescence 

Detector 

Wavelength 

Sets new Emission and Excitation 

wavelengths for the fluorescence 

detector and automatically zeroes the 

detector. 

Valid entries are (even values only):

• Excitation—200 to 650 nm

• Emission—200 to 800 nm

Zero Fluorescence 

Detector 

Zeroes the fluorescence detector 

output.

Fluorescence 

Detector Event 

Mark 

Marks the fluorescence data channel in 

the Strip Chart Recorder and data files 

with an event mark (red MRK).
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6Fraction Collector Events

Event Description

Collect 

Fraction 

If a fraction collector is not configured, places the 

fraction/waste valve in the Fraction position.

If a fraction collector is configured, controls the 

diverter valve on the external fraction collector to 

divert flow to fraction collection tubes.

Divert to 

Waste 

If a fraction collector is not configured, places the 

fraction/waste valve in the Waste position.

If a fraction collector is configured, controls the 

diverter valve on the external fraction collector to 

divert flow to waste.

Start 

Fraction 

Collection 

Starts fraction collection according to parameters 

you set. For information on setting fraction 

collection parameters, see “Setting fraction 

collection parameters” on page 6-47.

Stop 

Fraction 

Collection 

Stops fraction collection, diverts flow to waste, 

and advances one tube.

Reset 

Fraction 

Collector 

Resets the fraction collector diverter valve to the 

home position (tube 1) and diverts flow to waste. 

NOTE: Use this event to pool fractions when you 
run the same method multiple times.

Advance 

to Next 

Tube 

Advances the fraction collector diverter valve to 

the next tube in the rack sequence and collects 

flow.

Hint: If you make multiple runs and do not pool 
fractions, you can add an Advance event after a 
Stop event to leave an empty “marker” tube 
between fractions from different runs.
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Event Description

Load Sample into 

Loop 

Places injection valve and sample 

loop in the Load position. Loads loop 

with volume you specify.

Flush Sample 

Loader 

Places injection valve and sample 

loop in the Inject position and flushes 

sample line with indicated sample 

channel (1, 2, 3, or 4). Flushing clears 

the sample line from the sample 

selection valve to the injection valve.

NOTE: The volume used is the flush 
volume set in the Configuration dialog 
box. Default flush volume is 100 µl.

Inject Sample Places injection valve and sample 

loop in the Inject position. Injects 

contents of sample loop onto the 

column.

Prime Sample 

Loader 

Places injection valve and sample 

loop in the Inject position and primes 

sample line with indicated sample 

channel (1, 2, 3, or 4). Priming fills the 

entire selected sample line, up to the 

injection valve.

NOTE: The volume used is the prime 
volume set in the Configuration dialog 
box. Default prime volume is 350 µl.

Set Sample Loop 

to Load Position 

Places injection valve and sample 

loop in the Load position.

Set Sample Loop 

to Inject Position 

Places injection valve and sample 

loop in the Inject position.
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6NOTE: If Integrated Autosampler events are not listed, 
configure an AS 3500 as an integrated autosampler and 
enter samples in the Sample Table.

NOTE: If you add an Autosampler Inject segment to a 
method, you do not need to add events. If you want more 
control over the integrated autosampler, add the following 
events to a Step segment.

Autosampler Events

(Integrated AS 3500 Configured)

Event Description

Load Sample 

through 

Autosampler

Places autosampler injector valve and 

loop in the Load position. Loads loop 

with sample and volume you specify.

Inject Sample 

through 

Autosampler

Places autosampler injector valve and 

loop in the Inject position. Injects 

contents of autosampler loop onto the 

column.

Flush 

Autosampler

Flushes autosampler with the volume of 

flush solvent you specify.

Set Sample 

Loop to Load 

Position

Places autosampler injector valve and 

loop in the Load position.

Set Sample 

Loop to Inject 

Position

Places autosampler injector valve and 

loop in the Inject position. 
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6 NOTE: If Direct Wire Autosampler events are not listed, 
configure a direct wire autosampler.

Autosampler Events

(Direct Wire AS 3500 Configured)

Event Description

Autosampler 

Stop 

Sends a stop signal to a direct wire 

autosampler. The autosampler pauses 

at the point it receives the stop signal 

and waits for an inject signal from the 

BioCAD 700E Workstation.

AutoSampler 

Inject 

Sends an inject signal to a direct wire 

autosampler. The autosampler makes 

an injection from the next vial in the 

sample set.

Set Vial Number Associates a vial number with an 

Autosampler Inject event. 

NOTE: This event is for documentation 
purposes only. This event does not 
control the sample vial the autosampler 
injects from.
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Event Description

Display 

Message Event 

Allows you to customize a message to 

display on screen at the specified point 

in the method.

Type the time at which to display the 

message, the caption for the message 

box, the message, and the label to 

display on the command button in the 

message box. You can also set the 

event to beep and to hold the method.

Data Collection 

Start 

Sets starting point for data collection. 

The default is to start data collection at 

the start of an Inject or Autosampler 

Inject segment, or at the beginning of a 

method, if there is no Inject segment.

CAUTION: Add only one Data 
Collection Start event to a the method. If 
you add a Data Collection Start event 
after an Inject segment, data acquisition 
does not begin until after the Inject 
segment.

Hint: If you make a direct wire 
autosampler injection or a pump 
injection, add a Data Collection Start 
event in the Step segment when the 
sample is introduced. If you do not, data 
collection starts at the beginning of the 
method.

Continued
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Data Collection 

End 

Sets end point for data collection. The 

default is to end data collection at the 

end of the method.

CAUTION: Add only one Data 
Collection End event to a method. Do 
not add a Data Collection End event 
before an Inject or Autosampler Inject 
segment.

Auxiliary Out 

Event 

Sets two TTL output signals and one 

low and one high level current driver. 

For information on connecting 

terminals, see Section 5.2.10, 

Programming Event Outputs.

Auxiliary In 

Event 

Waits for specified conditions on two 

TTL input signals. see “Setting Auxiliary 

In Event conditions” on page 6-50 for 

instructions on connecting terminals 

and setting conditions.

Special Events (Continued)
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Setting fraction

collection
parameters

When you add a Start Fraction Collection event, the Fraction 

Collector Setup dialog box is displayed (Figure 6-12).

Figure 6-12  Fraction Collector Setup Dialog Box

The Fraction Collector Setup dialog box lets you specify:

• Only Collect Non-Peak Fractions 

• Only Peak Cutting

• Both Peak Cutting and Collect Non-Peak Fractions

Only Collect
Non-Peak
Fractions

If you do not select Peak Cutting, Collect Non-Peak Fractions is 

enabled by default. The fraction collector collects fractions 

based on time or volume, whether or not peaks are detected 

(Figure 6-13).

Type a Fraction Size, in ml, min, or CV (column volume).

Figure 6-13  Collect Non-Peak Fractions

Uniform fractions collected, regardless of peak detection
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Only Peak Cutting If you select only Peak Cutting, the fraction collector collects 

fractions only when a peak is detected, as specified by 

threshold and slope settings (Figure 6-14).

Type the following:

• Peak Size—Size of peak fractions to collect in min, ml, or 

CV (column volume). If actual peak exceeds the peak 

size setting, fractions are collected in multiple tubes.

• Threshold—Level in AU (absorbance units) that signals 

a peak.

• Slope—Rate of change in AU/minute that signals a peak.

NOTE: Both threshold and slope values must be exceeded to 
trigger a peak. These values are based on UV/Vis 
Channel #1 in dual-wavelength systems. When peaks are not 
detected, the diverter valve on the fraction collector is set to 
waste.

Figure 6-14  Peak Cutting

No fractions collected until peaks detected
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Both Peak Cutting

and Collect
Non-Peak
Fractions

If you select both Peak Cutting and Collect Non-Peak Fractions, 

the fraction collector collects fractions based on time or volume 

until a peak is detected (Figure 6-15).

Type the following:

• Fraction Size—Size of non-peak fractions to collect in 

ml, min, or CV (column volume)

• Peak Size—Size of peak fractions to collect in ml, min, or 

CV (column volume)

• Threshold—Level in AU (absorbance units) that signals 

a peak

• Slope—Rate of change in AU/min that signals a peak

Figure 6-15  Collect Non-Peak Fractions and Peak Cutting

Uniform fractions collected, until peaks detected
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Setting Auxiliary

In Event
conditions

When you add an Auxiliary In Event to a method, the 

Auxiliary In Event dialog box is displayed (Figure 6-16). 

Figure 6-16  Auxiliary In Event Dialog Box

The In Event signal is useful if you need to synchronize the 

method with the operation of an auxiliary device.

With this event, you can set the method to wait until the 

BioCAD 700E Workstation receives a low or high signal on 

one or both input terminals. If you select Freeze System 

Clock, the clock stops when the method reaches this event. 

Pump flow and current conditions continue. When the 

BioCAD 700E Workstation receives the specified signal, the 

method continues and the clock starts again.

To use the Auxiliary In Event method event, make the following 

connections to the auxiliary connector on the left side of the 

BioCAD 700E Workstation.

Signal BioCAD Connector Pin

Input #1—TTL Auxiliary Pins 7 (ground) and 8

Input #2—TTL Auxiliary Pins 7 (ground) and 9
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6.2.7  Using the Blend Graph

The Blend Graph is a pictorial representation of any 

buffer/solvent blends that you program in a method. Check the 

Blend Graph after creating a method to verify any buffer/solvent 

blends or gradients in your method.

To display the Blend Graph:

1. Select Blend Graph from the Display menu in the Method 

Editor. 

The Blend Graph is displayed at the bottom of the 

Method Editor window (Figure 6-17). 

Figure 6-17  Blend Graph (Percent Blend Mode)

2. To customize the Blend Graph, select Blend Graph Setup 

from the Display menu. 

The Blend Graph Setup dialog box is displayed 

(Figure 6-18).

Blend
Graph

GradientInjection
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Figure 6-18  Blend Graph Setup Dialog Box

3. Select the buffer/solvents to display.

4. Select the blend mode (Percent, pH, or Eluent) to display. 

5. To mark the Blend Graph when a new segment begins, click 

the Segments box.

6. Click OK.

Blend graph
annotations

The Blend Graph includes the following annotations:

• Segment marks—Each segment is designated by a 

number and letter. For example, the first segment in the 

first block is marked 1A, the second 1B, and so on.

• Injection marks—Injections are designated by a vertical 

blue line.
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6.2.8  Creating Prep Blocks

If you configure an integrated autosampler that supports sample 

preparation, you can add Prep blocks to a method. 

You typically add a Prep block to a method after entering the 

General Settings and adding an Equil block. You can add 

additional Prep blocks anywhere in the method, depending on 

your application. 

To add a Prep block:

1. Add sample vials to the Sample Table as described in 

Section 4.7.3, Entering Vials in Sample Table.

NOTE: You can access the Sample Table from the 
Method Editor by selecting Edit Sample Table from the 
Options menu. The changes you make are added to the 
method configuration, but not the system configuration.

NOTE: You cannot alter the Sample Table when a 
method is running. However, you can make an injection 
from the Sample Table when a method is running.

2. Click a divider line below a block in the Method Editor 

window. 

The block buttons are now active on the Method Editor 

toolbar.

3. Click the PR block button at the top of the Method Editor 

window.

The Prep Block Setup dialog box is displayed (Figure 6-19).
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Figure 6-19  Prep Block Setup Dialog Box

4. Enter the following information:

Parameter Description

Name Name assigned to the final vial. If you do not enter 

a name, the default name assigned to the final vial 

will be “Prep Block #” where # represents the 

number of the Prep block in the method. 

NOTE: After the Prep block runs, the state of the 
final vial is set to Derived. You can select this 
Derived vial by its name in subsequent Prep 
blocks or Autosampler Inject segments within the 
method.

After the entire method is complete, the state of 
all Derived vials is set to Sample, so that you can 
use the vial in subsequent methods.

Prep 

Volume

Total volume to prepare for the contents of the 

final vial. Valid range is greater than 0 and less 

than the maximum volume for the vial shape.

The total volume you enter in the Prep Volume 

text box determines the component volumes 

used to prepare the sample.

Continued
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5. Click OK.

A Prep block is added to the method, and the Prep block 

segment buttons (D, C, H/M) are now active on the 

Method Editor toolbar.

Expiration 

Time

Not available at this time.

Empty Vial 

Shape

Vial shape (Std 1800 µl, Std 2000 µl, Micro, or 

Unspecified) of the final vial and all intermediate 

vials that the Prep block creates. 

NOTE: Make sure you enter Empty vials in the 
Sample Table with this same vial shape. See 
“Entering single vials or batches of vials” on 

page 4-47.

Parameter Description
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Prep block

final vials
Each Prep block creates one final vial. The final vial is the last 

vial the Prep block creates.

The final vial name is the Prep block name. You can select the 

final vial by this name later in the method. You can select the 

final vial in any segments where you select Derived vials 

(Autosampler Inject, Dilute, Combine, or Heat/Mix segments).

After a Prep block runs, the final vial is changed to a Derived 

vial. After the method runs, all Derived vials are changed to 

Sample vials.

NOTE: You cannot use a Prep block to create more than one 
final vial. Do not add more than one Dilute segment or one 
Combine segment to a Prep block.

Prep block
intermediate vials

Prep block segments (Dilute, Combine, or Heat/Mix) create 

intermediate vials. Intermediate vials are temporary vials 

created to prepare the one final vial (for example, when making 

serial dilutions or combining samples). 

The intermediate vial name is the Prep block segment name 

plus the label “Product”. For example, if you name a Dilute 

segment “Diluted BSA”, the intermediate vial name is “Diluted 

BSA Product”. You can select intermediate vials later in the 

Prep block in any segments where you select Derived vials. You 

cannot select an intermediate vial later in the method.

After a Prep block runs, intermediate vials are changed to 

Waste vials.

NOTE: You must include the same shape of empty vials 
(Std 1800µl, Std 2000µl, Micro, or Unspecified) for the final 
vial and all intermediate vials. If a Prep block creates a final 
vial that is a Micro vial, you must include empty Micro vials 
for the intermediate vials.
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6.2.9  Creating Prep Block Segments

Overview Prep block segment buttons, at the top of the Method Editor 

window, are dimmed until you select a Prep block. Click a Prep 

block in the method, and the appropriate segment buttons are 

activated.

• D—Dilute

• C—Combine

• H/M—Heat/Mix

NOTE: Segment buttons are dimmed until you select a block. 
by default, the line below the block is selected, instead of the 
block. Display the method in Sequence view to get a more 
detailed look at the method.

6.2.9.1  Dilute Segments

You can add a Dilute segment to a Prep block only. A Dilute 

segment adds a diluent and sample in a specified ratio to the 

first Empty vial found in the Sample Table.

NOTE: Do not add more than one Dilute segment to a Prep 
block. Do not add a Dilute segment to a Prep block that 
contains a Combine segment. Because a Prep block can 
create only one final vial, the method would ignore the first 
segment.
If you need two Dilute segments or a Dilute segment and a 
Combine segment, add them to separate Prep blocks.
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To add a Dilute segment to a Prep block:

1. Click the Prep block and click the Segment D button to 

display the Dilute Segment Setup dialog box (Figure 6-20).

NOTE: If the Segment D button is dimmed, enter vials in 
the Sample Table. Select the same vial shape for Empty 
vial types in the Sample Table and for the Empty Vial 
Shape in the Prep Block Setup dialog box. Configure 
autosampler solvents; and update the method 
configuration.

Figure 6-20  Dilute Segment Setup Dialog Box

2. Select a diluent from the Diluent drop-down list box. The 

list contains the solvents you configured (AS1 through AS4) 

for the autosampler in “Autosampler solvents” on 

page 4-43. Click OK.



Creating a New Method

BioCAD® 700E Workstation User Guide 6-59

6
3. Select the type of samples to display in the Sample list box:

• Sample/Standards—Displays a list of all 

sample vials entered in the Sample Table as 

Sample, Standard, Control, or Reagent. See 

Section 4.7.3, Entering Vials in Sample Table.

• Derived—Displays a list of all Derived vials 

created by preceding Prep blocks in this 

method, and preceding segments in this Prep 

block.

4. Select a sample from the Sample list box. 

The initial concentration for the selected sample is 

displayed:

5. Type final concentration for the dilution. The BioCAD 

software uses the final concentration you enter and the 

initial concentration to determine the ratio of volumes to use 

in the dilution.

6. Type the number of steps over which to make the dilution 

in the Serial Dilution Steps text box. The number must be 

between 1 and 20. For example, if you want to make a 

1:1,000,000 dilution, and you type 3 for Serial Dilution 

Steps, the Dilute segment makes 3 dilutions of 1:100.

If you select… Initial concentration is…

Sample/Standard Concentration of 1st component 

entered in Sample Editor for 

sample.

Derived Concentration of 1st component 

listed in the Dilute or Combine 

segment that created the Derived 

sample.
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6 NOTE: Before running the method, add one empty vial to 
the autosampler tray and to the corresponding location in 
the Sample Table, for each Serial Dilution Step in each 
Dilute segment. Location of empty vials in the 
autosampler tray is not important. The autosampler finds 
the first available empty vial of the required shape.

7. Type a Segment Name to identify the purpose of the 

Dilute segment. The default name is Dilute segment. The 

segment name appears in the Status window when a 

segment is running. Intermediate vials created by this 

segment are given the segment name and the label 

“Product”.

8. Click OK.

A Dilute segment is added to the Prep block.

Hint: Add a Heat/Mix segment after a Dilute segment to 
produce a uniform mixture.
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6.2.9.2  Combine Segments

You can add a Combine segment to a Prep block only. A 

Combine segment combines multiple samples and reagents in 

the first Empty vial found in the Sample Table.

NOTE: Do not add more than one Combine segment to a 
Prep block. Do not add a Combine segment to a Prep block 
that contains a Dilute segment. Because a Prep block can 
create only one final vial, the method would ignore the first 
segment.
If you need two Combine segments or a Combine segment 
and a Dilute segment, add them to separate Prep blocks.

To add a Combine segment to a Prep block:

1. Click the Prep block and click the Segment C button to 

display the Combine Segment Setup dialog box

(Figure 6-21). 

NOTE: If the Segment C button is dimmed, enter vials in 
the Sample Table. Select the same vial shape for Empty 
vial types in the Sample Table and for the Empty Vial 
Shape in the Prep Block Setup dialog box. Update the 
method configuration.

Figure 6-21  Combine Segment Setup Dialog Box
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2. To select a sample, click the Add Sample button to display 

the Select Sample dialog box (Figure 6-22). 

Figure 6-22  Select Sample Dialog Box

3. Select the type of samples to display in the Sample list:

• Sample/Standards—Displays a list of all 

sample vials entered in the Sample Table as 

Sample, Standard, Control, or Reagent. See 

Section 4.7.3, Entering Vials in Sample Table.

• Derived—Displays a list of all Derived vials 

created by preceding Prep blocks in this 

method, and preceding segments in this Prep 

block. 

4. Select a sample then click OK. 

The sample is added to the list in the Combine Segment 

Setup dialog box. The component name and initial 

concentration for the first component entered for the 

sample in the Sample Library are also displayed.

5. Type the final concentration for the selected sample. 

This is the concentration of the component in the final 

combination.

6. To select additional samples, click the Add Sample button 

and repeat step 3 through step 5.
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7. Select a diluent from the Diluent drop-down list box. The 

list contains the solvents you configured (AS1 through AS4) 

for the autosampler in “Autosampler solvents” on 

page 4-43. Click OK.

The diluent is added if the combined percentages of 

samples do not equal 100%. When all samples and diluent 

are selected, the Ratio column displays the percentage of 

each used in the final combination.

NOTE: If the concentration for samples yields a 
combined ratio of 100%, it is not necessary to select a 
diluent. However, for best sample preparation accuracy, 
add at least 25% diluent to ensure all samples are 
flushed into the empty vial. If the concentration for 
samples yields a combined ratio of more than 100%, you 
must reduce sample concentrations.

8. Type a Segment Name to identify the function of the 

Combine segment. The default name is Combine Segment. 

The segment name appears in the Status window when a 

segment is running. Intermediate vials created by this 

segment are given the segment name and the label 

“Product”.

9. Click OK.

A Combine segment is added to the Prep block.

NOTE: Before running the method, add one empty vial to 
the autosampler tray and to the corresponding location in 
the Sample Table for each Combine segment. Location 
of empty vials in the autosampler tray is not important. 
The autosampler finds the first available empty vial of the 
required shape.

Hint: Add a Heat/Mix segment after a Combine segment 
to produce a uniform mixture.
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6.2.9.3  Heat/Mix Segments

You can add a Heat/Mix segment to a Prep block only. A 

Heat/Mix segment heats or mixes a sample vial. When a 

method includes a Heat/Mix segment, the autosampler places 

the specified sample vial in the heat chamber, and optionally 

mixes by spinning the tube using the compressed air source 

connected to the autosampler.

NOTE: Do not use plastic vials if you are using Heat/Mix 
segments in a method. Plastic vials do not conduct heat well.

Hint: Add a Heat/Mix segment after a Dilute segment or a 
Combine segment to produce a uniform mixture.

To add a Heat/Mix segment to a Prep block:

1. Set the temperature for the autosampler heat chamber in 

the Sample Preparation Configuration dialog box or from 

the Sample Table. For more information see “Sample 

heating (heat chamber)” on page 4-42 or “Controlling 

sample heating and cooling” on page 5-50. 

2. Click the Prep block and click the Segment HM button to 

display the Heat/Mix Segment Setup dialog box

(Figure 6-23).
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Figure 6-23  Heat/Mix Segment Setup Dialog Box

NOTE: If the Segment HM button is dimmed, update the 
method configuration after you enter sample vials in the 
Sample Table. See Section 4.7.3, Entering Vials in Sample 

Table.

3. Select the type of samples to display in the Sample list box:

• Sample/Standards—Displays a list of all 

sample vials entered in the Sample Table as 

Sample, Standard, Control, or Reagent. See 

Section 4.7.3, Entering Vials in Sample Table.

• Derived—Displays a list of all Derived vials 

created by preceding Prep blocks in this 

method, and preceding segments in this Prep 

block.

4. Select a sample to heat or mix from the Sample list box.

5. Type the duration for the segment.

6. To specify mixing, click the Mix check box.
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6 CAUTION
Mixing samples may denature proteins.

Hint: To mix without heating, turn off the autosampler 
heat chamber.

7. Type a Segment Name to identify the function of the 

Heat/Mix segment. The default name is Heat/Mix Segment. 

The segment name appears in the Status window when a 

segment is running. Intermediate vials created by this 

segment are given the segment name and the label 

“Product”.

8. Click OK.

A Heat/Mix segment is added to the Prep block.

9. Before running the method, check that the temperature has 

reached the set point. The Status window displays the heat 

chamber temperature.
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6.2.10  Specifying Data Storage Options

After you create a method, specify data storage options for 

storing the data files that the method creates.

To specify data storage options:

1. Select Data Storage from the Options menu in the Method 

Editor. 

The Set Data File Name and Directory dialog box is 

displayed (Figure 6-24).

Figure 6-24  Set Data File Name and Directory

2. Enable or disable Name file when run.

Hint: If you want to name the data files individually each 
time you run the method, enable Name file when run 
and click OK.

3. If you disable Name file when run, type a file name in the 

File text box. For more information, see “File naming 

conventions” on page 1-43.

4. Enable or disable Auto file extension.

If you enable Auto file extension, you can run the method 

multiple times using a single data file name. The data 

files are differentiated by their extension, starting with 

.B00 and incrementing one number for each method run. 
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6 NOTE: The maximum number of files you can generate 
using the auto file extension is 100 (00 through 99). If 
you attempt to run more than 100 files, an error message 
is displayed.

If you disable Auto file extension, the data file is given a 

.BIO extension.

CAUTION
If you disable Auto file extension and run a method 
multiple times, all data files are given the same file name 
with a .BIO extension and will overwrite each other. 

5. Specify a directory and path in which to store the data 

files. You can use the default directory (C:\BIOCAD\DATA), 

specify another directory, or create a new directory. The 

path is the location of the file within the directory tree, 

including the fine name.

Hint: To easily find data files related to specific users and 
projects, you can create subdirectories in the 
C:\BIOCAD\DATA directory.

6. To create a new directory from the Method Editor, click the 

Make Dir button to display the Set Data File and Directory 

dialog box. Type the name of a subdirectory to add to the 

C:\BIOCAD\DATA directory, then click OK. 

NOTE: You can also create directories using Windows 
Explorer. For information on creating directories, refer to 
the Microsoft Windows User’s Guide.

7. Click OK.

The data file name and directory settings are saved with 

the method.

NOTE: If you do not specify a file name for the data file, 
the data file name is DEFAULT.BIO.
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6.2.11  Specifying Print Settings

After you create a method, you can specify for the method to 

print various information after a data file is collected. This option 

allows you to automatically print information without setting up a 

custom report.

To specify print settings:

1. Select Print After Run from the Options menu. 

A check mark appears next to the command.

2. Select Print Settings from the Options menu to display the 

Print Options dialog box (Figure 6-25).

Figure 6-25  Print Options Dialog Box

3. Select any of the following Print Options:

• Chromatograms—Prints the data file chromatograms 

without baselines

• Method—Prints the method as it appeared when the 

data was collected

• Configuration—Prints the method configuration

• Event Log—Prints the Event Log (.EVL) for the data 

file
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4. Select the Chromatogram Orientation:

• Portrait—Page is vertical when you view the 

chromatogram upright

• Landscape—Page is horizontal when you view 

the chromatogram upright

5. Click the Chrom Setup button to display the Display 

Settings dialog box. 

Figure 6-26  Display Settings Dialog Box

6. Set the data channels displays, axes, ranges, and colors as 

desired, then click OK.

7. Click OK.

The print settings are saved with the method. The 

options you selected will print each time the method runs.
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6.2.12  Specifying Analysis and

 Printing After Run

After you create a method, you can specify automatic analyzing 

and printing after the method run. For information on setting 

analysis parameters, see the Data Analysis User’s Guide.

NOTE: The data file will be analyzed with the analysis 
parameters embedded within the method (.MET) file.

To automatically analyze data files created by the method run:

1. Select Analyze and Print Report After Run from the 

Options menu in the Method Editor window. 

A check mark appears next to the command.

2. Select Analysis Setup from the Options menu.

The Analysis Setup dialog box is displayed (Figure 6-27). 

Figure 6-27  Analysis Setup Dialog Box

3. Select up to three data channels (UV #1, UV #2, or 

Auxiliary) to analyze.
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4. To print a chromatogram in addition to a report, select 

Print Chromatogram.

5. Click OK and save the method.

After you run the method, the following occur:

• The generated data file is automatically analyzed, 

using the analysis parameters (.MTH) embedded in 

the method file.

• A report (and optionally a chromatogram) prints, 

using the report format parameters (.RPT) 

embedded in the method file.

6.2.13  Saving Methods

To save a method, select Save or Save As from the File menu.

Methods are saved as separate files with an .MET extension. 

Methods are also saved in the data files (.B*) created by the 

method.
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66.3  Creating Typical Methods

This section describes the following:

• Creating a simple method

• Making autoloader injections in a method

• Making direct autoloader injections in a method

• Making manual injections in a method

• Making pump injections in a method

• Making integrated autosampler injections in a method

• Making direct wire autosampler injections in a method

6.3.1  Creating a Simple Method 

This section provides an example of the General Settings, 

blocks, segments, and events in a simple, typical method. For 

detailed descriptions of creating each method part, see Section 

6.2, Creating a New Method.

To create a simple, typical method:

Method Editor
and General

Settings

1. Display the Method Editor by selecting Method Editor 
from the Window menu.

2. For a detailed view of the method, select Sequence View 

from the Display menu.

3. Double-click the General Settings line to display the 

General Settings dialog box (see Figure 6-5 on page 6-15).

4. Type flow rate and wavelengths. Select column state 

(selections depend on column configuration). Click Inline to 

place the pH and conductivity monitors inline. Click OK.

CAUTION
If you are using organic solvents, click Bypass to take 
pH and conductivity monitors out of line before running.
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Equil block 1. Click the EQ button to add an Equil block. 

2. Click the Equil block line and click the P button to add a 

Purge segment to the Equil block. 

The Purge Segment Setup dialog box is displayed

(see Figure 6-9 on page 6-25).

3. Specify purge blend, flow rate, and volume. Select a 

column under Flow Direction at end of Purge. Click OK.

The Purge segment is added to the Equil block.

4. Click the S button to add a Step segment to the Equil block.

The Step Segment Setup dialog box is displayed

(see Figure 6-7 on page 6-20). The blend settings are the 

same as those you entered in the Purge segment.

5. Enter a buffer/solvent blend for equilibrating the column 

and type a duration (minutes, ml, or CV).

Hint: Change the Segment Name to Equilibrate 
Column. If you do not change the segment name, it is 
labeled Step Segment in the method. Click OK.

The Step segment is added to the Equil block.

NOTE: Step 6 through step 8 are optional, but 
recommended.

6. Click the Equilibrate Column Step segment and click the 

Add Event button to display the Add Event dialog box.

7. Scroll down to the Detector Event Types, select Zero UV 
Detector, and click Add.

The Zero UV Detector dialog box is displayed. 

8. Type a duration (minutes, ml, or CV) that corresponds to 

the end of the Equilibrate Column Step segment. Click OK.

This event zeroes the detector after the column is 

equilibrated, but before you make an injection.
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Load block 1. Click the line below the Equilibrate Column Step segment 

and click the L button to add a Load block.

2. Click the Load block line and click the I button to add an 

Inject segment. 

The Inject Segment Setup dialog box is displayed

(see Figure 6-10 on page 6-28). 

3. Select an injection mode and type an injection amount. 
Click OK.

The Inject segment is added to the Load block.

NOTE: You can use Inject segments to make autoloader, 
direct autoloader, and manual injections. If you make a 
pump or direct wire autosampler injection, use a Step 
segment. If you make an integrated autosampler 
injection, use an Autosampler Inject segment. 
For more information, see the following sections on 
making injections in a method.

Wash block 1. Click the line below the Inject segment and click the 

W button to add a Wash block.

2. Click the Wash block line and click the S button to add an 

Step segment. 

The Step Segment Setup dialog box is displayed

(see Figure 6-7 on page 6-20). 

3. Leave the blend conditions you entered in the Equil block. 

Type a duration (minutes, ml, or CV) for the wash. Click 

OK.

The Step segment is added to the Wash block.
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Elute block 1. Click the line below the Step segment and click the EL 

button to add an Elute block.

2. Click the Elute Block line and click the G button to add a 

Gradient segment. 

The Gradient Segment Setup dialog box is displayed 

(see Figure 6-8 on page 6-23).

3. Select starting and ending buffer/solvent blends for the 

gradient and type a duration (minutes, ml, or CV). 

Click OK.

4. Click the S button to add a Step segment.

The Step Segment Setup dialog box is displayed (see 

Figure 6-7 on page 6-20). The blend settings are the 

same as those you entered in the Gradient segment.

5. Enter the ending buffer/solvent blend used in the 

gradient and type a duration (minutes, ml, or CV) to hold 

the blend. Change the Segment Name to Hold Gradient. 
Click OK.

NOTE: When the method runs, the Hold Gradient Step 
segment holds the ending gradient conditions for the 
specified time. 
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6.3.2  Making Autoloader 

Injections in a Method

Before
you begin

Before you run a method that makes an autoloader injection:

• Prepare up to four samples. For more information, see 

Section 3.3.1, Preparing Samples for Autoloader 

Injections (Small Vessels) or Section 3.3.2, Preparing 

Samples for Autoloader Injections (Large Vessels).

• Configure the autoloader. For more information, see 

Section 4.2.3, Configuring the Autoloader.

Creating
the method

The following table outlines the General Settings, blocks, 

segments, and events to add to a method to make an 

autoloader injection.

General Settings

Specify a flow rate, wavelength, initial column state, and 

initial detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, 

flow rate, and volume.

Step • Specify a buffer/solvent blend and 

duration to equilibrate the column. 

• Add a Zero UV Detector event at 

the end of the segment.

Load Inject • Select sample channel 1, 2, 3, or 4 

and type an injection amount.

• Add a Flush Sample Loader or 

Prime Sample Loader event at the 

start of the segment.
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6.3.3  Making Direct Autoloader 

Injections in a Method

Before
you begin

Before you run a method that makes a direct autoloader 

injection:

• Prepare your sample. For more information, see Section 

3.3.3, Preparing Samples for Direct Autoloader 

Injections.

• Configure the autoloader. For more information, see 

Section 4.2.3, Configuring the Autoloader.

Creating
the method

The following table outlines the General Settings, blocks, 

segments, and events to add to a method to make a direct 

autoloader injection.

General Settings

Specify a flow rate, wavelength, initial column state, and initial 

detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, flow 

rate, and volume.

Step • Specify a buffer/solvent blend and 

duration to equilibrate the column. 

• Add a Zero UV Detector event at the 

end of the segment.

Load Inject • Select Direct Autoload and select a 

sample from the Sample Library by 

double-clicking the Sample text box. 

Type an injection amount.

• Add a Prime Sample Loader event at 

the start of the segment.

NOTE: To conserve sample, you can also 
prime from the Sample menu.
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6.3.4  Making Manual Injections in a Method

Before
you begin

Before you run a method that makes a manual injection, 

prepare your sample. For more information, see Section 3.3.4, 

Preparing Samples for Manual Injections.

NOTE: When making manual injections, Autoloader 
configuration does not matter.

Creating
the method

The following table outlines the General Settings, blocks, 

segments, and events to add to a method to make a manual 

injection.

General Settings

Specify a flow rate, wavelength, initial column state, and 

initial detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, 

flow rate, and volume.

Step • Specify a buffer/solvent blend and 

duration to equilibrate the column.

• Add a Zero UV Detector event at 

the end of the segment.

Load Inject Select Manual Load and select a 

sample from the Sample Library by 

double-clicking the Sample text box. 

Type an injection amount.

NOTE: When making manual injections, 
there are no sample lines to prime.

NOTE: When you run a method containing a Manual Load 
injection, the method pauses at the point of injection and 
prompts you to make the injection. After you make the 
injection, click OK or press the Event Mark button on the 
front panel, and the method resumes. 
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6.3.5  Making Pump Injections in a Method

Before
you begin

Before you run a method that makes a pump injection:

• Prepare your sample. For more information, see Section 

3.3.5, Preparing Samples for Pump Injections.

• Prime the buffer/solvent sample line. For more 

information, see Section 3.4.4, Priming Buffer/Solvent 

Sample Lines for a Pump Injection.

• Configure the buffer/solvent channel that you are using 

for your sample as type Sample. For more information, 

see Section 4.2.2, Configuring Buffers/Solvents, and 

Section 4.5.1, Customizing the Buffer/Solvent Library.

NOTE: When making pump injections, Autoloader 
configuration does not matter.

Creating the
method

The following table outlines the General Settings, blocks, 

segments, and events to make a pump injection.

General Settings

Specify a flow rate, wavelength, initial column state, and 

initial detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, 

flow rate, and volume.

Step • Specify a blend and duration to 

equilibrate the column. 

• Add a Zero UV Detector event at the 

end of the segment.

Continued
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6 Block Segment Settings and Events

Load Step • Select the buffer/solvent channel 

and set to 100%.

Hint: Use the blending feature to 
make dilutions of your sample. For 
example, type 80% for the sample 
channel and 20% for a channel 
containing water or equilibration 
buffer.

• Type a duration (ml, min, or CV) for 

injection volume.

NOTE: If you type duration in 
minutes, the injection volume is 
equal to flow rate (ml/min) x 
duration of segment (min).

• Add a Data Collection Start Event at 

the start of the segment.
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6.3.6  Making Integrated Autosampler 

Injections in a Method

Before
you begin

Before you run a method that makes an integrated autosampler 

injection:

• Prepare your samples and the integrated autosampler. 

For more information, see Section 3.6, Preparing an 

Autosampler.

• Configure an integrated autosampler and enter samples 

in the Sample Table. For more information, see Section 

4.7, Configuring and Preparing the BioCAD Software for 

an Integrated Autosampler.

Creating the
method

The following table outlines the General Settings, blocks, 

segments, and events to add to a method to make an integrated 

autosampler injection.

General Settings

Specify a flow rate, wavelength, initial column state, and 

initial detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, 

flow rate, and volume.

Step • Specify a buffer/solvent blend and 

duration to equilibrate the column. 

• Add a Zero UV Detector event at 

the end of the segment.

Load Auto-

sampler 

Inject 

• Select a sample from the Sample 

list box and type an injection 

amount.

• Enable Flush Loader if appropriate 

for your application.
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6.3.7  Making Direct Wire Autosampler 

Injections in a Method

Before
you begin

Before you run a method that makes a direct wire autosampler 

injection:

• Prepare your samples, the autosampler method, and the 

direct wire autosampler. For more information, see 

Section 3.6, Preparing an Autosampler.

• Configure a direct wire autosampler. For more 

information, see Section 4.8, Configuring and Preparing 

the BioCAD Software for a Direct Wire Autosampler.

Creating the
method

The following table outlines the General Settings, blocks, 

segments, and events to add to a method to make a direct wire 

autosampler injection.

General Settings

Specify a flow rate, wavelength, initial column state, and 

initial detector state appropriate for your application.

 Block Segment Settings and Events

Equil Purge Specify an appropriate purge blend, 

flow rate, and volume.

Step • Specify a buffer/solvent blend and 

duration to equilibrate the column. 

• Add a Zero UV Detector event at 

the end of the segment.

Load Step • Add an Autosampler Inject event at 

0.0 minutes.

• Add a Data Collection Start Event 

at 0.01 minutes.
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6 6.4  Opening an Existing Method

This section describes:

• Opening a method from a method file

• Opening a method from a data file

6.4.1  Opening a Method From a Method File

To open a method from a method file: 

1. Display the Method Editor by selecting Method Editor 
from the Window menu.

2. Select Open from the File menu to display the Open File 

dialog box. 

3. Select a method file (.MET) to open and click OK.

NOTE: To open a method file created in a multi-method, 
type *.G* in the File Name text box to display .G## files.

Configuration
Mismatch

When you open an existing method, the Configuration Mismatch 

dialog box (Figure 6-28) is displayed if the method configuration 

is different from the current system configuration. 

Figure 6-28  Configuration Mismatch Dialog Box
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The Configuration Mismatch dialog box displays the settings for 

each configuration item in the system configuration and the 

method configuration. Use this dialog box to compare the two 

configurations. For more information on system and method 

configurations, see “System versus method configuration” on 

page 4-3.

You can:

• Click Update Method Configuration to change the 

method configuration to match the current system 

configuration

• Click Do Not Update Method Configuration to ignore 

the system configuration and leave the method 

configuration unchanged 

NOTE: If you select Do Not Update Method Configuration, 
the method configuration does not match the system 
configuration. The system configuration will be used when 
you run the method.

Do not run the method unless you change the system 
configuration to match the method configuration. You can edit 
the system configuration or load the method configuration as 
the system configuration. For more information, see 
Section 4.4, Loading an Existing Configuration.

Event warnings You will also see warning messages if:

• The method contains events that do not apply to the 

current system configuration.

• The Buffer Duration for the Strip Chart Recorder (set in 

the Configuration dialog box) is shorter than the method 

run time.

• Files names created by the method will overwrite existing 

files on your hard disk.

• The method requires a sample name or a sample volume 

that is not available in the system configuration.

If an error message occurs, you can accept or edit the events.
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6.4.2  Opening a Method From a Data File

Data files (.B*) that were created by a method run always 

contain the method used to create them. 

NOTE: Data files that you save from the Strip Chart Recorder 
do not contain a method.

To open the method file associated with a data file:

1. Display the Method Editor by selecting Method Editor 
from the Window menu.

2. Select Open from the File menu to display the Open File 

dialog box. 

3. Select Data Files (*.B*) from the List Files of Type 

drop-down list box.

No files are listed because you are looking at the 

methods directory instead of the data directory.

4. To change the directory, double-click the biocad folder in 

the Directories list box.

All subdirectories in the biocad directory are now 

displayed. 

5. Double-click the data folder.

All data files are listed.

6. Select a data file, then click OK.

If the configuration stored with the method is different 

from the current system configuration, the Configuration 

Mismatch dialog box is displayed. For more information, 

see “Configuration Mismatch” on page 6-84.

7. Click Do Not Update Method Configuration. 

The Method Editor displays the method associated with 

the selected data file.

Editing and
saving

You can edit a method associated with a data file, but you 

cannot save it to the same file name. You must save it under a 

new file name.
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66.5  Editing a Method

After you open a method, you can edit, delete, copy, or move 

method components. After you make changes you can save the 

method.

Editing To edit a method:

1. Double-click blocks, segments, or events to display the 

original dialog box used to create the block, segment, or 

event. 

NOTE: If you adjust the duration of a segment that 
contains an event at the end of the segment, the software 
automatically adjusts the timing of the event to the end of 
the segment. You do not have to manually change the 
event time to the end of the segment.

2. Make changes in the dialog box and click OK. 

Deleting To delete a block, segment, or event:

1. Select the item to delete.

2. Select Cut Block, Cut Segment, or Cut Event from the 

Edit menu.

NOTE: When you perform an operation from the Control 
Panel, such as turning off the pump, an event is added to 
the method in a data file. This event is flagged with an 
asterisk (*) and a plus sign (+), and you cannot delete it 
using Cut Event.

To delete this type of event, first save the file as a 
method file (.MET) by selecting Save As from the File 
menu.
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Copying To copy a block, segment, or event to another point in the 

method:

1. Select the item to copy.

2. Select Copy Block, Copy Segment, or Copy Event from 

the Edit menu. 

3. Click the location in the method where you want to copy the 

item.

4. Select Paste Block, Paste Segment, or Paste Event from 

the Edit menu.

Moving To move a block, segment, or event from one point to another in 

the method:

1. Select the item to move.

2. Select Cut Block, Cut Segment, or Cut Event from the 

Edit menu.

3. Click the location in the method where you want to move 

the item.

4. Select Paste Block, Paste Segment, or Paste Event from 

the Edit menu. 

CAUTION
Do not cut or copy another item until you paste the 
current item into its new location. If you do so, the 
original item is permanently deleted.

Saving When you have made all changes, save the method:

1. Select Save As from the File menu.

The Save File dialog box is displayed.

2. Type a file name and click OK.

3. To close the Method Editor, double-click the Control Menu 

box in the top left corner of the window.
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66.6  Running a Method

Overview To run a method:

• Load a configuration (optional)

• Open a method

• Specify settings (optional)

• Run the method

• Stop and resume a method (optional)

6.6.1  Loading a Configuration

When to load a
configuration

The BioCAD 700E Workstation uses the system configuration 

when you run a method.

To run a method using a configuration other than the current 

system configuration, load a configuration from a configuration 

file (.CFG), method file (.MET), or data file (.B*).

NOTE: If you load a configuration or change the current 
system configuration while a method is running, the running 
method and all methods in the Method Queue abort.

Loading a
configuration

To load a configuration from a configuration file, method file, or 

data file:

1. Select Open Configuration from the from the Control 

Panel File menu.

The Open File dialog box is displayed. 

2. Select Config Files (*.CFG), Method Files (*.MET), or 

Data Files (*.B*) from the List Files of Type drop-down list 

box.

3. Double-click the biocad folder in the Directories list box to 

display configuration files (.CFG). Double-click the 

methods folder to display method files (.MET) or 

double-click the data folder to display data files (.B*).
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4. Select a configuration file, method file, or data file, then 

click OK. 

The configuration settings associated with the selected 

file are loaded as the system configuration.

5. Check the physical setup of the BioCAD 700E Workstation 

and make sure it matches the system configuration. If 

necessary, change the physical configuration or the system 

configuration as appropriate for the method.

6.6.2  Opening a Method

For information on opening a method, refer to one of the 

following sections:

• Section 6.4.1, Opening a Method From a Method File

• Section 6.4.2, Opening a Method From a Data File

6.6.3  Specifying Settings

Each method has the following settings saved with it. To change 

these settings, see the appropriate section:

• Data Storage Options—See Section 6.2.10, Specifying 

Data Storage Options

• Print Settings—See Section 6.2.11, Specifying Print 

Settings

• Analysis Parameters—See the Data Analysis User’s 
Guide
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6.6.4  Running a Method

This section describes:

• Running a method

• Running a method STAT

• Making manual injections

• Viewing the run status 

Running a
method

You can run a method from two windows:

• Control Panel—Select Run Method from the File menu, 

then select the method file (.MET) to run.

NOTE: If the configuration stored with the method is 
different from the current system configuration, the 
Configuration Mismatch dialog box is displayed. For 
more information, see “Configuration Mismatch” on 

page 6-84.

• Method Editor—Select Run Method from the File menu 

to run the method currently displayed in the Method 

Editor window.

Hint: This is the easiest way to test a new method, 
because you do not have to save the method.

NOTE: When you run a method from the Method 
Editor, the method uses the settings displayed in the 
Method Editor window, even if you have not saved the 
changes.
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Running a

method STAT
You can send a method to run as soon as possible by selecting 

Run Method Stat from the File menu in the Control Panel. The 

method you select is added to the beginning of the Method 

Queue, and runs as soon as the currently running method is 

complete.

NOTE: A STAT method runs using the system configuration. 
If your STAT method requires a different configuration, stop 
the currently running method, load the appropriate 
configuration, then run the STAT method.

If a multi-method is in process when you add a method to the 

beginning of the queue, the method runs as soon as the current 

method in the multi-method is complete.

Making manual
injections

If you are making manual injections, the method pauses at the 

Inject segment and prompts you to make an injection. 

To make the manual injection:

1. Insert the needle port adaptor in port 6 of the injection 

valve.

2. Load a syringe with your sample.

3. Insert the syringe in the needle port adaptor and inject the 

sample (see Figure 5-22 on page 5-41).

4. Click OK or press the Event Mark button on the front panel.

The method resumes.

Viewing the
run status

You can view the status of a method run from three windows:

• Method Queue—Displays all methods that are waiting to 

run. For more information, see Section 8.1, Using the 

Method Queue.

• Status Window—Displays information about the pump, 

detector, fraction collector, and the running method. For 

more information, see Section 8.2, Using the Status 

Window.

• Strip Chart Recorder—Displays data as it is acquired. 

Can also display events. For more information, see 

Section 8.3, Using the Strip Chart Recorder.
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6.6.5  Stopping and Resuming a Method

There are three ways to stop a method:

• Hold

• Stop pump

• Abort

To stop a
method …

Description
To resume the 

method …

Click the Hold 

button in the 

Method section of 

the Control Panel

Suspends the method and freezes the 

workstation in its present state, with the 

pump running.

If a gradient is running, conditions do not 

change. You can perform manual actions 

from the Control Panel, such as 

replenishing buffers and priming lines.

Click the Resume 

button in the 

Method section of 

the Control Panel.

Stop the pump by 

clicking the Stop 

button in the 

Pump section of 

the Control Panel 

or by pressing the 

Pump button on 

the front panel of 

the workstation

Suspends the method and freezes the 

workstation in its present state, with the 

pump off.

Start the pump to 

resume the 

method. Click the 

Start button in the 

Pump section of 

the Control Panel 

or press the Pump 

button on the front 

panel of the 

workstation.

Click the Abort 

button in the 

Method section of 

the Control Panel 

or click the Abort 

button in the 

Method Queue

Clears the method and shuts down the 

pump. All methods are cleared from the 

Method Queue.

Data files contain data acquired up to the 

time you click Abort.

NOTE: To delete unwanted data files after 
clicking Abort, use Windows Explorer. For 
more information, refer to the Microsoft 
Windows User’s Guide.

You cannot 

resume a method 

after aborting it. 

You must run the 

method again.
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7.1  Creating and
Running Templates

This section includes:

• Overview

• Using templates and systematic method development

• Viewing the Method Queue

• Viewing the Status window

• Viewing data files and group files

• Stopping a template

Overview A BioCAD template is a predefined program that you set up to 

perform a sequence of method runs in which one or more 

parameters change from run to run. 

BioCAD templates include:

• pH Map—Changes pH

• Loading Study—Changes injection volume

• Linear Gradient—Changes gradient slope

• Flow Rate Study—Changes flow rate

• Auto Cycling—Runs the method multiple times

• Column Switching—Changes columns

• Analysis (Integrated Autosampler)—Changes the 

sample that is injected and the number of injections

• Analysis (Direct Wire Autosampler)—Documents the 

autosampler vial number and injection number in the 

method and data files

• Step Optimization—Changes blending conditions for 

column equilibration and step elution

• Combinatorial Optimization—Changes up to six 

parameters

For more information on the Column Switching template, see 

the SCOUT Column Selector User’s Guide. For more 

information on remaining templates, see the following sections. 
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Using templates
for systematic

method
development

The following procedure is a general description of how to use 

templates for systematic method development. For information 

on creating and running specific templates, see the following 

sections.

1. Open or create a method as described in Chapter 6, 

Creating and Running Methods.

2. Select a template from the Templates menu in the Method 

Editor window. 

The template dialog box is displayed.

3. Enter values for the parameter you wish to vary.

4. Click Run.

The method runs multiple times, changing the specified 

parameter each time.

5. When the template is complete, use the Group Analysis 

window to examine the data files from the template.

6. Select the data file with the optimized separation, then 

select Open Method from the File menu. 

The method that generated the optimized separation is 

displayed. It contains the optimized run conditions.

7. Set up the next template of interest, run the template, and 

examine the data files in the Group Analysis window. Select 

the optimized separation, open the method, and continue 

with the next template.

Templates and
autosampler

injections

NOTE: The following does not apply to the Analysis template.

When you run a template on a method containing an 

Autosampler Inject segment, the autosampler injects from the 

sample vial you select in the Sample list box. If the sample 

volume in the vial is insufficient to make the injection, the 

system:

• Automatically injects from another vial with the same 

sample name and sufficient volume (if one exists)

• If there is no vial with sufficient volume, the software 

displays a warning. Click OK to reduce the injection 

volume for the current method run of the template. Click 

Cancel to cancel the template.
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Viewing the
Method Queue

After you start a template run, view the Method Queue to see a 

listing of all the methods in the template. To view the Method 

Queue, select View Method Queue from the File menu in the 

Control Panel. 

For more information, see Section 8.1, Using the Method 

Queue.

Viewing the
Status window

After you start a template run, view the Status window to see the 

status of the template run. The Status window indicates that a 

method is running. It displays the method file name, data file 

name, and sequence (#/#) of the currently running method. 

For more information, see Section 8.2, Using the Status 

Window.

Viewing
data files and

group files

After the template run is complete, use the Group Analysis 

window to view the data files (.B##) and group file (.GRO) that 

the template creates. 

A data file (chromatogram) is created for each method run in the 

template. All data file names are the same. The data file name is 

the name you specified for data files before running the 

template method, with a .B## extension, beginning with B00 

and incrementing one digit for each run.

NOTE: The maximum number of data files you can generate 
using a template is 100 (.B00 through .B99).

One group file is created for the template run. It contains a list of 

all data files that the template generates. The group file name is 

the same as the data file names, but with a .GRO extension.

If you run more than one template with the same data file name, 

all data files are added to the same group file. New files are 

added to the end of the group file.

For more information, see the Data Analysis User’s Guide.

Stopping a
template

You can stop a template the same way you stop a method. You 

can hold the method, stop the pump, or abort the method.

For more information, see Section 6.6.5, Stopping and 

Resuming a Method.
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7.1.1  pH Map Template

Overview A pH Map template allows you to make a sequence of runs, 

each containing the same eluent gradient. The buffer/solvent pH 

changes from run to run.

NOTE: The buffer/solvent pH does not change within a run.

The pH Map Template dialog box is shown in Figure 7-1.

Figure 7-1  pH Map Template 

The following sections describe:

• Buffer/Solvent requirements

• Configuration requirements

• Method requirements

• Creating and running a pH Map template
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7.1.1.1  Buffer/Solvent Requirements

Before running a pH Map template, prepare four 

buffers/solvents:

• Two pH blend buffers (anion or cation)

• A salt solution

• Water

There are three types of pH blend mode buffers you can 

prepare:

• pH Blend Buffers—Special anion or cation pH buffers 

for which the workstation is already calibrated. These 

buffers exist in the Buffer/Solvent Library. Recipes for 

these buffers appear on page 3-21. You specify a pH 

value in the pH Map template. The BioCAD software then 

calculates the percent of each buffer needed to achieve 

the desired pH.

• Custom pH Blend Buffers (Calibrated)—Any other 

pair of pH buffers can be used for pH blending. You must 

calibrate custom buffers using the Calibrate pH Mode 

Buffers feature. (For more information, see Section 5.2.9, 

Calibrating Custom pH Blend Buffers.) You must add 

these buffers to the Buffer/Solvent Library. You specify a 

pH value in the pH Map template. The BioCAD software 

then calculates the percent of each buffer needed to 

achieve the desired pH.

• Custom pH Blend Buffers (Uncalibrated)—Any 

other pair of pH buffers can be used for pH blending. You 

must add these buffers to the Buffer/Solvent Library. You 

specify a percentage value in the pH Map template.
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7.1.1.2  Configuration Requirements

Before running a pH Map template, configure the four 

buffers/solvents as follows:

If you are 

using …
Then configure … As Type …

pH Blend 

Buffers

Anion Buffer - pH 6.0 + 100.0 mM Tris/bis-Tris propane

OR

Cation Buffer - pH 4.5 + 100.0 mM MES/HEPES/Acetate Buffer

Anion Buffer - pH 9.0 + 100.0 mM Tris/bis-Tris propane

OR

Cation Buffer - pH 7.5 + 100.0 mM MES/HEPES/Acetate Buffer

NaCl + 3000.0 mM NaCl Eluent

H2O H2O

Calibrated 

Custom pH 

Blend 

Buffers

OR

Uncalibrated

Custom pH 

Blend 

Buffers

pH Buffer 1 (anion or cation) Buffer

pH Buffer 2 (anion or cation) Buffer

Salt solution Eluent

Water H2O

NOTE: For information on configuring buffers/solvents as different types, see 
Section 4.2.2, Configuring Buffers/Solvents, and Section 4.5.1, Customizing the 

Buffer/Solvent Library.
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7.1.1.3  Method Requirements

The method requirements for a pH Map template depend on the 

buffers/solvents you use. The following sections describe pH 

Map template method requirements for:

• Calibrated pH buffers

• Uncalibrated pH buffers

Using
calibrated
pH buffers

To run a pH Map template, your method must include at least 

one segment programmed in pH blend mode. TheTable 7-1 lists 

guidelines for creating a method for use with a pH Map 

template, using either of the following calibrated pH buffers:

• pH blend buffers

• Calibrated Custom pH buffers

NOTE: If you use either of the above calibrated pH buffers, 
you can run one of the sample methods, ANIONPH.MET or 
CATPH.MET, to run a pH Map template. The sample methods 
are provided in Appendix D, BioCAD 700E Sample Methods. 
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Table 7-1   Method Guidelines for a pH Map Template Using Calibrated pH Buffers

Block Segment Settings

General

Settings

Appropriate for your application

Equil Purge 1. Click Setup and select pH blend mode.

2. Set the blend concentration for your application.

3. Set pH within the range of the buffers used.

4. Set flow rate and volume for your application.

5. Set column inline after purge.

Step 

(equilibrates)

1. Leave blend settings as is.

2. Set the duration to 10 CV.

Add Event Zero UV Detector at 10 CV.

Load Inject 1. Select a sample channel.

2. Set the injection volume.

Wash Step Set a duration appropriate for your application.

Elute Gradient 1. Leave Blend settings as is.

2. Enter the starting and ending eluent 

concentrations. For information on valid eluent 

concentration range, see “pH mode” on page 5-11.

3. Enter a gradient duration.

NOTE: The Gradient segment within each method runs 
an eluent gradient, not a pH gradient.

Step

(holds gradient 

at final 

conditions)

1. Leave Blend settings as is.

2. Set the duration to 5 CV.
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Using
uncalibrated

pH buffers

To run a pH Map template, your method must include at least 

one segment programmed in pH blend mode. Table 7-2 lists 

guidelines for creating a method for use with a pH Map 

template, using uncalibrated Custom pH buffers.

Table 7-2   Method Guidelines for a pH Map Template Using Uncalibrated pH Buffers

Block Segment Settings

General

Settings

Appropriate for your application

Equil Purge 1. Click Setup and select pH blend mode.

2. Set the blend concentration for your application.

3. Set a percent (%) value that represents the desired 

pH value. See “Understanding percent value in pH 

blending” on page 7-11 for an example of how 

percent value relates to pH value.

4. Set flow rate and volume for your application.

5. Set column inline after purge.

Step

(equilibrates)

1. Leave blend settings as is.

2. Set the duration to 10 CV.

Add Event Zero UV Detector at 10 CV.

Load Inject 1. Select a sample channel.

2. Set the injection volume.

Wash Step Set a duration appropriate for your application.

Elute Gradient 1. Leave Blend settings as is.

2. Enter the starting and ending eluent 

concentrations. For information on valid eluent 

concentration range, see “pH mode” on page 5-11.

3. Enter a gradient duration.

NOTE: The Gradient segment within each method runs 
an eluent gradient, not a pH gradient.
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Understanding

percent value
in pH blending

The percent (%) value you enter in a method segment or in the 

pH Map template corresponds to the pH of the two buffers.

For example, you use two buffers of pH 6 and pH 8. To set the 

pH blend map for pH 7, enter 50% (50% of pH 6 and pH 8 is 

approximately pH 7). The titration curve of the buffers affects 

the actual pH achieved.

Below is another example using buffers from pH 4 to pH 5:

NOTE: Because the software assumes a linear correlation 
between the two pH buffers, pH values achieved using this 
method are approximate. The pH Map template is designed 
to illustrate different chromatographic results at varying pH 
values, not to deliver precise pH conditions.

Elute

(cont’d)

Step

(holds gradient 

at final 

conditions)

1. Leave Blend settings as is.

2. Set the duration to 5 CV.

Block Segment Settings

pH 6 pH 8
pH 7 pH 7.5

50 % 75 %0% 100 %

Buffers Enter % … To achieve pH …

pH 4 and pH 5 10% 4.1

20% 4.2

30% 4.3
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7.1.1.4  Creating and Running a pH Map Template

To create and run a pH Map template:

1. Prepare and configure your buffers.

For more information, see Section 7.1.1.1, Buffer/Solvent 

Requirements, and Section 7.1.1.2, Configuration 

Requirements.

2. Open the Method Editor by selecting Method Editor from 

any Window menu.

3. Create or open a method by selecting Open from the File 

menu.

For more information, see Section 7.1.1.3, Method 

Requirements.

NOTE: If you are using pH blend buffers or calibrated 
custom pH buffers, you can use one of the sample 
methods, ANIONPH.MET or CATPH.MET, to run your pH 
Map template. If you use calibrated custom pH buffers, a 
Configuration Mismatch dialog box appears, because the 
buffers in the method do not match the buffers 
configured. If you click Yes to update the method with 
current system configuration, you can use the sample 
method to run a pH Map template.

4. Select pH Map from the Template menu.

The pH Map Template dialog box is displayed. The dialog 

box displayed depends on the type of pH buffers you 

configured (Figure 7-2).
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Figure 7-2  pH Map Template

5. Type pH or percent (%) values in the text boxes for each 

buffer pH value at which you want to run your method.

6. Click Run to run the template.

NOTE: When you run a pH Map template and enter a 
percent instead of a pH value, the actual pH is still 
measured and plotted in the Strip Chart Recorder and 
data file.

Using pH Blend Buffers
or Calibrated Custom pH Buffers

Using Uncalibrated
Custom pH Buffers

If you are using … Enter …

pH Blend Buffers pH values within the range of the buffers used.

Calibrated Custom 

pH Blend Buffers

pH values within the range of the buffers used.

Uncalibrated 

Custom pH Blend 

Buffers

Percent (%) values that represents the desired pH 

value. See “Understanding percent value in pH 

blending” on page 7-11 for examples of how percent 

value relates to pH value.
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7.1.2  Loading Study Template

The Loading Study template allows you to change the sample 

injection volume during multiple runs of the same method.

Method
requirements

Your method must contain a Load block with either an Inject (I), 

Autosampler Inject (AI), or Step (S) segment. The Loading 

Study template runs on only the first segment in the first Load 

block in a method. 

The following table describes the segment to use with each 

injection mode.

Creating and
running

To create and run a Loading Study template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Make sure your 

method meets the requirements listed in above.

2. Select Loading Study from the Templates menu in the 

Method Editor window.

The Loading Study Template dialog box is displayed 

(Figure 7-3). The minimum and maximum loading range 

is displayed.

NOTE: If you use a Step segment to make a pump 
injection, the loading range is unlimited. 
For other injection modes, the loading range is a function 
of syringe size, and the injection volume is a function of 
sample loop size. For example, using a 5 ml syringe and 
a 2 ml loop allows you to load up to 5 ml, but inject only 
2 ml. You can overfill the sample loop. For full loop 
injections, overfill the sample loop by a factor of three.

Injection mode Method Segment

Autoloader or direct autoloader Inject (I)

Integrated autosampler Autosampler Inject (AI)

Pump Step (S)
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Figure 7-3  Loading Study Template

3. Type up to nine loading values in the text boxes.

NOTE: The units used for the loading values depend on 
the duration units (minutes, ml, µl, or CV) you select in 
the method segment. For example, if you make a pump 
injection, and you add a Step segment to a method 
programmed in minutes, the Loading Study dialog box 
allows you to enter a loading time (minutes) instead of an 
injection volume.

4. Click Run. 

5. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template is executed.
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7.1.3  Linear Gradient Template

The Linear Gradient template allows you to change the slope of 

a gradient elution during multiple runs of the same method.

Method
requirements

Your method must contain an Elute block with a Gradient 

segment. The Linear Gradient template runs on only the first 

Gradient segment in the first Elute block in a method.

The Linear Gradient template allows you to change the gradient 

slope during elution by changing time or volume.

Creating and
running

To create and run a Linear Gradient template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Make sure your 

method meets the requirements listed in above.

2. Select Linear Gradient from the Templates menu in the 

Method Editor window.

The Linear Gradient Template dialog box is displayed 

(Figure 7-4). The gradient range is also displayed.

Figure 7-4  Linear Gradient Template
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3. Type up to nine gradient durations (minutes, ml, or CV) in 

the text boxes.

NOTE: The duration units (minutes, ml, or CV) are the 
same as the duration units you select for the Gradient 
segment in the method.

Shorter durations produce gradients with steeper slopes, 

and longer durations produce more shallow gradients. 

4. Click Run. 

5. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template is executed.
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7.1.4  Flow Rate Study Template

The Flow Rate Study template allow you to change the flow rate 

during multiple runs of the same method.

Creating and
running

To create and run a Flow Rate Study template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. 

2. Select Flow Rate Study from the Templates menu in the 

Method Editor window.

The Flow Rate Study Template dialog box is displayed 

(Figure 7-5). The flow rate range is also displayed.

Figure 7-5  Flow Rate Study Template

3. Type up to nine flow rates (ml/min) in the text boxes.

4. Click Run. 

5. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template is executed.
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NOTE: The flow rates in the template are substituted for the 
flow rate in the General Settings. The Flow Rate Study 
template does not affect flow rate changes triggered by 
added events in a method.

NOTE: The effect of a change in global flow rate on the 
method is a function of the units you use to program each 
segment in the method:
Segments programmed in volume (ml) or column volume (CV) 
execute more quickly as the flow rate increases.
Segments programmed in time (minutes) require a greater 
volume of liquid as flow rate increases.

7.1.5  Auto Cycling Template

The Auto Cycling template allows you to run the same method a 

number of times. It is useful in preparative chromatography to 

cycle a method repetitively and pool the product fractions.

Creating and
running

To create and run an Auto Cycling template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. 

2. Select Auto Cycling from the Templates menu in the 

Method Editor window.

The Auto Cycling Template dialog box is displayed 

(Figure 7-6).
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Figure 7-6  Auto Cycling Template

3. In the # of Runs text box, type the number of times to run 

your method.

4. If you want to use the template to pool the product fractions, 

click the Pool Fractions check box to reset the fraction 

collector after each run.

NOTE: If the Pool Fractions check box is dimmed, add a 
Start Fraction Collection event to your method.

5. If you want to override the Clean block in the method, click 

Yes under Regenerate Column and enter the number of 
runs between cleanings. If you do not select Yes, the 

Clean block runs every time the method runs.

NOTE: If the Regenerate Column section is dimmed, add 
a Clean block and segment to your method.

6. Click Run. 

7. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template is executed.
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7.1.6  Analysis Template
(Integrated Autosampler)

This section describes:

• Overview

• System and method requirements

• Creating and running 

• Example method for Analysis Template

7.1.6.1  Overview

The Analysis template (when used with an integrated 

autosampler) allows you to change the sample injected and the 

number of injections during multiple runs of the same method.

The Analysis template automatically substitutes and injects from 

different sample vials in Autosampler Inject segments. If your 

integrated autosampler supports sample preparation, the 

template can also substitute sample vials in Prep blocks.

Applications Use the Analysis template for the following applications:

• Analysis—Inject multiple samples using the same 

method (Figure 7-7).

• Preparation—Inject multiple samples that require 

sample preparation using the same method. Your 

autosampler must support sample preparation 

(Figure 7-8). See example on page 7-26.

• Analysis and Preparation—Prepare multiple samples 

for incubation using one method, and then inject these 

samples using another method. Your autosampler must 

support sample preparation (Figure 7-9). 

How the
template works

You specify which samples to substitute (maximum of 100) in 

the Analysis template. When you run your method, the system 

substitutes these samples for the first sample specified in your 

method, either in an Autosampler Inject segment or Prep block. 
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Figure 7-7  Using Analysis Template for Analysis

Figure 7-8  Using Analysis Template for Preparation

Figure 7-9  Using Analysis Template for Analysis and Preparation
(Requires Two Methods)

Equil block

Load block with
Inject segment

Template runs on Inject segment

During each template run,

is substituted with samples specified in template
sample specified in Inject segment

Equil block

Prep block

Load block with
Inject segment

Template runs on Prep block

During each template run,

is substituted with samples specified in template,
the sample specified in Prep block

During each template run,

 
product of Prep block is injected

producing multiple products

Method 1

Equil block

Prep block

Template runs

During each template run,

is substituted with samples
sample specified in Prep block

producing multiple samples
specified in template,

Method 2

Equil block

Load block with
Inject segment

Template runs on
Inject segment

on Prep block

for incubation

During each template run,
sample specified in Inject segment
is substituted with samples specified
in template (incubated samples)
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7.1.6.2  System and Method Requirements

Your system and method must meet the following requirements 

for each application.

Application System and Method Requirements

Analysis—Inject multiple 

samples using the same 

method 

(Figure 7-7)

• An AS 3500 integrated autosampler is configured

• Sample vials are loaded in the AS 3500 

autosampler and entered in the Sample Table

• Method contains a Load block with an Autosampler 

Inject segment

Preparation—Inject 

multiple samples that 

require sample 

preparation using the 

same method

(Figure 7-8)

NOTE: An example of 
using the Analysis 
template for this 
application is shown on 
page 7-26.

• An AS 3500 integrated autosampler that supports 

the sample preparation option is configured

• Sample vials are loaded in the AS 3500 

autosampler and entered in the Sample Table

• Method contains a Prep block followed by a Load 

block with an Autosampler Inject segment

• Autosampler Inject segment injects the product 

(Derived vial) of the Prep block 

NOTE: If you add a Combine segment to the Prep 
block, the first sample you add to the Combine Segment 
Setup dialog box is the sample that is substituted during 
each template run.

Analysis and 

Preparation— Prepare 

multiple samples for 

incubation using one 

method, and then inject 

these samples using 

another method

(Figure 7-9)

• An AS 3500 integrated autosampler that supports 

the sample preparation option is configured

• Sample vials are loaded in the AS 3500 

autosampler and entered in the Sample Table

• First method contains a Prep block that prepares 

sample for incubation

• Second method contains a Load block with an 

Autosampler Inject segment that injects the product 

(Derived vial) of the Prep block
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7.1.6.3  Creating and Running

To create and run an Analysis template:

1. Prepare your system according to the requirements listed 

in Section 7.1.6.2, System and Method Requirements.

2. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Make sure your 

method meets the requirements listed in Section 7.1.6.2, 

System and Method Requirements.

3. Select Analysis from the Templates menu in the Method 

Editor.

The Analysis template dialog box is displayed 

(Figure 7-10). The Samples list includes all sample vials 

you entered in the Sample Table as Sample, Standard, 

Control, or Reagent. See Section 4.7.3, Entering Vials in 

Sample Table.

Figure 7-10  Analysis Template Dialog Box

4. Select the sample vials to inject or prepare.

If your method contains an Autosampler Inject segment 

first, it injects the samples you select. If your method 

contains a Prep block first, it prepares the samples you 

select.
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To select multiple sample vials:

• Press and hold the Shift key, then click samples 

to select a range of contiguous samples

• Press and hold the Control key, then click 

samples to select noncontiguous samples.

5. Enter the number of injections or number of sample 
preparations for the selected sample vials.

6. Click Run.

7. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

The method runs repeatedly to inject or prepare the 

samples you specified, the number of times you 

specified. The maximum number of runs is 100.

For example, the template illustrated in Figure 7-10 runs 

the method 12 times. The first three runs inject or 

prepare sample A1, the next three runs sample A2, the 

next three runs sample A3, and the last three runs 

sample A4.

NOTE: When you run an Analysis template, the 
autosampler injects from the vial you select in the 
Analysis Template dialog box. If the sample volume in the 
vial is insufficient to make the injection, a warning is 
displayed. Click OK to cancel the current method and 
continue the template.

NOTE: If your method has a Prep block, include enough 
empty vials in the autosampler tray and in the Sample 
Table to allow for all the Derived vials the template 
creates.
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7.1.6.4  Example Method for Analysis Template

Figure 7-11 illustrates an example method for using the Analysis 

template to inject multiple samples that require sample 

preparation. The method contains a Prep block followed by an 

Inject segment. 

Prep block The Prep block contains a Combine segment that combines two 

samples and places the product in the first empty vial entered in 

the Sample Table (in this example, vial A7). Vial A7 becomes a 

Derived vial and contains the product of the Prep block. The vial 

that receives the product of the Prep block changes with each 

template run.

Autosampler
Inject segment

The Autosampler Inject segment injects the product of the Prep 

block. 

NOTE: To instruct an Autosampler Inject segment to inject 
the product of a Prep block, click the Derived option button in 
the Autosampler Inject Segment Setup dialog box. Select the 
sample vial that has the name of the Prep block. For more 
information, see “Autosampler Inject Segments” on page 6-30.

Figure 7-11  Example Method for Analysis Template

In first template run,

In next template run,

 

sample A1 and sample B1,
Prep block combines

creating sample A7

for sample A1
(sample A2) is substituted

Analysis Template
first sample specified in
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If you create and run the Analysis template shown in 

Figure 7-10, the next sample specified by the template is 

substituted for the first sample listed in the Prep block. The 

Autosampler Inject segment injects the product of the Prep 

block:

NOTE: Only the first sample that you select in the Prep block 
dialog box is substituted with each run. This sample is not 
necessarily the first sample listed in the method Prep block. 

You can use this combination of Prep block and Analysis 
template to incubate the same antibody/enzyme conjugate 
(B1) with each sample (A1, A2, A3).

Template 
Run

Prep block with 
Combine segment 
combines samples

Autosampler Inject 
segment injects 

product of Prep block

First A1 + B1 A7

Second A1 + B1 A8

Third A1 + B1 A9

Fourth A2 + B1 A10

Fifth A2 + B1 A11

Sixth A2 + B1 A12

Seventh A3 + B1 A13

Eighth A3 + B1 A14

Ninth A3 + B1 A15

Tenth A4 + B1 A16

Eleventh A4 + B1 A17

Twelfth A4 + B1 A18
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7.1.7  Analysis Template 
(Direct Wire Autosampler)

The Analysis template (when used with a direct wire 

autosampler) allows you to document the vial number and 

injection number during multiple runs of the same method.

NOTE: The Analysis template does not change the vial 
number or number of injections. You specify these 
parameters using the controls on the direct wire autosampler.

Hardware
requirements

Connect and prepare a direct wire autosampler, including 

programming the autosampler method and sample set using the 

autosampler controls. For more information, see “Connecting 

direct wire autosampler” on page 2-22, and Section 3.6, 

Preparing an Autosampler.

Configuration
requirements

Configure and prepare the BioCAD software for a direct wire 

autosampler before turning on the autosampler. For information, 

see Section 4.8, Configuring and Preparing the BioCAD 

Software for a Direct Wire Autosampler.

Method
requirements

Your method must contain a Load block with a Step segment 

and an Autosampler Inject and Data Collection Start event. For 

more information, see Section 6.2.6, Adding Events, and 

Section 6.3.7, Making Direct Wire Autosampler Injections in a 

Method.

Creating and
running

To create and run an Analysis template with a direct wire 

autosampler:

1. Verify that the BioCAD 700E Workstation and the direct 

wire autosampler meet the hardware and configuration 

requirements described above. Start the autosampler.

(If you are using an AS 3500 autosampler from Applied 

Biosystems, press Run on the front panel to start it.)

2. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Verify that your 

method meets the requirements listed in above.
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3. Select Analysis from the Templates menu in the Method 

Editor window.

The Analysis Template dialog box is displayed 

(Figure 7-12).

Figure 7-12  Analysis Template 

(Direct Wire Autosampler)

4. Enter the Number of runs (number of vials x injections per 

vial), the Initial vial number, and the Injections per vial. 
Use the same initial vial number and injections per vial that 

you specified in the autosampler method and sample set 

(programmed using the autosampler controls).

NOTE: The Analysis template does not control the initial 
vial number or the injections per vial. You must specify 
these parameters using the controls on the direct wire 
autosampler.

5. Click Run.

6. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template runs. The vial number and 

injection number information from the Analysis template 

is documented in the method stored with each data file 

(chromatogram) and in the title bar of each data file.
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7.1.8  Step Optimization Template

The Step Optimization template allows you to change the eluent 

concentration of the buffer/solvent blend during multiple runs of 

the same method. 

You use the Step Optimization template to optimize blending 

conditions for: 

• Column equilibration (loading conditions)

• Step elution

This template is useful when developing preparative methods 

and for process validation.

Method
requirements

Your method must contain one or both of the following:

• Equil block with a Step segment programmed in pH or 

Eluent blend mode

• Elute block with a Step segment programmed in pH or 

Eluent blend mode

NOTE: The Step Optimization template affects only the first 
Equil and the first Elute block in a method. However, you can 
change multiple Step segments within the Elute block.

Creating and
running

To create and run a Step Optimization template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Make sure your 

method meets the requirements listed in above.

2. Select Step Optimization from the Templates menu in the 

Method Editor window.

The Step Optimization Template dialog box is displayed 

(Figure 7-13).
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Figure 7-13  Step Optimization Template

The Step Optimization Template dialog box contains six 

columns. Each column represents a Step segment:

• Loading Conditions—Blend conditions in the 

first Step segment programmed in pH or Eluent 

blend mode in the first Equil block. 

This column is blank if the method does not 

contain a Step segment programmed in pH or 

Eluent blend mode in an Equil block.

• Elution Steps—Blend conditions in the first five 

Step segments programmed in pH or Eluent 

blend mode in the first Elute block. 

These columns are blank if the method does not 

contain any Step segments programmed in pH 

or Eluent blend mode in an Elute block.

3. In each row, enter an eluent concentration (mM) for each 

Step segment (column) represented in the template.

For information on valid eluent range, see “Valid eluent 

concentration” on page 7-32.

Blend conditions in
1st Step segment
in 1st Equil block

Blend conditions in
1st Step segment
in 1st Elute block

Blend conditions in
2nd Step segment
in 1st Elute block

Valid eluent
concentration
range for 
selected Step 
segment (column)
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Any fields that you leave blank will use the initial eluent 

concentration displayed at the top of the column.

4. Click Run. 

5. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

A method is created and executed for each row in the 

template.

Valid eluent
concentration

The minimum and maximum eluent concentration that you can 

enter for each Step segment (column) is displayed at the bottom 

of the dialog box when you click on each column. 

Valid eluent concentration range for each Step segment is 

determined by:

• Requested concentration for the blend entered in the 

Step segment

• Initial concentration of the buffers entered in the 

Buffer/Solvent Library

• Initial concentration of the eluent entered in the 

Buffer/Solvent Library

For example, assume the initial concentration of each buffer is 

200 mM. If you set the blend concentration to 100 mM of buffer, 

the system uses 50 percent of the buffer to achieve this 

concentration (100 mM/200 mM = 50 percent).

Assume the initial concentration of the eluent is 3,000 mM.

If 50 percent of the final solution is made up of buffer, the 

remaining 50 percent is made up of eluent and water. The valid 

range for the eluent in this example is 0 to 1,500 mM 

(50 percent of 3,000 mM = 1,500 mM). 

Blank fields If you leave any fields in a row blank, the initial eluent 

concentration displayed at the top of the column is used when 

you run the template. The next time you open the Step 

Optimization template, fields that you left blank display the initial 

eluent concentration in parentheses (Figure 7-14). 
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Figure 7-14  Blank Fields in Step Optimization Template

Gradient
segments

in the method

If a gradient segment programmed in pH or Eluent blend mode 

follows any of the Step segments listed in the template, the 

software automatically adjusts the initial gradient conditions to 

match the conditions of the preceding Step segment.

If a gradient segment programmed in pH or Eluent blend mode 

precedes any of the Step segments listed in the template, the 

software automatically adjusts the final gradient conditions to 

match the conditions of the following Step segment.

If a gradient segment programmed in pH or eluent mode is 

between two Step segments listed in the template, the software 

automatically adjusts initial and final conditions to match the 

conditions of the preceding and following Step segments.

Viewing results After you start a Step Optimization template, you can view the 

status of the template methods in the Method Queue. For each 

method, the first eluent concentration that you entered in each 

row in the template, is displayed in the Label column in the 

Method Queue.

NOTE: Eluent concentrations automatically entered by the 
software are not displayed in the Label column in the Method 
Queue.

Values

Values entered
by software
(from Step
segments)

you
entered
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7.1.9  Combinatorial
Optimization Template

The Combinatorial Optimization template combines the 

functionality of six templates in one template. 

The six parameters you can systematically vary with the 

Combinatorial Optimization template include:

• pH—Changes pH, comparable to pH Map template

• Sample Load—Changes injection volume, comparable 

to Loading Study template

• Flow Rate—Changes flow rate, comparable to Flow 

Rate template

• Gradient Duration—Changes gradient slope, 

comparable to Linear Gradient template

• Column—Changes column position on the SCOUT 

Column Selector, comparable to Column Switching 

template

• Cycling—Changes number of runs, comparable to Auto 

Cycling template

The Combinatorial Optimization template allows you to enter 

values for any or all of the above six parameters, then 

generates methods based on these values. You can create a 

sequence of methods, and vary one or more parameters from 

method to method.

The following sections describe:

• Method and system requirements

• Creating and running

• Viewing results
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7.1.9.1  System and Method Requirements

Your system and method must meet the following requirements 

if you want to change the corresponding parameter in the 

Combinatorial Optimization template:

NOTE: For information on method blocks and segments, see 
Chapter 6, Creating and Running Methods.

Parameter Method and System Requirements

pH Method must have at least one Step segment or 

Gradient segment programmed in pH mode

Sample 

Load

Method must have a Load block containing an 

Inject segment or Step segment

Flow Rate None

Gradient 

Duration

Method must have an Elute block containing a 

Gradient segment

Column System must have a SCOUT Column Selector 

configured

Cycle None
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7.1.9.2  Creating and Running

To create and run a Combinatorial Optimization template:

1. Open a method or create a new method as described in 

Chapter 6, Creating and Running Methods. Make sure your 

method meets the requirements listed in Section 7.1.9.1, 

System and Method Requirements.

2. Select Combinatorial Optimization from the Templates 

menu in the Method Editor window.

The Combinatorial Optimization dialog box is displayed, 

with a table containing a column for each of the six 

parameters (Figure 7-15).

NOTE: If minimum, maximum, and default values appear 
at the top of a parameter column, the method and system 
requirements are met for the parameter, and you can 
control the parameter.
If no values appear at the top of a parameter column, 
then the method and system requirements are not met 
for the parameter, and you cannot control the parameter.

Figure 7-15  Combinatorial Optimization Dialog Box

Parameter is not
available if no
values appear here
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3. Select or deselect Run All Possible Combinations.

Hint: Select Run All Possible Combinations if you want 
to enter parameters and let the software create all 
possible methods.

If you select Run All Possible Combinations: 

• One method is generated for each possible 

combination of the values entered in the table.

• The maximum number of methods and runs is 

100.

• The Cycles parameter is not available.

For example, if you select Run All Possible 

Combinations, as in Figure 7-15, the template generates 

eight methods, four combining each of the four sample 

load volumes with the 5 ml/min flow rate, and four 

combining each of the four sample load volumes with the 

10 ml/min flow rate.

Hint: Deselect Run All Possible Combinations if you 
want to specify parameters for each method individually.

If you deselect Run All Possible Combinations:

• One method is generated for each row of the 

table that contains any values.

• The maximum number of different methods is 

nine.

• The maximum total number of runs is 100.

(Each method runs the number of times 

specified by the Cycles parameter.)

• More than one value can change from method 

to method.

• Default values are used when table cells have 

no values entered in them.

For example, if you deselect Run All Possible 

Combinations in Figure 7-15, the template generates four 

methods, one for each row containing values.
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4. Type values in the table under the appropriate parameter.

NOTE: The units and default values for each parameter, 
displayed at the top of each column, are based on the 
current method.

To navigate through the table, click on a cell to select it, 

press Tab to move right, press Enter to move down, or 

use the arrow keys.

The following table describes the impact of each 

parameter on the method:

Parameter Units Impact on Method

pH pH or % The blend conditions of any 

segments programmed in pH 

mode will change to the table 

value.

Sample 

Load

• µl or ml

(Inject segment)

• minutes, ml, CV
(Step segment)

The sample volume of the first 

Inject or Step segment in the first 

Load block will change to the 

table value.

Flow Rate • ml/min

• cm/hr

• CV/min

The General Settings flow rate 

will change to the table value.

Gradient 

Duration

minutes, ml, or CV The duration of the first Gradient 

step in the first Elute block will 

change to the table value.

Column column position on 

SCOUT (A–F)

The column position in General 

Settings and in any Purge blocks 

will change to the table value.

Cycle number The method runs the number of 

times you specify.
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NOTE: As you enter values, the Total Runs, Estimated 
Time, and Estimated Buffer Use are updated and 
displayed at the bottom of the dialog box. Check this 
information and verify that you are prepared for the time 
and buffer volumes required to run the template 
methods.

5. Click OK.

6. If you chose to name files when run in the Data Storage 

options, type a data file name in the Set Data File Name 

and Directory dialog box and click OK.

Each method in the template runs.

Saving
 template values

The values you enter in the Combinatorial Optimization table 

are saved after the template runs. These values appear when 

you re-open the Combinatorial Optimization template.

Clearing
template values

To clear all values from the Combinatorial Optimization table, 

click Clear.
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7.2  Creating and 
Running Multi-Methods

The multi-method feature in the Method Editor allows you to 

create your own custom templates by:

• Making sequential modifications to a method and saving 

the methods in a multi-method file 

• Saving a group of different methods together in a 

multi-method file 

When you run a multi-method, all methods in the multi-method 

file run. The multi-method allows you to run methods 

sequentially without attending the workstation.

The following sections describe:

• Opening an existing multi-method file

• Creating a new multi-method file

• Adding method files to a multi-method file

• Running a multi-method

7.2.1  Opening an Existing Multi-Method File

To open an existing multi-method file (.GMM):

1. Select Method Editor from the Window menu to display 

the Method Editor window.

2. Select Open Multi Method from the Multi-Method menu.

The Open File dialog box is displayed.

3. Select a multi-method file (.GMM), then click OK. 

The multi-method file name is displayed in the title bar of 

the Method Editor.

4. To view the method files in the multi-method, select Edit 
Multi Method from the Multi Method menu.
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7.2.2  Creating a New Multi-Method File 

To create a multi-method file (.GMM):

1. Select Method Editor from the Window menu to display 

the Method Editor window.

2. Select New Multi Method from the Multi-Method menu.

The Save File dialog box is displayed.

3. Type a file name for the multi-method, then click OK. 

The Method Editor window is displayed with the 

Multi-method file name and a .GMM extension listed on 

the title bar. The Multi-Method button is now available at 

the top of the Method Editor window.

4. Add methods to your multi-method file. See Section 7.2.3, 

Adding Methods to a Multi-Method.

7.2.3  Adding Methods to a Multi-Method

You can add methods to the multi-method in two ways:

• Click the Multi-Method button

• Select Edit Multi Method from the Multi Method menu

Hint: If you want to make sequential modifications to a method 
and save the methods in a multi-method, use the Multi-Method 
button to add methods to a multi-method file.

If you want to save a group of different methods together in a 
Multi-method file, use the Edit Multi Method command.
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7.2.3.1  Using the Multi-Method Button 
to Add Methods to a Multi-Method

Use the Multi-Method button to add methods to a multi-method 

if you want to make sequential modifications to a method and 

save the resulting methods. 

To add methods to a multi-method:

1. Create a new Multi-method, as described in Section 7.2.2, 

Creating a New Multi-Method File.

2. Open a method by selecting Open from the File menu.

3. Click the Multi Method button at the top of the Method 

Editor to add the current method to the multi-method. 

4. Modify the current method, or open a new method and add 

to the multi-method by clicking the Multi Method button.

Each method is added to the multi-method under its 

original file name and a .G## extension, starting with 

.G00 and incrementing one digit for each method with the 

same file name.

5. To view the method files you added to the multi-method, 

select Edit Multi Method from the Multi Method menu.

Example For example:

1. In the Method Editor window, select New Multi Method 

from the Multi Method menu to display the Save File dialog 

box.

2. Type Test in the File Name text box and click OK.

3. Open METHODA. Click the Multi Method button.

METHODA.G00 is added to TEST.GMM.

4. Change the flow rate in METHODA. Click the Multi 
Method button.

METHODA.G01 is added to TEST.GMM.
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5. Change the wavelength in METHODA. Click the 

Multi Method button.

METHODA.G02 is added to TEST.GMM.

6. Open METHODB. Click the Multi Method button.

METHODB.G00 is added to TEST.GMM.

7. Change the flow rate in METHODB. Click the Multi 
Method button.

METHODB.G01 is added to TEST.GMM.

8. Change the wavelength in METHODB. Click the 

Multi Method button.

METHODB.G02 is added to TEST.GMM.

9. Select Edit Multi Method from the Multi Method menu to 

view the methods you added to the new multi-method. 

The Multi-Method dialog box is displayed (Figure 7-16).

Figure 7-16  Methods Added to a Multi-Method

NOTE: A multi-method is automatically saved every time you 
make changes to it. 

Method files
with .G## 
extensions
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7.2.3.2  Using Edit Multi-Method
to Add Methods to a Multi-Method

Use the Edit Multi Method command to add methods to a 

multi-method if you want to save a group of different methods 

together in a multi-method file.

To add methods to a multi-method:

1. Open or create a multi-method as described in Section 

7.2.1, Opening an Existing Multi-Method File, or Section 

7.2.2, Creating a New Multi-Method File.

2. Select Edit Multi Method from the Multi Method menu.

The Edit Multi Method dialog box is displayed 

(Figure 7-17).

Figure 7-17  Edit Multi Method Dialog Box
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3. Click the following buttons to add, arrange, and remove 

methods in the multi-method:

• Insert—Displays the Open File dialog box. 

Select a method and click OK. Inserts the 

method you select above the current line, using 

an .MET extension.

• Append—Displays the Open File dialog box. 

Select a method and click OK. Adds the 

method you select to the end of the method list, 

using an .MET extension.

• Remove—Removes the selected method from 

the multi-method.

• Clear All—Removes all methods from the 

multi-method.

NOTE: When you use Insert or Append to add methods 
to a multi-method, you do not get a Configuration 
Mismatch warning until you run the multi-method.

4. To view the contents of a method listed in the multi-method, 

select the method, then click the Open Method button.

5. To load the same method twice, enable the Duplicates 

check box before using the Insert or Append commands.

6. Click OK when you have added all methods to the 

multi-method.

7. To close the Multi-Method window, double-click the Control 

menu at the top left corner of the Method Editor window.

NOTE: A multi-method is automatically saved every time 
you make changes to it. 
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7.2.4  Running a Multi-Method

To run a multi-method:

1. Select Method Editor from the Window menu to display 

the Method Editor window.

2. Open or create a multi-method as described in Section 

7.2.1, Opening an Existing Multi-Method File, or Section 

7.2.2, Creating a New Multi-Method File.

3. Select Run Multi Method from the Multi Method menu. 

The Set Data File Name and Directory dialog box is 

displayed.

Figure 7-18  Set Data File Name and Directory

4. Type the file name for the data files the multi-method will 

create. The maximum number of characters in the file name 

is eight, not including the extension.

5. Click OK.

Each method in the multi-method runs.
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Viewing the
Method Queue

After you start a multi-method run, view the Method Queue to 

see a listing of all the methods in the multi-method. To view the 

Method Queue, select Method Queue from the File menu in the 

Control Panel.

For more information, see Section 8.1, Using the Method 

Queue.

Viewing the
Status window

After you start a multi-method run, view the Status window to 

see the status of the multi-method run. The Status window 

indicates that a method is running. It displays the method file 

name, data file name, and sequence (#/#) of the currently 

running method. 

For more information, see Section 8.2, Using the Status 

Window.

Viewing
data files and

group files

After the multi-method run is complete, use the Group Analysis 

window to view the data files (.B##) and group file (.GRO) that 

the multi-method creates. 

A data file (chromatogram) is created for each method run in the 

multi-method. All data file names are the same. The data file 

name is the name you specified for data files before running the 

multi-method, with a .B## extension, beginning with B00 and 

incrementing one digit for each run.

NOTE: The maximum number of data files you can generate 
using a multi-method is 100 (.B00 through .B99).

One group file is created for the multi-method run. It contains a 

list of all data files that the multi-method generates. The group 

file name is the same as the data file names, but with a .GRO 

extension.

For more information, see the Data Analysis User’s Guide.

Stopping a
multi-method

You can stop a multi-method the same way you stop a method. 

You can hold the method, stop the pump, or abort the method.

For more information, see Section 6.6.5, Stopping and 

Resuming a Method.
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8.1  Using the Method Queue

After you start a method, template, or multi-method, each 

method is loaded into the Method Queue (Figure 8-1). To 

display the Method Queue, select View Method Queue from 

the File menu in the Control Panel.

Figure 8-1  Method Queue

The Method Queue contains the following column headings:

• Method— Displays the method file name.

• Group File—Displays the group file name (.GRO) if you 

run methods using a template or multi-method. This 

column is blank if you run a single method.

• Data File—Displays the data file name each method 

creates.

• Label—If running a single method, displays the injection 

volume and the sample name. If running a template or a 

multi-method, displays the parameters that define each 

run.

Parameters that
define each run

Click-drag 
divider line 
to widen

Click and hold 
right scroll arrow 
to scroll right

Label column
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Label column The following table lists the abbreviations used for each 

template parameter in the Label column of the Method Queue:

If the parameter information in the Label column of the Method 

Queue is not all visible, you can:

• Scroll right by clicking and holding the right scroll arrow at 

the bottom of the Method Queue to display all the 

information. 

• Widen the Label column by positioning the pointer on the 

divider line between the Data File column and the Label 

column. Click-drag the divider line to the left.

Printing the
Method Queue

Print the Method Queue by clicking the Print button at the 

bottom of the dialog box. Printing the Method Queue provides a 

record of which parameters correspond to each data file. The 

parameters are also displayed in the title bar of each data file.

Removing
methods from

the Method
Queue

To remove a method from the Method Queue, select the 

method, then click Delete. To remove all methods, click Abort.

The Abort button has the same function as the Abort button in 

the Control Panel. Clicking Abort deletes all methods in the 

Method Queue and stops the pump.

Template 

Parameter

Abbreviation in Label Column of 

Method Queue

pH pH

Sample Load SL (autoloader or autosampler injection)

PL (pump injection)

Flow Rate FR

Gradient Duration GD

Column CS

Cycle #

Step Optimization ST



Chapter  8    Viewing Results and Checking Status

8-4 Applied Biosystems

8

8.2  Using the Status Window

The Status window (Figure 8-2) initially appears to the right of 

the Control Panel. You can position it anywhere on the screen. 

Sometimes it is useful to keep the Status window in the corner 

of the screen so you can see it while you are performing other 

software operations. 

Figure 8-2  Status Window

Status
information

The Status window provides the following real-time status 

information during runs:

• Pump

• Detector 

• Collector

• Method

NOTE: You can change units for values displayed in the 
Status window by clicking the down arrow to the right of the 
item.

Method file name

Segment letter

Run status

Block number

Time remaining

System flow rate

System pressure

Fraction/Waste
valve position

Detector output

Data file name

and name
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Pump The Pump section of the Status window displays:

• System flow rate—You can select ml/min, cm/hr or 

CV/min flow rates. See “Flow rate units” on page 5-14.

• System pressure—You can select psi (pounds per 

square inch), bar, or MPa (megapascal) pressure units. 

(1 bar = approximately 15 psi = 0.1 MPa)

Detector The Detector section of the Status window displays any three of 

the following five detector outputs:

• UV/Vis—Displays absorbance values for one or both 

UV/Vis wavelengths in AU (absorbance units).

• Fluor—Displays the fluorescence emission values in FU 

(fluorescence units).

• pH—Displays the pH measured in the pH flow cell.

• Conductivity—Displays conductivity in conventional 

mS (millisiemen) units or custom calibrated units. See 

Section 9.5.4, Calibrating the Conductivity Monitor. 

• Temperature—Displays the temperature in the 

conductivity flow cell.

• Auxiliary Detector Output—Displays auxiliary 

detector output in V (volts) or custom units. See 

“Configuring the auxiliary detector” on page 4-18.

NOTE: To change the detection display, select a different 
option from the View menu in the Status window.
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Collector The Collector section of the Status window displays the valve 

position of the Fraction/Waste valve. If a fraction collector is 

configured, it displays the current fraction collector tube.

Method The Method section of the Status window displays the following 

information about a method:

• Currently running data file name and number in 

sequence (if template or Multi-method run)

• Currently running method file name

• Currently running block number and segment name

• Time elapsed or remaining in run

• Run status

NOTE: To change the time display, select Time Elapsed or 
Time Left from the View menu.



Using the Strip Chart Recorder

BioCAD® 700E Workstation User Guide 8-7

8

8.3  Using the Strip Chart Recorder 

The Strip Chart Recorder window (Figure 8-3) appears below 

the Control Panel and the Status window. You can resize the 

strip chart recorder or click-drag the window anywhere on the 

screen.

Figure 8-3  Strip Chart Recorder Window

When the pump is running, the electronic Strip Chart Recorder 

continuously stores and displays data for all signals you 

selected in the Configuration dialog box. For more information, 

see “Configuring data channels” on page 4-16.

You can use the Strip Chart Recorder to:

• View data in real time as it is being acquired (Real-time 

mode)

• View previously acquired data by scrolling through the 

window (History mode)

• Save Strip Chart Recorder data in a data file. This is 

useful when you make an injection from the Control 

Panel without creating a method.
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Real-time and
History mode

The strip chart recorder can run in two modes:

• Real-time—As data is acquired, it is displayed in the 

Strip Chart Recorder. When the Strip Chart Recorder is in 

Real-time mode, the Real-Time command on the Display 

menu is checked, and there is no scroll bar displayed at 

the bottom of the window.

• History—Data acquired up until the time you switched to 

History mode is displayed. When the Strip Chart 

Recorder is in History mode, the Real-Time command on 

the Display menu is not checked, and there is a scroll bar 

displayed at the bottom of the window.

To place the Strip Chart Recorder in Real-time mode, select 

(check) Real-Time from the Display menu.

To place the Strip Chart Recorder in History mode, deselect 

(uncheck) Real-Time from the Display menu, or click anywhere 

on the Strip Chart Recorder.

Strip Chart
Recorder

annotations

The Strip Chart Recorder can display the following annotations:

• MRK (dark red)—Appears any time you add a chart 

mark, by pressing the Event Mark button on the front 

panel of the workstation, by clicking the Chart Mark 

button in the Control Panel, or by adding a detector event 

mark in a method.

• ON/OFF (red)—Appears any time you turn the pump on 

or off, from the front panel of the workstation, from the 

Control Panel, or by using a method event.

• INJ (blue)—Appears any time you make an autoloader, 

manual, or autosampler injection from a method.

NOTE: No INJ mark appears if you make a pump 
injection from a method. No INJ mark appears if you 
make an injection from the Control Panel.

• 1, 2, 3 and so on (green)—Fraction numbers. A solid line 

indicates the start of a fraction. A dotted line indicates the 

end of a fraction, if triggered by a threshold. If the fraction 

end is not triggered by a threshold, no fraction end is 

indicated.
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Customizing the
Strip Chart

Recorder

You can customize the Strip Chart Recorder to display various 

data channels, ranges, units, and colors.

To customize the Strip Chart Recorder:

1. Select White Background or Black Background from 

the Display menu in the Strip Chart Recorder window.

2. Select Options from the Display menu in the Strip Chart 

Recorder window. 

The Strip Chart Settings dialog box is displayed 

(Figure 8-4).

Figure 8-4  Strip Chart Settings

3. Select the Y-axis data channels for display and select a 

range, unit, and color for each. Choices are:

• Int UV/Vis #1

• Int UV/Vis #2, Ext UV/Vis, or Ext Fluor

• pH

• Conductivity

• Pressure

• Auxiliary Detector Output
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NOTE: If Y-axis variables are dimmed, it indicates that 
you did not select these variables in the Data Recorder 
Configuration dialog box. For more information, see 
“Configuring data channels” on page 4-16.

4. Click the Gradient check box to display the percentage of 

one of the six buffer/solvent channels that you programmed 

in the Control Panel or in a Gradient segment.

NOTE: In the Strip Chart Recorder, the actual percent of 
the buffer/solvent detected by the conductivity monitor is 
offset from the programmed percent due to system delay 
volume.

5. Check the Display Events box to display events on the 

Strip Chart Recorder. Events include:

• Injection marks (displayed in blue)

• Pump on/off (displayed in red)

• UV/Vis chart marks (displayed in dark red)

• Fraction start and end and fraction tube 

changes (displayed in green)

6. Specify the labels to display on the left and right axes. 

7. Select the following for the X-axis:

• X-Axis Scroll Position—Available only in 

History mode. Determines the number of 

previous minutes, ml, or CV displayed. 

For more information, see “X-Axis Scroll Position 

and Chart Range” on page 8-11.

• Chart Range—Sets the total number of 

minutes, ml, or CV displayed at one time on the 

Strip Chart Recorder. As new data is acquired, 

older data scrolls to the left out of the window. 

For example, if you set the range to 15 minutes, 

15 minutes worth of data is displayed. 

For more information, see “X-Axis Scroll Position 

and Chart Range” on page 8-11.

• Units—Minutes, ml, or CV (column volumes).
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X-Axis Scroll
Position and
Chart Range

X-Axis Scroll Position and Chart Range settings work together 

to determine how data is displayed in the Strip Chart Recorder. 

Figure 8-5 shows examples of the portion of the data displayed 

in the Strip Chart Recorder window using different settings.

Figure 8-5  X-Axis Scroll Position and Chart Range

Now- 10 min - 5 min

Now- 10 min

Now- 10 min

0 5

If Scroll Position is set to 10 and Chart range is set to 5, you will see:

If Scroll Position is set to 10 and Chart range is set to 10, you will see:
0 10

If Scroll Position is set to 10 and Chart range is set to 15, you will see:

0 15
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Moving around
the Strip Chart

Recorder

To move around the Strip Chart Recorder:

1. To zoom in on any area of the Strip Chart Recorder:

• Move the pointer into the Strip Chart Recorder.

The cursor arrow changes to a crosshair.

• Hold down the left mouse button.

• Click-drag a box around the area you want to 

zoom on.

• Release the mouse button. 

The selected area is expanded to full screen.

The data channel you selected as the Left Axis label in 

Strip Chart Settings is zoomed vertically and horizontally. 

All other data channels are zoomed horizontally only.

NOTE: Zooming on the Strip Chart Recorder during 
Real-Time mode automatically places the Strip Chart 
Recorder to History mode. 

2. To unzoom, select one of the following commands from the 

Display menu:

• Unzoom—Undoes the previous zoom. You can 

also double-click on the window to unzoom.

• Reset—Returns to the default settings for the 

Strip Chart Recorder (-8 to 8 AU).

3. You can scroll through the Strip Chart Recorder when it is in 

History mode only. To change from Real-time mode to 

History mode, do one of the following:

• Deselect the Real-time command on the Display 

menu

• Zoom in on an area of or click on the Strip Chart 

Recorder
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Saving Strip
Chart Recorder

data to a
data file

You can save all data currently displayed in the Strip Chart 

Recorder to a data file. You can analyze the data file in the 

Group Analysis window. This is useful when you make an 

injection from the Control Panel without creating a method.

To save Strip Chart Recorder data to a data file:

1. Zoom in on or expand the Strip Chart Recorder to display 

the data you want to save. Only the segment of data 

shown on the X-axis is saved. All signals collected are 

saved, even if they are not displayed in the Strip Chart 

Recorder.

2. Select Save Data As from the Strip Chart Recorder File 

menu. 

3. Enter a file name. The default file extension is .BIO. 

Specify a directory, if desired. Click OK.

NOTE: Method and configuration information is not 
stored in data files created from the Strip Chart Recorder. 
Data files created from the Strip Chart Recorder cannot 
be exported.
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8.4  Using the Timer

The Timer window (Figure 8-6) does not appear on the screen 

when you start the BioCAD software. To display the Timer 

window, select Timer from the Window menu.

Figure 8-6  Timer Window

The Timer is an electronic stopwatch. It gives you an 

independent measurement of both elapsed time and volume.

To use the Timer:

1. Click the Start button to start timing in minutes, ml, and 

CV (column volume).

2. Click the Stop button to stop the Timer.

3. Click the Reset button to reset the values to zero. 

Note the following when using the Timer:

• The ml counter does not start if the pump is off

• The CV counter does not start if the pump is off, a column 

is not configured, or a column is not inline
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8.5  Using the Event Log

As the system runs, all events and errors that occur are stored 

in the Event Log. If errors occur while a method is running, 

these errors are also stored in the data file.

The Event Log is stored in the SYSTEM.EVL file, which is 

located in the C:\BIOCAD directory.

This section describes:

• Displaying the Event Log window

• Types of errors and events

• Filtering events

• List of error codes

• Displaying Event Log detail

• Searching

• Displaying the Event Log for data files

• Printing

• Clearing
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Displaying the
Event Log

window

To display the Event Log window, do one of the following:

• Select Event Log from the Window menu in the Control 

Panel to display events and errors that occurred since the 

last time the Event Log was cleared. This is the system 

Event Log.

• Select Open Event Log from the File menu in the Group 

Analysis window to display events and errors that 

occurred while the selected data file was acquired. This is 

a data file Event Log.

NOTE: You can also display the event log for a data 
file by selecting Open from the File menu in the Event 
Log window.

Figure 8-7  Event Log
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Types of errors
and events

The Event Log stores four types of errors and events. One of 

the following icons appears to the left of each item in the Event 

Log:

• Hardware ( wrench icon)—Problem with hardware, 

such as an instrument malfunction, valve problem, 

hardware board failure

• System (  folder icon)—Error related to a system 

problem, such as math, serial communications, file I/O 

errors

• Resource ( hand icon)—Not enough memory or 

disk space to complete the requested action

• Method (  book icon)—Start and end of a method 

run

Filtering events There are two ways to filter errors and events displayed in the 

Event Log:

• Select Filter Records from the Edit menu—A cascade 

menu is displayed listing Hardware Errors, System and 

Resource Errors, Method Events, and GMP Events. A 

check mark indicates the error or event is displayed in the 

Event Log. 

To suppress an event, click the checked event type. To 

show an event, click the unchecked event type. You can 

show or suppress multiple event types.

• Click the filter buttons at the top of the Event Log—

 If a filter button is active, it has a white 

background. If a filter button is inactive, it has a gray 

background. 

To suppress an event type, click an active filter button. To 

show an event type, click an inactive filter button. You can 

show or suppress multiple event types.

List of
error codes

The Event Log also lists error codes. For an explanation of 

individual error codes, see Section 10.2, Error Codes.
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Displaying
Event Log detail

Double-click on a line in the Event Log to display the Event Log 

Detail dialog box (Figure 8-8).

Figure 8-8  Event Log Detail Dialog Box

The error is displayed in the Description box. The date, time, 

method file name, and data file name that were running at the 

time the error occurred are displayed at the top of the dialog 

box.

If Method and Data File fields are blank, no method was running 

at the time the error occurred.

Searching You can search for a specific event or error by date.

To search for a specific date:

1. Select Date from the Search menu or click the Calendar 
icon .

The Find Date dialog box is displayed.

2. Type a date in MM/DD/YY format and click OK. 

The first event that matches the date you typed is 

selected and scrolled into view.
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Displaying the
Event Log for

data files

To display events and errors that occurred while a specific data 

file was being acquired:

1. Select Open from the File menu in the Event Log 

window.

The Open File dialog box is displayed.

2. Select Data Files (*.B*) from the List Files of Type 

drop-down list box. 

3. Double-click the data folder or the folder where the desired 

data file is stored.

4. Select the data file and click OK. 

The data file name is displayed in the menu bar of the 

Event Log window, and events and errors for the data file 

are displayed in the Event Log window. 

If no events and errors are stored with the data file, or if 

the data file was collected on an earlier version of 

BioCAD software, a message is displayed.

5. To display the complete Event Log again, select System 
Log from the File menu, or click the folder icon. The name 

of the event and error log file (SYSTEM.EVL) is displayed in 

the menu bar of the window.

NOTE: You can also display the Event Log for a specific data 
file from the Group Analysis window.
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Printing You can manually print the contents of the Event Log by 

selecting Print commands from the File menu in the Event Log 

window:

• Print All—Prints all errors

• Print Item—Prints only the error you have selected 

(clicking the printer icon also prints the selected item)

You can automatically print the contents of the Event Log for a 

data file at the end of each run by setting the method to Print 

after Run. For more information, see Section 6.2.11, Specifying 

Print Settings.

Clearing Clear the Event Log when the information is no longer needed, 

or if you need to free some disk space.

NOTE: Clearing the system Event Log does not affect the 
Event Log stored in individual data files.

Before clearing the Event Log, do one of the following:

• Select Print All from the Print menu and save the list of 

error codes.

• Rename the SYSTEM.EVL file and save it on a floppy 

diskette.

To clear the Event Log, select Clear from the Edit menu.
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9.1  Maintenance Overview

The following sections describe:

• Maintenance schedule

• General maintenance

• UV/Vis detector maintenance

• pH/conductivity monitor maintenance

• Pump maintenance

• Autoloader maintenance

• Valve maintenance

• Hard disk maintenance

• Long term shutdown

CAUTION

Only the parts listed in this chapter are recommended for 
replacement by customers. If you attempt to service any 
parts not listed in this chapter, you may invalidate your 
warranty.

NOTE: You can purchase a Scheduled Maintenance Visit 
from Applied Biosystems. For more information, contact 
Technical Support. See the back cover of this guide for 
Technical Support contact information.

A maintenance log for use with the BioCAD 700E Workstation is 

provided in Appendix G, Maintenance Log.
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9.2  Maintenance Schedule

Regular preventative maintenance will help keep your BioCAD 

700E Workstation functioning properly. Perform the following 

procedures as indicated:

When to 

perform
Task Page

Daily Purge system and run 

SYSCLEAN.MET

page 2-38

Calibrate pH probe (GLP) page 9-19

Calibrate conductivity monitor 

(GLP)

page 9-21

Weekly Change pump seal wash 

solution

page 3-22

Calibrate pH probe page 9-19

Calibrate conductivity monitor page 9-21

Back up data page 9-48

Test hard disk integrity 

(run SCANDISK)

page 9-50

Monthly Clean fan filter page 9-7

Clean pH probe and cell page 9-16

Clean pump filter/mixer frit page 9-33

Optimize disk performance 

(run DEFRAG)

page 9-51

Continued
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Every 6 

months

Clean UV/Vis flow cell page 9-12

Replace solvent pump seals, 

clean piston, clean pump 

heads

page 9-23

Clean check valves page 9-30

Clean fluorescence flow cell see 

Fluorescence 
Detector 
Manual

Inspect autoloader syringe 

seal

page 9-34

Clean injection/column 

switching valve stators

page 9-37

When to 

perform
Task Page
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9.3  General Maintenance

General maintenance procedures include:

• Replacing the main power fuse

• Cleaning the fan filter

9.3.1  Replacing the Main Power Fuse

WARNING
For continued protection against fire hazard, replace fuses 
with those of the same type and rating.

AVERTISSEMENT
Remplacez les fusibles par ceux de même type et puissance 
pour éviter les risquesd’incendie.

To replace the main power fuse:

1. Power down the workstation.

2. Remove the power cord from the workstation.

3. Pry out the voltage selector cover using a small flat-blade 

screwdriver (Figure 9-1).

4. Rotate the selection wheel until the proper voltage is 

displayed.

5. Pull out on the white tab to remove the fuse block

(Figure 9-1).
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Figure 9-1  Removing the Voltage Selector Cover and Removing the Fuse Block

6. Remove the fuse and replace with a fuse of the proper 

rating.

7. Insert the fuse block into the receptacle. 

8. Replace the voltage selector cover.

9. Plug in and power up the workstation.

PB100030 PB100031

Power cord
connector

Pull out
white tab

Volts/Amps Fuse

100V~6A T6A 250V

120V~5A T5A 250V

220V~3A T3A 250V

240V~2.5A T2.5A 250V
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9.3.2  Cleaning the Fan Filter

Clean the fan filter monthly to allow proper ventilation of the unit:

1. Pry off the filter holder on the rear panel of the 

workstation.

2. Remove the filter.

3. Vacuum or shake dust from the filter.

NOTE: If you rinse the filter in water, dry thoroughly 
before replacing.

4. Replace the filter and the filter holder.
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9.4  UV/Vis Detector Maintenance

This section describes:

• Changing the UV/Vis detector lamps

• Cleaning the UV/Vis detector flow cell

• Changing the UV/Vis detector flow cell

9.4.1  Changing the UV/Vis Detector Lamps

Change the UV/Vis detector lamps after 1,000 hours of use. 

NOTE: To determine hours of use, check the gauge in the 
UV/Vis detector compartment (Figure 9-2).

Removing To remove the UV/Vis detector lamps:

1. Power down the workstation and remove the power cord.

WARNING

UV light can damage eyes and skin. Power down and 
remove the power cord before replacing the lamp.

AVERTISSEMENT

La lumière UV peut être dangereuse pour les yeux et la 
peau. Mettez hors tension et débranchez le câble 
d’alimentation avant de remplacer la lampe.

2. Allow the lamps to cool for ten minutes.

3. Remove the screw or knurled knob from the detector lamp 

cover and remove the cover.

The tungsten and deuterium lamps are exposed 

(Figure 9-2).
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Figure 9-2  UV/Vis Detector Compartment

Tungsten 4. To remove the tungsten lamp:

• Disconnect the bottom power connector.

• Unscrew the retaining screw at the base of the 

lamp (see Figure 9-2).

• Pull out the lamp.

Figure 9-3  Tungsten Lamp
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Deuterium 5. To remove the deuterium lamp:

• Disconnect the top power connector.

• Unscrew the two retaining screws (see 

Figure 9-2).

• Pull out the lamp.

Figure 9-4  Deuterium Lamp

PB100034

Lamp
Lamp

chronometer
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Replacing CAUTION

Do not touch lamp glass. Fingerprints can cause poor lamp 
performance.

Tungsten To replace the tungsten lamp:

1. Position the lamp mounting bracket on the pins at the left 

of the lamp compartment. See Figure 9-2 for tungsten 

lamp position.

2. Replace the retaining screw.

3. Plug in to the bottom power connector.

4. Replace the detector cover and replace the retaining screw 

or knurled knob.

5. Connect the power cord, and power up. Allow the lamp to 

warm up for 20 minutes.

Deuterium To replace the deuterium lamp:

1. Position the lamp mounting bracket on the pin at the right 

of the lamp compartment. See Figure 9-2 for deuterium 

lamp position.

2. Replace the two retaining screws.

3. Plug in to the top power connector.

4. Replace the detector cover and replace the retaining screw 

or knurled knob.

5. Connect the power cord, and power up. Allow the lamp to 

warm up for 20 minutes.
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9.4.2  Cleaning the UV/Vis Detector Flow Cell

Clean the UV/Vis detector flow cell every six months. If you 

have problems with the UV/Vis detector performance, such as 

excessive noise or unexpected readings, clean the UV/Vis 

detector flow cell more often.

WARNING
Wear gloves, safety glasses, and a laboratory coat when 
performing this procedure.

AVERTISSEMENT
Veuillez porter des gants, des lunettes de sécurité, et une 
blouse de laboratoire lors de cette opération.

To clean the UV/Vis detector flow cell:

1. Bypass the pH and conductivity monitors by clicking the 

Bypass option button in the Detector section of the 

Control Panel.

2. Flush the system with 1 N NaOH. For more information, see 

Section 5.2.4, Purging the System.

3. Flush the system completely with deionized water.

NOTE: Check the pH of the waste stream to determine if 
the system has been completely flushed with deionized 
water.

4. If necessary, flush the system with 1 N HCl, then flush with 

deionized water.

If cleaning does not correct the problem, change the 

UV/Vis detector flow cell. See Section 9.4.3, Changing the 

UV/Vis Detector Flow Cell.

NOTE: As an alternative to flushing the system you can inject 
NaOH and HCl into the system through the injection valve. 
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9.4.3  Changing the
UV/Vis Detector Flow Cell

CAUTION

Do not touch the UV/Vis lens. Fingerprints can cause poor 
detector performance.

Removing To remove the UV/Vis detector flow cell:

1. Remove the detector flow cell cover (Figure 9-5).

Figure 9-5  Detector Flow Cell Cover

2. Disconnect the inlet (bottom) and outlet (top) tubing from 

the Column Switching and Detector Bypass valve.

3. Remove the sample diode by removing the knurled knobs.

4. Remove the tubing from the tubing guide (Figure 9-6).

Flow Cell

Bypass Valve

Sample
Out

Sample
In

PB100035

Outlet

Inlet

Flow celltubing

tubing

cover
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Figure 9-6  Removing Flow Cell Screws
(Sample Diode Not Shown)

5. Unscrew the flow cell retaining screws (Figure 9-6). If you 

are removing an analytical flow cell, you need a 9/64-inch 

hex wrench (provided in the startup kit).

6. Remove the flow cell from the alignment pins.

Replacing To replace the UV/Vis detector flow cell:

1. Position the new flow cell over the alignment pins:

• Semi-prep flow cell—Position the set screw 

hole on the lower-right side of the cell.

• Analytical flow cell—Position the warming 

block at the top of the cell.

2. Replace the retaining screws. Make sure the cable is not in 

the way before tightening the screws.

3. Replace the sample diode and retaining screws.

PB100521 PB100036

Retaining
screws

Tubing
guide

Tubing
guide

Semi-Prep Flow Cell Analytical Flow Cell

Set screw hole on lower-right

Retaining
screws

Heat exchange block at top
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CAUTION
Plumb the UV/Vis flow cell so that fluid flows into the cell 
at the bottom and out of the cell at the top. If plumbing 
connections are reversed, air bubbles can be trapped in 
the flow cell and cause excessively noisy baselines.

4. Connect the inlet (bottom) and outlet (top) tubing. Secure 

the inlet and outlet tubing in the tubing guide. Do not 

overtighten.

5. Replace the flow cell cover.

6. Connect the detector inlet tubing (bottom) to the 

high-pressure connection from the Column Switching 

valves. Connect the outlet tubing (top) to the green 

connector (port 5) on the Detector Bypass valve. 
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9.5  pH and Conductivity
Monitor Maintenance

This section describes:

• Cleaning the pH probe

• Calibrating the pH probe

• Storing the pH probe

• Calibrating the conductivity monitor

9.5.1  Cleaning the pH Probe and Cell

Clean the pH probe and cell monthly. To clean the pH probe and 

cell:

• Remove the pH probe

• Clean the pH probe

• Clean the pH cell

• Replace the pH probe

Removing
pH probe

To remove the pH probe:

1. Unscrew the retaining cap holding the probe in place.

Figure 9-7  Removing the pH Probe
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2. Disconnect the round BNC connector by pushing it in and 

turning to the left.

3. Pull the probe straight up and out of the cell.

Cleaning
pH probe

To clean the pH probe:

WARNING

Wear gloves, safety glasses, and a laboratory coat when 
performing this procedure.

AVERTISSEMENT

Veuillez porter des gants, des lunettes de sécurité, et 
une blouse de laboratoire lors de cette opération.

• If the coating is soft, clean the probe by stirring vigorously 

in water or 1 N HCl.

• If the coating is hard or caused by an organic chemical, 

replace the probe.

CAUTION
Do not scrub the probe. Abrasion will damage the probe.

Cleaning
pH cell

To clean the pH cell:

1. Disconnect the inlet and outlet tubing from the cell.

2. Lift the cell out of its holder.

3. Place the cell under running water. 

4. Replace the cell.

NOTE: Replace the cell so that the arrow on the bottom 
of the cell points in the same direction as the flow.

5. Connect the inlet and outlet tubing to the cell.
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Replacing
pH probe

To replace the pH probe:

1. Make sure the black O-ring is on the tip of the pH probe.

2. Carefully push the probe into the cell until the probe is all 

the way to the bottom of the flow cell.

3. Tighten the retaining cap only until it is snug.

CAUTION
Do not overtighten the retaining cap. Overtightening can 
break the glass membrane of the probe.
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9.5.2  Calibrating the pH Probe

pH values NOTE: The pH probe in the BioCAD 700E Workstation 
provides a way to monitor pH values during methods 
development and execution. It is not intended for use as a 
precision benchtop pH meter.

When to
calibrate

Calibrate the pH probe weekly.

NOTE: Calibrate the pH probe daily if you are operating 
under Good Laboratory Practices.

Calibration
solution

For accurate performance, calibrate the pH probe with one of 

the following:

• Standards at pH 4 and 7.

• Standards at pH 7 and 10.

• Two buffers that cover the range of interest. Check the 

buffers with a calibrated pH meter before calibrating the 

BioCAD 700E pH probe.

CAUTION

Do not expose the probe to organic solvents.

Calibrating This procedure performs a two-point calibration. To calibrate the 

pH probe:

1. Select Calibrate pH from the Detector menu in the 

Control Panel.

The pH and conductivity monitors are placed in bypass 

mode and the pH Calibration dialog box is displayed 

(Figure 9-8).

Figure 9-8  pH Calibration Dialog Box
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2. Enter the pH value of the first calibration standard (or 

buffer) in the pH text box and click OK.

3. Using a syringe, inject the first calibration standard

(or buffer) through port 1 (black connector) on the Detector 

Bypass valve (Figure 9-9). Continue injecting until the pH 

reading in the Status window stabilizes. Click OK.

Figure 9-9  Injecting Calibration Solution

A second pH Calibration dialog box is displayed.

4. Enter the pH value of the second calibration standard (or 

buffer) in the pH text box and click OK.

5. Using a syringe, inject the second calibration standard

(or buffer) through port 1 (black connector) on the Detector 

Bypass valve (Figure 9-9). Continue injecting until the pH 

reading in the Status window stabilizes. Click OK.

The pH probe is now calibrated.

PB100545

pH/conductivity

Bypass valve

Port 1
(black connector)
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9.5.3  Storing the pH Probe

Short term
shutdown

When the pH probe is not in use, flush the system with 1 M salt 

solution. Then click the Bypass option button in the pH/Cond 

section of the Control Panel to remove the pH and conductivity 

monitors from the flow path before flushing the system with 

other solutions. 

Long term
shutdown

If you will not be using the pH probe for longer than one week, 

or if you will be moving the workstation, remove the probe and 

store it in the shipping bottle with 4.0 M KCl.

9.5.4  Calibrating the Conductivity Monitor

When to
calibrate

Calibrate the conductivity monitor weekly.

NOTE: Calibrate the conductivity monitor daily if you are 
operating under Good Laboratory Practices.

Calibration
solutions

Use commercially available conductivity standards to calibrate 

the conductivity monitor. If you do not have standards available, 

use HPLC-grade water and 1 M NaCl.

Calibrating You can calibrate the conductivity monitor in conventional 

mS (millisiemen) units or in concentration units of a specific 

eluent, such as mM for NaCl. The following procedure performs 

a two-point calibration. 

To calibrate the conductivity monitor:

1. Select Calibrate Conductivity from the Detector menu 

on the Control Panel.

The pH and conductivity monitors are placed in bypass 

mode and the Conductivity Calibration dialog box is 

displayed (Figure 9-10).
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Figure 9-10  Conductivity Calibration Dialog Box

2. Enter the conductivity value of the first standard and 

click OK.

NOTE: The conductivity value for water is 0.0 mS.

3. Using a syringe, inject a low calibration standard through 

port 2 (red connector) on the Detector Bypass valve (see 

Figure 9-9). Continue injecting until the conductivity reading 

in the Status Window stabilizes. Click OK. 

A second Conductivity Calibration dialog box is 

displayed.

4. Enter the conductivity value of the second standard and 

click OK. 

NOTE: The conductivity value for 1 M NaCl is 77.8 mS.

5. Using a syringe, inject a high calibration standard through 

port 2 (red connector) on the Detector Bypass valve (see 

Figure 9-9). Continue injecting until the conductivity reading 

in the Status Window stabilizes. Click OK. 

The conductivity monitor is now calibrated.
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9.6  Pump Maintenance

This section describes:

• Replacing the pump seals and cleaning the pistons and 

pump heads

• Cleaning the check valves

• Cleaning the filter frit

9.6.1  Replacing the Pump Seals and
Cleaning the Pistons and Pump Heads

This section describes:

• When to replace and clean

• Removing pump heads

• Replacing solvent pump seal

• Replacing wash pump seal

• Cleaning the piston

• Cleaning the front pump head

• Replacing pump heads

When to replace
and clean

Replace the pump seals and clean the pistons every six months 

or when the pump is leaking. 

NOTE: When you change pump seals, always change seals 
in both the primary pump head (right) and the accumulator 
pump head (left).

The BioCAD 700E Workstation includes an automatic pump 

seal wash that significantly extends the pump seal life. For more 

information, see “Pump seal wash system” on page 1-11. 

Running the SYSCLEAN. MET daily extends the life of the 

pump seals. For more information, see “Shutting down” on 

page 2-38.
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Removing
pump heads

To remove the pump heads:

1. Exit the BioCAD software.

This closes the six solvent proportioning valves in the 

base of the pump unit and prevents leaking.

2. Remove the pump seal wash lines from the seal wash 

solution (see Figure 1-4 on page 1-10).

• Primary pump head (right)—Remove the 

tubing from the outlet (top) check valve housing 

(Figure 9-11). Remove the barb and tubing from 

the inlet (bottom) check valve housing. (Do not 

remove the tubing from the barb.)

• Accumulator pump head (left)—Remove the 

tubing from the top and bottom of the pump 

head

NOTE: It is not necessary to remove the seal wash 
tubing from the back pump head.

3. Using a 9/64-inch hex wrench, remove the retaining bolts 

holding the pump heads in place (Figure 9-11).

4. Remove the pump heads.

5. Separate the front and back pump heads.

• Solvent (front) pump head—Controls solvent 
delivery

• Seal wash (back) pump head—Controls pump 
seal wash delivery
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Figure 9-11  Primary Pump Assembly 

NOTE: The Accumulator pump assembly is the same as the 
Primary pump assembly except that the solvent (front) head 
on the Accumulator pump has fittings instead of check valve 
housings. Also, the solvent pump seal and the piston on the 
Accumulator pump are smaller. 
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Replacing the
solvent pump

seal

All parts you need to replace seals are contained in the Pump 

Head Seal Kit. 

To replace the solvent pump seal:

1. Use the flanged end of the removal tool (Figure 9-12) 

(included in THE Pump Head Seal Kit) to remove the 

solvent pump seal from the solvent (front) pump head 

(Figure 9-13).

Figure 9-12  Pump Seal Removal and Insertion Tool

Figure 9-13  Replacing Solvent Pump Seal

For inserting solvent pump 
seal on Accumulator pump

For inserting
wash pump seals

For inserting 
solvent pump seal 
on Primary pump

Flanged end 
for removing 

seals
PB100833

PB100747

Spring
facing
to front

O-Ring

Solvent
(front)
pump
head

Pump seal
(solvent)



Pump Maintenance

BioCAD® 700E Workstation User Guide 9-27

9

2. Use the blunt end of the removal/insertion tool (Figure 9-12) 

to insert the new solvent pump seal with the spring in the 

seal facing toward the front of the pump head (Figure 9-13). 

NOTE: Be sure to use the larger pump seal for the 
Primary pump head, and the smaller pump seal for the 
Accumulator pump head.

3. Use the removal/insertion tool or your finger to seat the new 

solvent pump seal. The spring is not visible when the pump 

seal is properly installed.

Replacing the
wash pump seal

To replace the wash pump seal:

1. Use the flanged end of the removal/insertion tool 

(Figure 9-12) (in the Pump Head Seal Kit) to remove the 

wash pump seal from the seal wash (back) pump head 

(Figure 9-14). 

Figure 9-14  Replacing Wash Pump Seal

2. Use the blunt end of the removal/insertion tool to insert the 

new wash pump seal with the spring in the seal facing 

toward the front of the pump head (Figure 9-14). 

NOTE: The wash pump seals are identical for the 
Primary pump head and the Accumulator pump head.

3. Use the removal/insertion tool or your finger to seat the new 

wash pump seal. The spring is not visible when the seal is 

properly installed.

PB100748

Spring
facing
to front

Pump seal
(wash)

 

Seal wash
(back)
pump
head



Chapter  9    Maintenance

9-28 Applied Biosystems

9

Cleaning the
pistons

To clean the pistons:

1. Remove the washer from the piston (see Figure 9-11 on 

page 9-25).

CAUTION
Touch the piston as little as possible. Finger oil can 
adversely affect pump performance.

2. Remove the piston by grasping the metal base of the piston 

and sliding it to the right to remove it from the notch in the 

piston holder (Figure 9-15).

Figure 9-15  Removing the Piston

3. Using the scrubbing pad (in the Pump Head Seal Kit), scrub 

the piston using a rotary motion.

CAUTION
Do not scrub the piston using a linear motion (back and 
forth) because this will damage the piston. Touch the 
piston as little as possible. Finger oil can adversely affect 
pump performance.

4. Rinse the piston with water.

5. Replace the piston by sliding the metal base into the notch 

in the piston holder (Figure 9-15).

PB100749
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NOTE: If you replace the piston with a new piston, be 
sure to use a piston from the correct piston kit (Primary 
or Accumulator pump head).

6. Reinstall the washer (see Figure 9-11).

Cleaning
the solvent
pump head

To clean the solvent (front) pump head:

1. Place the solvent pump head (Figure 9-13) under running 

water and wash off any debris or residue.

2. Thoroughly dry the solvent pump head before reinstalling.

Reinstalling
the pump heads

To reinstall the pump heads:

1. Slide the seal wash (back) pump head over the piston (see 

Figure 9-11). Position the pump head so that the fitting is at 

the top and the check valve housing is at the bottom.

2. Place the O-ring around the front part of the pump head 

(see Figure 9-11).

3. Slide the solvent pump head over the piston. 

NOTE: Make sure the solvent pump head is oriented so 
that the opening near the letter “P” faces up.

4. Push the solvent pump head onto the unit, then finger-

tighten the retaining bolts. Do not tighten the bolts all the 

way.

NOTE: If you cannot push the solvent pump head all the 
way on the unit, do not use excessive force. If pump 
heads are hard to seat, reach your finger up behind the 
pump head to verify that the piston is centered.

5. Place the pump seal wash lines in the flush solution and 

prime the pump seal wash lines. See Section 3.4.2, Priming 

the Buffer/Solvent Lines, for the priming procedure.
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6. Start the BioCAD software, then set the pump flow rate to 5 

ml/min.

7. Alternately tighten the retaining bolts as the piston moves. 

Tightening the bolts as the piston moves aligns the piston 

and pump seals.

8. Reinstall, then prime the pump lines. See the user’s guide 

provided with your system for the priming procedure.

9.6.2  Cleaning the Check Valves

Clean the check valves on the primary pump head every 

six months.

To clean the check valves, you must:

• Remove the check valves

• Sonicate the check valves

• Reinstall the check valves

Removing To remove the check valves from the primary pump head 

(Figure 9-16):

1. Remove the tubing from the outlet (top) check-valve 

housing. Remove the barb and tubing from the inlet 

(bottom) check-valve housing. Do not remove the tubing 

from the barb.

2. Unscrew the check valve housings from the pump head.
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Figure 9-16  Check Valves 

3. Remove each check valve from its housing. Yoiu may need 

to force the valves out by injecting water from a syringe 

(though the housing).

Sonicating
WARNING

Before handling any chemical, refer to its Material Safety 
Data Sheet provided by the manufacturer, and observe all 
relevant precautions.

To clean the check valves, sonicate the check valves and 

housings in 30% isopropanol-water for 10 minutes.
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Reinstalling To reinstall the check valves:

1. Reassemble the check valves and housings as shown in 

Figure 9-17. 

NOTE: The inlet and outlet check valves are 
interchangeable. However, make sure the three-hole end 
of each check valve faces up (Figure 9-17). 

Figure 9-17  Re-assembling Check Valves

2. Install the reassembled check valves and housings on the 

pump head.

 NOTE: Make sure to insert the inlet housing on the 
bottom of the pump head and the outlet housing on the 
top of the pump head. The inlet housing has a larger 
diameter through-hole.

3. Finger-tighten the housings, then tighten an additional 1/8 

turn with a small wrench.

PB100753

 

Primary front pump head

P

Outlet check valve housing—smaller diameter
through-hole

Inlet check valve—three holes face up 
toward pump head

Inlet check valve—three holes face up 
toward pump head

Outlet check valve—three holes face up
away from pump head

Inlet check valve housing—larger diameter
through hole



Pump Maintenance

BioCAD® 700E Workstation User Guide 9-33

9

NOTE: If the check valve housing does not screw in to 
the proper depth, the check valve is not seated properly. 
Unscrew the housing, remove the check valve, reposition 
it, then reinstall it into the pump head.

9.6.3  Cleaning the Filter Frit

WARNING
Before handling any chemicals, refer to the Material Safety 
Data Sheet provided by the manufacturer, and observe all 
relevant precautions.

Clean the filter frit monthly. To clean the filter frit:

Removing 1. Remove the compression ring fitting from end cap at the 

bottom of the Filter/Mixer (see Figure 1-4 on page 1-10). 

2. Using a 1/2-inch wrench, unscrew the end cap from the 

bottom of the Filter/Mixer.

3. Remove the filter frit (PEEK disk) from the end cap. If the 

filter frit is not on the end cap, remove it from the 

Filter/Mixer assembly.

Cleaning 4. Sonicate the filter assembly and filter frit in 30% 

isopropanol-water for 10 minutes.

5. Rinse the filter assembly and filter frit in deionized water.

NOTE: If the frit is discolored, replace it with a new frit.

Replacing 6. Place the frit on top of the end piece.

7. Screw the end piece into the bottom of the Filter/Mixer, then 

tighten 1/8 turn with a 1/2-inch wrench.

8. Reinstall the compression ring fitting.
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9.7  Autoloader Maintenance

Inspect and change (if necessary) the autoloader syringe seal 

every six months. 

The following sections describe:

• Removing the syringe

• Inspecting the syringe seal

• Changing the syringe seal

• Replacing the syringe

Removing
the syringe

To remove the syringe:

1. On the Control Panel, select Change Syringe from the 

Sample menu. 

The syringe plunger retracts and the Set Syringe Size 

dialog box is displayed.

CAUTION
Do not remove the syringe before retracting the plunger. 
The syringe can break.

2. Unscrew and remove the knurled knob at the base of the 

plunger. 

3. Unscrew the body of the syringe (turn to the left) and 

remove.

Inspecting the
syringe seal

To inspect the syringe seal:

1. Hold the syringe in one hand.

2. Move the plunger through its full range of motion.

You should feel a constant resistance through the entire 

range. If the plunger slips at any point, the seal is worn 

and must be replaced. See“Changing the syringe seal” on 

page 9-35.
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Changing the
syringe seal

To change the syringe seal:

1. Remove the syringe as described in “Removing the 

syringe” on page 9-34.

2. Remove the plunger from the barrel of the syringe.

3. Remove the syringe seal from the top of the plunger by 

gripping it with a pair of pliers approximately one-third of 

the way down and pulling it off.

4. Slip a new O-ring over the plunger tip.

5. Wet the O-ring and plunger tip with deionized water.

6. Place the new seal on a flat surface with the open end 

facing up.

7. Press the plunger tip into the hole in the seal until the seal 

snaps into place.

8. Wet the seal and insert the plunger into the syringe barrel.

9. Replace the syringe as described in “Replacing the syringe” 

on page 9-36.
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Replacing
the syringe

To replace the syringe:

1. Place the hole in the base of the plunger over the pin on 

the syringe piston (Figure 9-18).

Figure 9-18  Replacing the Syringe

2. Pull up on the syringe body until it reaches the fitting.

3. While pushing up gently, turn the syringe body to the right 

and screw into place.

4. Replace the knurled knob in the plunger base.

5. Click OK in the Set Syringe Size dialog box.

The syringe plunger returns to the home position.

POWER FRACTION

LAMP

PUMP EVENT MARK

PerSeptive Biosystems, Inc.
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9.8  Valve Maintenance

Clean the injection and column switching valve stators every six 

months.

Cleaning stators To clean the injection and column switching valve stators:

1. Unscrew all fittings from the injection and column 

switching valves.

2. Using a 9/64-inch hex wrench, unscrew the three screws 

holding the metal stator support ring in place. Remove the 

support ring.

3. Remove the front of the injection and column switching 

valves. The front piece includes the stator face assembly 

(PEEK). Separate the two pieces of the valve front.

NOTE: If the assembly does not include two pieces, the 
stator face assembly may be stuck in the valve. Remove 
it from the valve.

4. Sonicate the two pieces in 30 percent isopropanol for ten 

minutes.

5. Rinse the two pieces with deionized water. Wipe with a 

lint-free tissue.

6. Reassemble by aligning the pins on the stator face 

assembly with the holes on the stator.

7. Place the reassembled pieces in the injection and column 

switching valves by aligning the pin in the injection and 

column switching valves with the hole in the stator.

8. Replace the stator support ring. Make sure the numbers on 

the ring are positioned properly with the number 1 at the top 

right and the number 2 at the top left.

9. Alternately tighten the three screws until finger-tight. Make 

sure equal pressure is applied to each screw.

10. Using a 9/64-inch hex wrench, tighten the screws 

1/4-turn past finger-tight.
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9.9  Autosampler Maintenance

Autosampler maintenance includes:

• Cleaning and replacing the autosampler needle

• Adjusting the needle height

• Cleaning the sample tray area

• Cleaning autosampler rails and rollers

9.9.1  Cleaning and Replacing 
the Autosampler Needle

Once a month, inspect the autosampler needle to see if it is 

plugged. If it is plugged, clean or sonicate the needle module. If 

cleaning does not unplug the needle, replace the needle.

This section describes:

• Removing and inspecting the needle

• Cleaning the needle module

• Installing the needle module

Removing and
inspecting
the needle

To remove and inspect the needle:

1. Power down the autosampler.

2. Open the autosampler door.

3. Remove the needle module from the holder by carefully 

unclipping it from the tower and pulling toward the rear of 

the autosampler (Figure 9-19).
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Figure 9-19  Removing the Autosampler Needle Module

(Right Side View of Autosampler Area)

4. Look at the needle tip. If the bore is plugged, unscrew the 

needle line from the autosampler injector valve (port 2) 

using a 1/4-inch open-end wrench. Clean the needle 

module as described in “Cleaning the needle module” on 

page 9-40.

CAUTION
The needle line is very fragile. Do not bend or kink the 
line. The sample needle module is glued during 
manufacture. Do not try to disassemble.

PB100139
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Cleaning the
needle module

To clean the autosampler needle module, flush it using the 

BioCAD 700E solvent pump:

WARNING
Wear safety glasses when performing this procedure.

AVERTISSEMENT
Veuillez porter des lunettes de sécurité lors de cette 
opération.

1. Connect the needle line to the pump filter on the BioCAD 

700E.

Figure 9-20  BioCAD 700E Pump Filter

2. Place buffer/solvent line A in water. Place the needle in a 

waste container.

3. On the BioCAD 700E Control Panel, select buffer/solvent 

channel A and start the pump at 0.1 ml/min.

Filter Purge

Mixer

PB100473

Connect
needle
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NOTE: Observe the pump filter connection. If the 
connection is leaking, tighten with a wrench. Do not 
overtighten.

4. Do one of the following:

Installing the
needle module

To install the needle module:

1. Snap the needle module into place on the sample tower. 

Position the needle module so that its label, “This side 

out”, faces the sample tray area.

2. Thread the needle line through the hole in the front of the 

autosampler.

3. Screw the needle line into the autosampler injector valve 

(port 2). Tighten with a 1/4-inch open-end wrench.

If you are installing a new needle module, use the fitting 

and ferrule provided with the needle.

4. If you are installing a new needle module, adjust the needle 

height. See Section 9.9.2, Adjusting the Needle Height.

If fluid flows 

out of the 

needle

1. Increase flow rate to 2 ml/min or 

5 ml/min until you see a steady 

stream of liquid.

2. Stop pump flow.

3. Reinstall the needle module.

If fluid does 

not flow out 

of the needle

1. Stop pump flow.

2. Disconnect the needle line from the 

pump filter.

3. Sonicate the needle module for 

5 minutes.

4. Flush the needle again and check 

for flow.

5. If there is no flow, install a new 

needle module.
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9.9.2  Adjusting the Needle Height

Adjust the needle height when you install a new needle.

To adjust the needle height:

1. Prime the autosampler lines with autosampler flush 

solution. For more information, see Section 3.6.5, Priming 

the Autosampler.

2. Close the BioCAD software if it is open.

3. Click the Start button, then click Run.

The Run dialog box is displayed.

4. Type C:\BIOCAD\SYSDIAG.EXE in the Open text box and 

click OK.

The BioCAD 700E System Level Diagnostics window is 

displayed. 

5. Select Autosampler Display from the Windows menu.

The Autosampler window is displayed (Figure 9-21).

Figure 9-21  Autosampler Window

Click
here



Autosampler Maintenance

BioCAD® 700E Workstation User Guide 9-43

9

6. When the Current State field displays Ready, click the Set 
button in the Needle Height section of the window.

A dialog box is displayed (Figure 9-22) listing the 

equipment you need to adjust the needle height.

.

Figure 9-22  Autosampler Needle Height Equipment

7. Click OK to continue the procedure.

The following Autosampler Needle Height dialog box is 

displayed (Figure 9-23).

Figure 9-23  Autosampler Needle Height—Vial Weight
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8. Fill a standard 1800 µl vial with 400 mg of deionized water, 

weigh it, and place the vial in autosampler position A1. Type 

the weight of the vial and contents in the weight text box. 

Click Continue and wait for the autosampler to make an 

injection from the vial in position A1.

The following Autosampler Needle Height dialog box is 

displayed (Figure 9-24).

Figure 9-24  Autosampler Needle Height—Vial Weight

9. Remove the vial from position A1 and weigh the vial and 

contents. Type the final weight in the weight text box and 

click Continue.

The autosampler compares the pre-injection weight to 

the post-injection weight. The following Autosampler 

Needle Height dialog box is displayed with the adjusted 

needle height, which can be between 0.0 and 2.0 mm.

Figure 9-25  Autosampler Needle Height 
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10. Repeat step 6 through step 9.

After repeating the procedure, if the needle height 

adjustment is the same, a dialog box is displayed stating 

that the needle height is properly adjusted.

After repeating the procedure, if the needle height 

adjustment is not the same, repeat the procedure until 

you get the same result. If you cannot get the same 

result, check the following:

• Vial weighed correctly

• Weights entered correctly

• Needle installed properly

• Autosampler primed properly

• Leaks in the system

9.9.3  Cleaning the Sample Tray Area

Clean the sample tray area once a week.

To clean the sample tray area:

1. Remove autosampler trays.

2. Clean the autosampler tray area with a damp paper towel 

and dry out.

3. Clean the trays and replace.
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9.9.4  Cleaning the 
Autosampler Rails and Roller

Every three months, clean the autosampler rails and rollers to 

ensure smooth operation of the autosampler arm.

CAUTION

Do not oil the rails or roller. Oiling these parts will cause dust 
to collect and jam the mechanism.

To clean the autosampler rails and rollers:

1. Remove autosampler trays.

2. Using a lint-free tissue, wipe the rails and rollers 

(Figure 9-26).

Figure 9-26  Cleaning Autosampler Rails and Rollers
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9.10  Hard Disk Maintenance

This section includes procedures for maintaining and 

configuring the hard disk on your workstation. It describes:

• Backing up and archiving data

• Testing hard disk integrity

• Defragmenting the hard disk

CAUTION

Do not compress the hard disk. Hard disk compression slows 
system performance. Also, if you have a hard disk failure, it is 
very difficult to retrieve data if the hard disk is compressed.

Operating
system

requirements

To perform the procedures in this section, your workstation must 

be running Windows 95.

BioCAD 700E Workstations are currently shipped with

Windows 95 installed. 

Viewing files Use Windows Explorer to view the files stored in specific drives 

and directories.

Use the commands in the View menu to:

• View file details, such as the file size and date and time 

files were collected.

• Sort files. You can sort and display files by date, name, 

type, or size.
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9.10.1  Backing Up and Archiving Data

Back up data weekly, or as needed. Back up and archive data if 

the free disk space on your hard drive is less than 20%.

Why back up
data?

To run properly, the BioCAD software requires:

• Disk space for the data recorder

• Disk space for data files and method files

• Disk space for printing

If the disk becomes full, writing data files, printing, or saving 

methods may fail and can result in loss of data. The system also 

operates more slowly as free disk space decreases. 

To maintain adequate disk space, back up and archive data on a 

routine basis:

• Back up—Temporarily store data in case of a hard disk 

problem.

• Archive—Permanently store important data for retrieval 

at a later time, and remove the original data from the hard 

drive.
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Backing up Use the Backup utility to back up data.

The first time you run the Backup utility, it automatically 

configures itself for your system. You will need two blank 

1.44 MB floppy disks so the Backup utility can test the floppy 

drive.

NOTE: It is necessary to copy only data files, group files, 
method files, and multi-method files. You can retrieve 
configuration files from data files.

To back up data:

1. Start Windows.

2. Click Start, point to Programs, point to Accessories, point 

to System Tools, and then click Backup.

The Welcome to Microsoft Backup window is displayed.

3. Follow the onscreen instructions. 

Archiving On a regular basis (frequency depends on your workload and 

amount of data), copy data files from completed projects to a 

floppy disk or other backup media. Use Windows Explorer to 

copy data. For instructions on using Windows Explorer, see the 

Microsoft Windows User’s Guide.

After copying the data to backup media, delete it from your hard 

disk. Make sure to properly label the media.
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9.10.2  Testing Hard Disk Integrity 

Once a week, run ScanDisk to verify the hard disk drive integrity 

and repair it if necessary.

To test disk integrity:

1. Start Windows.

2. Click Start, point to Programs, point to Accessories, point 

to System Tools, and then click ScanDisk.

The ScanDisk dialog box is displayed.

3. Select Thorough and click Start.

NOTE: Selecting Thorough can take over one hour to 
complete. Run ScanDisk when you will not be using the 
workstation. 

4. Follow the onscreen instructions. 



Hard Disk Maintenance

BioCAD® 700E Workstation User Guide 9-51

9

9.10.3  Defragmenting the Hard Disk

Why defragment
the hard disk?

Once a month (or as needed), defragment your hard disk to 

optimize disk performance.

When your workstation is first installed, each file uses 

sequential (contiguous) blocks on the hard disk. The free space 

on the disk is also sequential. This provides the fastest access 

because the whole file can be read without searching more than 

one area of the disk. 

As files are created and deleted from the disk, and disk blocks 

are reused, the disk becomes fragmented. New files no longer 

use sequential blocks on the disk, and it takes longer to access 

these files. In addition, the system must search the disk for free 

space when creating new files.

Defragmenting the disk reorganizes the files so they are 

sequential on the disk. Defragmenting can substantially improve 

system speed, especially if the disk is badly fragmented.

Defragmenting To defragment the hard disk:

1. Free up as much disk space as possible by backing up 

and deleting unneeded files. For more information, see 

Section 9.10.1, Backing Up and Archiving Data.

2. Delete all files from the C:\BIOCAD\TEMP directory.

NOTE: Files in the C:\BIOCAD\TEMP directory are Strip 
Chart Recorder files. You lose the contents of the Strip 
Chart Recorder when you delete these files.

3. Click Start, point to Programs, point to Accessories, point 

to System Tools, then click Disk Defragmenter.

The Select Drive dialog box is displayed.

4. Follow the onscreen instructions. 
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9.11  Long Term Shutdown

If you are shutting down the BioCAD 700E Workstation for more 

than one week:

1. Click the Bypass option button in the Column section of 

the Control Panel, to take the column out of line.

NOTE: If you select Low Dispersion, Three Columns, or 
Direct Control column plumbing configurations, you 
cannot bypass the column. Replace the columns with 
unions before running the SYSCLEAN method.

2. Purge the system with a 1 M salt solution to prepare the pH 

and conductivity monitors for shutdown. For more 

information, see Section 5.2.4, Purging the System.

3. Run the SYSCLEAN method as described on page 2-38.

NOTE: As an alternative to running the SYSCLEAN 
method, you can purge the system with water from the 
Control Panel. Take the pH monitor offline by clicking the 
Bypass option button in the pH/Cond section of the 
Control Panel. Then purge the system with filtered 
deionized water. For more information, see Section 5.2.4, 

Purging the System.

4. Purge the system with a solution of water and 

isopropanol (80:20). For more information, see Section 

5.2.4, Purging the System.

5. Remove the pH probe and store as described in 

Section 9.5, pH and Conductivity Monitor Maintenance.

6. Exit the BioCAD software by selecting Exit BioCAD from 

the File menu in the Control Panel.

7. Exit Microsoft Windows by clicking Start, then Shut Down.
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8. Power down the components of the workstation in any 

order. 

9. Set the Helium On/Off switch to the Off position.

10. Power down the BioCAD 700E Workstation.

11. Turn off all gas and helium sources.

CAUTION
Do not close the helium tank without turning off the 
helium switch. Helium diffuses out of the line, forming a 
vacuum, which pulls liquid into the sparging system.

NOTE: If you shut down the system for an extended time 
period, you may want to remove the pH probe. Store the 
probe in the storage solution (saturated KCl) and 
protective container provided with the probe.
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10.1  Troubleshooting

This section contains troubleshooting information for:

• System 

• Control Panel

• Status window

• Strip Chart Recorder

• Fraction Collector

• Integrated autosampler

• Sample Table

• Method Editor

• Templates

• Computer

Technical
support

If you cannot solve problems using the guidelines in the 

following sections, call Applied Biosystems Technical Support. 

To reach Applied Biosystems Technical Support, refer to the 

back cover of this book.
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10.1.1  System Troubleshooting

Table 10-1   System Troubleshooting 

Symptom Possible Cause Action

No fluid flowing 

from the BioCAD 

700E waste line

Buffer/solvent line not in 

reservoir

Place line in reservoir and 

secure. Prime lines. See 

Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Reservoirs empty Fill reservoir. Prime lines. See 

Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Lines not primed Prime buffer/solvent lines. See 

Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Leak in flow path Check all fittings for leaks.

Wrong valve plumbed to 

waste

Check both ports on 

fraction/waste valve. 

Bottom port should be 

plumbed to waste. 

Replumb if necessary.

Erratic flow and 

short-term 

pressure 

fluctuations

Buffers/solvents not sparged Sparge buffers/solvents.

See Section 3.2.1, Preparing 

Buffers/Solvents.

Air bubbles in line Prime buffer/solvent lines. See 

Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Check valves leaking Clean check valves. 

See Section 9.6.2, Cleaning the 

Check Valves.



Chapter  10    Troubleshooting and Error Codes

10-4 Applied Biosystems

10

High pressure 

shutdown

Tubing plugged or crimped Flush tubing, uncrimp. 

Replace tubing if necessary. 

See Section 3.1.3, Plumbing 

Tubing and Columns.

High Pressure limit is set too 

low in the Configuration 

dialog box

Increase high pressure limit. 

See Section 4.2.1, Configuring 

the Pump.

Column option set in the 

Configuration dialog box 

does not match physical 

plumbing. For example, the 

workstation is plumbed with 

two columns, and you have 

one column configured.

Check column plumbing and 

column option selected in the 

Configuration dialog box. 

Adjust. See Section 4.2.4, 

Configuring Columns and 

Plumbing.

Column pressure set too low 

in configuration dialog box

Adjust column pressure limit. 

See Section 4.5.3, Customizing 

the Column Library.

Column or column frit 

plugged

Clean column.

Wash column, replace column 

frit.

Replace column.

Pump filter frit on BioCAD 

700E Workstation plugged

Clean or replace frit. 

See Section 9.6.3, Cleaning the 

Filter Frit.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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High pressure 

shutdown 

(continued) 

Ports on sample injection 

valve or column switching 

valves are blocked

Identify which port is blocked 

and backflush valve by 

reversing appropriate 

plumbing. 

Clean or replace stators. See 

page 9-37.

UV/Vis detector flow cell 

blocked

Backflush detector flow cell by 

switching inlet and outlet 

connections and starting 

pump.

Wrong tubing or flow cell for 

flow rate range

Change tubing. See 

Section 3.1.1, Selecting Tubing 

Diameter and Length, for 

tubing diameter/flow rate 

ranges.

Change flow cell. See 

Section 9.4.3, Changing the 

UV/Vis Detector Flow Cell.

Gradient not linear Buffers/solvents not sparged Sparge buffers/solvents.

See Section 3.2.1, Preparing 

Buffers/Solvents.

Buffer/solvent lines not 

primed

Prime buffer/solvent lines. See 

Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Gradient delayed Tubing diameter too large for 

application

Change tubing. See 

Section 3.1.1, Selecting Tubing 

Diameter and Length, for 

tubing diameter/flow rate 

ranges.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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Unexpected 

gradient 

performance

Gradient not programmed 

properly

Check method and Blend 

Graph. Run gradient from 

Control Panel to duplicate 

error.

Blend settings on Control 

Panel Settings not activated 

until you click Set.

Click Set.

See “Gradient not linear” 

causes and actions

____________

No peaks Buffer/solvent lines not 

purged properly, you did not 

click Set after changing 

blend settings

When purging from the 

Control Panel, click Set after 

changing settings.

UV/Vis lamp off Turn UV/Vis lamp on.

No flow Start pump.

Reservoirs empty Fill reservoirs. Prime lines. 

See Section 3.4.2, Priming the 

Buffer/Solvent Lines.

Wrong buffer/solvent 

configured for your 

application

Adjust configuration. See 

Section 4.2.2, Configuring 

Buffers/Solvents.

Wrong buffer/solvent used 

for your application, no 

peaks eluting from column

Change buffer/solvents.

Wrong wavelength set in 

method or Control Panel

Adjust wavelength.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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No peaks 

(continued)

Problems with chemistry or 

application

Address problems with 

chemistry or application.

Sample proteins bound to 

filter during sample 

preparation

Use low-protein-binding filter.

Non-specific absorbance to 

column

Determine by bypassing 

column and making injection 

from Control Panel. If peak is 

present when column 

bypassed, reevaluate column 

or mobile phase chemistry.

No sample injected See “No sample injected” 

causes and actions below.

No sample injected Wrong sample channel 

selected

Select proper sample channel 

(1, 2, 3, or 4) in the Control 

Panel or method. 

See Section 5.3.1, Making 

Autoloader Injections, or 

Section 6.3.2, Making 

Autoloader Injections in a 

Method.

Sample lines not primed Prime autoloader sample 

lines. See Section 3.4.3, 

Priming and Flushing the 

Autoloader Sample Lines, or 

“Sample Loader Events” on 

page 6-42.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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Chromatogram run 

in single 

wavelength mode 

between 366 nm to 

450 nm differs from 

chromatogram run 

in dual-wavelength 

mode at same 

wavelength.

In single wavelength mode, 

wavelength ranges for lamps 

are:

• Deuterium—190 to 365 

• Tungsten—366 to 800

In dual-wavelength mode, 

wavelength ranges for lamps 

are: 

• Deuterium—190 to 450

• Tungsten—366 to 700

No action. Lower sample rate 

in dual mode caused by the 

grating movement between 

wavelengths.

Beeping and 

clicking noise from 

internal UV/Vis 

detector

Motorized grating is 

switching between 

wavelengths in 

dual-wavelength mode

No action, normal occurrence.

Pump shuts down “Pump Off” or “Set Flow Rate 

= 0” events added to method

Check method for “Pump Off” 

or “Set Flow Rate = 0” events.

See “High pressure 

shutdown” causes and 

actions
____________

No signal collected 

on UV/Vis #2 

detector channel

UV/Vis #2 channel not 

enabled

Enable UV/Vis #2 channel in 

Configuration dialog box. See 

Section 4.2.5, Configuring 

Detectors.

No external detector 

selected in BioCAD 

hardware setup

Update hardware setup. See 

Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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Excessive noise in 

chromatogram

Buffers/solvents not sparged Sparge buffers/solvents.

See Section 3.2.1, Preparing 

Buffers/Solvents.

Electronic interference Make sure other equipment 

connected to outlet is well-

grounded. Use surge 

protector.

UV/Vis flow cell plumbed 

incorrectly

Remove the flow cell cover 

and verify the inlet tubing is 

plumbed to the bottom of the 

flow cell and outlet tubing to 

the top of the flow cell. 

Reversed connections may 

trap air bubbles in the flow 

cell. See Section 9.4.3, 

Changing the UV/Vis Detector 

Flow Cell

Dirty or cracked UV/Vis flow 

cell

Clean or replace flow cell. 

See Section 9.4.2, Cleaning the 

UV/Vis Detector Flow Cell, or 

Section 9.4.3, Changing the 

UV/Vis Detector Flow Cell.

Low UV/Vis detector lamp 

energy

Replace UV/Vis lamp. See 

Section 9.4.1, Changing the 

UV/Vis Detector Lamps.

Buffer in use contains 

UV-absorbing compound

Use buffer/solvent without 

UV-absorbing compound.

Tubing, column, injection or 

column switching valves dirty

Replace tubing. Clean 

column. Clean valve stators 

See page 9-37.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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pH response slow 

or not accurate

Dirty pH probe Clean pH probe. 

See Section 9.5.1, Cleaning the 

pH Probe and Cell.

pH probe not seated properly Reinstall the pH probe. See 

“Replacing pH probe” on 

page 9-18.

pH probe not properly 

calibrated

Calibrate the pH probe.

See Section 9.5.2, Calibrating 

the pH Probe.

pH monitor bypassed Place pH monitor inline by 

doing one of the following:

• Adjust General Settings 

in method to place pH 

monitor inline.

• Click Inline option button 

in pH/Cond section of 

Control Panel.

pH cell dirty Clean pH cell. See 

Section 9.5.1, Cleaning the pH 

Probe and Cell.

Buffers do not have buffering 

capacity at the working pH

Monitor pH with pump flowing 

and column bypassed.

PH.CAL file corrupt Delete PH.CAL file (in 

BIOCAD directory) and reboot 

computer.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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Conductivity 

monitor response 

not accurate

Conductivity monitor not 

properly calibrated

Calibrate conductivity monitor. 

See Section 9.5.4, Calibrating 

the Conductivity Monitor.

Conductivity monitor 

bypassed

Place conductivity monitor 

inline by doing one of the 

following:

• Adjust General Settings 

in method to place 

conductivity monitor 

inline.

• Click Inline option button 

in pH/Cond section of 

Control Panel.

Blockage in conductivity flow 

cell

Backflush flow cell by 

switching inlet and outlet 

connections and starting 

pump.

No data collected 

during Inject or 

Autosampler Inject 

segment

There is a Data Collection 

End event in the method 

before the Inject or 

Autosampler Inject segment

Delete the Data Collection 

End event. 

Move the Data Collection End 

event after the Inject or 

Autosampler Inject segment.

UV/Vis detector 

resets to single 

wavelength at end 

of method

When you run a method with 

dual wavelength enabled, 

the setting changes to single 

wavelength at the end of a 

method to reduce wear of 

the detector grating

No action, normal occurrence.

Table 10-1   System Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.2  Control Panel Troubleshooting

Table 10-2   Control Panel Troubleshooting 

Symptom Possible Cause Action

In pH blend mode, 

no pH text box in 

Blend section of 

Control Panel

(% text box 

instead)

Buffers/solvents configured 

are uncalibrated custom pH 

blend buffers

Configure either of the 

following buffers/solvents:

• Calibrated custom pH 

blend buffers

• pH blend buffers

See Section 3.2.2, Preparing 

pH Blend Mode Buffers, and 

Section 4.2.2, Configuring 

Buffers/Solvents.

pH dimmed on 

Blend menu

pH mode is available only if 

you specify buffer/solvents 

as the following types in the 

Buffer/Solvent Library:

• pH buffers—must be of 

type Buffer

• Water—must be of type 

H2O

• Salt solution—must be 

of type Eluent

Adjust type of buffers/solvents 

in Buffer/Solvent Library and 

add them to the Configuration 

dialog box.

See Section 4.2.2, Configuring 

Buffers/Solvents, and 

Section 4.5.1, Customizing the 

Buffer/Solvent Library.

Eluent dimmed on 

Blend menu

Eluent mode is available 

only if you specify a 

buffer/solvent as type Eluent 

in the Buffer/Solvent Library
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Changes you make 

to blend settings in 

Blend section of 

Control Panel are 

not activated

Settings not activated until 

you click Set

Click Set after changing blend 

settings on Control Panel.

Flow rate units 

CV/min and cm/hr 

dimmed in Pump 

section of Control 

Panel

Column not configured Configure a column in the 

Configuration dialog box. See 

Section 4.2.4, Configuring 

Columns and Plumbing.

When pump is 

running, flow 

change you make 

not initiated

Change not initiated until you 

click on another area on the 

Control Panel

Click on another area of 

Control Panel.

Method section of 

Control Panel blank

No method running No action, normal occurrence.

Fraction/waste 

valve on BioCAD 

700E not 

responding when 

you click option 

buttons in Collector 

section of Control 

Panel

Fraction collector in use. 

When fraction collector is 

configured, option buttons 

control the diverter valve on 

the fraction collector, not the 

BioCAD 700E fraction/waste 

valve.

Disable fraction collector in 

configuration by selecting 

Built In Fraction/Waste 

Valve in Collector section of 

Configuration dialog box.

No Fraction 

Collector Setup 

command on 

Config menu

Fraction Collector not 

configured

Adjust configuration. 

See Section 4.6, Configuring 

and Preparing the BioCAD 

Software for a Fraction 

Collector.

Table 10-2   Control Panel Troubleshooting  (Continued)

Symptom Possible Cause Action
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Cannot select 

UV/Vis Dual 

Wavelength from 

the Detector menu

An external fluorescence 

detector is enabled in 

hardware setup 

Disable the external 

fluorescence detector in the 

hardware setup. See 

Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

Cannot select 

UV/Vis Single 

Wavelength from 

the Detector menu

An external UV/Vis detector 

is enabled in hardware setup 

Disable the external UV/Vis 

detector in the hardware 

setup. See Section 2.5.2, 

Updating BioCAD Hardware 

Setup Options.

Table 10-2   Control Panel Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.3  Status Window Troubleshooting

10.1.4  Strip Chart Recorder
Troubleshooting

Table 10-3   Status Window Troubleshooting

Symptom Possible Cause Action

Wrong detectors 

displayed in Status 

window

Status window not set to 

display desired signals

Select the signals to display 

from the View menu. Selected 

signals are checked. Only the 

first three selected signals are 

displayed.

Table 10-4   Strip Chart Recorder Troubleshooting 

Symptom Possible Cause Action

Cannot scroll Strip 

Chart Recorder

Strip Chart Recorder is in 

Real-Time mode

Change Strip Chart Recorder 

to History mode by doing one 

of the following:

• Deselect Real-Time from 

Display menu in Strip 

Chart Recorder.

• Click on the Strip Chart 

Recorder.
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pH/conductivity 

signal on Strip 

Chart Recorder 

does not change

Buffers do not have buffering 

capacity at the working pH

Use appropriate buffers.

Detectors bypassed in 

General Settings in method

Place monitors inline in 

General Settings section of 

method. See Section 6.2.3, 

Specifying General Settings.

Detectors bypassed on 

Control Panel

Click Inline option button in 

pH/Cond section of Control 

Panel.

pH/conductivity 

signal not shown 

on Strip Chart 

Recorder

pH and conductivity 

channels are not selected in 

Strip Chart Recorder 

Settings

Change Strip Chart Recorder 

Settings by selecting Options 

from the Display menu. 

See Section 8.3, Using the 

Strip Chart Recorder.

pH and conductivity 

channels are not configured

Enable the pH and 

conductivity channels in the 

Configuration dialog box.

See Section 4.2.5, Configuring 

Detectors.

Table 10-4   Strip Chart Recorder Troubleshooting  (Continued)

Symptom Possible Cause Action
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Data not displayed 

on Strip Chart 

Recorder as it is 

acquired

Strip Chart Recorder is not in 

Real-Time mode

Place Strip Chart Recorder in 

Real-Time mode by selecting 

Real-Time from the Display 

menu.

Data offscale Adjust scale by selecting 

Options from the Display 

menu and changing scale. 

See “Customizing the Strip 

Chart Recorder” on page 8-9.

No channels selected in Strip 

Chart Settings

Enable channels by selecting 

Options from the Display 

menu. See “Customizing the 

Strip Chart Recorder” on 

page 8-9.

Detector data channels are 

not enabled in the Recorder 

section of the Configuration 

dialog box

Enable data channels in the 

Recorder section of the 

Configuration dialog box. 

See Section 4.2.5, Configuring 

Detectors.

Table 10-4   Strip Chart Recorder Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.5  Fraction Collector Troubleshooting

Table 10-5   Fraction Collector Troubleshooting 

Symptom Possible Cause Action

No Fraction 

Collector Setup 

command on 

Config menu

Fraction Collector not 

configured

Adjust configuration. 

See Section 4.6, Configuring 

and Preparing the BioCAD 

Software for a Fraction 

Collector.

Unable to change 

settings on 

Fraction Collector 

front panel

Cannot use Fraction 

Collector front panel when it 

is configured in BioCAD 

software

To program the fraction 

collector front panel, you must 

do one of the following:

• Disable fraction collection 

in the configuration by 

selecting Built In 

Fraction/Waste Valve in 

Collector section of 

Configuration dialog box

• Disconnect fraction 

collector cable from the 

BioCAD 700E Workstation

• Exit the BioCAD software

Fraction Collector 

settings in Control 

Panel not used 

during method run

During a run, fraction 

collector settings in method 

override settings in Control 

Panel

No action, normal occurrence.

Non-peak fractions 

not collected at 

proper times

Incorrect delay volume set 

for Fraction Valve to Fraction 

Collector

Adjust delay volumes in 

Configuration dialog box.

See “Setting delay volumes” on 

page 4-13.



Troubleshooting

BioCAD® 700E Workstation User Guide 10-19

10

Fractions not 

deposited cleanly 

into tubes

Rack not positioned properly 

in fraction collector

Test tube rack has tabs that 

line up with the base of the 

fraction collector. Make sure to 

push the rack all the way back 

against the base.

Tubes not positioned 

properly in rack

Make sure all test tubes are 

centered in the slots and are 

pointing straight up.

Outlet on fraction collector 

diverter valve is dirty or 

plugged

Clean diverter valve.

Fraction collector cables or 

tubing caught on fraction 

collector arm

Untangle cables or tubing.

Fraction collector is 

not filling tubes in 

the correct order

Number of tubes in fraction 

collector software not set to 

120 (if using Simple mode)

Change number of tubes in 

fraction collector software. 

See Section 3.5.3, Preparing 

Fraction Collector Software.

Wrong number or wrong type 

of tubes, or wrong mode 

(Simple or Bottle) 

programmed in fraction 

collector software

Reprogram fraction collector. 

See Section 3.5.3, Preparing 

Fraction Collector Software.

Fraction collector 

tubes overfilling

Volume (ml/tube) set in 

Configuration dialog box 

exceeds tube volume.

Adjust configuration.

See Section 4.6, Configuring 

and Preparing the BioCAD 

Software for a Fraction 

Collector.

Table 10-5   Fraction Collector Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.6  Integrated Autosampler
(AS 3500) Troubleshooting

When you click the 

Advance button on 

the Control Panel 

with a fraction 

collector 

configured, fraction 

collector does not 

respond 

immediately

When the pump is flowing, 

the fraction collector does 

not advance until the delay 

volume specified in 

configuration is exceeded

No action, normal occurrence.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting 

Symptom Possible Cause Action

Autosampler arm 

jam

After the autosampler picked 

up a vial, you placed a new 

vial in the temporarily empty 

location

1. Remove vial from the 

current position and from 

the autosampler arm. 

2. Place vial removed from 

arm in proper tray position.

3. Select Edit Configuration 

from the Control Panel and 

click OK after the 

configuration is displayed.

4. Restart method.

Table 10-5   Fraction Collector Troubleshooting  (Continued)

Symptom Possible Cause Action
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Autosampler arm 

jam (continued)

Vial dropped 1. Pick up vial and place in 

proper tray position. 

2. Select Edit Configuration 

from the Control Panel and 

click OK after the 

configuration is displayed.

3. Restart method.

Vial not seated properly in 

tray

1. Pick up vial and place in 

proper tray position. 

2. Select Edit Configuration 

from the Control Panel and 

click OK after the 

configuration is displayed.

3. Restart method.

Sample tray misaligned Check that sample tray is 

seated properly on pins. It 

may be necessary to remove 

the tray and then place it back 

in position. See “Installing 

sample trays” on page 3-55.

Vial stuck in autosampler 

tower

See “Vial stuck in autosampler 

tower” on page 10-26.

No vial in 

autosampler arm

Vial not in correct position of 

tray

Place vial in the correct 

position. Restart method.

Vial dropped Replace vial and check the 

sample tray alignment. Restart 

method.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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Autosampler drops 

vial when returning 

to sample tray

Autosampler arm is 

misaligned

Call Applied Biosystems 

Technical Support.

Sample Table does 

not appear in 

Window menu

Integrated autosampler is 

not configured

Select an AS 3500 integrated 

autosampler in hardware 

setup. See Section 2.5.2, 

Updating BioCAD Hardware 

Setup Options.

Autosampler warm 

when autosampler 

cooler (tray) is 

turned on

Normal operation. Air above 

sample trays is often warm.

Touch bottom of tray with your 

hand to check temperature. If 

it is cool, cooling is operating 

properly.

If it is not cool, select Sample 

Cooler from the Sample menu 

in the Sample Table window. 

Verify that the cooler is turned 

on and the temperature is set 

correctly.

Temperature control is 

turned off or setpoint 

temperature is higher than 

ambient temperature

Select Sample Cooler from 

the Sample menu in the 

Sample Table window. Verify 

that the cooler is turned on 

and the temperature is set 

correctly.

You did not allow sufficient 

time for autosampler cooler 

(tray) to reach temperature

Allow 30 minutes for 

autosampler cooler (tray) to 

reach temperature.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action



Troubleshooting

BioCAD® 700E Workstation User Guide 10-23

10

Selected 

temperature does 

not match 

temperature 

displayed in 

Sample Table 

window

Temperature control is 

turned off

Select Sample Heater or 

Sample Cooler from the 

Sample menu in the Sample 

Table window. Verify that the 

heater or cooler is turned on 

and the temperature is set 

correctly. See “Controlling 

sample heating and cooling” on 

page 5-50.

You did not allow sufficient 

time for autosampler heater 

(heat chamber) or cooler 

(tray) to reach temperature

Allow 30 minutes for 

autosampler heater (heat 

chamber) or cooler (tray) to 

reach temperature.

Method runs, but 

autosampler does 

not inject sample

Sample Table has incorrect 

sample vial volume

Check sample vial volume in 

configuration by 

double-clicking on a vial 

position in the Sample Table to 

display the Vial Editor. 

Make sure sample vial volume 

is greater than injection 

volume set in method 

Autosampler Inject (AI) 

segment.

For more information, see 

Section 4.7.3, Entering Vials in 

Sample Table.

Autosampler does 

not pick up vial 

when running a 

method

Autosampler heater (heat 

chamber) or cooler (tray) has 

not reached set temperature

Allow 30 minutes for 

autosampler heater (heat 

chamber) or cooler (tray) to 

reach temperature.

Autosampler door is open Close autosampler door.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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Autosampler 

chooses wrong vial 

when you run a 

template other than 

the Analysis 

template

If the sample volume in the 

vial you select in the template 

is insufficient to make the 

injection, the system 

automatically injects from 

another vial with the same 

sample name and sufficient 

volume (if one exists)

No action. Normal occurrence.

Air bubbles in 

autosampler 

syringes

Autosampler solvent or flush 

bottles are empty

Fill bottles and prime lines. 

See Section 3.6.5, Priming the 

Autosampler.

Autosampler lines not 

primed

Prime autosampler lines.

See Section 3.6.5, Priming the 

Autosampler.

Fittings above autosampler 

syringes loose

Hand-tighten fittings.

Autosampler syringes loose Hand-tighten syringes.

Autosampler syringes 

leaking

Call Applied Biosystems 

Technical Support.

Autosampler 

syringes leaking, 

and you can turn 

the syringe barrel 

without turning the 

metal band at the 

top of the barrel

Seal broken between barrel 

and metal band

Call Applied Biosystems 

Technical Support.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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Integrated AS 3500 

not available in 

Autosampler 

section of 

Configuration 

dialog box

Integrated AS 3500 

autosampler is not specified 

in hardware setup

Update hardware setup. See 

Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

Autosampler does 

not run startup 

routine when 

BioCAD 700E 

Workstation is 

powered up

Hardware fault Power down and power up 

autosampler. If symptom still 

present, call Applied 

Biosystems Technical 

Support.

Autosampler does 

not respond when 

you control it from 

the BioCAD 

software

Communications failure Reboot BioCAD software.

Power down and power up 

BioCAD 700E Workstation.

Call Applied Biosystems 

Technical Support.

Loud buzzing noise 

from autosampler 

syringe area

Defective switch Call Applied Biosystems 

Technical Support.

Loud noise prior to 

injection

Autosampler is mixing 

sample

No action. Normal occurrence.

Autosampler motor 

does not stop after 

autosampler 

syringe returns to 

home position

Defective sensor Call Applied Biosystems 

Technical Support.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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Autosampler hook 

does not lift vial

Autosampler arm motor 

failed

Call Applied Biosystems 

Technical Support.

Vial stuck in 

autosampler tower

Autosampler needle bent Replace needle. See the 

Autosampler Reference 
Manual.

Non-recommended vial or 

septa

Remove vial and replace with 

recommended vial and septa. 

For more information, see 

Section 3.6.6, Preparing 

Sample Vials.

Vial stuck in mixer Communications error 1. Power down workstation.

2. Move autosampler arm out 

of the way.

3. Remove vial.

4. Power up and restart 

method.

Septa on sample 

vials torn

Autosampler needle bent Replace needle. See the 

Autosampler Reference 
Manual.

Autosampler stops 

during an injection

Autosampler door is open Close autosampler door.

Autosampler is not 

making an injection 

when instructed to 

do so by a method 

or from the Sample 

Table

Communication error 

between computer and 

autosampler

Reset configuration by 

displaying the Configuration 

dialog box, then clicking OK.

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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Autosampler not 

injecting accurate 

volume

Air bubbles in autosampler 

lines

Prime autosampler lines.

See Section 3.6.5, Priming the 

Autosampler.
Air bubbles in autosampler 

syringes

Teflon plunger in 

autosampler syringe (sample 

or prep syringe, depending 

on injection volume) not 

sealing

Call Applied Biosystems 

Technical Support.

Autosampler 

makes incomplete 

injection

You installed a new sample 

needle on the autosampler, 

but did not adjust the needle 

height

Adjust the needle height. See 

Section 9.9.2, Adjusting the 

Needle Height.

Autosampler 

aspirates air 

instead of injecting 

sample

Table 10-6   Integrated Autosampler (AS 3500) Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.7  Sample Table Troubleshooting

Table 10-7   Sample Table Troubleshooting

Symptom Possible Cause Action

Sample Table does not 

appear in Window menu

Integrated autosampler is 

not configured

Select an AS 3500 

integrated autosampler in 

hardware setup. See 

Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

Autoname check box is 

dimmed in the Vial Editor 

dialog box

You did not use the Add 

Vials button to add sample 

vials to the Sample Table

Click Add Vials after 

selecting vials in the 

Sample Table. See 

“Autonaming batch-entered 

vials” on page 4-50.
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10.1.8  Method Editor Troubleshooting

Table 10-8   Method Editor Troubleshooting 

Symptom Possible Cause Action

In Method Editor, 

values for column 

volume too large, 

or duration too long

Column dimensions set 

incorrectly in Configuration 

dialog box

Adjust column dimensions in 

Configuration dialog box. 

See Section 4.2.4, Configuring 

Columns and Plumbing, and 

Section 4.5.3, Customizing the 

Column Library.

Method events not 

displayed in blocks

Method Editor is in Block 

view, and events displayed in 

Sequence view only

Select Sequence View from 

the Display menu.

Changes to system 

configuration not 

recognized by open 

method in Method 

Editor

Changes made to system 

configuration are not 

recognized by method 

configuration unless you 

update the method 

configuration

To recognize changes to the 

system configuration after 

method is saved, select 

Update Configuration from 

the Options menu in the 

Method Editor.

System not using 

method 

configuration when 

running method

During a run, the workstation 

always uses the system 

configuration set in the 

Configuration dialog box, not 

the method configuration 

saved with the method.

For a description of each 

configuration, see 

Section 4.1, Configuration 

Overview.

Load the method configuration 

as the system configuration.

See Section 4.4, Loading an 

Existing Configuration.
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During a run, 

method Step 

segment skipped

In Step segment, you set 

thresholds, but did not set a 

delay. At beginning of 

segment, peak has not yet 

eluted therefore threshold 

criteria met (signal is above 

or below the threshold) and 

so segment is skipped.

Set Delay for threshold in Step 

segment. See “Setting 

thresholds and delay durations” 

on page 6-22.

Block buttons at 

top of window 

dimmed

Buttons not active when 

blocks or segments selected

Click on line below the last 

block in method to activate 

block buttons.

Segment buttons at 

top of window 

dimmed

Buttons active only when 

appropriate block selected

Click on block in method to 

activate appropriate segment 

buttons.

Second Data 

Collection Start 

event in method 

ignored

Method can have only one 

contiguous segment of 

recorded data

Remove second Data 

Collection Start event from 

method.

In Blend Graph 

Setup, pH and 

Eluent dimmed in 

Mode section

pH mode is available only if 

you specify two pH buffers 

as type Buffer, water as type 

H2O, and a salt solution as 

type Eluent in the 

Buffer/Solvent Library. 

Eluent mode is available 

only if you specify a 

buffer/solvent as type Eluent 

in the Buffer/Solvent Library.

Adjust configuration. See 

Section 4.2.2, Configuring 

Buffers/Solvents, and 

Section 4.5.1, Customizing the 

Buffer/Solvent Library.

Table 10-8   Method Editor Troubleshooting  (Continued)

Symptom Possible Cause Action
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During a run, 

software prompts 

you for a data file 

name before every 

injection

You did not specify Data 

Storage options

Before a run, select Data 

Storage from the Options 

menu. Specify file name, 

extension, and directory. See 

Section 6.2.10, Specifying Data 

Storage Options.

In Data Storage Options, you 

selected Name File When 

Run

Select Auto file extension in 

Data Storage Options. 

See Section 6.2.10, Specifying 

Data Storage Options.

Method duration 

longer or shorter 

than expected

Column dimensions set 

incorrectly in Configuration 

dialog box

Adjust column dimensions in 

Configuration dialog box. 

See Section 4.2.4, Configuring 

Columns and Plumbing, and 

Section 4.5.3, Customizing the 

Column Library.

Column bypassed in General 

Settings of method

Place column inline in General 

Settings. See Section 6.2.3, 

Specifying General Settings.

Segment duration 

0 CV

Column not set inline after 

Purge segment

In Purge segment, set Flow 

Direction at End of Purge to 

something other than Bypass. 

See “Purge Segments” on 

page 6-25.

All segment 

durations 0

No flow rate and no column 

inline in General Settings

Adjust General Settings. 

See Section 6.2.3, Specifying 

General Settings.

Table 10-8   Method Editor Troubleshooting  (Continued)

Symptom Possible Cause Action
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In pH mode, Step 

segment requests 

percent value 

instead of pH value

Buffers/solvents configured 

are uncalibrated custom pH 

blend buffers

Configure either of the 

following buffers/solvents:

• Calibrated custom pH 

blend buffers

• pH blend buffers

See Section 3.2.2, Preparing 

pH Blend Mode Buffers, and 

Section 4.2.2, Configuring 

Buffers/Solvents.

Method run stops 

before end of 

method

Pump Off event included 

before the end of the last 

segment

Delete Pump Off event and 

insert at end of segment.

Multi-Method 

button dimmed

Multi-Method button is not 

active unless a multi-method 

is open

Select New Multi Method or 

Open Multi Method from the 

Multi Method menu.

Cannot enable dual 

wavelength in 

General Settings or 

“Set UV Detector 

Wavelength” event

An external fluorescence 

detector is enabled in 

hardware setup 

Disable the external 

fluorescence detector in the 

hardware setup. See 

Section 2.5.2, Updating BioCAD 

Hardware Setup Options.

Cannot disable 

dual wavelength in 

General Settings or 

“Set UV Detector 

Wavelength” event

An external UV/Vis detector 

is enabled in hardware setup 

Disable the external UV/Vis 

detector in the hardware 

setup. See Section 2.5.2, 

Updating BioCAD Hardware 

Setup Options.

Table 10-8   Method Editor Troubleshooting  (Continued)

Symptom Possible Cause Action
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Purge (P) segment 

button dimmed

You configured Low 

Dispersion, Three Columns, 

or Direct Control for the 

Column Option. Because 

column bypass is not 

available with these column 

options, the Purge segment 

is not available.

Change column option in the 

Configuration dialog box. 

See Section 4.2.4, Configuring 

Columns and Plumbing.

Prep block button 

(PR) is not 

displayed on 

Method Editor 

toolbar

Integrated AS 3500 

autosampler is not 

configured

Configure an integrated 

AS 3500 autosampler. 

See Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

Autosampler does not 

support sample preparation

You cannot use the Prep block 

feature.

Prep block 

segment buttons 

(D, C, HM) are not 

displayed on 

Method Editor tool 

bar

Prep block is not selected in 

method

Select a Prep block in the 

method.

Table 10-8   Method Editor Troubleshooting  (Continued)

Symptom Possible Cause Action
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Prep block 

segment buttons 

(D, C, HM) are 

dimmed

Sample vials or empty vials 

are not loaded in the Sample 

Table

Load sample vials and empty 

vials in the Sample Table. 

See Section 4.7.3, Entering 

Vials in Sample Table.

No autosampler solvents are 

configured in the Sample 

Preparation Configuration 

dialog box

Configure autosampler 

solvents. See “Configuring 

sample prep” on page 4-42.

Different vial shape 

(Standard or Micro) is 

selected for empty vials in 

the Prep block and empty 

vials in the Sample Table

Select the same vial shape 

(Standard or Micro) for empty 

vials in the Prep block and 

empty vials in the Sample 

Table.

Method configuration is not 

updated with Sample Table 

information

Update configuration from the 

Method Editor by selecting 

Update Configuration from the 

Options menu.

Autosampler Inject 

(AI) segment 

button is dimmed

Sample vials are not loaded 

in the Sample Table when an 

integrated autosampler is 

configured

Load sample vials in the 

Sample Table. See 

Section 4.7.3, Entering Vials in 

Sample Table.

Add Event button is 

dimmed

A segment (Step, Gradient, 

Inject, Autosampler Inject, or 

Purge) is not selected

Select a segment (Step, 

Gradient, Inject, Autosampler 

Inject, or Purge).

Table 10-8   Method Editor Troubleshooting  (Continued)

Symptom Possible Cause Action
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10.1.9  Templates Troubleshooting

Table 10-9   Templates Troubleshooting

Symptom Possible Cause Action

In pH mode, pH Map 

Template dialog box 

requests percent value 

instead of pH value

Buffers/solvents 

configured are 

uncalibrated custom pH 

blend buffers

Configure either of the 

following buffers/solvents:

• Calibrated custom pH 

blend buffers

• pH blend buffers

See Section 3.2.2, 

Preparing pH Blend Mode 

Buffers, and Section 4.2.2, 

Configuring 

Buffers/Solvents.

Values do not appear 

under a parameter in the 

Combinatorial 

Optimization Template 

dialog box

Method or system 

requirements are not met 

for the parameter

Make sure method and 

system requirements are 

met for the desired 

parameter. See 

Section 7.1.9.1, System 

and Method Requirements.

Parameter information 

that defines each template 

run is not fully visible in 

the Method Queue

Label column in Method 

Queue is not wide enough

Widen Label column in 

Method Queue. 

See Section 8.1, Using the 

Method Queue.



Chapter  10    Troubleshooting and Error Codes

10-36 Applied Biosystems

10

10.1.10  Computer Troubleshooting

Table 10-10   Computer Troubleshooting

Symptom Possible Cause Action

Nothing appears on 

monitor

Not powered on Power on.

Contrast not adjusted Adjust contrast.

Computer performance 

very slow

Too many windows open Close windows you are 

not using.

Hard disk is fragmented Defragment the disk using 

a computer utility 

program. See 

Section 9.10.3, 

Defragmenting the Hard 

Disk.

Too many data points 

collected in data file

See Section 4.2.5, 

Configuring Detectors, for 

guidelines on setting data 

rate.
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10.2  Error Codes

Error codes may be displayed in warning boxes during normal 

operation. Codes are also displayed in the Event Log window, 

described in Section 8.5, Using the Event Log.

This section describes the following types of error codes:

• File 

• Blend 

• Hardware 

• Resource/Memory

• Configuration 

• Autoloader

• Autosampler (AS 3500)

• Sample Table

• Syringe Pump 

• Detector 

• Method 

• Supervisor Option 

• Program Loading 

• Communications 

• COM Port 
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10.2.1  File Error Codes

Table 10-11   File Error Codes 

Error Possible Cause Action

“Error in Writing to <file>” Disk full Delete unneeded files 

from disk.

File marked as 

“Read-only”

Change file access.

“Data Loss to file <file>” Disk full, cannot store all 

data

Delete unneeded files 

from disk.

“Cannot create Directory 

<dir>—Unknown Error!” 

You are running on a 

network and do not have 

rights to create directories

Choose another drive.

See your network 

manager.

“Too many files with same 

base name: <name>”

You are running methods 

using auto file extension 

feature, and will create 

more than 100 data files

Run fewer than 100 data 

files.

Change the base file 

name.

“Cannot open method.” Not enough memory Close windows.

Reboot computer.

Not a method file Select BioCAD method file 

(.MET).

File damaged Retrieve file from backup 

diskette.

“Cannot Read Method 

<name>”

Not enough memory Close windows.

Reboot computer.

File does not exist, or file 

damaged

Retrieve file from backup 

diskette.
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“Cannot Add method 

<name> to group” 

Group file or multi-method 

file contains maximum of 

100 files

Create new group file or 

multi-method file.

“Cannot access method 

file <name>”

File does not exist Select valid file name.

File damaged Retrieve file from backup 

diskette.

“Cannot create group file 

<name>”

Disk full Delete unneeded files.

You are running on a 

network and do not have 

rights to create directories

Choose another drive.

See your network 

manager.

“Cannot create data file 

<name>”

Disk full Delete unneeded files.

You are running on a 

network and do not have 

rights to create directories

Choose another drive.

See your network 

manager.

“<dataFile> is currently in 

the queue and cannot be 

overwritten”

Starting a run that 

duplicates a data file 

name already in the 

Method Queue

Delete the method in the 

Method Queue.

Change the data file 

name.

Table 10-11   File Error Codes  (Continued)

Error Possible Cause Action
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“Drive A does not exist” You opened a data file 

from a floppy disk in the 

Group Analysis window. 

Group Analysis keeps the 

file open, even after you 

close the Group Analysis 

window.

To correct the error, do 

one of the following:

• Open another file 

from the C drive

• Exit the BioCAD 

software

To prevent the error from 

occurring again, copy files 

to the C drive before 

opening.

Hardware problem Call Applied Biosystems 

Technical Support.

Table 10-11   File Error Codes  (Continued)

Error Possible Cause Action
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10.2.2  Blend Error Codes

Table 10-12   Blend Error Codes 

Error Possible Cause Action

“- Invalid Blend: Changed 

from... to...”

Buffers in Configuration 

do not match buffers in 

method

Adjust buffers in method 

to match system 

configuration, or load 

configuration from method 

as system configuration, 

or change system 

configuration.

“- Illegal Blend: Changed 

from... to...”

Method programmed in 

blend mode that system 

configuration does not 

support (example, method 

programmed in pH mode, 

but configuration does not 

contain two buffers/ water/ 

salt)

Load configuration from 

method as system 

configuration, or change 

system configuration.
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10.2.3  Hardware Error Codes

Table 10-13   Hardware Error Codes

Error Possible Cause Action

“Illegal Hardware 

Configuration for 

Detectors. Run the 

BioCAD Setup Program 

Again.”

Hardware setup does not 

match software setup

Update hardware setup. 

See Section 2.5.2, 

Updating BioCAD 

Hardware Setup Options.

“BioCAD Hardware is not 

functional”

Internal problem Call Applied Biosystems 

Technical Support.
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10.2.4  Resource/Memory Error Codes

Table 10-14   Resource/Memory Error Codes 

Errors Possible Cause Action

“Insufficient resources for 

<n> hours of Recorder 

Buffering. Using <m> 

hours.”

Not enough memory or 

hard disk space to 

accommodate Buffer 

Duration

Close unneeded 

applications.

Delete unneeded files 

from disk.

Decrease data rate.

Decrease buffer duration.

“Insufficient memory to 

initialize data recording 

for <name>. Exit 

Windows and restart.”

Ran out of disk space or 

memory during a method 

run

Stop method, close 

unneeded applications, 

delete unneeded files, 

restart method.

Ran out of memory during 

initialization of software

Check Windows virtual 

memory settings.

“Not enough system 

resources to initialize 

data recording for <n> 

hours. Maximum of <m> 

hours is selected.”

Ran out of disk space or 

memory during a method 

run

Stop method, close 

unneeded applications, 

delete unneeded files, 

restart method.

Ran out of memory during 

initialization of software

Check Windows virtual 

memory settings.
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“Insufficient system 

resources to open 

BioCAD. Try closing 

applications or 

documents.”

Too many windows open Close windows.

“Insufficient system 

resources to run BioCAD. 

Try closing applications or 

documents.”

“Only <n> bytes of virtual 

memory are available out 

of a maximum of <n> 

bytes. Please close 

applications, free up disk 

space or check virtual 

memory settings.”

Not enough disk space 

free to run BioCAD 

software (need 15 to 

20 MB free disk space)

Delete unneeded files.

“Not enough memory to 

copy Method.”

Too many windows open Close windows.

Reboot computer.

Table 10-14   Resource/Memory Error Codes  (Continued)

Errors Possible Cause Action
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10.2.5  Configuration Error Codes

Table 10-15   Configuration Error Codes 

Error Possible Cause Action

“Illegal Hardware 

Configuration for 

Detectors. Run the 

BioCAD Setup Program 

Again.”

Hardware setup does not 

match software setup

Update hardware setup.

See Section 2.5.2, 

Updating BioCAD 

Hardware Setup Options.

“Available Detectors are 

different from 

Configuration. Change 

configuration to match?”

You have installed an 

external detector and 

have changed the BioCAD 

hardware setup.

Message displayed the 

first time you start 

software after installing 

device, or when you load 

an old configuration.

Click OK.

“Configured Recorder 

Channels are not 

available. Change 

configuration?”

You removed an external 

detector and have 

changed the BioCAD 

hardware setup.

Message displayed the 

first time you start 

software after removing 

device, or when you load 

an old configuration.

Click OK.
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“Configured Recorder 

Rates are not available. 

Change configuration?”

Data rate selected 

incorrect for installed 

detector (for example, 

data rate of 20 pps set for 

Model 204). May occur if 

you share files between 

workstations containing 

different detector models, 

or you change hardware.

If sharing files, change 

data rate in configuration.

If you installed a new 

detector, update BioCAD 

hardware setup. See 

Section 2.5.2, Updating 

BioCAD Hardware Setup 

Options.

“Solvent Pump 

Configuration does not 

match instrument. Change 

configuration?”

You have installed a new 

solvent pump and have 

changed the BioCAD 

setup.

Message displayed the 

first time you start 

software after installing 

device.

Click OK.

“System Configuration 

does not match 

instrument. Change 

configuration?”

You have changed 

BioCAD hardware setup

Click OK.

“Loader Configuration 

does not match 

instrument. Change 

configuration?”

You have changed 

BioCAD hardware setup

Click OK.

“Plumbing Configuration 

does not match 

instrument. Change 

configuration?”

You have changed 

BioCAD hardware setup

Click OK.

Table 10-15   Configuration Error Codes  (Continued)

Error Possible Cause Action
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“Blend Configuration does 

not match instrument. 

Change configuration?”

Method configuration 

does not match system 

configuration

Load configuration from 

method as system 

configuration, or change 

system configuration.

“Collector Configuration 

does not match 

instrument. Change 

configuration?”

Method configuration 

does not match system 

configuration

Load configuration from 

method as system 

configuration, or change 

system configuration.

“Sample Loader 

Configuration does not 

match instrument. Change 

configuration?”

You have changed 

BioCAD hardware setup

Click OK.

“Changing Configuration 

will shut down the system. 

All methods will be 

canceled.”

You displayed the 

Configuration dialog box 

while a method is running, 

or pump is flowing.

Click Cancel to allow the 

method or pump to 

continue at present 

settings

OR

Click OK to abort run and 

change settings.

“Configuration Mis-match” Method configuration 

does not match system 

configuration

Run method using system 

configuration

OR

Load configuration from 

method as system 

configuration, or change 

system configuration.

Table 10-15   Configuration Error Codes  (Continued)

Error Possible Cause Action
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10.2.6  Autoloader Error Codes

10.2.7  Autosampler (AS 3500) Error Codes

Table 10-16   Autoloader Error Codes

Error Possible Cause Action

“Injector valve stuck in 

counter clockwise 

position” 

Compressed dry gas (air or 

nitrogen) source for valve 

operation not turned on, or 

regulated below 80 psi

Turn on or adjust gas (air 

or nitrogen) pressure.

Valve not switching Call Applied Biosystems 

Technical Support.

Table 10-17   Autosampler (AS 3500) Error Codes 

Error Possible Cause Action

“Connection # 108" error 

on autosampler front 

panel

You powered up a direct 

wire autosampler before 

powering up BioCAD 

700E Workstation

Power up the workstation 

before the direct wire 

autosampler.

You have an autosampler 

connected to the BioCAD 

700E Workstation, and the 

BioCAD 700E Workstation 

is configured for an 

autoloader

Adjust configuration for 

autosampler. See 

Section 4.8, Configuring 

and Preparing the BioCAD 

Software for a Direct Wire 

Autosampler.
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“AutoSampler Invalid 

Load Amount”

Injection volume entered 

in BioCAD software zero 

or negative value

Enter positive value for 

injection volume.

“AutoSampler is Busy” Autosampler not ready to 

make injection

Wait for device to 

complete cycle before 

making injection.

“Input Fault: <fault_code>, 

<fault Text>”

Autosampler error Depends on error.

“RealTime Fault: 

<fault_code>, <fault 

Text>”

Fatal autosampler error Power down autosampler. 

Call Applied Biosystems 

Technical Support.

“Power-Up Fault(s): 

<fault_code>, <fault 

Text>”

Autosampler hardware 

error

Power down autosampler. 

Call Applied Biosystems 

Technical Support.

“Initialization Fault: 

<errorCode>, <errorText>”

Autosampler power up 

error, hardware problem

Depends on error. Power 

down autosampler and 

correct problem before 

continuing.

“RealTime Fault: 

<errorCode>, <errorText>”

Fatal error Power down, power up.

Table 10-17   Autosampler (AS 3500) Error Codes  (Continued)

Error Possible Cause Action
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10.2.8  Sample Table Error Codes

Table 10-18   Sample Table Error Codes 

Error Possible Cause Action

“No name has been 

specified. Enter the name 

then exit.”

You did not enter a Short 

Name in the Sample 

Editor dialog box

Enter a name in the Short 

Name text box of the 

Sample Editor dialog box. 

See Section 4.7.2, 

Customizing the Sample 

Library.

“Cannot edit Sample Table 

while method is running!”

Method is running Wait until method finishes, 

or abort method before 

editing Sample Table.

“No vial at current 

location!”

You clicked Load Loop 

when a blank vial position 

(no sample loaded) is 

selected in the Sample 

Table

Select a vial position in 

the Sample Table that has 

a sample loaded (Sample, 

Standard, Control, or 

Reagent vial type).

“Invalid vial at current 

location!”

You clicked Load Loop 

when an Empty vial type 

is selected in the Sample 

Table

Select a vial position in 

the Sample Table that has 

a sample loaded (Sample, 

Standard, Control, or 

Reagent vial type).

OR

Add sample to vial and 

load vial in Sample Table 

before clicking Load 

Loop.
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“Required volume of .. µl 

exceeds volume in Vial!”

You clicked Load Loop 

when the volume entered 

in the Volume text box 

exceeds the volume 

available in the vial

Enter a smaller volume in 

the Volume text box of the 

Sample Table.

“Cannot specify zero 

volume”

You clicked Load Loop 

when the volume entered 

in the Volume text box 

is 0.0

Enter a value larger than 

0.0 in the Volume text box 

before clicking Load 

Loop.

“Sample has already been 

loaded into loop”

You are trying to load the 

sample loop a second 

time before injecting the 

contents of the loop

Inject previously loaded 

sample.

“Injection volume exceeds 

syringe capacity, amount 

set to .. µl”

The volume you entered 

in the Volume text box is 

greater than:

• 200 µl (PushLoop)

• 2 ml (other modes)

Click OK to allow the 

software to adjust the 

injection volume.

“Prep Syringe Over expel” 

(doesn't occur during 

proper operation)

A previous incomplete 

action left the autosampler 

prep syringe plunger 

down, and it cannot pull 

the required volume

Reboot to reset 

autosampler.

Table 10-18   Sample Table Error Codes  (Continued)

Error Possible Cause Action



Chapter  10    Troubleshooting and Error Codes

10-52 Applied Biosystems

10

“Loading .. µl into .. µl 

loop”

The volume you entered 

in the Volume text box is 

greater than the maximum 

loop volume for Pull or 

Push modes

Click Cancel and adjust 

the volume.

Note: If you click OK to 
continue, the system 
injects the maximum loop 
volume. It does not inject 
the volume entered in the 
Sample Table Volume text 
box.

“Cannot perform an 

accurate full loop 

injection, the .. µl loop will 

be under filled.”

Installed sample loop is 

too large for the injection 

volume

Click OK, change the 

installed sample loop, and 

reconfigure the sample 

loop size by selecting 

Change Loop Size from 

the Sample command in 

the Sample Table.

Table 10-18   Sample Table Error Codes  (Continued)

Error Possible Cause Action
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10.2.9  Syringe Pump Error Codes

Table 10-19   Syringe Pump Error Codes 

Error Possible Cause Action

“Syringe Pump Busy” Syringe pump in use Wait for syringe pump to 

complete cycle before 

using.

“Amount is Greater than 

Syringe Capacity” 

Injection volume entered 

in BioCAD software 

exceeds capacity of 

installed syringe

Change injection volume.

Change to a larger 

syringe. 

See Section 5.2.1, 

Changing the Syringe and 

Sample Loop.

“Syringe Pump: Failed to 

find home position”

Syringe not moving 

properly

Make sure syringe is 

properly installed, plunger 

not bent, nothing 

obstructing motion.

“Syringe Pump: 

Microprocessor failure”

Internal problem Call Applied Biosystems 

Technical Support.

“Syringe Pump: EPROM 

check sum error”

“Syringe Pump: Software 

error”

“Syringe Pump 

Initialization Error”
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“Syringe Pump: Serial link 

hardware failure”

Communication lost 

between BioCAD software 

and autoloader syringe

Reset configuration by 

displaying the 

Configuration dialog box, 

then clicking OK.“Syringe Pump: Serial link 

framing error”

“Syringe Pump 

Communications Error”

Communication problem 

with pump

Power down BioCAD 

700E Workstation, then 

power up.

“Syringe Pump Off Line” Usually displayed after 

Offline message. Pump 

not responding

Power down BioCAD 

700E Workstation, then 

power up.

“Syringe Pump: Pump not 

Responding” or “Syringe 

pump failed to respond” 

Communication lost 

between BioCAD software 

and autoloader syringe

Reset configuration by 

displaying the 

Configuration dialog box, 

then clicking OK.

Exit BioCAD software and 

restart. If problem 

persists, call Applied 

Biosystems.

Wrong syringe pump 

specified in hardware 

setup

Update hardware setup. 

• On SB1200 syringes, 

inlet and outlet tubing 

is perpendicular to 

the syringe

• On XL300 syringes, 

inlet and outlet tubing 

is at an angle to the 

syringe

Table 10-19   Syringe Pump Error Codes  (Continued)

Error Possible Cause Action
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“Syringe Pump: Operation 

Timeout”

Communication problem 

with pump

Call Applied Biosystems.

“Syringe Pump 

Communications Error”

Communication problem 

with pump

Power down BioCAD 

700E Workstation, then 

power up.

“Syringe Pump Off Line” Usually displayed after 

Offline message. Pump 

not responding

Power down BioCAD 

700E Workstation, then 

power up.

“Syringe Pump Not 

Initialized”

You tried to use the 

autoloader before it 

completed initialization 

cycle

Wait for autoloader to 

complete cycle before 

using.

“Syringe Pump Plunger 

Overload”

Syringe cannot find home 

position. Syringe plunger 

bent or dirty

Clean or replace plunger.

Syringe not properly 

screwed into position

Tightly screw syringe into 

position.

Sample loop clogged Replace sample loop.

“Syringe Pump Valve 

Overload”

Valve dirty Clean valve by forcing 

water through lines 

attached to syringe.

Table 10-19   Syringe Pump Error Codes  (Continued)

Error Possible Cause Action
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10.2.10  Detector Error Codes

Table 10-20   Detector Error Codes 

Error Possible Cause Action

“UV Detector Offline” Problem with 

communication between 

BioCAD 700E hardware 

and BioCAD software

Reset configuration by 

displaying the 

Configuration dialog box 

and clicking OK.

Exit BioCAD software and 

restart. If problem 

persists, call Applied 

Biosystems Technical 

Support.

“UVIS-201 Detector 

Offline”

Communication problem Reset Configuration by 

displaying Configuration 

dialog box, then clicking 

OK.

“UVIS-201 Detector: 

<errorText>”

Error from detector Depends on error.

“Real-time Fault: <code>, 

Low light on D2 lamp.”

 UV/Vis flow cell dirty Clean UV/Vis flow cell. 

See Section 9.4.2, 

Cleaning the UV/Vis 

Detector Flow Cell. 

Deuterium lamp aging Replace lamp.

See Section 9.4.1, 

Changing the UV/Vis 

Detector Lamps.

Optics misaligned Call Applied Biosystems 

Technical Support.
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“UV/VIS Detector: 

Deuterium Lamp Light 

Level Low”

See “Real-time Fault: 

<code>, Low light on D2 

lamp” causes and actions
_________________

“Real-time Fault: <code>, 

Low light on W lamp.”

UV/Vis flow cell dirty Clean UV/Vis flow cell. 

See Section 9.4.2, 

Cleaning the UV/Vis 

Detector Flow Cell.

Tungsten lamp aging Replace lamp.

See Section 9.4.1, 

Changing the UV/Vis 

Detector Lamps.

Optics misaligned Call Applied Biosystems 

Technical Support.

“UV/VIS Detector: 

Tungsten Lamp Light 

Level Low”

See “Real-time Fault: 

<code>, Low light on W 

lamp” causes and actions
_________________

“D2 Lamp Not Present or 

Failed”

Lamp burned out, or not 

installed

Try turning on by pressing 

Lamp button on front 

panel.

Replace lamp. 

See Section 9.4.1, 

Changing the UV/Vis 

Detector Lamps.

Table 10-20   Detector Error Codes  (Continued)

Error Possible Cause Action
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“W Lamp Not Present or 

Failed”

Lamp burned out, or not 

installed

Try turning on by pressing 

Lamp button on front 

panel.

Replace lamp. 

See Section 9.4.1, 

Changing the UV/Vis 

Detector Lamps.

“UV/VIS Detector: Could 

not turn ON lamp”

Bad lamp Replace lamp. 

See Section 9.4.1, 

Changing the UV/Vis 

Detector Lamps.

“UV/VIS Detector: Stepper 

Motor Error”

Internal problem Call Applied Biosystems 

Technical Support.

“Detector bypass valve 

stuck in counter clockwise 

position” 

Compressed dry gas (air or 

nitrogen) source for valve 

operation not turned on, or 

regulated below 80 psi

Turn on or adjust gas (air 

or nitrogen) pressure.

Valve not switching Call Applied Biosystems 

Technical Support.

“Conductivity Reference 

<value> is not within 

expected range.”

Problem with analog 

board

Call Applied Biosystems 

Technical Support.

Table 10-20   Detector Error Codes  (Continued)

Error Possible Cause Action
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“FL-304/305 COM <> 

Timeout Error” when you 

start the BioCAD software

Fluorescence detector not 

powered on

Power on Fluorescence 

detector.

Fluorescence detector not 

connected to COM port on 

BioCAD 700E Workstation

Connect Fluorescence 

detector to COM port.

Fluorescence detector 

connected to different 

COM port than you 

specified in hardware 

setup

Connect to correct COM 

port, or change hardware 

setup. See Section 2.5.2, 

Updating BioCAD 

Hardware Setup Options.

“FL-304/305 Detector 

<error text>”

Error from detector Depends on error.

“FL-304/305 Detector 

Offline”

Communication problem 

between BioCAD 

hardware and BioCAD 

software

Reset configuration by 

displaying the 

Configuration dialog box, 

then clicking OK.

“Fluorescence Detector 

Offline”

Communication problem 

between BioCAD 

hardware and BioCAD 

software

Reset configuration by 

displaying the 

Configuration dialog box, 

then clicking OK.

Exit and restart BioCAD 

software. If problem 

persists, call Applied 

Biosystems Technical 

Support.

Table 10-20   Detector Error Codes  (Continued)

Error Possible Cause Action
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10.2.11  Method Error Codes

Table 10-21   Method Error Codes 

Error Possible Cause Action

“Illegal Event <event> in 

Method”

Event in method does not 

match configuration

Delete event, or load 

configuration from method 

as system configuration.

“The data recorder Buffer 

Duration is less than the 

method duration. Loss of 

data may result... Run 

method anyway?” 

Buffer duration shorter 

than method run

Increase Buffer Duration, 

or run the method anyway, 

but you may not capture 

all data in the Strip Chart 

Recorder.

“Event [<event>] is illegal 

for this system 

configuration.”

System configuration 

does not allow a method 

event

Delete event, or load 

configuration from method 

as the system 

configuration.

“Event [<event>] is invalid 

for this system 

configuration.”

Method event settings do 

not match configuration

Change method event 

settings.

“Method: <name> aborted 

due to file error!”

File corrupted Retrieve file from backup 

diskette.
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“Method’s configuration 

does not match current 

System Configuration... 

Update Method?”

Method configuration 

does not match system 

configuration

Load configuration from 

method as system 

configuration, or change 

system configuration.

Sample names and 

volumes you entered in 

the Sample Table do not 

match the sample names 

and volumes requested in 

the method

Change the sample name 

and volume information in 

the Sample Table or the 

method.

“File... does not contain a 

valid BioCAD Method.”

You are exporting or 

printing a file that does not 

contain a valid BioCAD 

method, for example, a 

data file saved from the 

Strip Chart Recorder

No action. Normal 

occurrence.

“<fileName> Does not 

contain a valid method.”

“Injection volume exceeds 

limits, amount set to ...µl”

Injection volume in Inject 

segment is greater than 

the maximum volume that 

the autosampler syringe 

can draw

Click OK to allow the 

system to adjust the 

injection volume.

“Sample Loader: Loading 

... µl into ...µl loop.”

Injection volume is greater 

than the loop volume for 

Pull or Push modes. 

Injected volume will be 

smaller than the volume 

you entered.

Click Cancel and adjust 

the injection volume.

Note: If you click OK to 
continue, the system 
injects a volume less than 
the volume you entered.

Table 10-21   Method Error Codes  (Continued)

Error Possible Cause Action



Chapter  10    Troubleshooting and Error Codes

10-62 Applied Biosystems

10

“No <sample> available. 

Volume set to 0”

Sample listed in method is 

not listed in the currently 

loaded Sample Table

Select different sample in 

Inject segment, or add 

sample to Sample Table.

Sample listed in method 

has same Short Name as 

another sample listed in 

the Sample Table, but has 

different attributes. These 

two samples are treated 

as different samples, even 

though Short Name is the 

same.

Select same sample in 

method and Sample 

Table. For more 

information on attributes 

of a sample, see 

Section 4.7.2, Customizing 

the Sample Library.

 “<sample> not found” Sample listed in method is 

not listed in the currently 

loaded Sample Table

Select different sample in 

Inject segment, or add 

sample to Sample Table.

“Only .. µl of sample 

<sample> available” 

Not enough specified 

sample available in 

sample vial

Adjust injection volume in 

method, or add sample to 

vial and adjust volume in 

Vial Editor dialog box. See 

Section 4.7.3, Entering 

Vials in Sample Table.

“Not enough sample 

available. Vial contains 

..µl.” 

“Insufficient volume of 

<sample> to perform 

dilution.”

“No diluent configured on 

channel ...”

You are creating or editing 

a Dilute segment or 

Combine segment with no 

diluent configured

Edit configuration. In the 

Sample Preparation 

Configuration dialog box, 

select a reagent. See 

“Configuring sample prep” 

on page 4-42.

Table 10-21   Method Error Codes  (Continued)

Error Possible Cause Action
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“Final Concentration must 

be greater than zero and 

less than the initial 

concentration.”

In a Dilute or Combine 

segment, you entered a 

final concentration greater 

than the initial 

concentration of a sample

Enter a final concentration 

less than the initial 

concentration of the 

sample.

“Number of Serial Dilution 

Steps must be between 1 

and 20”

In a Dilute segment, you 

entered a number greater 

than 20 in the Serial 

Dilution Steps text box

Enter a number between 1 

and 20 in the Serial 

Dilution Steps text box.

See “Dilute Segments” on 

page 6-57.

“Not enough empty vials. 

Number of dilution steps 

changed from .. to ...”

Not enough empty vials of 

the required shape

Add enough empty vials of 

the required vial shape 

(Standard or Micro) to the 

autosampler tray and to 

the Sample Table for each 

Dilute segment. The 

number of empty vials 

needed is # Serial Dilution 

Steps.

“This dilution requires .. 

empty vial(s). <#> empty 

vials are available for this 

segment.”

“Combination requires 1 

empty vial. No empty vials 

are available for this 

segment.”

Not enough empty vials of 

the required shape for 

Combine or Dilute 

segment

Add enough empty vials of 

the required vial shape 

(Standard or Micro) to the 

autosampler tray and to 

the Sample Table for each 

Combine or Dilute 

segment. The number of 

empty vials needed for 

each Dilute segment is # 

Serial Dilution Steps. The 

number of empty vials 

needed for each Combine 

segment is 1.

Table 10-21   Method Error Codes  (Continued)

Error Possible Cause Action



Chapter  10    Troubleshooting and Error Codes

10-64 Applied Biosystems

10

10.2.12  Supervisor Option Error Codes

“Total percentage of 

samples is greater than 

100%. Modify sample 

concentrations.”

In a Combine segment, 

you have entered Final 

Concentrations for 

samples that exceed a 

total of 100%

Change percentages to 

total 100% in the Combine 

Segment Setup dialog 

box. See “Combine 

Segments” on page 6-61.

“Insufficient volume for 

Loading Template” 

Volume in vial not 

sufficient to run template

Adjust injection volume in 

method, or add sample to 

vial and adjust volume in 

Vial Editor dialog box. See 

Section 4.7.3, Entering 

Vials in Sample Table.

“Not enough sample 

<sample> for Run #... 

Template canceled.”

Table 10-22   Supervisor Option Error Codes

 Error Possible Cause Error

“Selected Option not 

Available. Protection key 

not found.” 

Hardware key not installed 

for Supervisor software 

option

Install hardware key. 

See Section 2.5.3, 

Installing the Hardware 

Key.
“Selected Option not 

Available. Protection key 

not found or incorrect key 

type.” 

“Selected Option not 

Available.This option is 

disabled by the Protection 

Key.” 

Option not available with 

Supervisor standalone 

software

No action. Normal 

occurrence.

Table 10-21   Method Error Codes  (Continued)

Error Possible Cause Action
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10.2.13  Program Loading Error Codes

Table 10-23   Program Loading Error Codes 

Error Possible Cause Action

NOTE: The following messages can be generated when you attempt to open 
another application (for example, Microsoft Excel) from the BioCAD Window menu.

“Cannot Load 

<appName>: Insufficient 

Memory”

Too many windows open Close unneeded windows.

“Cannot Load 

<appName>: File Not 

Found”

File missing Copy file back onto 

system from floppy 

diskette.

“Cannot Load 

<appName>: Path Not 

Found”

Path corrupted Fix path and reload 

application.

“Cannot Load 

<appName>: Invalid.EXE 

file”

Executable file missing Reload application.

“Cannot Load 

<appName>: Application 

created for earlier version 

of Windows”

Software not compatible 

with current version of 

Microsoft Windows

No action. Cannot run.

“Cannot Load 

<appName>: Error 

<errcode>”

Depends on error Depends on error.
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10.2.14  Communication Error Codes

Table 10-24   Communications Error Codes 

Error Possible Cause Action

“Data Overrun” BioCAD 700E Workstation 

not able to receive all data 

sent by device, for 

example, when two 

detectors are sending 

data at same time

Power down unneeded 

devices.

“Receive Buffer Overflow” Data collection rate too 

high for method run time

Reduce data collection 

rate. See “Configuring data 

channels” on page 4-16.

Too many applications 

open when running a 

method

Close some applications.

“Parity Error” Problem with 

communication between 

BioCAD 700E hardware 

and BioCAD software

Check hardware and 

software configuration. 

Make sure configuration 

matches physical setup.

“Framing Error”

“Transmit Buffer Overflow” External device not 

receiving messages fast 

enough from BioCAD 

700E Workstation. Device 

not powered up. Device 

not functioning.

Power up device.

Check function.

“CommLink error: 

<deviceName> TimeOut”

BioCAD 700E component 

not responding within an 

internal timeout period

Exit BioCAD software. 

Check that device is 

powered up. Start 

software.
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“CommLink error: 

<deviceName> 

<errorname>”

Problem with device Depends on problem and 

device.

“Packet Error: 

<errorCode>”

“Can't Handle ASCII 

Message: <text>”

“Input Fault: <errorCode>, 

<errorText>”

“CommLink error: Unable 

to write packet (probable 

queue full)”

Problem with 

communication between 

BioCAD 700E hardware 

and BioCAD software

Reset configuration by 

displaying the 

Configuration dialog box 

and clicking OK.

Exit software, start 

software.

Table 10-24   Communications Error Codes  (Continued)

Error Possible Cause Action
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10.2.15  COM Port Error Codes

Table 10-25   COM Port Error Codes

Error Possible Cause Action

“Comm Port Conflict: 

Registering port <n>. That 

port already exists.”

Same COM port selected 

for more than one device.

Update hardware setup. 

Specify different COM 

ports. See Section 2.5.2, 

Updating BioCAD 

Hardware Setup Options.“Comm Port Conflict: 

<device1> Requested 

Comm Port <n>.That port 

is already owned by 

<device2>”
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A  Specifications

This appendix includes specifications for:

• General

• Detection

• Miscellaneous

NOTE: The specifications for this instrument are subject 
to change without notice.
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Table A-1   General

Condition Specification

Weight 275 pounds (125 kg)

Space 

requirements

Space required for workstation, computer monitor, keyboard, 

mouse, and buffers:

• Height—36 inches (91 cm) 

• Depth—36 inches (91 cm)

• Width—72 inches (183 cm) 

Pumping system Dual piston, positive displacement with 6 inlets, pressure 
safety, and built-in seal flush

Flow rate 0.2–100 ml/min

Accuracy is +/- 1% of setpoint or 0.05 ml/min (whichever is 

greater) 

Maximum system 

pressure

3,000 psi (204 bar, 20.4 MPa)

Gradient capability Up to six solvents, with low-pressure quaternary blending in 
Percentage, Eluent, or pH blend modes with 0.1% increments. 
Compositional accuracy:

• 0.2–90 ml/min: ±1%

• 90–100 ml/min: ±1.5%
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Sample handling  Six injection modes:

• Autoloader—Up to four sample channels, with a sample 

loading range of 1 µl to 25 ml, ±1% accuracy at full stroke

• Direct Autoloader—Reduces prime volume (minimum 5 

µl), single sample channel, with a sample loading range of 

1 µl to 25 ml, ±1% accuracy at full stroke

• Manual—Eliminates prime volume, needle port adapter 

included

• Pump—Unlimited volume loading

• Integrated Autosampler (optional)—Inject from multiple 

samples, with complete control over autosampler 

functions

• Direct Wire Autosampler (optional)—Inject from 

multiple samples, control autosampler from autosampler 

front panel

Column sizes • POROS® Perfusion Chromatography® columns—2.1 to 
25 mm diameter

• Conventional chromatography columns—no limit on 
column size

Column 

configurations

• Single column, with bypass and reverse

• Tandem columns, with bypass

• Three columns

• Low dispersion

• Direct control

NOTE: Use up to eight columns with optional SCOUT Column 
Selector.

Fraction collection • Internal fraction/waste valve for manual and automated 

control of single fraction collection

• Integrated control of optional external fraction collectors, 

which accommodate tubes or larger bottles. Tube-to-tube 

switching time is 0.1 seconds.

Table A-1   General (Continued)

Condition Specification
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Materials Biocompatible and solvent-resistant—PEEK, Teflon®, Kel F®, 

Kynar®, sapphire, stainless steel, aluminum oxide, ruby

Auxiliary inputs 

and outputs

• Inputs—2 TTL

• Outputs—2 TTL

Auxiliary driver 

outputs

• Spareout LC—12 V (0.25 A)

• Spareout HC—24 V (1 A)

Table A-1   General (Continued)

Condition Specification
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Table A-2   Detection

Condition Specification

Pressure Transducer on pump discharge—0 to 3,000 psi

Auxiliary input 12-bit A/D for additional detector

Monitor bypass Automated valve switches pH/conductivity probes in and out of line

pH probe • Range—2 to 12 pH units

• Flow cell volume—50 µl

Conductivity 

probe

• Range—0 to 200 mS

• Flow cell volume—7 µl

UV/Visible Model 201 (single wavelength)—190 nm to 800 nm

Model 205 (dual wavelength)

• 190 nm to 800 nm (single wavelength range)

• 190 to 450 nm OR 366 to 700 nm (dual wavelength ranges)

Flow cells available:

• Analytical—6 mm path length, 9 µl  volume, 45 ml/min flow 

rate maximum

• Semi-prep—3 mm path length, 4.5 µl  volume, 100 ml/min 

flow rate maximum
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Table A-3   Miscellaneous

Standard Specification

Hardware

(standard)

• Internal Pentium/133 MHz processor (minimum)

• 3.2 gigabyte hard disk drive (minimum)

• 64 megabyte RAM (minimum)

• 3.5-inch floppy disk drive

• 14-inch Super VGA color monitor

• Keyboard

• Mouse

• Network card

• SCSI card

Hardware

(options)

• 17-inch color monitor

• 21-inch color monitor

• Laser and color printers

• SCOUT Column Selector

• External detector (UV/Vis or fluorescence)

• Fraction collector

• Autosampler

• Kits of selected POROS columns

Software

(standard)

• BioCAD Software

• Windows 95 Version OSR 2.5 (minimum)

Software

(options)

• Supervisor™ Software (stand-alone software version)

• Microsoft Office 97
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B  Spare Parts

This appendix contains part numbers for the following 

spare parts:

• Solvent pump

• Fittings and tubing

• Detector and monitor

• Fraction collector

• Miscellaneous

• Spare Parts Kits

The parts listed in this appendix are recommended for 

customer installation. 

Procedures other than those listed in 

Chapter 2, Installing the BioCAD 700E Workstation, and 

Chapter 9, Maintenance, may require a trained service 

representative. 

CAUTION

Damage resulting from unauthorized work on your 
workstation may invalidate your warranty.
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Table B-1   100 ml/min Solvent Pump Spare Parts 

Item Where used Part Number

Check valve kit, TSS-100

• Inlet check valve housing (1)

• Outlet check valve housing (1)

• Check valves (2)

Primary solvent (front) 

pump head

Contact your 

technical service 

representative

Check valves, primary head, TSS-100 

(1)

Primary solvent (front) 

pump head

PH602848

Check valves, seal wash, TSS-100 

(1)

Pump seal wash 

system

PH602840

Fitting, stainless steel, compression 

ring, and ferrule (10/pkg)

Columns, prime/purge 

valve, filter/mixer, 

union

GEN602135

Fitting, wing nut, 10-32, with ferrule, 

PEEK (5/pkg)

Columns, prime/purge 

valve, filter/mixer, 

union

GEN602301

Inlet tubing/solvent barb kit, TSS-100

• Barb fittings, 3/32-inch (4)

• Barb fittings, 1/8-inch (10)

• Spacers, solvent valve (10)

• Inlet tubing

Accumulator solvent 

(front) pump head

Contact your 

technical service 

representative

Piston, primary pump head, TSS-100 Primary pump 

assembly

PH602836

Piston, accumulator pump head, 

TSS-100 

Accumulator pump 

assembly

PH602837
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Pump head seal kit, TSS-100

• Solvent pump seal, primary (1)

• Solvent pump seal, accumulator 

(1)

• Wash pump seal (2)

• O-rings (2)

• Seal insertion and removal tools

• Scouring pad

• Installation instructions

Primary and 

accumulator solvent 

(front) and seal wash 

(back) pump heads

Contact your 

technical service 

representative

Seal wash line kit, TSS-100

• Barb fittings, 1/8-inch (10)

• Tubing, Tygon®, 102 inches

• Installation instructions

Pump seal wash 

system

Contact your 

technical service 

representative

Solvent proportioning valve kit Pump compartment GEN 601114

Table B-1   100 ml/min Solvent Pump Spare Parts  (Continued)

Item Where used Part Number



Appendix  B    Spare Parts

B-4 Applied Biosystems

B

Table B-2   60 ml/min Solvent Pump Spare Parts 

Item Where used Part Number

Check valve assembly kit
(housing, inlet valve, outlet valve)

Pump head P5-1006-00-5030

Mixer filter frit replacement kit

• Filter frit
• Fitting, extra long, with ferrule, 

for 1/16-in tubing, 1.03-in length, 
10-32 threads, PEEK 
(1 each)

• Fitting, barbed, 1/8-in, 
10-32 threads, PP

• Tubing, Tygon®, 3-in,
1/8-in ID, 1/4-in OD

• Fitting, Luer-Lok, for 1/8-in barb
• Seal, filter/mixer

Filter/mixer GEN 601907

Fitting, extra-long, with ferrule, for 
1/16-in tubing, 1.03-in length, 
10-32 threads, PEEK (10 each)

Filter/mixer GEN 601933

Fitting, compression ring, with 
stainless steel nut, stainless steel 
ring, and PEEK ferrule, for 1/16-in 
tubing (10 each)

Filter/mixer, 
prime/purge valve

GEN 602135

Piston Pump head P5-1006-06-5160

Seal, filter/mixer Filter/mixer GEN 602376

Seal kit, pump head 
(complete to refurbish 2 pump 
heads)

Pump head P5-1006-06-5020

Seal wash line kit Seal wash lines P5-1006-06-5040

Solvent proportioning valve kit Pump compartment GEN 601114

Check valve assembly kit
(housing, inlet valve, outlet valve)

Pump head P5-1006-00-5030
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Table B-3   Fittings and Tubing 

Item Where used Part Number

Fitting, 10-32 threads, with ferrule, 

PEEK (5 each)

Flow cell GEN 602301

Fitting, Rheodyne Rheflex (6 each) Injection and column 

switching valves

P5-1017-06

Seal wash line kit Seal wash lines P5-1006-06-5040

Sample loop, 5.0 µl 1/16-in Injection valve P5-1016-00-0005

Sample loop, 10 µl 1/16-in Injection valve P5-1016-00-0010

Sample loop, 20 µl 1/16-in Injection valve P5-1016-00-0020

Sample loop, 50 µl 1/16-in Injection valve P5-1016-00-0050

Sample loop, 100 µl 1/16-in Injection valve P5-1016-00-0100

Sample loop, 200 µl 1/16-in Injection valve P5-1016-00-0200

Sample loop, 500 µl 1/16-in Injection valve P5-1016-00-0500

Sample loop, 1 ml 1/16-in Injection valve P5-1016-00-1000

Sample loop, 2 ml 1/16-in Injection valve P5-1016-00-2000

Sample loop, 5 ml 1/16-in Injection valve P5-1016-00-5000

Tubing, PEEK 0.010-in blue, 5 ft Connections to 

injection and switching 

valves

P5-1023-06-0010

Tubing, PEEK 0.020-in orange, 5 ft Connections to 

injection and switching 

valves

P5-1023-06-0020
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Tubing, PEEK 0.030-in green, 5 ft Connections to 

injection and switching 

valves

P5-1023-06-0030

Tubing, Teflon 1/16-in, 25 ft Waste line from 

autoloader and waste 

valve

P5-1020-06-0031

Tubing, Teflon 1/8-in, 25 ft Air supply line P5-1020-12-0062

Tubing cutter Tubing P5-1030-00-0000

Table B-3   Fittings and Tubing  (Continued)

Item Where used Part Number

Table B-4   Detector and Monitor Spare Parts

Item Where used Part Number

Lamp, tungsten UV/Vis detector P5-1085-00-5010

Lamp, deuterium assembly UV/Vis detector P5-1085-00-5020

Flow cell, Semi-prep UV/Vis detector P5-1085-51-0000

Flow cell, Analytical UV/Vis detector P5-1085-52-0000

pH probe* pH monitor P5-1086-02-0000

pH flow cell* pH monitor P5-2085-02-0000

Conductivity cell Conductivity monitor P5-1087-11-0000

* Call Technical Support to determine the pH probe and flow cell to order for your workstation.
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Table B-5   Fraction Collector Spare Parts

Item Where used Part Number

Cable, Advantec fraction collector Advantec fraction 

collector 

P5-1908-00-0000

Cable, Gilson fraction collector Gilson fraction collector P5-2082-00-0000

Cart, mobile Advantec fraction 

collector

P5-1260-51

Nozzle, high flow Advantec fraction 

collector

P5-1260-00-5140

Nozzle, low flow Advantec fraction 

collector

P5-1260-00-5130

Rack, Eppendorf Advantec fraction 

collector

P5-1260-11

Rack, funnel Advantec Fraction 

Collector

P5-1260-31

Rack, prep funnel Advantec fraction 

collector

P5-1260-32

Rack, vial, 4 ml Advantec fraction 

collector

P5-1260-21

Tubing, prep Advantec fraction 

collector

P5-1260-33

Valve, Advantec fraction collector Advantec fraction 

collector

P5-1260-01-0000

Valve, Gilson fraction collector Gilson fraction collector P5-1924-21-0000
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Table B-6   Miscellaneous Spare Parts

Item Where used Part Number

Fan Guard, 4.69-in Fan on rear panel of 

workstation

P5-1242-00-0000

Keyboard, Windows 95 104-key Computer GEN 602329

Syringe, reagent, 500 µl Autoloader syringe P5-1012-00-0005

Syringe, reagent, 2.5 ml Autoloader syringe P5-1012-00-0025

Syringe, reagent, 5 ml Autoloader syringe P5-1012-00-0050

Syringe, reagent, 25 ml Autoloader syringe P5-1012-00-0250

Rotor Seal, Rheodyne, Tefzel 6-port injection valve or 

column switching 

valves

P5-1013-00-5110

Stator, Rheodyne, PEEK 6-port injection valve P5-1013-00-5120

Stator, Rheodyne, PEEK 6-port column 

switching valves

P5-1013-00-5200

Stator assembly, white, ceramic 6-port injection valve or 

column switching 

valves

P5-1013-00-5160
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Table B-7    Spare Parts Kits 

Item Where used Part Number

BioCAD Accessory Kit

• Sample loop, 100 µl 1/16-in

• Sample loop, 5 ml 1/16-in

• Fitting, 10-32 thread, with ferrule, 

PEEK 

• Tubing, PEEK 0.010-in blue, 5 ft 

(2)

• Tubing, PEEK 0.020-in orange, 

5  ft (2)

• Tubing, PEEK 0.030-in green, 

5 ft (2)

• Adapter, brass, male, 1/8-in 

Swagelok® to 1/4-in NPT (2)

• Syringe, 60 ml plastic

• Adaptor, needle port

• BioCAD Fitting Kit

• BioCAD Tubing Label Kit

• Accessory Kit instructions

Miscellaneous areas 

of BioCAD 700E 

Workstation

P5-2305-01-0000
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BioCAD Fitting Kit

• Ferrule, 1/16-in, plastic, blue (10)

• Nut, 1/16-in, low pressure, plastic, 

black (6)

• Nut, 1/16-in, low pressure, long, 

plastic, blue (2)

• Ferrule, 1/8-in, plastic, yellow (10)

• Nut, 1/8-in, low pressure, plastic, 

black (10)

• Union, 0.020-in, high pressure, 

PEEK (2)

• Union, 1/4-in, low pressure, 

Tefzel (2)

• Tubing cutter

Miscellaneous 

connections on the 

BioCAD 700E 

Workstation

P5-1937-01-0000

BioCAD Sparge Kit

• Bottle cap, plastic (6)

• Bottle cap insert, plastic, white (6)

• Vent plug, plastic, white (6)

• Sparge element (6)

• Tubing, 1/8-in, 4 ft, Teflon (6)

• Tubing, 1/4-in, 2-in, Urethane (2)

• Sparge kit instructions

Buffer/Solvent lines 

and sparge panel 

P5-2296-02-0000

BioCAD Solvent Line Kit

• Spacer, 0.209 x 0.125 x 0.160, 

Kel-F (10)

• Fitting, barbed, small, 

polypropylene, (10)

• Tubing, 1/8-in, 4 ft, Teflon (6)

Buffer/Solvent 

connections

P5-2303-02-0000

Column Clamp Kit Injection and column 

switching valves

GEN 601113

Table B-7    Spare Parts Kits  (Continued)

Item Where used Part Number
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Fuse Kit Main power and 

internal printed circuit 

board fuses

P5-1953-02-0000

Gas Fitting Kit

• Brass fittings for regulator, 

1/8 to 1/4 NPT (2)

• Brass ferrules (10)

Gas regulator GEN 601116

Seal Wash Line Kit Seal wash lines P5-1006-06-5040

Syringe Seal Kit (2.5 ml) Syringe pump GEN 601111

Syringe Seal Kit (0.5 ml) Syringe pump GEN 601112

Table B-7    Spare Parts Kits  (Continued)

Item Where used Part Number
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C  Warranty/Service 
Information

Applied Biosystems supplies or recommends certain 

configurations of computer hardware, software, and 

peripherals for use with its instrumentation. Applied 
Biosystems reserves the right to decline support for or 

impose charges for supporting nonstandard computer 

configurations or components that have not been supplied 

or recommended by Applied Biosystems. Applied 
Biosystems also reserves the right to require that computer 

hardware and software be restored to the standard 

configuration prior to providing service or technical support. 

For systems such as BioCAD®, VISION™, SPRINT™, or 

INTEGRAL™, which have built-in computers, installing 

unauthorized hardware or software may void the Warranty 

or Service Plan.

C.1  Limited Product Warranty

Limited warranty Applied Biosystems warrants that all standard components 

of the BioCAD Workstation will be free of defects in 

materials and workmanship for a period of ninety (90) days. 

Applied Biosystems will repair or replace, at its discretion, all 

defective components during this warranty period. After this 

warranty period, repairs and replacement components may 

be purchased from Applied Biosystems at its published 
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rates. Applied Biosystems also provides service agreements for 

post-warranty coverage. Applied Biosystems reserves the right to 

use new, repaired, or refurbished instruments or components for 

warranty and post-warranty service agreement replacements. 

Repair or replacement of products or components under warranty 

does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories 

supplied with its BioCAD Workstation, such as peripherals, 

printers, and special monitors, will be free of defects in materials 

and workmanship for a period of ninety (90) days. Applied 

Biosystems will repair or replace, at its discretion, defective 

accessories during this warranty period. After this warranty 

period, Applied Biosystems will pass on to the buyer, to the extent 

that it is permitted to do so, the warranty of the original 

manufacturer for such accessories.

With the exception of consumable and maintenance items, 

replaceable products or components used on the instrument are 

themselves warranted to be free of defects in materials and 

workmanship for ninety (90) days.

Applied Biosystems warrants that chemicals and other 

consumable products will be free of defects in materials and 

workmanship when received by the buyer, but not thereafter, 

unless otherwise specified in documentation accompanying the 

product.

Applied Biosystems warrants that for a period of ninety (90) days 

from the date of installation, the software designated for use with 

the product will perform substantially in accordance with the 

function and features described in its accompanying 

documentation when properly installed on the product. Applied 

Biosystems does not warrant that the operation of the instrument 

or software will be uninterrupted or error free. Applied Biosystems 

will provide any software corrections or “bug-fixes” if and when 

they become available, for a period of ninety (90) days after 

installation.
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Warranty
period effective

date

Any applicable warranty period under these sections will begin on 

the date of installation for hardware and software installed by 

Applied Biosystems personnel, unless that date has been 

delayed at the buyer’s request. In that case, and for all hardware 

and software installed by the buyer, and for all other products, the 

applicable warranty period begins the date the component is 

received by the buyer.

Warranty
exceptions

The above warranties shall not apply to defects resulting from 

misuse, neglect, or accident, including without limitation: 

operation with incompatible solvents or samples in the system; 

operation outside of the environmental or use specification 

instructions for the product or accessories; performance of 

improper or inadequate maintenance by the user; installation of 

software or interfacing not supplied by Applied Biosystems; and 

modification or repair of the product or the software not 

authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems’ sole and 

exclusive representations, warranties, and obligations with 

respect to its products, and Applied Biosystems makes no other 

warranty of any kind whatsoever, expressed or implied, including 

without limitation, warranties of merchantability and fitness for a 

particular purpose, whether arising from a statute or otherwise in 

law or from a course of dealing or usage of trade, all of which are 

expressly disclaimed. Such limited warranty is given only to buyer 

or any third party in the event of use of products furnished 

hereunder by any third party.

Warranty
limitations

The remedies provided herein are the buyer's sole and exclusive 

remedies. Without limiting the generality of the foregoing, in no 

event shall Applied Biosystems be liable, whether in contract, in 

tort, warranty, or under any statute (including without limitation, 

any trade practice, unfair competition, or other statute of similar 

import) or on any other basis, for direct, indirect, punitive, 

incidental, multiple, consequential, or special damages sustained 

by the buyer or any other person, whether or not foreseeable and 

whether or not Applied Biosystems is advised of the possibility of 

such damage, including without limitation, damage arising from or 
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related to loss of use, loss of data, failure or interruption in the 

operation of any equipment or software, delay in repair or 

replacement, or for loss of revenue or profits, loss of good will, 

loss of business or other financial loss or personal injury or 

property damage.

No agent, employee, or representative of Applied Biosystems has 

any authority to bind Applied Biosystems to any affirmation, 

representation, or warranty concerning the product that is not 

contained in this Limited Warranty Statement. Any such 

affirmation, representation, or warranty made by any agent, 

employee, or representative of Applied Biosystems will not be 

binding on Applied Biosystems.

This warranty is limited to the buyer of the product from Applied 

Biosystems and is not transferable.

C.1  Damages, Claims, Returns

Damages Unpack shipments promptly after receipt to check for any 

concealed damage. 

If you discover damage, stop unpacking. Contact the shipping 

carrier and request inspection by a local agent. Secure a written 

report of the findings to support any claim. Do not return damaged 

goods to Applied Biosystems without first securing an inspection 

report and contacting Applied Biosystems Technical Support for a 

Return Authorization (RA) number.

Claims After a damage inspection report is secured, Applied Biosystems 

will supply the replacements and process claims that are initiated 

by either party.

Returns Do not return any material without prior notification and 

authorization. 

If for any reason it becomes necessary to return material to 

Applied Biosystems, contact Applied Biosystems Technical 

Support or your nearest Applied Biosystems subsidiary or 

distributor for a return authorization (RA) number and forwarding 

address. Place the RA number in a prominent location on the 

outside of the shipping container, and return the material to the 

appropriate address.
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Sample Methods

Sample method
description

The BioCAD 700E includes sample methods which are stored 

on your hard drive in the C:\BIOCAD\METHOD directory. 

You can use these sample methods:

• For demonstrations and training.

• As templates for creating new methods. Methods are 

designed so you can substitute different column sizes 

and types or different flow rates without affecting the 

chromatography.

Sample method
configuration

Your system configuration may differ from the method 

configuration set in the sample methods. When you open a 

sample method, a configuration mismatch error may be 

displayed. 

Click Update Method with System Configuration to update 

the method with the current system configuration.

Click Do Not Update Method with System Configuration to 

leave the method configuration unchanged. If you want to run 

the sample method using the method configuration, you must 

load the method configuration as the system configuration. For 

more information, see Section 4.4, Loading an Existing 

Configuration.



Appendix  D    BioCAD 700E Sample Methods

D-2 Applied Biosystems

D

D

Printing You can print the sample methods from the Method Editor by 

selecting Print Method from the File menu. All methods are 

stored on your hard drive in the C:\BIOCAD\METHOD 

directory.

List of sample
methods

This appendix describes the following sample methods:

Sample Method 

Name
Purpose

AFFSTD.MET Separation of standard proteins on 

POROS A and POROS G columns

HICSTD.MET Separation of standard proteins on 

POROS HP, PE, and ET columns

RPSTD.MET Separation of standard proteins on 

POROS R1 and R2 columns

ANIONSTD.MET Separation of standard proteins on 

POROS HQ, QE, and PI columns

CATIONSD.MET Separation of standard proteins on 

POROS HS, SP, S, and CM columns

ANIONPH.MET Anion exchange pH map with 

standard proteins

CATPH.MET Cation exchange pH map with 

standard proteins

CUSTOMPH.MET Custom pH map with standard 

proteins (for use with uncalibrated 

pH buffers)

SYSCLEAN.MET Automated system cleaning and 

shutdown
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D.1  AFFSTD.MET—Separation
on POROS A and POROS G

Configuration Configuration settings are listed below:

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—Phosphate buffered saline (PBS)

• Channel B—Acid - 12 mM HCl + 0.15 M NaCl

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS A/M

Tubing ID 0.010" (blue) 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—BSA and human IgG, protein 

concentration 10 mg/ml each

Prime/Flush volumes 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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Method settings Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Segments and Added Events

Equil • Purge segment—Equilibrates system with PBS (Channel A) before 

placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in the configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

• Step segment—Flows standard on column for 0.5 min. Ensures 

sample passes through column and non-retained components are 

washed off before Elute block begins.

Elute • Purge segment—Flushes system with acid (Channel B). This 

minimizes column elution time (because you are not waiting for the 

acid front to reach the column head). It also performs a true step 

change to acid, rather than a gradual change from PBS to acid.

• Step segment—Holds acidic conditions for 5 CV, to allow peak to 

elute and pass through the detector before method ends.
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D.2  HICSTD.MET—Separation on
POROS HP, PE, and ET

Configuration Configuration settings are listed below:

Method settings Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—20 mM phosphate pH 7 + 3M ammonium 

sulfate

• Channel B—Phos - consists of 20 mM Phosphate, pH 7

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS PE/M

Tubing 0.010" (blue) 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—ribonuclease and lysozyme, protein 

concentration 5 mg/ml

Prime/Flush volumes 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Segments and Added Events

Equil • Purge segment—Equilibrates system with ammonium sulfate buffer 

(Channel A) before placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in the configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.
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D.3  RPSTD.MET—Separation
on POROS R1 and POROS R2

Configuration Configuration settings are listed below:

Method settings Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—0.1% v/v TFA in water

• Channel B—Acetonitrile

Plumbing Single Column (can use other configurations) 

Column 4.6 mmD/100mmL POROS R/M

Tubing 0.010" (blue) 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—cytochrome C and soybean trypsin 

inhibitor (STI), protein concentration 10 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 220 nm

Initial Detector State pH/conductivity bypassed

NOTE: Take pH/conductivity monitors out of line when 
performing reversed-phase separations.

Block Segments and Added Event

Equil • Purge segment—Equilibrates system with 85% 0.1% TFA 

(Channel A) and 15% acetonitrile (Channel B) before placing column 1 

inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in the configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.
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D.4  ANIONSTD.MET—Separation
on POROS HQ, QE, and PI

Configuration Configuration settings are listed below:

Method settings Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—20 mM Tris, pH 8

• Channel B—20 mM Tris, pH 8 + 0.5 M NaCl

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS HQ/M

Tubing 0.010" (blue)

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—BSA and ovalbumin, protein 

concentration 10 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains 

the same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Segments and Added Event

Equil • Purge segment—Equilibrates system with Tris buffer (Channel A) 

before placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in the configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

Elute • Gradient segment—A 15 CV gradient changes from 100% Tris 

(Channel A) to 100% Tris and salt (Channel B). Gradient segment can 

be programmed in time (min) or volume (ml). 

There is a 2.5 ml delay before the gradient front reaches the column, 

due to delay volumes inherent in the proportioning/blending system. 

Therefore, it is not necessary to program a wash segment before 

gradient start, unless you need more than 2.5 ml of wash.

• Step segment—Holds end of the gradient for 10 ml to ensure the 

gradient front is through column and detector before method ends.
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D.5  CATIONSD.MET—Separation
on POROS HS, SP, S, and CM

Configuration Configuration settings are listed below:

Method settings Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—20 mM MES, pH 6.2

• Channel B—20 mM MES, pH 6.2 + 0.5 M NaCl 

(substitute 100 mM acetate pH 4.5 and 100 mM acetate 

pH 4.5 + 1.0 M NaCl for POROS CM)

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS HS/M

Tubing 0.010" (blue)

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—ribonuclease and lysozyme (substitute 

ovalbumin and bovine serum albumin for POROS CM), protein 

concentration 5 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

UV/Vis Wavelength 280 nm

Initial Column State Column 1 inline

Initial Detector State pH/conductivity inline

Block Segments and Added Events

Equil • Purge segment—Equilibrates system with MES buffer (Channel A) 

before placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

Elute • Gradient segment—A 15 CV gradient changes from 100% MES 

(Channel A) to 100% MES and salt (Channel B). Gradient segment can 

be programmed in time (min) or volume (ml). 

There is a 2.5 ml delay before the gradient front reaches the column, 

due to delay volumes inherent in proportioning/blending system. 

Therefore, it is not necessary to program a wash segment before 

gradient start, unless you need more than 2.5 ml of wash.

• Step segment—Holds end of the gradient for 10 ml to ensure the 

gradient front is through column and detector before method ends.
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D.6  ANIONPH.MET—
Anion Exchange pH Map

Configuration Configuration settings are listed below:

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—100 mM anion buffer, pH 6 (pH blend anion 

buffer); configure as type Buffer in Buffer/Solvent Library

• Channel B—100 mM anion buffer, pH 9 (pH blend anion 

buffer); configure as type Buffer in Buffer/Solvent Library

• Channel C—Water; configure as type H2O in 

Buffer/Solvent Library

• Channel D—3 M NaCl; configure as type Eluent in 

Buffer/Solvent Library

NOTE: You can also use your own custom pH blend buffers, 
if you calibrate them.

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS HQ/M

Tubing 0.010" (blue) 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—BSA and ovalbumin, protein 

concentration 10 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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Method settings All segments are programmed in the pH blend mode. 

In pH blend mode, you specify:

• Blend concentration (mM) 

NOTE: The blend concentration is typically a two fold 
or greater dilution of the concentrated buffers in 
channels A and B.

• Blend pH 

• Eluent concentration (mM) 

NOTE: The eluent concentration is typically a two 
fold or greater dilution of the concentrated eluent in 
channel D (in this case NaCl).

You can select Percentage blend mode in each segment to 

see actual percentages that the system is blending in 

response to the pH mode specification.

The ANIONPH.MET method was designed for use with the pH 

Map template. Note that the easiest way to change the pH 

setting may be by running the pH Map template, even if the 

template consists of only one run.

Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Segments and Added Events

Equil • Purge segment—Equilibrates system with the pH blend settings 

(50 mM buffer, pH 7) before placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

Elute • Gradient segment—A 15 CV gradient changes from 0 mM NaCl to 

1000 mM NaCl. Gradient segment can be programmed in time (min) 

or volume (ml).

When specifying the gradient segment in pH blend mode, specify 

buffer concentration (50 mM), pH gradient (in this case, pH is held 

constant at 7), and eluent gradient (in this case, 0 to 1000 mM NaCl). 

There is a 2.5 ml delay before the gradient front reaches the column, 

due to delay volumes inherent in the proportioning/blending system. 

Therefore, it is not necessary to program a wash segment before 

gradient start, unless you need more than 2.5 ml of wash.

• Step segment—Holds end of the gradient for 10 ml to ensure the 

gradient front is through column and detector before method ends.
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D.7  CATPH.MET—
Cation Exchange pH Map

Configuration Configuration settings are listed below:

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—100 mM cation buffer, pH 4.5 (pH blend 

cation buffer); configure as type Buffer in Buffer/Solvent 

Library

• Channel B—100 mM cation buffer, pH 7.5 (pH blend 

cation buffer); configure as type Buffer in Buffer/Solvent 

Library

• Channel C—Water; configure as type H20 in 

Buffer/Solvent Library

• Channel D—3 M NaCl; configure as type Eluent in 

Buffer/Solvent Library

NOTE: You can also use your own custom pH blend buffers, 
if you calibrate them.

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS HS/M

Tubing 0.010" 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—ribonuclease and lysozyme, protein 

concentration 5 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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Method settings All segments are programmed in the pH blend mode. 

In pH blend mode, you specify:

• Blend concentration (mM) 

NOTE: The blend concentration is typically a two fold 
or greater dilution of the concentrated buffers in 
channels A and B.

• Blend pH 

• Eluent concentration (mM) 

NOTE: The eluent concentration is typically a two 
fold or greater dilution of the concentrated eluent in 
channel D (in this case NaCl).

You can select Percentage blend mode in each segment to 

see actual percentages that the system is blending in 

response to the pH mode specification.

The CATPH.MET method was designed for use with the pH 

Map template. Note that the easiest way to change the pH 

setting may be by running the pH Map template, even if the 

template consists of only one run.

Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Includes

Equil • Purge segment—Equilibrates system with the pH blend settings 

(50 mM buffer, pH 5) before placing column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

Elute • Gradient segment—A 15 CV gradient changes from 0 mM NaCl to 

1,000 mM NaCl. Gradient segment can be programmed in time (min) 

or volume (ml). 

When specifying the gradient segment in pH blend mode, specify 

buffer concentration (50 mM), pH gradient (in this case, pH is held 

constant at 5), and eluent gradient (in this case, 0 to 1,000 mM NaCl). 

There us a 2.5 ml delay before the gradient front reaches the column, 

due to delay volumes inherent in the proportioning/blending system. 

Therefore, it is not necessary to program a wash segment before 

gradient start, unless you need more than 2.5 ml of wash.

• Step segment—Holds end of the gradient for 10 ml to ensure the 

gradient front is through column and detector before method ends.
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D.8  CUSTOMPH.MET—
Custom pH Map

Configuration Configuration settings are listed below:

Instrument Configuration

High/Low pressure 3,000 psi, 0 psi

Buffers/Solvents • Channel A—100 mM phosphate, pH 6; configure as type 

Buffer in Buffer/Solvent Library

• Channel B—100 mM phosphate, pH 9; configure as type 

Buffer in Buffer/Solvent Library

• Channel C—Water; configure as type H2O in 

Buffer/Solvent Library

• Channel D—3 M NaCl; configure as type Eluent in 

Buffer/Solvent Library

Plumbing Single Column (can use other column configurations) 

Column 4.6 mmD/100mmL POROS HQ/M

Tubing/ 0.010" (blue) 

Flow Cell Analytical

Sample Loader Autoloader, 0.5 ml syringe, 100 µl sample loop

Sample Sample Channel 1—BSA and ovalbumin, protein 

concentration 10 mg/ml

Prime/Flush volume 500 µl, 100 µl

Recorder Detector Channel UV/Vis #1
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Method settings All segments are programmed in pH mode. 

Because the CUSTOMPH.MET method configuration does 

not use pH Blend Buffers or calibrated custom pH blend 

buffers, the pH blending uses a percentage, instead of a pH 

specification.

In pH mode with uncalibrated pH blend buffers, you specify:

• Blend percentage of the two pH buffers. The resulting 

pH is equal to the percent of the pH values. For 

example, if buffers are pH 4 and pH 6, and you enter 

50%, the resulting pH is 5.

• Blend concentration (mM)

NOTE: The blend concentration is typically a two fold 
or greater dilution of the concentrated buffers in 
channels A and B.

• Eluent concentration (mM)

NOTE: The eluent concentration is typically a two 
fold or greater dilution of the concentrated eluent in 
channel D (in this case NaCl).

You can select Percentage blend mode in each segment to 

see actual percentages that the system is blending in 

response to the pH mode specification.

The CUSTOMPH.MET method was designed for use with the 

pH Map template. Note that the easiest way to change the pH 

setting may be by running the pH Map template, even if the 

template consists of only one run.

Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings
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General Settings

Flow rate 5 ml/min. You can specify an 1,800 cm/hr flow rate so that 

when you configure a new column, the method maintains the 

same linear velocity for the new column.

Initial Column State Column 1 inline

UV/Vis Wavelength 280 nm

Initial Detector State pH/conductivity inline

Block Includes

Equil • Purge segment—Equilibrates system with the pH blend settings 

(50 mM buffer, 20% low pH buffer/80% high pH buffer) before placing 

column 1 inline to equilibrate. 

• Step segment—Equilibrates column for 10 column volumes (CV). If 

you select a column with different dimensions in the configuration, the 

method updates itself and maintains a 10 CV equilibration based on 

the new column dimensions.

Load • Inject segment—Injects sample onto column. Flush Loader is 

selected to flush sample lines with sample channel 1 before loading 

loop with 20 µl of sample.

• Zero UV Detector Event—Zeroes UV/Vis detector after injection.

Elute • Gradient segment—A 15 CV minute gradient changes from 0 mM 

NaCl to 1,000 mM. Gradient segment can be programmed in time 

(min) or volume (ml). 

When specifying the gradient segment in the pH mode, specify buffer 

concentration (50 mM), pH gradient (in this case, pH blend of buffers 

is held constant at 20/80) and eluent gradient (0 to 1,000 mM NaCl). 

There is a 2.5 ml delay before the gradient front reaches the column, 

due to delay volumes inherent in the proportioning/blending system. 

Therefore, it is not necessary to program a wash segment before 

gradient start, unless you need more than 2.5 ml of wash.

• Step segment—Holds end of the gradient for 10 ml to ensure the 

gradient front is through column and detector before method ends.
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D.9  SYSCLEAN.MET—Shutdown

Configuration The SYSCLEAN.MET method is for automated system 

cleaning and shutdown. However, the method does not 

include steps to clean inline columns. All flow is in the bypass 

column mode. Set High Pressure limit to 3,000 psi.

CAUTION
The system must be in Single Column or Tandem Column 
plumbing configuration to run SYSCLEAN.MET. You cannot 
bypass columns in other plumbing configurations.

Method settings To run this method, place all solvent and sample lines in a 

beaker of water (or other appropriate flush solution).

Method settings are listed below, including:

• General Settings

• Block/Segment/Added Event Settings

General Settings

Flow rate 30 ml/min. Depending on tubing diameter and detector flow 

cell, you may not be able to run at 30 ml/min without exceeding 

3,000 psi and shutting down the pump. If this occurs, reduce 

the flow rate in General Settings and in all Purge segments. 

Initial Column State Columns bypassed

UV/Vis Wavelength 254 nm

Initial Detector State pH/conductivity bypassed

Block Includes

Equil • Purge segments A through F—Purges all buffer/solvent lines (A–F).

• Prime Sample Loader events—Primes sample lines (1–4).

• Set Detectors Inline event—Places conductivity/pH monitors inline.

• Turn UV Detector Lamp Off event—Turns off UV/Vis detector.

• Pump Off event—Turns off pump.
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E  External
Instrument
Connections

The BioCAD 700E Workstation has three connectors on 

the left side panel:

• Fraction Collector

• Autosampler

• Auxiliary

Connectors are mounted vertically with Pin 1 at the top. 

Pin assignments are listed in the following tables.
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Table E-1   Fraction Collector Connector Pin 

Assignments

Pin Assignment

1 Integrator Output (+)—1 Volt/AU

2 Integrator Output (-)—1 Volt/AU

3 Logic Ground Output

4 Fraction Collector Start—TTL

5 Fraction Collector End—TTL

6 Advance Tube—TTL

7 Event Mark Input—TTL

8 Event Mark Ground

9 Valve Power Output +12 V, 0.25 Amp

10 Valve Switch Output
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Table E-2   Autosampler Connector Pin Assignments

Pin Assignment

1 Logic Input Ground 

2 Input Injection Trigger—TTL

3 Input Stop—TTL

4 Busy Output—TTL

5 Start Output—TTL

6 Stop Output—TTL

7 Logic Output Ground

8 No Connection

9 No Connection

10 No Connection
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NOTE: When connecting a device to the Auxiliary 
connector, use a shielded cable with a ferrite bead to 
maintain CE compliance. Recommended source and 
part number for the ferrite bead is: 
Fair-Rite Products Corporation, No. 2643164151.

Table E-3   Auxiliary Connector Pin Assignments

Pin Assignment

1 Analog Input (+)  0 To 1 Volt Full Scale

2 Analog Input (-)  0 To 1 Volt Full Scale

3 Output Valve Power # 1  +24 Volt, 1 Amp

4 Output Valve Switch # 1

5 Output Valve Power # 2  +12 Volt, 0.25 Amp

6 Output Valve Switch # 2

7 Logic Input Ground

8 Input # 1—TTL

9 Input # 2—TTL

10 Output # 1—TTL

11 Output # 2—TTL

12 Logic Output Ground

13–16 Do Not Connect
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F  Autosampler 
Injection Types

This appendix describes how the AS 3500 autosampler 

makes each injection type.

NOTE: For more information on plumbing the 
autosampler injector valve, see Section 3.6.2, Plumbing 

Autosampler Injector Valve. 

NOTE: For information on selecting and configuring 
injection type for an integrated autosampler, see 
Section 4.8, Configuring and Preparing the BioCAD 

Software for a Direct Wire Autosampler.
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Table F-1   AS 3500 Autosampler Injections

Injection Type Autosampler Function

Pull Loop 

(< 200 µl)

(default) 

• An air bubble is drawn into the needle to isolate the sample 

slug from the flush solvent in the line.

• With injector valve in Load position, sample is drawn into 

needle.

• The sample vial is lowered below needle tip, and sufficient air 

is drawn into the needle to pull the sample slug into the loop.

• The injector valve rotates to Inject position and sample is 

carried from the loop onto the column.

PushLoop ® • An air bubble is drawn into the needle to isolate the sample 

slug from the flush solvent in the line.

• With the injector valve in Inject position, sample is pulled up to 

and past the injector valve. 

• The injector valve rotates to Load position and the desired 

sample volume is pushed into the loop.

• The injector valve rotates to Inject position and sample is 

carried from the loop onto the column.

Full Loop

(≤ 100 µl) 

• An air bubble is drawn into the needle to isolate the sample 

slug from the flush solvent in the line. 

• With the injector valve in Load position, the syringe retracts to 

pull sample from the vial into the sample loop. The volume of 

sample drawn is approximately two times the loop volume to 

ensure the loop is completely filled.

• The injector valve rotates to Inject position and sample is 

carried from the loop onto the column.

Pull Loop 

(> 200 µl)

OR

Full Loop

(> 100 µl)

• With the injector valve in Inject position, the autosampler 

sample syringe pulls sample into needle, past injector valve.

• The injector valve rotates to Load position.

• The autosampler prep syringe pulls sample into the loop.

• The injector valve rotates to Inject position and sample is 

carried from the loop onto the column.
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G  Maintenance Log

The following pages include a log sheet listing maintenance 

procedures. Copy these pages and keep them by your BioCAD 

700E Workstation.

Instructions for performing maintenance procedures are listed in:

• Section 2.6, Starting Up and Shutting Down

• Section 3.2.3, Preparing Pump Seal Wash Solution

• Chapter 9, Maintenance



Maintenance Log 

for BioCAD 700E System Serial Number ____________
Record the date and your initials when you perform maintenance procedures.

Daily Jan Feb Mar Apr May June July Aug Sept Oct Nov Dec

Flush system with 

SYSCLEAN.MET

Calibrate pH 

probe and 

conductivity 

monitor 

(If operating under 

GLP)

Weekly

Change pump 

seal wash solution

Calibrate pH 

probe

Calibrate 

conductivity 

monitor

Back up data

Run SCANDISK

Continued



Monthly Jan Feb Mar Apr May June July Aug Sept Oct Nov Dec

Clean fan filter

Clean pH probe

Clean pump 

filter/mixer frit

Run DEFRAG

6 Months Jan Feb Mar Apr May June July Aug Sept Oct Nov Dec

Replace pump 

seals, clean 

pistons, clean 

pump heads

Clean check 

valves

Clean UV/Vis 

detector flow cell

Clean 

fluorescence flow 

cell (See 

Fluorescence 

Detectors Manual)

Inspect autoloader 

syringe seal

Clean injection 

and column 

switching valve 

stators
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H  Autoloader 
Flow Path

This appendix includes diagrams of the flow path of the 

autoloader during the following operations:

• Priming and Flushing

• Filling the sample loop with buffer

• Loading the sample loop with sample

• Injecting sample (emptying the sample loop)

NOTE: For information on making autoloader injections, 
see Section 5.3, Making Injections From the Control Panel.
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H.1  Priming and Flushing

Figure H-1 illustrates the autoloader flow path when priming 

and flushing the sample lines.

Figure H-1  Autoloader Flow Path 

When Priming and Flushing Sample Lines

To prime or flush the sample lines, select the appropriate 

command from the Sample menu in the Control Panel. For 

more information, see Section 3.4.3, Priming and Flushing 

the Autoloader Sample Lines.

During priming, the syringe withdraws and pulls sample 

through the line between the sample vial and the Injection 

valve.
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During flushing, the syringe withdraws a smaller volume of 

sample than priming. Flushing pulls a volume of sample 

sufficient to fill the line between the Sample valve and the 

Injection valve.

NOTE: If you prime only once using default volumes, 
sample does not enter the syringe. If you prime more than 
one time, or increase the prime volume, sample enters the 
syringe.
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H.2  Filling the
Sample Loop with Buffer

Figure H-2 illustrates the autoloader flow path when filling the 

sample loop with buffer.

Figure H-2  Autoloader Flow Path 

When Filling the Sample Loop With Buffer

To fill the sample loop with buffer, place the Injection valve in 

the Inject position while the pump is running.
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H.3  Loading the
Sample Loop with Sample

Figure H-3 illustrates the autoloader flow path when loading 

the sample loop with sample.

Figure H-3  Autoloader Flow Path 

When Loading the Sample Loop With Sample

NOTE: Figure H-3 is not drawn to scale. The actual sample 
loop path between port 5 and port 2 is shorter than it 
appears in the illustration. 

Load sample loop with sample
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To load the sample loop with sample, click the Load Loop 

button in the Control Panel. For more information, see 

Section 5.3.1, Making Autoloader Injections.

The Injection valve switches to the Load position. As the 

syringe withdraws, it pulls buffer out of the sample loop and 

into the syringe. The displaced buffer pulls sample into the 

sample loop.

NOTE: Sample does not enter the syringe, unless the 
injection volume exceeds the sample loop volume.
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H.4  Injecting Sample 
(Emptying the Sample Loop)

Figure H-4 illustrates the autoloader flow path when injecting 

sample (emptying the sample loop).

Figure H-4  Autoloader Flow Path When Injecting Sample 

(Emptying the Sample Loop)
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To inject sample (empty the sample loop):

• Prime or flush the sample line as described in 

Section H.1, Priming and Flushing

• Fill the sample loop as described in Section H.2, Filling 

the Sample Loop with Buffer

• Load the sample loop as described in Section H.3, 

Loading the Sample Loop with Sample

• With the pump running, click the Inject option button in 

the Sample section of the Control Panel. 

For more information, see Section 5.3.1, Making Autoloader 

Injections.

The Injection valve switches to the Inject position and places 

the sample loop in the fluid path. Buffer from the pump 

pushes the sample out of the sample loop and through the 

system. The switching valve on the autoloader syringe diverts 

buffer in the syringe to waste as the syringe plunger returns to 

the home position.
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Analysis—Integration, calibration, 

and reporting of data. In BioCAD, 

analysis is performed in the Group 

Analysis window and Data Analysis 

module.

Area percent—Percent of area 

value contributed by a given integrated 

peak, as compared to all integrated 

peaks in a chromatogram.

Asymmetry—Shape of a 

chromatographic peak. Peak 

asymmetry is a value you can export 

from the BioCAD software, and is 

described by B/A where B = RT at rear 

of peak at 10% of peak height and 

A = RT at front of peak at 10% of peak 

height.

AU—Absorbance unit, a measure of 

UV/Vis light absorbance.

.BIO or .B## file—Data file 

generated by BioCAD software. ## are 

sequential numbers generated with the 

auto file extension feature.

Blocks—Six types of operations 

which you can easily assemble to 

create a method. Blocks include: Prep, 

Equilibrate, Load, Wash, Elute, and 

Clean.

Bypass valve—A six-port 

selection valve that lets you bypass the 

conductivity and pH monitors so that 

output from the absorbance detector 

flows directly to the fraction collection 

valve.

Calibration curve—Plots peak 

area versus amounts of known pure 

standards. By comparing the peak area 

of unknowns to the curve, you can 

calculate amounts.

Calibration level— 

Concentration of each calibrated peak 

in calibration standards. 

Capacity factor - k’—
Chromatographic value that indicates 

the number of column volumes that a 

peak is retained.

.CFG file—BioCAD system 

configuration file, created in the 

Configuration dialog box.

CV—Column volumes.

Defragment—To eliminate 

non-contiguous disk space. Can 

improve computer performance.

Desktop—Screen background for 

windows. Windows, icons, and dialog 

boxes are displayed on the desktop.

Direct autoloader 
injection—Automatically injects 

from one sample vial with minimum 

sample loss. Effective range of injection 

is the same as the autoloader, but dead 

volume and priming volume are 

minimized.

Directory—Structure that 

organizes your files on disk. A directory 

can contain files or subdirectories.
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DOS prompt—Letter designation 

for the active drive. In the DOS window, 

the prompt appears at the left side of 

the computer screen and is followed by 

a colon.

.DRC file—BioCAD strip chart 

recorder file.

Eluent mode—BioCAD blend 

programming mode that allows you to 

specify an eluent concentration, and 

select a buffer and an eluent to 

accomplish the blend.

External detector—External 

detector controlled by the BioCAD 

software (UV Channel 2).

External Standard— 

Unknowns are compared to standards 

without correction. With external 

standard calibration, it is important that 

injection size is accurate and 

reproducible.

Flush—Automated action for the 

BioCAD autoloader. Flushes line 

between sample selection valve and 

injection valve.

.GMM file—BioCAD multi-method 

file.

.GRO file—BioCAD group file. A 

group file is a directory of files created 

using a multi-method or a template.

.G## file—Method file generated 

by BioCAD Multi-Method Editor. ## are 

sequential numbers that represent 

subsequent methods.

Group—In BioCAD software, a file 

that contains a directory of file names. A 

group is created automatically when you 

run a template or multi-method.

Group integration—
Integration in the BioCAD Data Analysis 

software, where all files are integrated 

with one set of analysis parameters.

Hardware key—Protection key 

required to run Supervisor stand-alone 

software option.

Height percent—Percent of 

height value contributed by a given 

integrated peak, as compared to all 

integrated peaks in a chromatogram.

Icon—Graphical representation of a 

program or window. When a window is 

minimized, it is reduced to an icon.

Individual integration—
Integration in the BioCAD Data Analysis 

software, where each file is integrated 

with its own set of analysis parameters.

Integration—Calculations that 

determine area or height of peak.

Internal dual 
wavelength—A model 205 

detector is installed in the workstation. 

The detector includes deuterium and 

tungsten lamps. Only one lamp is used 

at one time.
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Internal Standard—Samples 

(standards and unknowns) are spiked 

with a known amount of a known 

compound. When samples are run, 

areas are “corrected” using the internal 

standard. The internal standard 

technique corrects for errors in sample 

preparation and injection.

Linear velocity—Expression of 

flow rate in cm/hr, calculated as 

volumetric flow rate (ml/hr) divided by 

column cross-sectional area (cm2).

.MET file—Method file generated 

by BioCAD Method Editor. 

Method—Set of instructions 

BioCAD software needs to collect data. 

Includes blocks, segments, and events 

that control settings and operation of 

instruments.

Method configuration—
Configuration information stored with 

the method. You can think of this as the 

inactive configuration. Method 

configuration not used when you run a 

method unless you load the 

configuration before running.

MS-DOS®—Microsoft Disk 

Operating System.

Microsoft® Windows®—
Graphical user interface (GUI) in which 

the BioCAD software runs.

Multi-method—Feature in the 

Method Editor that allows you to create 

your own templates by:

• Making sequential modifications 

to the current method and saving 

them in a multi-method file 

• Linking a group of different 

methods together in a 

multi-method file

Path—Specifies location of a file in 

the directory. Example: the path for data 

files in the BioCAD software is 

C:\BIOCAD\DATA.

Peak width—Width of peak in 

minutes. In BioCAD, defined by the 

formula:

PEEK—Acronym for 

polyetheretherketone. Chemically inert, 

flexible polymer that can withstand high 

pressures and temperatures.

Percentage mode—BioCAD 

blend programming mode. Conventional 

% (v/v) technique used on most 

conventional HPLC instruments. Allows 

you to select a percentage of solvent 

and blend up to four of the six 

configured solvents.

Time

Peak
Width

Peak Area
Peak Height
__________= 1.6( )
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pH mode—BioCAD blend 

programming mode that uses two 

concentrated buffers at different pH 

values, water and a concentrated eluent 

such as salt. This mode is required for 

running pH maps.

When you use special PerSeptive pH 

buffers, the BioCAD software 

automatically calculates the required 

percentages needed to obtain the 

programmed pH buffer and eluent 

concentrations. 

When you use any other buffers, you 

regulate the proportions of the two 

buffers in the total blend.

Prime—Automated action for the 

BioCAD autoloader. Primes line 

between sample vessels, through 

sample selection valve, to injection 

valve.

POROS® media—Patented 

media that contains two types of pores: 

throughpores (allow convective flow 

through the particle) and diffusive pores 

(provide high surface area).

Perfusion 
Chromatography®—
Flow-through particle chromatography 

that uses POROS® columns and 

media. Patented technology that takes 

advantage of convective and diffusive 

flow. Overcomes the speed limitations 

of standard LC and HPLC.

Plate count—Measure of column 

efficiency.

Purge—Automated BioCAD feature 

that allows you to run the system at high 

flow rates for efficient solvent 

changeover. Purge:

• Switches the columns out of line

• Changes the blend to the new value

• Increases the flow rate

• Runs for a set duration

Quantitation—Calculation of 

amounts for unknowns by comparing to 

a calibration curve.

RAM—Random access memory.

Response—Quantitative value of 

a detector output, often 

chromatographically measured in peak 

height or area.

Response Factor—
Measurement of detector response to a 

specific compound. Ideally follows a 

linear curve.

Segments—Actions within each 

method block. Segments include: Step, 

Gradient, Inject, Autosampler Inject, 

Purge, Dilute, Combine, and Heat/Mix.

Supervisor ™ software—A 

stand-alone version of the BioCAD 

software, designed to run on a 

computer without a BioCAD 

workstation. The Supervisor software 

option contains all software modules 

except the Control Panel, and lets you 

create and edit methods and 

configurations, and analyze data.
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System configuration—
Information currently set in the 

Configuration dialog box (accessed 

from the Control Panel). System 

configuration is used when you run the 

BioCAD workstation. You can think of 

this as the active configuration.

Systematic methods 
development—Using the 

BioCAD workstation and POROS 

columns and media, methods 

development in which key variables are 

identified, then systematically evaluated 

and optimized.

Template—A predefined program 

that is set up to perform a sequence of 

runs in which one or more variables 

change from run to run. BioCAD 

templates include:

• pH Map—Changes pH

• Loading Study—Changes 

injection volume

• Linear Gradient—Changes 

gradient slope

• Flow Rate Study—Changes flow 

rate

• Auto Cycling—Runs the method 

multiple times

• Column Switching—Changes 

columns

• Analysis—Changes the sample 

that is injected and the number of 

injections

• Step Optimization—Changes 

blending conditions for column 

equilibration and step elution

• Combinatorial Optimization—

Changes up to six parameters

Window—Area on the desktop in 

which a software application (for 

example, the BioCAD software) runs.
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Numerics/Symbols
1 V signal 2-23

10 mV signal 2-23

- minus sign in method 6-7, 6-33

* asterisk in method 5-3, 6-7, 6-9, 6-33, 

6-34, 6-87

+ plus sign in method 5-3, 6-7, 6-9, 

6-33, 6-34, 6-87

A
Abbreviations, parameters 8-3

Abort button 5-33, 6-93, 8-3

Aborting a method 5-33, 6-89, 8-3

Accessories, connecting 2-13, E-1

Acquisition data rate

guidelines 4-18

minimum number of points 4-18

setting 4-18

AFFSTD.MET D-3

Air, see Gas supply

Analysis template

applications 7-21

creating 7-24

direct wire autosampler 7-28

example method 7-26

how system selects vial 7-25

insufficient injection volume 7-25

integrated autosampler 7-21

method requirements 7-23

overview 7-21

running 7-24

system requirements 7-23

using Combine segments 7-23

Analytical flow cell 4-13, A-5

Analyze after run 6-71

Anion buffers (pH blending) 3-21

Anion exchange method D-13

ANIONPH.MET D-13

ANIONSTD.MET D-9

Applied Biosystems

world wide web address xxvii

Archiving 9-49

AS 3500 autosampler

see also Autosampler, direct wire

see also Autosampler, integrated

adjusting the needle height 9-42

cleaning and replacing needle 9-38

cleaning rails and rollers 9-46

cleaning tray area 9-45

configuring 2-32

maintenance 9-38

needle height, adjusting 9-42

troubleshooting 10-20

Auto Cycling template 7-19

Auto file extension 6-68, 7-4, 7-47

Autoloader

changing syringe or sample 

loop 3-13, 4-8

configuring 4-7

controlling from Control 

Panel 5-36, 5-38, 5-40

description 1-12

error codes 10-48

flowpath during priming and 

flushing H-2

flowpath when injecting sample 

loop (emptying sample 

loop) H-7

flowpath when loading sample loop 

with buffer H-4
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Autoloader (continued)

flowpath when loading sample loop 

with sample H-5

flush volume, setting 4-9

flushing from Control Panel 3-36, 

H-2

flushing in method 6-29

injection types that use 4-7

injections 1-13, 3-23, 3-24, 5-36, 

6-77, H-5, H-7

maintenance 9-34

method events 6-42

preparing samples for 3-23, 3-24

prime volume, setting 4-9

priming 3-34, H-2

sample does not enter syringe H-3, 

H-6

Autoname

batch-entering vials 4-50

check box 4-51

maximum number of samples 4-50

suffix 4-50

using 4-50

Autosampler connector, pin 

assignments 2-22, E-1

Autosampler Inject segment

adding to method 6-30

button not available 6-30

creating 6-30

description 6-5

how system selects vial 6-32, 7-3

insufficient injection volume 6-32, 

7-3

Autosampler, direct wire

Analysis template 7-28

configuring 2-32, 4-53

connecting 2-21

connector pin assignments 2-22

controlling from Control Panel 5-52

empty vials needed 3-54

error codes 10-48

filtering solvents 3-48

flush line 3-48

gas supply, connecting 3-48

injections 1-13, 5-51, 6-44, 6-83

method event needed to make 

injection 6-44, 6-83

method events 6-44

method segment needed to make 

injection 6-20, 6-83

options 3-45

pin assignments 2-22

plumbing injector valve 3-46

preparing 3-43 to 3-58

preparing sample vials 3-51

preparing solvents 3-48

priming 3-49

programming front panel 3-56

setting mode 3-44

setting up 3-44

solvent lines 3-48

solvents, preparing 3-48

Stand Alone mode 3-44

timeout 4-55

trays, installing 3-55

vial loading 3-53

vial numbers 4-56

vial requirements 3-51

vial septa 3-51
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when to power up 2-22, 2-37, 4-53

Autosampler, integrated

Analysis template 7-21

clearing vials 4-52

combining samples 6-61

configuring 2-32, 4-36

connecting 2-21

controlling from Control Panel 5-46

determining if sample prep/cooling 

supported 2-32, 3-45, 3-57

diluting samples 6-57

displaying temperature 5-50

empty vials needed 3-54

error codes 10-48

filtering solvents 3-48

flush line 3-48

flush solvent 3-48, 4-40

flush volume 4-40

flushing from Sample Table 5-47

flushing in method 6-32

full loop injection 4-38, F-2

gas supply, connecting 3-48

how system selects vial 5-48, 6-32, 

7-3, 7-25

injection ranges 4-38

injection types 4-38, F-1

injections 1-13, 5-46, 6-43, 6-82

injector valve 3-46, 5-48

insufficient injection volume 5-48, 

6-32, 7-3, 7-25

method events 6-43

method segment needed to make 

injection 6-30, 6-82

mode, setting 3-44

needle height, adjusting 9-42

options 3-45

partial loop injections 4-38, F-2

plumbing injector valve 3-46

preparing 3-43 to 3-58

preparing sample vials 3-51

prime volume 4-40

priming 3-49

pull loop injection 4-38, F-2

PushLoop injection 4-38, F-2

sample cooling 4-43, 5-50

sample heating 4-42, 5-50, 6-64

sample loop 3-47, 4-40, 5-49

sample mixing 6-32, 6-64

Sample Prep button not displayed 

in Config 4-42

sample prep, configuring 4-42

samples, preparing 3-51, 6-53

setting up 3-44

software version 3-44, 3-45, 4-36

solvent lines 3-48

solvents, configuring 4-43

solvents, preparing 3-48

SpectraNet mode 3-44

temperature 4-42, 4-43, 5-50

trays, installing 3-55

troubleshooting 10-20

turning heating/cooling on and 

off 4-42, 4-43, 5-50

vial clearing 4-52

vial loading 3-53

vial numbers 4-56

vial requirements 3-51

vial septa 3-51

when to power up 2-21, 2-37, 4-36

Autozero

fluorescence detector 6-40

UV/Vis detector 6-38

Auxiliary connector, pin 

assignments 2-20, 5-32, E-1

Auxiliary detector, see Detector, 

auxiliary

Auxiliary outputs 5-31
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B
B## files, see Data files (.BIO)

Backflushing columns 1-15, 5-19, 6-36

Backing up data 9-48

Base name and suffix

adding to Sample Library 4-52

autonaming vials 4-50

Baseline noise 2-15, 2-17, 3-5, 9-15, 

10-9

Batch-entering vials 4-50

Beep, setting system to 6-45

Bench space required 2-3

BIO files, see Data files (.BIO)

Blend graph

annotations 6-52

customizing 6-51

setup 6-51

using 6-51

Blend modes

eluent 5-9, 5-10

percentage 5-9, 5-10

pH 5-9, 5-11

Blending

buffers/solvents 3-18

error codes 10-41

from Control Panel 5-8

from method 6-21, 6-24, 6-26

Step Optimization template 7-30

Block view of method 6-8

Blocks, method

allowable segments 6-6

Clean 6-4

copying 6-88

creating 6-18

deleting 6-87

description 6-4

editing 6-87

Elute 6-4

ending before duration 6-22

Equilibrate 6-4

Load 6-4

moving 6-88

overriding Clean block 7-20

Prep 6-4, 6-53

typical method 6-73

viewing 6-8

Wash 6-4

Buffer duration

and data rates 4-18

Strip Chart Recorder 4-16

Buffer/Solvent Library

autosampler solvent 4-43

calibrated buffers in 5-26, 5-30

configuring buffers/solvents 4-6

creating and editing channels 4-26

customizing 4-25

flush reagent 4-40

types of buffers 4-28



BioCAD ® 700E Workstation User’s Guide Index-5

I

D
E
X

N

Buffers/solvents

anion (pH blending) 3-21

autosampler 3-48

blending from Control Panel 5-8

calibrated pH blend 3-20

calibrating for pH blend mode 5-26

cation (pH blending) 3-21

changing library 4-25

configuring 4-6

connecting 2-9

custom pH blend 3-20

filtering 3-18

incompatible solvents 2-9, 3-17

maximum for blending 3-18

maximum number allowed 3-18

monitoring composition 1-17

organic 3-17

pH mapping 3-20

preparing 3-17 to 3-22

priming 3-30, 3-37

reservoir location 3-18

sparging 3-18

type Buffer 4-28

type Eluent 4-28

type H2O 4-28

type None 4-28

type Sample 4-28

uncalibrated pH blend 3-20

unused lines 2-9, 3-18

venting 2-10

Bypass option button (columns) 5-18

Bypass option button (pH and 

conductivity) 5-22, 6-17

Bypass valve 1-17

Bypassing

columns 1-15, 5-19

pH and conductivity monitor 5-22, 

6-17

C
C (Control) vial type 4-48

CAL files 1-34

Calibrated pH buffers

calibration procedure 5-26

description 3-20

in Buffer/Solvent Library 5-30

using in pH mode 5-12

Calibrating

see also Data Analysis User’s 
Guide

conductivity monitor 9-21

pH mode buffers 5-26

pH probe 9-19

Calibration curve

see also Data Analysis User’s 
Guide

fit, see Calibration fit

pH mode buffers 5-26

Calibration fit, pH mode 

calibration 5-30

Carryover, minimizing 4-10

Cation buffers (pH blending) 3-21

Cation exchange method D-16

CATIONSD.MET D-11

CATPH.MET D-16

CD ROM drive

connecting 2-26

installing software if you do not 

have 2-30

Centimeters/hour 5-14

CFG files, see Configuration files 

(.CFG)

Chart mark 1-9, 5-22, 6-39, 6-40

Chart Range 8-10

Check boxes 1-39
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Check valves, cleaning 9-30

Chromatograms, printing 6-69

Chromatography

conventional 1-5, 4-18

Perfusion, see Perfusion 

Chromatography

preparative 7-19

variables affecting 1-5

Clean block

allowable segments 6-6

creating 6-18

description 6-4

overriding 7-20

Closing

BioCAD software 2-36

Microsoft Windows 2-36

window 1-38

cm/hr 5-14

Cold room operation 2-6

Column

backflushing 1-15, 5-19, 6-36

bypassing 5-19, 6-25, 6-36

changing configuration in 

method 6-36

configuring 4-11

connecting 3-9

connecting fittings 3-6

controlling from Control Panel 5-18

Direct Control configuration 3-12

Low Dispersion configuration 3-11

method events 6-36

part number 4-33

plumbing diagram 3-9, 3-10, 3-12

pressure limit, setting 4-34

putting inline 5-19, 6-25, 6-36

regenerating 1-15, 5-19, 6-4, 6-27, 

7-20

Single Column configuration 3-10

Tandem configuration 3-10

Three Column configuration 3-11

washing 1-15, 5-19

Column Editor dialog box 4-33

Column Library

configuring columns 4-12

customizing 4-32

Column Switching template 7-2

Column switching valves

description 1-14

illustration 1-14

maintenance 9-37

plumbing 3-2

Column volumes (CV)

listed as zero in method 6-10

not available for programming 4-33

programming method in 6-10, 6-21

units not available 6-10

Column volumes/minute 5-14

Combinatorial Optimization dialog 

box 7-36

Combinatorial Optimization template

creating and running 7-36

description 7-34

method requirements 7-35

parameters 7-38

system requirements 7-35

viewing results 7-21

Combine segment

adding to method 6-61

button not available 6-61

description 6-61

using with Analysis template 7-23

Combine Segment Setup dialog 

box 6-61

Command buttons 1-39

Component name of sample, entering 

in Sample Library 4-31, 4-52

Compressed air, see Gas supply
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Computer

configuration requirement C-1

defragmenting hard disk 9-51

disk space, see Disk space

error codes 10-37

maintenance 9-47

memory 1-20, 4-16, 8-17, 10-43

overview of components 1-20

technical support for altered 

configuration C-1

troubleshooting 10-36

Concentration

eluent 5-11, 7-32

entering component 4-31

Concentration of sample, entering in 

Sample Library 4-31, 4-52

Conductivity

of NaCl 9-22

of water 9-22

Conductivity monitor

and organic solvents 6-17

bypassing 1-17, 5-22, 6-17, 6-37

calibrating 9-21

collecting signal 4-16

configuring 4-16

displaying signal 8-5

displaying temperature 8-5

enabling data channel 4-17

troubleshooting 10-11

Configuration

aborting method when changing or 

loading 4-3, 6-89

causes of mismatch 6-84

checking before creating a 

method 6-13

clearing vials from 4-52

creating 4-4

definition 4-2

diagrams 3-9, 5-19

difference between system and 

method 4-3

Configuration (continued)

Edit Config, when to use 6-14

error codes 10-45

loading from configuration file 4-22

loading from data file 4-23

loading from method file 4-23

method 4-3

mismatch 6-84

saving Sample Table settings 

in 4-52

system 4-3

Update Config, when to use 6-14

used during method run 4-3

Configuration dialog box 4-4

Configuration files (.CFG)

changing in method 6-14

creating 4-4

default directory 1-34

loading from configuration file 4-22, 

6-89

loading from data file 4-23, 6-89

loading from method file 4-23, 6-89

location 1-30

printing 4-21, 6-69

saving 4-20

Configuration libraries

Buffer/solvent 4-25

Column 4-32

customizing 4-24 to 4-34

Sample 4-29, 4-44

Configuring 4-2 to 4-19

AS 3500 autosampler 2-32

autosampler 2-32, 4-36, 4-53

autosampler solvents 4-43

buffers/solvents 4-6

column pressure limits 4-34

columns and plumbing 4-11

data channels 4-16

data rates 4-18

delay volumes 4-13

detectors 4-15
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Configuring (continued)

direct wire autosampler 2-32, 4-53

external detector 2-31

flow cell of detector 4-13

flush volume 4-10

fraction collector 4-35

injection type 4-38

integrated autosampler 2-32, 4-36

method 6-14

pressure limits 4-5, 4-34

prime volume 4-10

pump 4-5

recorder setup 4-16

sample loop size 4-8

Sample Prep button not 

displayed 4-42

sample preparation 4-42

sample vials in Sample Table 4-46

SCOUT Column Selector 2-32

syringe size 4-8

Connecting

accessories 2-13, E-1

autosampler 2-21

auxiliary detector 2-16

buffer/solvent bottles 2-9

CD ROM drive 2-26

columns 3-9

compressed gas 2-7

direct wire autosampler 2-21

external detector 2-14

external hard drive 2-26

external instruments E-1

fittings 3-4

fraction collector 2-18

gas 2-7

helium supply line 2-8

integrated autosampler 2-21

integrator 2-23

Iomega Zip drive 2-26

keyboard 2-24

monitor 2-24

mouse 2-24

network 2-25

Connecting (continued)

peripheral devices 2-26

printer 2-25

printer with hardware key 2-33

SCOUT Column Selector 2-23

sparge element 2-11

sparge lines 2-10

Strip Chart Recorder 2-23

tubing 3-9

waste lines 2-12

Connector, pin assignments 2-19, 2-20, 

2-22, 5-32, E-1

Control Panel

adding events to method 5-3

blending 5-8

changing column 

configuration 5-18

changing flow rate 5-13

changing sample loop 5-4

changing syringe 5-4

changing wavelength 5-20

collecting fractions 5-23, 5-43

detectors 5-20

displaying 5-2

event out 5-31

making injections from 5-34 to 5-52

purging 5-15

running gradient from 5-24

starting pump 5-13

troubleshooting 10-12, 10-15

using 5-2 to 5-52

Conventions xxiv

Cooling samples

determining if autosampler 

supports 3-45, 3-57

displaying temperature 5-50

setting temperature 4-43, 5-50

turning on and off 4-43, 5-50

Customer support 10-2

CUSTOMPH.MET D-19

CV, see Column volumes (CV)

CV/min 5-14
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D
D (Derived) vial type

changing to Sample vial type 6-54

creating 6-54

not available 4-48, 6-31

Damage, reporting C-4

Data Analysis software

see also Data Analysis User’s 
Guide

overview 1-29

Data channels

configuring 4-16

enabling 4-17

Data collection

default starting point in 

method 6-45

method event 6-45

setting rate 4-18

starting and stopping 6-45

starting when injection is 

complete 6-45

without Inject segment 6-20

Data files (.BIO)

see also File

default directory 1-34

error codes 8-18, 8-19

Event log 8-18, 8-19

in Method Queue 8-2

in method runs 6-68, 7-4, 7-47

in multi-methods 7-47

in templates 7-4

location 1-30

maximum number with auto file 

extension 6-68, 7-4, 7-47

naming 6-67, 6-68

overwriting 6-68

saving from Strip Chart 

Recorder 8-13

setting directory 6-67, 7-46

Data rate

guidelines 4-18

minimum 4-18

setting 4-18

Data storage, setting 6-67, 7-46

DCT files 1-34

Dead volume

eliminating 3-52, 4-39, 4-41

Micro vial 3-51

Micro vial inserts 3-52

Micro vial shape 4-39

Standard vial 3-51

Std 1800 µl vial shape 4-39

Std 2000 µl vial shape 4-39

Unspecified vial shape 4-39

Dead volume, see Delay volume

Default vial shape, setting 4-39

Defragmenting disk 9-51

Degassing solvents 3-18

Delay time in Step segments 6-22

Delay volume

configuring 4-14

minimizing 1-15, 5-19

when to set 4-13, 4-14

Derived vial type, see D (Derived) vial 

type

Detector

see also conductivity monitor

see also Detector, auxiliary

see also Detector, fluorescence

see also Detector, UV/Vis

see also pH monitor

bypassing 5-22, 6-17

error codes 10-56

Detector bypass valve 1-16
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Detector, auxiliary

collecting signal 4-16

configuring 4-16, 4-18

connecting 2-16

enabling data channel 4-17

flow cell, plumbing 2-17

flow cell, preventing air 

bubbles 2-17

monitoring in Status window 8-5

optional 1-18

Detector, fluorescence

autozeroing 6-40

changing wavelength 6-40

chart mark 5-22

collecting signal 4-16

configuring 4-15, 4-16

connecting external 2-14

controlling from Control Panel 5-22

data rates 4-18

enabling data channel 4-17

flow cell, plumbing 2-15

flow cell, preventing air 

bubbles 2-15

maintenance 9-4

method events 6-40

optional 1-18

turning lamp on and off in 

method 6-40

wavelengths 5-22, 6-40

zeroing from Control Panel 5-22

zeroing in the method 6-40

Detector, UV/Vis

autozeroing 6-38

changing flow cell 9-13

changing lamp 9-8

changing wavelength 5-20, 6-38

chart mark 5-22

collecting signal 4-16

configuring 4-15, 4-16

configuring flow cell 4-13

connecting external 2-14

controlling from Control Panel 5-20

data rates 4-18

Detector, UV/Vis (continued)

deuterium and tungsten 

lamps 5-20, 6-39, 9-8

dual wavelength automatically 

setting to single 

wavelength 5-21, 6-16, 

6-38, 10-11

dual wavelength not available 4-15

enabling data channel 4-17

enabling dual-wavelength 

option 4-15

flow cell volumes 4-13

flow cell, changing 9-13

flow cell, cleaning 9-12

flow cell, plumbing 2-15

flow cell, preventing air 

bubbles 2-15

lamps, replacing 9-8

maintenance 9-4, 9-8

maximum flow rates for cells 4-13

method events 6-37, 6-38

monitoring in Status window 8-5

overview 1-16

path length 4-13

resetting to single 

wavelength 5-21, 6-16, 

6-38, 10-11

single and dual wavelength 

options 1-17, 4-15

turning lamp on and off in 

method 6-39

turning off lamp 1-9

wavelengths 5-20, 6-38

zeroing from Control Panel 5-22

zeroing in the method 6-39

Deuterium lamp

changing 9-8

turning off in method 6-39

wavelength range 1-17, 5-20

Dialog box, using 1-39

Diluent, in Sample Editor 4-31
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Dilute segment

adding to method 6-57

button not available 6-58

description 6-57

Dilute Segment Setup dialog box 6-58

Direct autoloader injections 1-13, 3-25, 

5-38, 6-78

Direct Control

configuration 3-12

description 1-15, 5-19

limitations 3-31, 3-33, 3-37, 5-15, 

9-52

Direct wire autosampler, see 

Autosampler, direct wire

Directories

BioCAD 1-33

changing 1-44

creating 1-35, 6-68

Disk space

defragmenting 9-51

error code 8-17

MB/hr used 9-48

required to install software 2-27

required to run software 9-48, 

10-44

total available 1-20

warning on startup 2-34

Doors, opening BioCAD 1-8

DRC file 1-30, 1-34, 9-51

Dual UV/Vis

automatically changes to 

single 5-21, 6-16, 6-38, 

10-11

Dual UV/Vis operation

not available 4-15

Dwell volume, see Delay volume

E
E (Empty) vial type

description 4-48

not available 4-48

Edit Config, when to use 6-14

Eluent concentration

optimizing 7-30

range 5-11, 7-32

Eluent mode

definition 5-9

setting 5-10

Elute block

allowable segments 6-6

creating 6-18

description 6-4

Elution conditions, optimizing 7-30

Elution, reversed 1-15, 5-19

E-mail address, Technical 

Publications xxvii

Emission wavelength

changing in method 6-40

range 5-22

setting on Control Panel 5-22

Empty vial type, see E (Empty) vial type

Equilibrate block

allowable segments 6-6

creating 6-18, 6-74

description 6-4

Error codes

autoloader 10-48

autosampler 10-48

blend 10-41

COM port 10-68

communication 10-66

configuration 10-45

description of icons in Event 

log 8-17
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Error codes (continued)

detector 10-56

Event Log 10-37

file 10-38

hardware 10-42

memory 10-43

method 10-60

program loading 10-65

resource 10-43

Sample Loader 10-48

Sample Table 10-50

Supervisor software option 10-64

syringe pump 10-53

Errors

data file 8-18

method 8-18

types of 8-17

Event in, setting in method 6-46, 6-50

Event log

clearing 8-20

description of icons 8-17

displaying 8-16, 8-18, 8-19

error codes 10-37

filtering events 8-17

printing 6-69, 8-20

searching 8-18

types of errors 8-17

using 8-15

Event mark 1-9

Event out

setting in method 6-46

setting manually 5-31

Events

external, see Event out

method, see Method events

EVL files 1-30, 1-34

Excitation wavelength

changing in method 6-40

range 5-22

setting on Control Panel 5-22

Exiting

BioCAD software 2-36

Microsoft Windows 2-36

External detector, configuring 2-31

EZ Grip fittings, connecting 3-6

F
Fan, cleaning the filter 9-7

Ferrules, installing 3-5

File

contents 1-30

directories 1-33

error codes 10-38

maintenance 9-47

management 1-33

opening 1-42

path 6-68

saving data from Strip Chart 

Recorder 8-13

selecting different types 1-43, 1-45

types 1-30

viewing by date 9-47

File name

auto extension 6-68, 7-4, 7-47

conventions for 1-43

maximum length 1-43, 7-46

multi-method 7-47

template 7-4

Filter, inline 1-10

Filter/mixer frit, pump 9-33

Filtering

autosampler solvents 3-48

buffers/solvents 3-18

samples 3-23, 3-24, 3-25, 3-26, 

3-27, 3-53

Final vial, Prep block 6-56
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Fittings

column 3-6

EZ Grip 3-6

location of fitting types 3-4

plastic 3-7

RheFlex 3-5

stainless/PEEK 3-6

Flow

reversing 1-15, 5-19, 6-36

stopping 5-33, 6-35, 6-93, 8-3

Flow cell

changing 9-13

cleaning 9-12

configuring 4-13

flow direction requirements 2-15, 

2-17, 3-5, 9-15

maximum flow rates for 4-13

path length 4-13

plumbing 2-15, 2-17, 3-5, 9-15

volumes 4-13

Flow path

autoloader diagram H-1

system diagram 3-4

Flow rate

and tubing size 3-3

changing 5-13

in Status window 8-5

limits 4-13, 5-13

maximums for UV/Vis detector flow 

cells 4-13

minimum and maximum 4-13, 5-13

pressure limits for 4-5

programming in different units 5-14

setting 5-13, 6-16, 6-35

Flow Rate Study template

and added events 7-19

description 7-18

Fluorescence detector, see Detector, 

fluorescence

Flush

autoloader from Control 

Panel 3-34, H-2

autoloader in method 6-29

diagram of lines 3-34, 4-10

in Gradient segment of 

method 6-29

line, autosampler 3-48

loader in method 6-29

method event 6-42

setting default volume 4-9, 4-10

solvent, integrated 

autosampler 3-48, 4-40

volume, autoloader 4-9

volume, integrated 

autosampler 4-40

Flushing, integrated autosampler

from Sample Table 5-47

in method 6-32

selecting solvent 3-48, 4-40

setting volume 4-40

Fraction collector

advancing 5-45, 6-41

bottle position 0 3-42

configuring 4-35

connecting 2-18

controlling from Control Panel 5-43

controlling from method 6-41

delay volume 4-13, 4-14

features 3-39

installing rack 3-39

method events 6-41

mode for Gilson 3-40

optional racks 3-39

pin assignments 2-19

pooling 5-45, 6-41, 7-20

preparing 3-39 to 3-42

programming 3-40

reset 5-45, 6-41

setting delay volume 4-13, 4-14

troubleshooting 10-18, 10-20
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Fraction collector connector, pin 

assignments 2-19, E-1

Fraction/waste valve

controlling from Control Panel 5-23

controlling from method 6-41

description 1-19

method event 6-41

waste line 2-12

Fractions

collecting 1-19

collecting single 5-23

marks on Strip Chart Recorder 8-8

pooling 5-45, 6-41, 7-20

Freezing temperatures, preventing 

damage 2-2

Front panel

description 1-9

opening 1-8

Full loop injection

description 4-38, F-2

injection range 4-38

integrated autosampler 4-38

plumbing 3-47

volume drawn 4-38

when to use 4-38

Fuse

rating 2-6, 9-6

replacing main power 9-5

G
G## files

creating 7-42

default directory 1-34

description 1-30

location 1-30

opening in Method Editor 6-84

Gas supply, autosampler 3-48

Gas supply, workstation

connecting 2-7

pressure 2-4

General Settings

changing later in a method 6-15

dialog box 6-15

in method 6-15

GMM files, see Multi-method files 

(.GMM)

Gradient

creating in method 6-23, 6-76

holding 6-23, 6-76

running from Control Panel 5-24

template 7-16

Gradient segment

creating 6-23

description 6-5

GRO files, see Group files (.GRO)

Group files (.GRO)

in Method Queue 8-2

in multi-methods 7-47

in templates 7-4

location 1-30

H
Hard disk drive

backing up 9-48

defragmenting 9-51

disk space needed to run 

software 10-44

error code 8-17

external, connecting 2-26

free space warning 2-34

optimizing 9-51

size 1-20

testing disk integrity 9-50

Hardware

error codes 10-42

errors in Event log 8-17

installing hardware key 2-33

system 1-20

updating setup 2-31
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Hardware key

error codes 10-64

installing 2-33

Heat/Mix segment

adding 6-64

button not available 6-65

description 6-64

Heat/Mix Segment Setup dialog 

box 6-65

Heating samples

displaying temperature 5-50

recommended vials 3-51, 6-64

setting temperature 4-42, 5-50

turning on and off 5-50

Helium, see Sparge panel

Help line 10-2

HICSTD.MET D-5

Hints

adding event to end of 

segment 6-34

changing segment names 6-74

changing solvents 3-30

Combinatorial Optimization 

template 7-37

displaying plumbing diagrams 3-9

entering 100% for blends 5-24

entering vials in Sample Table 4-50

finding hidden windows 1-37

injecting through the pump 3-27

installing autosampler trays 3-55

making large injections without 

changing loop 6-27

mixing after sample prep 6-60, 

6-63, 6-64

mixing without heating 6-66

organizing data 6-68

priming autoloader lines 3-35, 3-36

programming the autosampler 3-56

sample prep accuracy 6-63

turning off detector at end of 

day 6-39, 6-40

History mode, Strip Chart Recorder 8-8

Hold

button 5-33, 6-93

gradient 6-23, 6-76

method 5-33, 6-93

method event 6-45

Holdup volume, see Delay volume

Hotline, help 10-2

How to use this guide xxi

I
Incompatible solvents 2-9, 3-17, 6-17

Incubating samples 4-42, 5-50

INJ 8-8

Inject segment

creating 6-27

description 6-5

Inject Segment Setup dialog box 6-30

Injection modes

overview 1-13

volume ranges 1-13, 4-38

Injection valve

description 1-14

illustration 1-14

maintenance 9-37

Injection volume, considerations 1-13, 

3-13, 5-4, 5-34

Injections

see also Injection modes

autoloader 1-13, 3-23, 3-24, 5-36, 

6-77, H-5, H-7

Autosampler Inject segment 6-30

direct autoloader 1-13, 3-25, 5-38, 

6-78

direct wire autosampler 1-13, 5-51, 

6-20, 6-83

greater than 5 ml 6-27

Inject segment 6-27

integrated autosampler 1-13, 5-46, 

6-30, 6-82

making from Control Panel 5-34
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Injections (continued)

manual 1-13, 3-26, 5-40, 6-28, 6-79

method events 6-42

multiple 6-27

overview 1-12

pump 1-13, 3-27, 5-42, 6-20, 6-80

Step segment 6-20

Injections, integrated autosampler

allowable volumes 4-38, 6-31

dead volume, eliminating 3-52, 

4-39, 4-41

fixed volume 4-38

full loop 4-38, F-2

high precision F-2

how system selects vial 5-48, 6-32, 

7-3, 7-25

injection ranges 1-13, 4-38, 6-31

insufficient injection volume 5-48, 

6-32, 7-3, 7-25

large 4-38, 6-31

low volume F-2

partial loop 4-38, F-2

pull loop 4-38, F-2

PushLoop 4-38, F-2

types of 4-38, F-1

variable volume 4-38

volume considerations 6-31

volume ranges 1-13, 4-38

Injector valve, integrated autosampler

inject position 5-48, 6-43

load position 5-48, 6-43

plumbing 3-46

Inline filter recommendation 1-10

Inserts, see Micro vial inserts

Installing 2-1 to 2-41

autosampler 2-21

autosampler trays 3-55

auxiliary detector 2-16

bench space required 2-3

BioCAD software 2-27

columns and tubing 3-9

compressed gas 2-7

connecting to network 2-25

external detector 2-14

fittings 3-4

fraction collector 2-18

gas 2-7

initial 2-2

integrator 2-23

keyboard 2-24

monitor 2-24

mouse 2-24

power requirements 2-4

printer 2-25

software 2-27

software if you do not have CD 

ROM drive 2-30

Strip Chart Recorder 2-23

waste lines 2-12

Integrated autosampler, see 

Autosampler, integrated

Integrating

see Data Analysis User’s Guide
Integration

see also Data Analysis User’s 
Guide

minimum number points per 

peak 4-18

Integrator

connecting 2-23

signal 2-23

Intermediate vials, Prep block 6-56

Iomega Zip drive 2-26
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K
Keyboard shortcuts 1-40

Keyboard, connecting 2-24

L
Label, in Method Queue 8-2

Lamp, fluorescence

turning off and on from Control 

Panel 5-22

turning off and on in method 6-40

Lamp, UV/Vis

changing 9-8

low energy error message 10-56

turning off and on from Control 

Panel 5-20

turning off and on from front 

panel 1-9

turning off and on in method 6-39

warmup period 9-11

Library

Buffer/Solvent 4-25

Column 4-32

Sample 4-29, 4-44

Linear Gradient template 7-16

Linear velocity 5-14

Load block

allowable segments 6-6

creating 6-18

description 6-4

including Data Collection 

event 6-20

Load Loop button 5-36, 5-39

Loading conditions, optimizing 7-30

Loading Study template

description 7-14

Inject segment used 7-14

Log sheet, maintenance 3

Loop, integrated autosampler 4-40

Loop, see Sample loop

Low Dispersion

configuration 3-11

description 1-15, 5-19

limitations 3-33

M
Maintenance

autoloader 9-34

autosampler 9-38

checklist 9-3

column switching valves 9-37

daily shutdown 2-38

fan filter 9-7

filter/mixer frit 9-33

fluorescence detector 9-4

fuse replacement 9-5

general 9-5

hard disk 9-47

injection valve 9-37

log sheet 3

long term shutdown 2-40, 9-52

needle height, autosampler 9-42

pH and conductivity monitors 9-16

preventative 9-3

pump 9-23

schedule 9-3

scheduled visits, purchasing 9-2

UV/Vis detector 9-4, 9-8

Make Dir button 6-68
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Making injections

autoloader 3-23, 3-24, 5-36, 6-77, 

H-5, H-7

autosampler 5-46, 5-51, 6-20, 6-30

direct autoloader 3-25, 5-38, 6-78

from Control Panel 5-34

greater than 5 ml 6-27

Inject segment 6-27

manual 3-26, 5-40, 6-28, 6-79

method events 6-42

multiple 6-27

overview 1-12

procedure 6-77, 6-78, 6-79, 6-80, 

6-82, 6-83

pump 3-27, 5-42, 6-80

Step segment 6-20

Making injections, integrated 

autosampler

allowable volumes 4-38, 6-31

fixed volume 4-38

full loop 4-38, F-2

high precision F-2

injection ranges 4-38, 6-31

large 4-38, 6-31

low volume F-2

partial loop 4-38, F-2

procedure 5-46

pull loop 4-38, F-2

PushLoop 4-38, F-2

types 4-38, F-1

variable volume 4-38

volume considerations 6-31

Manual injections 1-13, 3-26, 5-40, 

6-28, 6-79

Map, see pH mapping

Memory

computer 1-20, 4-16, 10-43

error code 8-17

required for Supervisor option 2-27

Menus

dimmed commands 1-41

using 1-41

Message, sending during method 

run 6-45

MET files, see Method files (.MET)

Method

aborting 5-33, 6-89, 6-93, 8-3

adding to top of Method 

Queue 6-92

anion exchange D-13

asterisk (*), meaning of 5-3, 6-7, 

6-9, 6-33, 6-34, 6-87

blend graph 6-51

blocks, segments, and events 6-3

cation exchange D-16

changing configuration 6-14

configuration mismatch 6-84

configuration, definition 4-3

configuration, difference from 

system 4-3

creating 6-11

creating typical 6-73

determining order in run 6-92

editing 6-87

error codes 8-18, 10-60

Event log 8-18

General Settings 6-15

holding 5-33, 6-93

icons in Event log 8-17

in multi-methods 7-42

injections, making 6-77 to 6-83

loading configuration from 4-23, 

6-89

minus sign (-), meaning of 6-7, 6-33

opening 6-84

opening from data file 6-86

opening from method file 6-86

opening methods created in a 

multi-method 6-84

plus sign (+), meaning of 5-3, 6-7, 

6-9, 6-33, 6-34, 6-87

print settings 6-69

printing 6-69

programming in column 

volumes 6-21
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Method (continued)

resuming 5-33, 6-93

running 6-89

running multiple times 7-19, 7-21, 

7-28

running STAT 6-92

saving 6-72, 6-88

sending a message during 6-45

setting analysis parameters 6-71

setting data storage options 6-67, 

7-46

setting run parameters 6-71

specifying print settings 6-69

STAT 6-92

stopping 5-33, 6-89, 6-93

stopping pump 5-33, 6-35

structure of 6-3

supplied with BioCAD D-1 to D-22

synchronizing with external 

device 6-50

triggering data collection 6-45

units 6-10

Method blocks, see Blocks, method

Method Editor

blocks, description 6-4

closing 6-88

creating blocks 6-18

creating segments 6-19

displaying 6-12

displaying different views 6-8

displaying events in 6-8

events, description 6-35

events, see Method events

segment buttons not available 6-30

segments, description 6-5

troubleshooting 10-29

using 6-2

Method events

adding 6-33

adding to end of segment 6-34, 

6-87

automatically moved to end of 

segment 6-34, 6-87

column 6-36

copying 6-88

data collection 6-45

deleting 6-34, 6-87

description 6-7, 6-35

detector 6-37, 6-38

direct wire autosampler 6-44

displaying in Method Editor 6-7, 

6-33

editing 6-87

fluorescence detector 6-40

fraction collector 6-41

fraction/waste valve 6-41

from Control Panel operation 5-3

holding the method 6-45

integrated autosampler 6-43

message 6-45

moving 6-88

plumbing 6-36

pump 6-35

sample load 6-42

special symbols (*+-) 5-3, 6-7, 6-9, 

6-33, 6-34, 6-87

viewing 6-9

Method files (.MET)

creating 6-11, 6-73

default directory 1-34

location 1-30

opening 6-84

sample D-1



I

D
E
X

N

Index-20 Applied Biosystems

Method Queue

adding method to top 6-92

clearing 5-33, 6-93, 8-3

deleting methods 6-89, 8-3

label column 8-2

printing 8-3

removing methods 8-3

viewing 8-2

Method segments, see Segments, 

method

Methods development 1-4, 6-11, 6-73

Micro vial inserts 3-52, 4-39

Micro vial shape

dead volume 3-51, 4-39

for Empty vials 3-54, 6-55

for intermediate vials 6-56

in Vial Editor 4-49

maximum volume 3-51, 4-49

minimum volume 3-51, 4-49

recommended types 3-51

setting as default 4-39

Microsoft Backup 9-49

Microsoft Excel, version 1-20

Microsoft Windows

closing a window 1-38

exiting 2-36

finding hidden windows 1-37

introduction 1-36

minimizing and maximizing 1-38

parts of a window 1-37

resizing a window 1-38

using dialog boxes 1-39

using menus 1-41

using the mouse 1-40

version 1-20

Mixer, see Filter/mixer

Mixing samples, integrated 

autosampler

Autosampler Inject segment 6-32

gas supply requirement 3-48

Heat/Mix segment 6-64

in method 6-64

Mix Sample check box 6-32

without heating 6-66

ml/min 5-14

Modes

blend 5-9

injection 1-13

Monitor, connecting 2-24

Mouse

connecting 2-24

using 1-40

MRK 1-9, 8-8

MS-DOS version 1-20, 9-47

Multi-method files (.GMM)

adding methods to 7-41

creating 7-41

default directory 1-34

editing 7-44

location 1-30

opening 7-40

running 7-46

Multi-Methods

adding methods to 7-41

creating 7-41

creating and running 7-40 to 7-47

example 7-42

opening 7-40

running 7-46

stopping 7-47

viewing results 7-47
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N
NaCl conductivity 9-22

Needle, autosampler

adjusting height 9-42

cleaning 9-38

replacing 9-38

Network card 2-25

Network, connecting BioCAD to 2-25

Nitrogen, see Gas supply

Noise, troubleshooting 2-15, 2-17, 3-5, 

9-15, 10-9, 10-25

O
Open File dialog box, using 1-42

Optimizing

elution conditions 7-30

loading conditions 7-30

Option buttons 1-39

Optional accessories

auxiliary detector 1-18

computer monitor 1-20

fluorescence detector 1-18

fraction collector 1-19

printers 2-25

single or dual wavelength 1-17

Supervisor stand-alone 

software 1-22

Organic solvents 6-17

Outgassing, preventing 3-18

Overview

BioCAD windows 1-21

creating a method 6-11

system 1-8

Overwriting data files 6-68

P
Parameter abbreviations 8-3

Parameters, Combinatorial 

Optimization template 7-38

Partial loop injections 4-38, F-2

Path length, flow cells 4-13

Path, file 6-68

Peak detection

see Data Analysis User’s Guide
Peak, minimum number of data 

points 4-18

PENEXE directory 1-33, 2-28

Percent value in pH blending 5-12, 7-11

Percentage mode

automatically set to total 

100% 5-10

definition 5-9

setting 5-9

Perfusion Chromatography

advantages 1-5

data rates 4-18

Peripheral devices, connecting 2-26

pH blend buffers 5-12

pH blending

calibrated pH buffers 3-20

custom pH buffers 3-20

percent value in 5-12

uncalibrated pH buffers 3-20

pH Map template

buffer/solvent requirements 7-6

configuration requirements 7-7

creating 7-12

method requirements 7-8

overview 7-5

running 7-12
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pH mapping

calibrated buffers in Buffer/Solvent 

Library 5-30

calibrating buffers for 5-26

percent value in 7-11

preparing buffers 3-20

sample methods 7-8

standard method D-13, D-16, D-19

template 7-5

pH mode

calibrated buffers in Buffer/Solvent 

Library 5-30

calibrated pH blend buffers 5-12

calibrating buffers 5-26

definition 5-9

eluent concentration range 5-11, 

7-32

percent value in 5-12

pH blend buffers 5-12

setting 5-11

uncalibrated pH blend buffers 5-12

pH monitor

and organic solvents 6-17

bypassing 1-17, 5-22, 6-17, 6-37

calibrating 9-19

cleaning flow cell 9-17

cleaning probe 9-16

collecting signal 4-16

configuring 4-16

displaying signal 8-5

enabling data channel 4-17

installing probe 9-18

preventing damage 2-2

removing probe 2-2, 2-41, 9-16

shutting down 2-38, 9-53

storing probe 2-41, 9-21

troubleshooting 10-10

PH.CAL file 10-10

PHCALIB.B## file 5-29

Pin assignments, external 

connectors E-1

Plumbing

auxiliary detector flow cell 2-17

column diagram 3-10, 3-12

configuration diagram 3-9, 5-19

configuring 4-11

connecting 3-9

Direct Control 3-12

fluorescence flow cell 2-15

injector valve, integrated 

autosampler 3-46

Low Dispersion 3-11

method events 6-36

Single Column 3-10

system diagram 3-4

Tandem Column 3-10

Three Column 3-11

UV/Vis detector flow cell 3-5, 9-15

UV/Vis flow cell 2-15

Points per peak, minimum 4-18

Pooling fractions 5-45, 6-41, 7-20

POROS

A and G D-3

columns and media 1-5

HP, PE, and ET D-5

HQ, QE, and PI D-9

HS, SP, S, and CM D-11

R1 and R2 D-7

Power down sequence 2-38

Power requirements 2-4

Power up sequence 2-37

Preface xxi

Prep block

adding to method 6-53

expiration time 6-55

final vials 6-56

intermediate vials 6-56

name 6-54

prep volume 6-54

segment buttons not 

available 6-58, 6-61

vial shape 6-55
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Prep block segments

buttons not available 6-58, 6-61

Combine 6-61

Dilute 6-57

Heat/Mix 6-64

Prep Block Setup dialog box 6-54

Prep, sample see Sample preparation

Preparative chromatography 7-19

Preparing

autosampler 3-43

autosampler solvents 3-48

buffers/solvents 3-18

columns 3-9

fraction collector 3-39

pH blend mode buffers 3-20

pump seal wash solution 3-22

samples for autosampler 3-51

samples for workstation 3-23

tubing 3-9

vials for integrated 

autosampler 3-51

Pressure limits

and flow rates 4-5

column 4-34

system 4-5

Pressure trace

collecting signal 4-16

configuring 4-16

enabling data channel 4-17

Pressure, in Status window 8-5

Preventative maintenance 9-3

Prime volume

autoloader 4-9

integrated autosampler 4-40

Prime/purge valve, description 1-11

Priming

autoloader sample lines 3-34

buffer/solvent channels 3-30

diagram of lines 3-34, 4-10

direct wire autosampler 3-49

integrated autosampler 3-49

pump seal wash 3-28

setting default volume 4-9, 4-10

system 3-28 to 3-36

Print driver 2-25

Print setup 4-21

Printer

connecting 2-25

connecting with hardware key 2-33

setting up 4-21

supported 2-25

Printing

after a method run 6-71

chromatograms 6-69

configuration 4-21, 6-69

Event log 6-69, 8-20

method 6-69

Method Queue 8-3

Proportioning valve, description 1-11

Protection key

error codes 10-64

installing 2-33

Pull loop injection

description 4-38, F-2

injection range 4-38

integrated autosampler 4-38

plumbing 3-47

volume drawn 4-38

when to use 4-38
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Pump

cavitation 1-10

changing pump seals 9-23

cleaning check valves 9-30

cleaning filter/mixer frit 9-33

cleaning piston 9-23

configuring 4-5

description 1-11

diagram of parts 9-25

filter 1-11

injections 1-13, 3-27, 5-42, 6-80

method events 6-35

pressure limits 4-5

priming 3-30

shutdown caused by tubing 3-2

starting and stopping from Control 

Panel 5-13

starting and stopping from front 

panel 1-9

starvation 1-10

turning off and on from Control 

Panel 5-13

turning off and on from front 

panel 1-9

turning off and on in method 5-33, 

6-35, 6-93, 8-3

Pump seal wash

connecting lines 2-12

description 1-11

preparing 3-22

priming 3-28

when to change 3-22

Purge command 5-15

Purge segment

creating 6-25

description 6-5

Purge valve, description 1-11

Purging

from Control Panel 5-15

in method 6-25

PushLoop injection

description F-2

injection range 4-38

integrated autosampler 4-38

plumbing 3-47

volume drawn 4-38

when to use 4-38

Q
Quitting

BioCAD software 2-36

Microsoft Windows 2-36

R
R (Reagent) vial type 4-48

RA number C-4

RAM 1-20

Real-time mode, Strip Chart 

Recorder 8-8

Recorder setup 4-16

Regenerating columns 1-15, 5-19, 6-4, 

6-27, 7-20

Related documents xxvi

Reports

see Data Analysis User’s Guide
Reservoir location 3-18

Resource error 8-17

Results, viewing 1-24, 1-25, 6-92, 7-4, 

7-47, 8-4, 8-7

see also Data Analysis User’s 
Guide

Resume button 5-33, 6-93

Returning damaged items C-4

Reversed elution 1-15, 5-19

Reversing flow 6-36

RheFlex fittings 3-5
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RPSTD.MET D-7

Run and report, see Analyze after run

Run log 6-69

Running

methods 6-89

multi-methods 7-46

STAT methods 6-92

templates 7-3

S
S (Sample) vial type

changing from Derived vial 

type 6-54

description 4-48

Sample

adding to Sample Library 4-44, 

4-52

changing library 4-29

clearing from Sample Table 4-52

component name 4-52

concentration 4-52

cooling 4-43, 5-50

dead volume 3-51

displaying temperature 5-50

entering in Sample Table 4-47

filtering 3-53

heating 4-42, 5-50

incubating 4-42, 5-50

location 3-23

maximum volume 3-51, 4-49

minimum volume 3-51, 4-49

mixing 6-32, 6-64

names in configuration 4-9, 4-49

names in method 6-29, 6-31

preparation 3-23, 3-51

selecting from Sample 

Library 4-48, 4-49

short name 4-52

vials 3-51

viscosity 4-52

volume 3-51, 4-49

Sample Editor dialog box 4-30

Sample Library

adding base name and suffix 4-52

adding sample name 4-52

component name of sample 4-52

concentration of sample 4-52

customizing 4-29, 4-44

displaying 4-48

selecting sample from 4-48, 4-49

short name of sample 4-52

viscosity of sample 4-52

Sample Library dialog box 4-45

Sample lines (autoloader)

priming 3-34

Sample lines (pump injection), 

priming 3-37

Sample Loader

configuring 4-7

controlling from Control 

Panel 5-36, 5-38, 5-40

description 1-12

error codes 10-48

injection modes 1-13

method events 6-42

Sample loop

changing 3-13, 4-8, 5-4, 5-7

configuring 4-8

creating your own 4-8

method events 6-42

size 4-8, 5-4, 5-7

Sample loop, integrated autosampler

plumbing 3-47

setting size 5-49

Sample loss, minimizing 1-15, 3-35, 

4-10, 5-19

Sample methods D-1
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Sample name

adding to Sample Library 4-44, 

4-52

entering in Sample Table 4-48, 

4-49

selecting from Sample 

Library 4-48, 4-49

Sample Prep button not displayed in 

Config 4-42

Sample preparation

Analysis template 7-21

configuring 4-42

cooling 4-43

determining if autosampler 

supports 2-32, 3-45, 3-57

diluent recommendation 6-63

empty vials needed 3-54

heating 4-42

integrated autosampler 4-42

mixing after 6-60, 6-63, 6-64

Prep block in method 6-53

Sample Preparation Configuration 

dialog box 4-42

Sample rate for data

guidelines 4-18

minimum number points per 

peak 4-18

setting 4-18

Sample Table

adding samples to Sample 

Library 4-44, 4-52

autonaming vials 4-50

batch-entering vials 4-50

changing sample loop size 5-49

clearing vials 4-52

configuring sample vials 4-46

controlling cooling 5-50

controlling heating 5-50

controlling integrated 

autosampler 5-47

displaying 5-3

entering samples 4-47

Sample Table (continued)

error codes 10-50

injecting from 5-47

not displayed on Window 

menu 4-44, 5-3

overview 4-46, 5-3

saving settings in system 

configuration 4-46, 4-52

selecting samples from Sample 

Library 4-48, 4-49

troubleshooting 10-28

SCANDISK 9-50

SCOUT Column Selector

configuring 2-32

connecting 2-23

SCSI card 2-26

Seal wash, see Pump seal wash

Segments, method

Autosampler Inject 6-30

buttons not available 6-30, 6-58, 

6-61

Combine 6-61

copying 6-88

creating 6-19

deleting 6-87

Dilute 6-57

editing 6-87

ending before duration 6-22

Gradient 6-23

Heat/Mix 6-64

Inject 6-27

moving 6-88

overview 6-5

Purge 6-25

Step 6-20

viewing 6-9

Semi-preparative flow cell 4-13, A-5

Septa, autosampler 3-51

Sequence view of method 6-8

Set vial 4-56
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Setting

default vial shape 4-39

flush solvent, integrated 

autosampler 4-40

flush volume, integrated 

autosampler 4-40

loop size, integrated 

autosampler 4-40

prime volume, integrated 

autosampler 4-40

Setup files 1-34

Shape, vial, see Vial shape

Short Name

entering in Sample Library 4-52

in Sample Editor 4-31

Shutdown

daily 2-38

long term 2-40, 9-52

method D-22

running SYSCLEAN.MET 2-38

short term 2-38

software 2-36

storing pH probe 2-2, 2-41, 9-21

Side panel diagram 2-13, 2-24

Single Column

configuration 3-10

description 1-15, 5-19

Software

autosampler 3-44, 3-45, 4-36

BioCAD window descriptions 1-21

directories 1-33

exiting 2-36

file contents 1-30

file structure 1-30

file types 1-30

installing 2-27

installing if you do not have CD 

ROM drive 2-30

overview 1-20

stand-alone, see Supervisor 

software option

Software (continued)

starting 2-34

Supervisor 1-22

version number 1-22, 2-25, 3-44, 

4-36

Solvent blending, see Blending

Solvent lines, autosampler 3-48

Solvents

connecting 2-9, 3-17

incompatible 2-9, 6-17

maximum number 3-18

maximum number for blending 3-18

organic 6-17

venting 2-10

Solvents, autosampler

configuring 4-43

filtering 3-48

preparing 3-48

Spare parts B-1

Sparge

element 2-11

kit 2-9, B-10

lines 2-10

rate 2-11, 3-19

vent plug 2-10

Sparge panel

connecting helium line 2-8

connecting sparge lines 2-10

illustration 2-8

pressure 2-4, 2-8

rate 2-11, 3-19

turning off helium before closing 

tank 2-8

when to use 3-18

Specifications A-1

Specify Channel 4-26

SpectraNet mode 3-44

ST (Standard) vial type 4-48

Stand Alone mode 3-44
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Standard vial shape

dead volume 3-51, 4-39

for Empty vials 3-54

for intermediate vials 6-56

in Vial Editor 4-49

maximum volume 3-51, 4-49

minimum volume 3-51, 4-49

setting as default 4-39

Startup sequence 2-37

STAT method run 6-92

Stators, cleaning 9-37

Status window

changing signals monitored 8-5

troubleshooting 10-15

using 8-4

viewing during a run 6-92

Step Optimization template

eluent concentration range 7-32

overview 7-30

Step segment

creating 6-20

description 6-5

including Data Start events 6-20

using to make injections 6-20, 6-44, 

6-81, 6-83

Stopping

flow 1-9, 5-33, 6-35, 6-93

method runs 5-33, 6-93

multi-method runs 7-47

pump 1-9, 5-33, 6-35, 6-93

template runs 7-4

Stopwatch utility 8-14

Strip Chart Recorder

annotations 8-8

buffer duration 4-16

customizing 8-9

data acquisition time 4-16

default settings 8-12

deleting contents of 4-16, 9-51

events displayed in 8-10

Strip Chart Recorder (continued)

History mode 8-8

Real-time mode 8-8

saving data 8-13

setting duration 4-16

temp files 1-30, 1-34

troubleshooting 10-15

using 8-7

viewing during a run 6-92

zooming 8-12

Strip chart recorder, external

connecting 2-23

signal 2-23

Subdirectories 1-35, 6-68

Suffix, autoname 4-50

Supervisor software option

description 1-22

error codes 10-64

hardware (protection) key 2-33

main screen 2-35

memory required 2-27

Switching valves 1-14

Syringe

changing 3-13, 4-8, 5-4, 5-5

injection volume ranges 3-13

loading range 3-13, 5-5

sample does not enter during 

injection H-7

seal, checking and changing 9-34

setting size in configuration 4-8

Syringe pump error codes 10-53

SYSCLEAN.MET 2-39, D-22

SYSCONF.CFG file 4-3

System

error codes in Event log 8-17

hardware 1-20

parts of 1-8

plumbing diagram 3-4

software 1-20
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System configuration

diagram 3-9, 5-19

difference from method 

configuration 4-3

sample vials added to 4-46, 4-52

SYSTEM.EVL 8-15

Systematic methods development 1-4, 

7-3

T
Tandem Column

configuration 3-10

description 1-15, 5-19

Task Manager 1-37

Technical support

contacting 10-2

for computers with altered 

configuration C-1

Temperature, autosampler

displaying 5-50

setting 4-42, 5-50

turning on and off 4-42, 5-50

Temperature, displaying in Status 

window 8-5

Templates

abbreviations for parameters 8-3

Analysis 7-21, 7-28

Auto Cycling 7-19

Column Switching 7-2

Combinatorial Optimization 7-34

creating and running 7-2 to 7-39

creating group files 7-4

creating your own 7-40

determining the template to use 7-2

example 1-7

Flow Rate Study 7-18

how system selects vial 7-3, 7-25

insufficient injection volume 7-3, 

7-25

Linear Gradient 7-16

Loading Study 7-14

Templates (continued)

parameter abbreviations 8-3

pH Map 7-5

Step Optimization 7-30

stopping 7-4

systematic method 

development 1-7

systematic methods 

development 7-3

troubleshooting 10-35

viewing results 7-4

Three Column

configuration 3-11

description 1-15, 5-19

limitations 3-31, 3-33, 3-37, 5-15, 

9-52

Threshold, Step segment 6-22

Timeout, direct wire autosampler 4-55

Timer window 8-14

Trays, autosampler

installing 3-55

number of vials 3-53

Troubleshooting

AS 3500 autosampler 10-20

autosampler 10-20

computer 10-36

conductivity monitor 10-11

Control Panel 10-12, 10-15

error codes 10-37

fraction collector 10-18, 10-20

gradient 10-5

high pressure shutdown 10-4, 10-5

Method Editor 10-29

no peaks 10-6, 10-7

noise 2-15, 2-17, 3-5, 9-15, 10-9, 

10-25

pH monitor 10-10

Sample Table 10-28

Status window 10-15

Strip Chart Recorder 10-15

system 10-3 to 10-11

templates 10-35
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Tubing

and pump shutdown 3-2

compressed gas 2-7

connecting 3-9

considerations 3-2

cutting 3-4

delay volume 4-14

diagram 3-9

flow rates and volumes 3-3, 4-12

gas 2-7

helium supply line 2-8

lengths 3-2

lengths for Direct Control 3-12

lengths for Low Dispersion 3-11

lengths for Single Column 3-10

lengths for Tandem column 3-10

lengths for Three Column 3-11

overview 1-11

pump seal wash line 2-12

recommendations for maximum 

efficiency 3-2

selecting size 3-2

size and volume 3-3

sparge 2-9

waste line 2-12

Tungsten lamp

changing 9-8

turning off in method 6-39

wavelength range 1-17, 5-21

Two column, see Tandem Column

Type, buffers/solvents

Buffer 4-28

Eluent 4-28

H2O 4-28

None 4-28

Sample 4-28

Type, vial, see Vial type

U
Uncalibrated pH buffers

description 3-20

in pH mode 5-12

Unspecified vial shape 3-52, 4-39, 

4-41, 4-49

Unused workstation, preventing 

damage 2-2

Update Config command, when to 

use 6-14

Updating hardware setup 2-31

UV/Vis detector, see Detector, UV/Vis

V
Valves

column switching 1-14

detector bypass 1-16

fraction/waste 1-19

injection 1-14

maintenance 9-37

Variable volume injection 4-38

Variables affecting chromatography 1-5

Venting buffers/solvents 2-10

Version number

autosampler software 3-44, 3-45, 

4-36

BioCAD software 1-22, 4-36

Excel 1-20

MS-DOS 1-20

Windows 95 software 1-20
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Vial

“Product” label 6-56

autonaming in Sample Table 4-50

batch-entering 4-50

clearing from Sample Table 4-52

contents 4-45, 4-47

dead volume, eliminating 3-52, 

4-39, 4-41

dead volumes of 3-51

entering in Sample Table 4-47

injecting from empty 4-49

inserts, see Micro vial inserts

loading in autosampler tray 3-53

maximum volume 3-51, 4-49

Micro 3-51

Micro vial inserts 3-52

minimum volume 3-51, 4-49

overfilling 4-49

requirements 3-51

septa 3-51

shape, see Vial shape

Standard 3-51

temporary 6-56

type, see Vial type

volume 3-51, 4-49

Vial Editor dialog box 4-45, 4-47

Vial number

autosampler 4-56

setting 4-56, 6-44

Vial shape

changing in Prep block 6-55

dead volume, eliminating 3-52, 

4-39, 4-41

dead volumes of 4-39

default 4-39

maximum volumes 3-51, 4-49

Micro 3-54, 4-39, 4-49, 6-56

minimum volume 3-51, 4-49

setting default 4-39

Standard 3-54, 6-56

Std 1800 µl 4-39, 4-49

Std 2000 µl 4-39, 4-49

Unspecified 3-52, 4-39, 4-41, 4-49

Vial type

Control 4-48, 6-31, 6-59, 6-62, 

6-65, 7-24

Derived 4-48, 6-31, 6-59, 6-62, 

6-65

Empty 4-48

Reagent 4-48, 6-31, 6-59, 6-62, 

6-65, 7-24

Sample 4-48, 6-31, 6-59, 6-62, 

6-65, 7-24

Standard 4-48, 6-31, 6-59, 6-62, 

6-65, 7-24

Viewing results, see Results, viewing

Viscosity of sample

entering in Sample Library 4-52

for autosampler injection 3-58

Void volume 4-34

Voltage

changing 2-5

checking 2-4

Volume

autosampler injection 4-38

dead volume in vial 3-51

flush 4-10

injection 1-13, 3-13, 5-4, 5-34

Micro vial 3-51, 4-49

prime 4-10

programming in different units 6-10

Standard vial 3-51, 4-49

tubing 3-3

UV/Vis detector flow cells 4-13

valid ranges for integrated 

autosampler 

injections 4-38

vial 3-51, 4-49

Volume ranges

injection modes 1-13

syringes 3-13

vial 3-51, 4-49
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W
W (Waste) vial type

description 4-48

not available 4-48

W lamp, see Tungsten lamp

Warranty

damages, claims, returns C-4

exceptions C-3

for computers with altered 

configuration C-1

information 9-2, C-1, H-1

invalidating 9-2

period C-2

Wash block

allowable segments 6-6

creating 6-18

description 6-4

Washing columns 1-15, 5-19

Waste lines, connecting 2-12

Water conductivity 9-22

Wavelength

changing from Control Panel 5-20

changing in method 6-38, 6-40

dual UV/Vis not available 4-15

enabling dual 4-15

fluorescence ranges 5-22

range 5-20, 6-16

single/dual options 1-17

UV/Vis dual ranges 5-21

UV/Vis single ranges 5-20

zeroing the detector 6-38

zeroing the fluorescence 

detector 6-40

Weight of BioCAD unit 2-3

Wildcards 1-43

Windows, see Microsoft Windows

World wide web address, Applied 

Biosystems xxvii

X
X-Axis scroll position 8-10

Z
Zeroing the detector

from Control Panel 5-22

in the method 6-39, 6-40

when fluorescence wavelength 

changes 6-40

when UV/Vis wavelength 

changes 6-38

Zip drive, Iomega 2-26

Zooming

Strip Chart Recorder 8-12
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